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9

Πρόλογος

Το βιβλίο αυτό απευθύνεται στους μαθητές της Β΄ Τάξης του 1ου Κύκλου των Τεχνι-

κών Επαγγελματικών Εκπαιδευτηρίων. Η δομή του ακολουθεί το πρόγραμμα σπου-

δών του μαθήματος «Εφαρμογές Ηλεκτρονικών Υπολογιστών» του Τομέα Εφαρμο-

σμένων Τεχνών που εκπόνησε το Παιδαγωγικό Ινστιτούτο.

Ο σκοπός του βιβλίου είναι να εξοικειώσει τους μαθητές με τις βασικές έννοιες των 

υπολογιστών όπως αυτές εφαρμόζονται στις γραφικές τέχνες.

Οι στόχοι που έχουν τεθεί είναι:

	 -	� Η γνωριμία των μαθητών με τα προγράμματα που χρησιμοποιού-

νται στον χώρο των γραφικών τεχνών.

	 -	� η επισήμανση των δυσκολιών για την πιστή αναπαραγωγή από 

την οθόνη του υπολογιστή στο τυπωμένο χαρτί.

	 -	� η εξάσκηση των μαθητών με τα επιτραπέζια εκδοτικά συστήματα 

και τα προγράμματά τους.

Το βιβλίο χωρίζεται σε τρεις ενότητες:

	 -	 Επεξεργασία εικόνας μέσω Η/Υ

	 -	 Ψηφιακή σχεδίαση 

	 -	 Ηλεκτρονική τυπογραφία

Δόθηκε ιδιαίτερη προσπάθεια ώστε να παρουσιασθούν με απλό τρόπο όλες οι δοκι-

μασμένες τεχνικές που χρησιμοποιούνται στην πράξη. Θα πρέπει να τονισθεί όμως 

ότι το βιβλίο δεν είναι οδηγός εκμάθησης προγραμμάτων. Στα παραδείγματα που 

υπάρχουν χρησιμοποιούνται συγκεκριμένα προγράμματα, αλλά οι οδηγίες που δί-

δονται είναι γενικές και εφαρμόζονται στα (σχεδόν όλα) ανάλογα προγράμματα σε 

όποια έκδοση και αν βρίσκονται.

Οι συγγραφείς
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Ε Φ Α Ρ Μ Ο Γ Ε Σ  Η Λ Ε Κ Τ Ρ Ο Ν Ι Κ Ω Ν  Υ Π Ο Λ Ο Γ Ι Σ Τ Ω Ν

Κεφάλαιο 1ο
Η ψηφιακή εικόνα

Στόχοι:

Μετά τη μελέτη αυτού του κεφαλαίου οι μαθητές θα είναι σε θέση να:

	 •	 �Κατανοήσουν τις δυνατότητες των ψηφιακών τεχνικών φωτογράφησης 
και επεξεργασίας φωτογραφιών.

	 •	 �Κατανοήσουν τις παραμέτρους που υπεισέρχονται στην ανάλυση της 
ψηφιακής εικόνας.

1.1 Εισαγωγή

Τα τελευταία χρόνια συντελείται μία πραγματική επανάσταση στο χώρο της φωτο-
γραφίας. Κάθε τόσο ακούμε και για μία καινούργια αλλαγή. Αλλαγή στην τεχνο-
λογία των φωτογραφικών μηχανών, αλλαγή στον τρόπο αποθήκευσης της εικόνας, 
αλλαγή στον τρόπο επεξεργασίας και εκτύπωσης των φωτογραφιών.

Εξετάζοντας την εξέλιξη της τεχνολογίας της φωτογραφίας, θα αναφερθούμε πρώ-
τα στην κλασική φωτογραφική μηχανή, ένα «μαύρο κουτί» που έχει ένα οπτικό σύ-
στημα φακών, αποτελούμενο από το διάφραγμα, το κλείστρο και το σκόπευτρο. Τα 
ηλεκτρονικά συστήματα που προστέθηκαν και αυτοματοποίησαν τη φωτογράφηση 
δεν άλλαξαν ριζικά την αρχή στην οποία στηρίζεται η λειτουργία της.

Ακόμη και πριν από το 1826, χρονολογία εφεύρεσης της φωτογραφικής τεχνικής, 
ήταν γνωστή η λεγόμενη Camera Obscura (ή μηχανή σκιαγραφίας). Πρόκειται για 
ένα αδιαφανές κουτί με μία οπή σε μία έδρα του. Από την οπή αυτή περνούσε μία μι-
κρή δέσμη φωτός που, με τη βοήθεια ενός φακού, εστιαζόταν σε ένα γαλακτόχρωμο 
τζάμι. Αν η ακτίνα του φωτός προερχόταν από ένα αντικείμενο, τότε το είδωλό του 
προβαλλόταν στο τζάμι, οπότε ο καλλιτέχνης μπορούσε να τοποθετήσει ένα χαρτί 
και να το σχεδιάσει με το χέρι (Εικόνα 1.1 Α και Β). Το φως διερχόμενο από την οπή 
σχηματίζει ανεστραμμένη εικόνα του εξωτερικού περιβάλλοντος. Όσο μεγαλύτερη 
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είναι η διάμετρος της οπής, τόσο αυξάνει η φωτεινότητα σε βάρος όμως της ευκρί-
νειας της εικόνας που σχηματίζεται. Αυτή την τεχνική λέγεται ότι χρησιμοποιούσε 
ο Ολλανδός ζωγράφος Johannes Vermeer (1632-1675) σε πολλά από τα έργα του.

Παρόλο που από την εποχή της Camera Obscura έγιναν πολλές βελτιώσεις, η αρχή 
λειτουργίας των φωτογραφικών μηχανών παραμένει ίδια. Όλες οι φωτογραφικές 
μηχανές επιτρέπουν τη διέλευση από τη θέση του φακού μόνο της δέσμης του 
φωτός που μεταφέρει το είδωλο του αντικειμένου. Εκείνο, επομένως, που σημα-
τοδότησε την εξέλιξη της φωτογραφίας δεν ήταν η φωτογραφική μηχανή, αλλά η 
...χημεία, και πιο συγκεκριμένα η χημεία παρασκευής του φωτοευαίσθητου υλι-
κού για την εμφάνιση και σταθεροποίηση του ειδώλου στο φιλμ.

Αρχικά, η βάση για την επίστρωση του φωτοευαίσθητου γαλακτώματος ήταν η κα-
λογυαλισμένη επιφάνεια ενός λεπτού φύλλου χαλκού. Μετά από τη φωτογράφηση, 
που είχε διάρκεια 10-15 λεπτά, ερχόταν η σειρά της εμφάνισης και στη συνεχεία της 
σταθεροποίησης του ειδώλου του θέματος. Στη διάρκεια των περίπου 180 ετών της 
εξέλιξης της φωτογραφίας, από τα φύλλα χαλκού μέχρι τα σύγχρονα φιλμ από ζελα-
τίνα, παρά την τεράστια βελτίωση της ποιότητας της εικόνας, το βασικό συστατικό 
του φωτοευαίσθητου υλικού παρέμεινε το ίδιο, ο βρωμιούχος άργυρος.

Το φιλμ που όλοι γνωρίζουμε, απεικονίζει το θέμα μας αρνητικά, δηλαδή τα φωτει-
νά μέρη του εμφανίζονται σκοτεινά και το αντίστροφο. Για να δημιουργήσουμε το 
θετικό είδωλο στο φωτογραφικό χαρτί, δηλαδή την τελική φωτογραφία, θα πρέπει, 

Α

Εικόνα 1.1: (A) Camera Obscura.
(Β) Το είδωλο του αντικειμένου εμφανίζεται ανεστραμμένο στο γαλακτόχρωμο τζάμι, αφού διέλ-
θει μέσα από το φακό a και στη συνέχεια ανακλαστεί στο κάτοπτρο b.

Β

a

b
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με τη βοήθεια ενός μεγενθυντήρα (enlarger), να μεγεθύνουμε και να επαναλάβου-
με τη φωτογράφηση του θέματος από το αρνητικό φιλμ (Εικόνα 1.2 Α και Β).

Εικόνα 1.2: (Α) Το αρνητικό φιλμ. (Β) Η τυπωμένη φωτογραφία.

Αν, όπως συμβαίνει συνήθως σήμερα, χρησιμοποιούμε έγχρωμο φιλμ, πρέπει να 
γνωρίζουμε ότι η βάση του καλύπτεται από τρεις φωτοευαίσθητες επιστρώσεις, 
όπου η κάθε μία είναι ευαίσθητη στις αντίστοιχες χρωματικές συνιστώσες του φω-
τός, δηλαδή του μπλε, του πράσινου και του κόκκινου.

Σήμερα, η τεχνολογία της φωτογραφίας γνωρίζει μία επαναστατική αλλαγή. Οι 
ψηφιακές μηχανές δε χρησιμοποιούν φιλμ. Η καταγραφή του ειδώλου γίνεται σε 
φωτοκύτταρα και η αποθήκευση σε κάρτα με ψηφιακή μνήμη. Επομένως, καταρ-
γούνται τα στάδια της εμφάνισης και σταθεροποίησης του ειδώλου, ενώ ο σκοτεινός 
θάλαμος του φωτογράφου, με τα χημικά, «έδωσε τη θέση του» στον ηλεκτρονικό 
υπολογιστή με τα προγράμματα επεξεργασίας εικόνας. (Εικόνα 1.3).
Σήμερα, μπορούμε να τυπώσουμε φωτογραφίες στον εκτυπωτή μας, σε χαρτί, ή 
ακόμη και σε εικονοθέτη, αν πρόκειται να χρησιμοποιήσουμε τη φωτογραφία μας 
σε σελίδα εντύπου που θα τυπωθεί με κάποια εκτυπωτική μέθοδο.

Α Β
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Εικόνα 1.3: (Α) Σχηματική αναπαράσταση μιας ψηφιακής και μιας αναλογικής μηχανής με φιλμ. 
Το οπτικό σύστημα που αποτελείται από τον φακό εστίασης και το διάφραγμα είναι το ίδιο και 
στους δύο τύπους μηχανών. Η καταγραφή του θέματος όμως στην ψηφιακή, γίνεται στους αισθη-
τήρες CCD αντί στο φιλμ, και στην συνέχεια αποθηκεύεται στην κάρτα μνήμης. Από εκεί οδηγεί-
ται προς επεξεργασία στον Η/Υ, ή εκτύπωση.
(Β) Διάγραμμα που δείχνει τα στάδια φωτογράφησης με φιλμ και με ψηφιακή φωτογραφική 
μηχανή.

1.2 Γενική επισκόπηση

Πότε άρχισε η χρήση του όρου ψηφιακή εικόνα (ή φωτογραφία); Για το μέσο άν-
θρωπο που δεν ασχολείται με την εικόνα, ο όρος αυτός εμφανίστηκε στις αρχές του 
1990, όταν εμφανίστηκαν στην αγορά τα πρώτα προγράμματα επεξεργασίας εικό-
νας για τους προσωπικούς υπολογιστές.

Δεν υπάρχει ένας κοινά αποδεκτός ορισμός για την “ψηφιακή φωτογραφία”. Θα πα-
ρατηρήσουμε ωστόσο ότι ο όρος αυτός χρησιμοποιείται στις παρακάτω περιπτώσεις:
	 •	� Όταν φωτογραφίζουμε με ψηφιακή φωτογραφική μηχανή, δηλαδή, χω-

ρίς να χρησιμοποιούμε φιλμ.
	 •	� Όταν, με τη βοήθεια ενός επιτραπέζιου σαρωτή (scanner), εισάγουμε 

στον υπολογιστή τυπωμένες φωτογραφίες.
	 •	� Όταν επεξεργαζόμαστε φωτογραφίες στον ηλεκτρονικό υπολογιστή.
	 •	� Όταν τυπώνουμε ψηφιακές εικόνες. Η εκτύπωση μπορεί να γίνεται με 

οποιαδήποτε μέθοδο εκτύπωσης.

Φωτογραφική μηχανή με φιλμ

Ψηφιακή μηχανή

Διάφραγμα

Φιλμ

Φακός

Φακός

Πλέγμα
αισθητήρων
CCD

Κάρτα μνήμης RAM
Διάφραγμα

Α Β

Αντικείμενο προς φωτογράφιση

Οπτικό σύστημα = Εστίαση αντικειμένου

Φωτογράφιση σε φιλμ

Λανθάνουσα εικόνα

Εμφάνιση και Σταθεροποίηση

Η μετάβαση
από τα φιλμ
στα pixel

Καταγραφή σε φωτοκύτταρα

Ψηφιακή εικόνα

Ηλεκτρονική επεξ. εικόνας

Εκτύπωση
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Βλέποντας μία φωτογραφία μπορεί να μην είμαστε σε θέση να αναγνωρίσουμε αν 
αυτή είναι ψηφιακή ή όχι. Για να απαντήσουμε σε ένα παρόμοιο ερώτημα θα πρέπει 
να γνωρίζουμε αν έχει αυτή τραβηχτεί με απλή ή ψηφιακή φωτογραφική μηχανή 
και αν έχει αποθηκευτεί σε κάποιο ψηφιακό μέσο. Επίσης, συχνά δεν είναι εύκολο 
να αντιληφθούμε αν το θέμα μιας φωτογραφίας (π.χ ένα τοπίο, ένα πρόσωπο, ένα 
αντικείμενο) υπήρξε στην πραγματικότητα ή όχι. Στην πρώτη περίπτωση το θέμα 
παραμένει όπως αποτυπώθηκε από το φακό της μηχανής, ενώ στη δεύτερη έχει 
υποστεί κάποια επεξεργασία ή, ενδεχόμενα, έχει εξολοκλήρου δημιουργηθεί με τη 
βοήθεια σχεδιαστικών εργαλείων, σε σχεδιαστήριο ή σε οθόνη υπολογιστή. Οι πα-
ρατηρήσεις αυτές είναι καλή αφορμή για να προσπαθήσουμε να αποσαφηνίσουμε 
δυο έννοιες που συχνά βλέπουμε να συγχέονται.

	 •	� Ψηφιακή φωτογραφία είναι η εικόνα εκείνη που έχει ληφθεί με τη βοή-
θεια φωτογραφικής μηχανής απλής ή ψηφιακής και έχει καταγραφεί 
στον υπολογιστή. Είναι αποτέλεσμα της έμπνευσης και του ταλέντου 
του φωτογράφου χωρίς άλλη παρέμβαση.

	 •	� Ψηφιακή εικόνα είναι το προϊόν σύνθεσης ή επεξεργασίας φωτογραφι-
ών (ή και άλλων εικόνων) που επίσης καταγράφεται στον υπολογιστή, 
αλλά δεν απεικονίζει την πραγματικότητα. Φυσικά και αυτή η μη πραγ-
ματική απεικόνιση αποτελεί, συνήθως, αποτέλεσμα έμπνευσης κάποιου 
καλλιτέχνη.

Σύμφωνα με τους παραπάνω ορισμούς το θέμα της φωτογραφίας είναι αυθεντικό, 
ενώ της εικόνας έχει προκύψει τεχνητά. Ανεξάρτητα όμως από τη λεπτή αυτή δια-
φοροποίηση των εννοιών, στα πλαίσια αυτού του βιβλίου θα χρησιμοποιούμε τον 
όρο «ψηφιακή εικόνα» για όλες τις εικόνες που εισάγονται στον υπολογιστή, χωρίς 
διάκριση για την αυθεντικότητα του αρχικού θέματος.

1.3 Η ορολογία της ψηφιακής εικόνας

Εικονοστοιχείο (Pixel – Picture Element): Όταν παρατηρούμε προσεκτικά και από 
κοντά ένα αντικείμενο, προσπαθούμε να διακρίνουμε τα μέρη που το αποτελούν, να 
διακρίνουμε τα δομικά του στοιχεία. Αν δούμε ένα κτήριο από μία απόσταση ενός 
χιλιομέτρου διακρίνουμε μόνο το βασικό του σχήμα. Πλησιάζοντας όμως περισσό-
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τερο, μπορούμε να δούμε τα παράθυρα, τις πόρτες, την οροφή. Συνεχίζοντας την 
προσεκτική παρατήρησή μας, ενώ πλησιάζουμε όλο και πιο κοντά, π.χ. στον τοίχο 
του κτηρίου, είναι δυνατόν να δούμε ακόμη και τα τούβλα που τον αποτελούν με τη 
χαρακτηριστική τους διάταξη και το τσιμέντο ενδιάμεσα.

Ας μεταφέρουμε το παράδειγμα του τοίχου στο αντικείμενο της μελέτης μας, την 
ψηφιακή εικόνα. Τα δομικά στοιχεία μίας ψηφιακής εικόνας είναι τα εικονοστοι-
χεία (pixels).

Εικονοστοιχείο*: ονομάζεται η ελάχιστη μονάδα οπτικής πληροφορίας σε μία ψη-
φιακή εικόνα στην οθόνη ή στον σαρωτή.

Το κάθε εικονοστοιχείο (ή και εικονοψηφίδα για άλλους), σαν ένα μικρό τετράγωνο 
τούβλο, είναι ανεξάρτητο από τα διπλανά του, αλλά, όλα μαζί σχηματίζουν τη συ-
νολική εικόνα.

Γενικεύοντας, μπορούμε να παρατηρήσουμε ότι τα σχετικά προγράμματα επεξερ-
γασίας, προκειμένου να αλλάξουν ή να βελτιώσουν μία εικόνα, επιδρούν σε μεμο-
νωμένα ή σε ομάδες εικονοστοιχείων της.

Ανάλυση Εικόνας (Image resolution): Πόσα εικονοστοιχεία έχει μία ψηφιακή ει-
κόνα; Τι μέγεθος έχουν; Πώς κατανέμονται στην επιφάνειά της; Οι απαντήσεις σε 
όλες αυτές τις ερωτήσεις βασίζονται στην παράμετρο της ανάλυσης.

Ανάλυση ψηφιακής εικόνας: ονομάζεται η πυκνότητα των εικονοστοιχείων που τη 
συνθέτουν.

Τα εικονοστοιχεία σε μία εικόνα είναι κατανεμημένα το ένα δίπλα στο άλλο. Μπο-
ρούμε να παραλληλίσουμε την κατανομή τους με αυτή των ψηφιδωτών. Όσο μικρό-
τερες είναι οι ψηφίδες ενός ψηφιδωτού – ή, κατ’ αντιστοιχία, τα εικονοστοιχεία 
μιας εικόνας – τόσο περισσότερες είναι οι λεπτομέρειες που αποτυπώνονται. Για να 
διακρίνουμε τα εικονοστοιχεία μιας εικόνας, θα πρέπει να τη μεγεθύνουμε. Μάλι-
στα, μία εικόνα με μικρά εικονοστοιχεία θα πρέπει να μεγεθυνθεί περισσότερο από 
μία άλλη που αποτελείται από εικονοστοιχεία μεγαλυτέρου μεγέθους.

* Οι ορισμοί των σημαντικών όρων δίνονται και στο Γλωσσάριο, στο τέλος του Βιβλίου

24-0151 Book.indb   1724-0151 Book.indb   17 27/10/2021   12:17:20 µµ27/10/2021   12:17:20 µµ



18

Ε Φ Α Ρ Μ Ο Γ Ε Σ  Η Λ Ε Κ Τ Ρ Ο Ν Ι Κ Ω Ν  Υ Π Ο Λ Ο Γ Ι Σ Τ Ω Ν

Δεν έχει νόημα να μετρήσουμε άμεσα το μέγεθος του κάθε εικονοστοιχείου. Αυτό 
το καθορίζουμε έμμεσα με την ανάλυση, δηλαδή με ένα αριθμό που δίνει το πλή-
θος των εικονοστοιχείων ανά εκατοστό (pixels per cm), ή ανά ίντσα (pixels per 
inch). Παραδείγματος χάρη, η ανάλυση της οθόνης του υπολογιστή είναι συνήθως 
72 εικονοστοιχεία ανά ίντσα (ppi) που σημαίνει ότι σε μία ίντσα χωράνε 72 εικονο-
στοιχεία. Αναλύσεις εκτύπωσης από 300 ppi έως 1200 ppi είναι συνηθισμένες στην 
ηλεκτρονική τυπογραφία. Ενώ, υπάρχουν σαρωτές με ανάλυση εισόδου έως 10000 
ppi που αποδίδουν κάθε λεπτομέρεια μιας ψηφιακής εικόνας.

Βάθος χρώματος (Bit depth): Τα εικονοστοιχεία μιας εικόνας έχουν, φυσικά, και 
χρώμα. Δεν έχουμε όμως απεριόριστη δυνατότητα αποτύπωσης των αποχρώσεών 
τους. Όλα τα δυνατά χρώματα που μπορούν να πάρουν τα εικονοστοιχεία μιας συ-
γκεκριμένης εικόνας υπολογίζονται με τη βοήθεια του δυαδικού συστήματος αρίθ-
μησης που γνωρίζουμε από τα μαθήματα πληροφορικής.

Με τον όρο βάθος χρώματος αναφερόμαστε επίσης και στο μέγιστο αριθμό χρωμά-
των που αποθηκεύεται ως πληροφορία σε ένα αρχείο ψηφιακής εικόνας. Φυσικά, 
χρησιμοποιούμε το δυαδικό σύστημα αρίθμησης. Έτσι, βάθος χρώματος με ένα δυα-
δικό ψηφίο (1-bit) μπορεί να εκφράσει μόνο δύο αποχρώσεις (21, δηλαδή 0 για το 
μαύρο και 1 για το λευκό). Βάθος χρώματος 2-bit εκφράζει 22=4 αποχρώσεις. Βά-
θος χρώματος 8-bit εκφράζει 256 αποχρώσεις και βάθος χρώματος 24-bit αποδίδει 
16.777.216 αποχρώσεις. Όσο μεγαλύτερο είναι το βάθος χρώματος της ψηφιακής 
εικόνας τόσο μεγαλύτερο γίνεται το αρχείο της, με αποτέλεσμα να καταλαμβάνει 
περισσότερο χώρο στο δίσκο του υπολογιστή μας.
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1.4 Τι είναι αυτό που βλέπουμε;

Με αυτό το ρητορικό ερώτημα και γνωρίζοντας τη βασική ορολογία, θα ξεκινήσουμε 
την παρουσίασή μας για τον τρόπο που εμφανίζονται οι φωτογραφίες στον 
υπολογιστή μας.

Οι ψηφιακές εικόνες στην οθόνη του υπολογιστή είναι πάντα ορθογώνιου σχήματος.
Οι διαστάσεις τους ορίζονται από τον αριθμό των εικονοστοιχείων κατά το πλάτος 
και το ύψος τους. Για παράδειγμα, μπορούμε να πούμε ότι έχουμε φωτογραφία 640 
επί 480 pixels, ή ότι η οθόνη μας είναι 1024 επί 768 pixels με την ίδια λογική που 
μία σκακιέρα έχει πάντα διαστάσεις 8 επί 8 τετράγωνα (Εικόνα 1.4).

Εικόνα 1.4: Τα εικονοστοιχεία σχηματίζουν στην οθόνη τη φωτογραφία σα σε ψηφιδωτό. Το 
χρώμα κάθε εικονοστοιχείου καθορίζεται έμμεσα, από το βάθος χρώματος, αφού το ίδιο εικονο-
στοιχείο στην ίδια φωτογραφία έχει διαφορετική απόχρωση αν εμφανίζεται με βάθος χρώματος 
4-bit (16 αποχρώσεις) ή 8-bit (256 αποχρώσεις).

Οι ψηφιακές εικόνες, όταν είναι αποθηκευμένες στον σκληρό δίσκο, μπορεί να 
έχουν οποιοδήποτε μέγεθος στα όρια της χωρητικότητας του μέσου αποθήκευσης. 
Βέβαια, το μέγεθός τους προσδιορίζεται από τα χαρακτηριστικά της συσκευής που 
τις κατέγραψε (σαρωτής, ψηφιακή φωτογραφική μηχανή). (Προσοχή! Το μέγεθος, 
όπως το ορίσαμε μόλις τώρα, δεν έχει καμιά σχέση με τις φυσικές διαστάσεις της 
φωτογραφίας σε εκατοστά ή σε άλλες μονάδες μέτρησης).

Οι φωτογραφίες στην ψηφιακή τους μορφή έχουν πάντα τον ίδιο αριθμό εικονοστοι-
χείων. Όταν αλλάζει το πλήθος τους (αυτό λέγεται επαναδειγματοληψία –resampling), 
μεταβάλλεται και το συνολικό μέγεθος του αρχείου στο οποίο αποθηκεύονται.

24-0151 Book.indb   1924-0151 Book.indb   19 27/10/2021   12:17:21 µµ27/10/2021   12:17:21 µµ



20

Ε Φ Α Ρ Μ Ο Γ Ε Σ  Η Λ Ε Κ Τ Ρ Ο Ν Ι Κ Ω Ν  Υ Π Ο Λ Ο Γ Ι Σ Τ Ω Ν

Όταν θελήσουμε να τυπώσουμε ή απλώς να εμφανίσουμε τη φωτογραφία, υπει-
σέρχεται ο παράγοντας των φυσικών διαστάσεων. Η σχέση μεταξύ των φυσικών 
διαστάσεων και του αριθμού των εικονοστοιχείων της εικόνας καθορίζεται από την 
ανάλυση. Είναι σημαντικό και γι’ αυτό πρέπει να γίνει απόλυτα κατανοητό, ότι η 
ανάλυση δεν είναι μία εγγενής ιδιότητα των ψηφιακών εικόνων, αλλά ένα χαρακτη-
ριστικό που μεταβάλλεται, ανάλογα με το μέσο όπου εμφανίζουμε την εικόνα μας.
Παραδείγματος χάρη, άλλη ανάλυση είναι αναγκαία προκειμένου να παρουσιάσου-
με μία φωτογραφία στην οθόνη μας για μία εφαρμογή πολυμέσων, άλλη ανάλυση 
χρειαζόμαστε για να τυπώσουμε την ίδια φωτογραφία στον εκτυπωτή μας, και άλλη 
για εκτύπωση όφσετ. Σε όλες αυτές τις περιπτώσεις θεωρώντας ότι το πλήθος των 
εικονοστοιχείων είναι σταθερό, κάθε μεταβολή της ανάλυσης επιφέρει αντίστροφη 
μεταβολή στις πραγματικές διαστάσεις της εικόνας. Δηλαδή η σχέση μεταξύ ανάλυ-
σης και φυσικών διαστάσεων είναι αντιστρόφως ανάλογη.

Έως τώρα δεν έχουμε μιλήσει για τα ποιοτικά χαρακτηριστικά του κάθε 
εικονοστοιχείου. Αν χρησιμοποιήσουμε ξανά το παράδειγμα του ψηφιδωτού, 
μπορούμε εύκολα να κατανοήσουμε ότι η κάθε ψηφίδα θα πρέπει να έχει ένα 
συγκεκριμένο χρώμα, έτσι ώστε, τοποθετημένη μαζί με τις υπόλοιπες, να σχηματίσει 
τη συνολική εικόνα.

Το κάθε εικονοστοιχείο είναι μονόχρωμο, δεν μπορούμε να έχουμε πολύχρωμα 
εικονοστοιχεία.

Έχοντας υπόψη μας τα προηγούμενα, μπορούμε να αντιστοιχίσουμε στο χρώμα του 
κάθε εικονοστοιχείου έναν αριθμό που ορίζεται από το βάθος χρώματος. Έτσι, μία 
φωτογραφία που περιέχει μόνο μαύρο και άσπρο, χωρίς ενδιάμεσους γκρι τόνους 
(δηλαδή, δύο μόνο τόνους) τη χαρακτηρίζουμε ως εικόνα του ενός bit (1-bit), αφού, 
με βάση το δυαδικό σύστημα, 21=2 (Εικόνα 1.5).

Εικόνα 1.5: Στη φωτογραφία αυτή του 1-bit, τα εικονοστοιχεία μπορούν να είναι μαύρα ή λευκά.
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Εικόνες των 8-bit είναι δυνατόν να περιέχουν 256 διαφορετικούς τόνους, αφού, με 
βάση το δυαδικό σύστημα, 28 =256. Επομένως, μπορούμε να χαρακτηρίσουμε με 
256 διαφορετικούς αριθμούς όλα τα εικονοστοιχεία τους (Εικόνα 1.6).

Εικόνα 1.6: Με βάθος χρώματος 8-bit τα εικονοστοιχεία της φωτογραφίας μπορούν να έχουν ένα 
από 256 διαφορετικούς τόνους του γκρι.

Όμως, το ερώτημα για τα χρώματα παραμένει! Είπαμε για μαύρο-άσπρο, για τόνους 
του γκρι. Τι συμβαίνει με τα υπόλοιπα χρώματα; Το πρόβλημα είναι ότι το βάθος 
χρώματος, όπως το ορίσαμε προηγουμένως, δεν μας δίνει καμία πληροφορία για το 
χρώμα του κάθε εικονοστοιχείο. Για μία εικόνα 1-bit είναι εύκολο να ορίσουμε ότι 
το 1 είναι κάποιο χρώμα και το 0 είναι το λευκό, (1=On, 0=Off). Το 256 όμως τι εί-
ναι; 256 τόνοι του γκρι; 256 διαφορετικά χρώματα ή κάτι άλλο; Ο υπολογιστής δεν 
‘καταλαβαίνει’ από χρώματα, γνωρίζει μόνο τους αριθμούς των ψηφιακών πληρο-
φοριών και τίποτα άλλο. Το χρωματικό σύστημα (color model) ή ο τύπος της φωτο-
γραφίας (image mode), είναι το χαρακτηριστικό εκείνο που συνδέει τα χρώματα με 
τον υπολογιστή. Στα προγράμματα επεξεργασίας εικόνας επιλέγουμε το χρωματικό 
σύστημα που εργαζόμαστε από την εντολή Εικόνα > Κατάσταση (Image > Mode).

Στην εντολή αυτή, αν επιλεγεί η Κλίμακα του γκρίζου (Grayscale) (εικόνα 8-bit), 
τότε όλα τα εικονοστοιχεία της εικόνας αποκτούν έναν από τους 256 τόνους του 
γκρι με 0=μαύρο και 255=λευκό. (Προσοχή! Αφού υπολογίζεται και το 0, το λευκό 
αντιστοιχεί στο 255 και όχι στο 256).
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Αν επιλεγεί η εντολή Χρωματικός πίνακας (Indexed mode) (εικόνα 8-bit), τότε κάθε 
εικονοστοιχείο αποκτά μία από 256 αυθαίρετα επιλεγμένες αποχρώσεις (Εικόνα 1.7)

Εικόνα 1.7: Με την επιλογή Image>Mode>Indexed Color... η εικόνα αποκτά αποκλειστικά τα 
256 χρώματα που φαίνονται στην παλέτα δίπλα. Ας σημειωθεί ότι τα Windows έχουν παλέτα με 
διαφορετικά χρώματα από αυτήν για τα Macintosh. Διαφορετική είναι επίσης και η παλέτα με τα 
χρώματα για το διαδίκτυο (Web palette).

Αν όμως επιλεγεί RGB, το προσθετικό σύστημα χρωμάτων, με το οποίο εμφανίζουν 
τα χρώματα οι οθόνες των υπολογιστών αλλά και οι τηλεοπτικοί δέκτες, το κάθε 
εικονοστοιχείο χαρακτηρίζεται από τρεις 8-bit τιμές (24-bit), για κάθε ένα από τα 
χρώματα Red-Green-Blue (Εικόνα 1.8).

Εικόνα 1.8: Το κάθε εικονοστοιχείο χρωματίζεται από ένα ή και όλα τα βασικά χρώματα Red-
Green-Blue. Η κάθε μία από τις συνιστώσες RGB θα έχει κάποια από τις 256 διαφορετικές τιμές.

Στο σύστημα CMYK, το αφαιρετικό σύστημα χρωμάτων της τυπογραφίας, το κάθε 
εικονοστοιχείο χαρακτηρίζεται από τέσσερις 8-bit τιμές (32-bit) για κάθε ένα από 
τα Cyan-Magenta-Yellow-BlacK  (Εικόνα 1.9).
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Εικόνα 1.9: Το κάθε εικονοστοιχείο χρωματίζεται από ένα ή και όλα τα βασικά χρώματα 
Cyan-Magenta-Yellow-BlacK. Η κάθε μία από τις συνιστώσες CMYK θα έχει κάποια από τις 256 
διαφορετικές τιμές.

Σε επόμενο κεφάλαιο θα επανέλθουμε στα συστήματα χρωμάτων για μια πιο ολο-
κληρωμένη παρουσίαση.

1.5 Τι είναι αυτό που τυπώνουμε;

Στην προηγούμενη παράγραφο είπαμε ότι ο παράγων ‘ανάλυση’ υπεισέρχεται όταν 
θέλουμε να τυπώσουμε μία φωτογραφία. Όμως, ο όρος αυτός χρησιμοποιείται αδια
κρίτως, για οποιαδήποτε συσκευή ή εικόνα θέλουμε να χαρακτηρίσουμε, με αποτέ-
λεσμα συχνά να δημιουργείται σύγχυση για το τι ακριβώς αντιπροσωπεύει.

Ας επαναλάβουμε λοιπόν ότι:
Κάθε ψηφιακή εικόνα αποτελείται από εικονοστοιχεία και ο τρόπος με τον οποίο 
διευθετούνται αυτά ανά μονάδα μήκους καθορίζεται από την ανάλυση.

Θα τονίσουμε ένα γενικό κανόνα:
Δεν υπάρχει εικόνα που οι τόνοι της να είναι συνεχείς.

Οι φωτογραφίες που βλέπουμε εμφανίζονται συνεχών τόνων γιατί τα μάτια μας δε 
διακρίνουν τα μικρά εικονοστοιχεία ή τις κουκκίδες που τις αποτελούν.
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Βλέποντας τις φωτογραφίες των περιοδικών από μια απόσταση 25-30 εκατοστών δεν 
μπορούμε να διακρίνουμε τις κουκκίδες του ράστερ, που σχηματίζουν τις μορφές 
και τα σχήματα (Εικόνα 1.10)

Εικόνα 1.10: Με αυξομειώσεις της διαμέτρου των κουκκίδων, αποδίδονται οι τονικές διαβαθμί-
σεις της φωτογραφίας.

Πρέπει λοιπόν να γίνει κατανοητό ότι:
Η ομαλή μίξη και διαδοχή των τόνων που βλέπουμε σε μία φωτογραφία δεν είναι 
παρά μία οφθαλμαπάτη!

Μία γιγαντοαφίσα από μεγάλη απόσταση δείχνει να είναι συνεχών τόνων. Το ίδιο 
συμβαίνει και με τις φωτεινές γιγαντοοθόνες των γηπέδων. Όμως, ακόμη και μία 
φωτογραφία που μόλις εμφανίσαμε στο φωτογραφικό εργαστήριο, αν την εξετά-
σουμε με ένα μεγεθυντικό φακό, θα δούμε ότι οι τόνοι της σχηματίζονται με τους 
κόκκους της φωτοευαίσθητης επιφάνειας. Μπορούμε λοιπόν να συμπεράνουμε ότι 
εκείνο που κάνει μία εικόνα να φαίνεται συνεχών τόνων είναι η απόσταση παρατή-
ρησης συνδυασμένη με την κατάλληλη ανάλυση εκτύπωσης. Μπορούμε σχετικά να 
αναφέρουμε και ένα εμπειρικό κανόνα: Διπλασιάζοντας την απόσταση παρατήρη-
σης, είναι δυνατόν να μειώσουμε στο μισό την ανάλυση της εικόνας.

Ποια είναι η ιδανική ανάλυση μιας φωτογραφίας; Αυτό είναι ένα ερώτημα που δε 
δέχεται μονοσήμαντη απάντηση, αφού η ανάλυση εξαρτάται από τον τρόπο και το 
μέσο που θα τυπώσουμε τη φωτογραφία. Η ανάλυση χρησιμοποιείται προκειμένου 
να μεταφέρουμε μία εικόνα από ένα σύστημα απεικόνισης σε ένα άλλο. Αν γνωρί-
ζουμε ποια είναι η ανάλυση του κάθε συστήματος, θα είναι πολύ εύκολο να ρυθμί-
ζουμε τον τρόπο μεταφοράς μεταξύ των συστημάτων.
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Οι πιο κοινές συσκευές εξόδου είναι:
-	 οι οθόνες των Η/Υ,
-	 οι εκτυπωτές (inkjet ή laser) και εικονοθέτες και
-	 οι εκτυπωτές εξάχνωσης (dye sublimation printers).
Κάθε συσκευή εξόδου έχει τη δυνατότητα να εμφανίζει συγκεκριμένη ανάλυση. Η 
ανάλυση αυτή χαρακτηρίζεται ως ανάλυση εξόδου.
Οι συσκευές εξόδου είναι δύο τύπων:
1.	Άμεσης αντιστοίχησης (direct pixel imaging), όπου το κάθε εικονοστοιχείο της 
εικόνας αντιστοιχεί σε ένα εικονοστοιχείο της μονάδος εξόδου, (π.χ. εκτυπωτές 
εξάχνωσης, οθόνη Η/Υ).
2.	Κουκκίδας παραλλαγής (dithering), Ημιτονικής κουκκίδας (halftone dot re-
production), όπου περισσότερα του ενός εικονοστοιχεία σχηματίζουν μία κουκκίδα 
στη μονάδα εξόδου (π.χ. εκτυπωτές ψεκασμού, ή εικονοθέτες αντιστοίχως).

Σε κάθε περίπτωση, τα «εικονοστοιχεία» του ενός συστήματος μετασχηματίζονται 
σε «εικονοστοιχεία» του άλλου. Ο τρόπος μετατροπής της ανάλυσης από το ένα σύ-
στημα στο άλλο ονομάζεται λόγος δειγματοληψίας (sampling ratio), που στην πε-
ρίπτωση εκτυπωτή άμεσης αντιστοίχησης είναι 1:1, ενώ της ημιτονικής κουκκίδας 
είναι (συνήθως) 2:1.

1.6 Ανάλυση και πληροφορία

Κάθε ψηφιακή εικόνα προκειμένου να αναπαραχθεί χρειάζεται μία «ποσότητα» 
πληροφορίας που είναι όμως διαφορετική για κάθε συσκευή και μέθοδο απεικόνι-
σης ή εκτύπωσης. Αυτή η πληροφορία είναι η ανάλυση. Η σύγχυση που υπάρχει με 
αυτό τον όρο οφείλεται στους εξής παράγοντες:
		  1.	� Χρησιμοποιείται σε πλήθος περιπτώσεων που όμως έχουν διαφορετικό 

περιεχόμενο.
	 2.  Με τις μονάδες μέτρησής της.
Σε αυτή την παράγραφο θα επιχειρήσουμε να εξαλείψουμε αυτή την σύγχυση.
Φιλμ με οξείδια του αργύρου: Τα φιλμ που όλοι γνωρίζουμε περιέχουν κόκκους 
αργύρου. Αν τα παρατηρήσουμε μετά την εμφάνιση, με μικροσκόπιο, εμφανίζουν 
υψηλή συγκέντρωση κόκκων στους σκούρους τόνους και χαμηλή συγκέντρωση 
στους ανοικτούς τόνους. Οι κόκκοι διαφέρουν σε μέγεθος και έχουν τυχαία διά-
ταξη.
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Εικόνα 1.11: Κόκκοι οξειδίων του αργύρου μετά την εμφάνιση του φιλμ.

Στην Εικόνα 1.11 φαίνεται ένα τέτοιο φιλμ που αποδίδει γκρίζους τόνους. Θα μπο-
ρούσαμε να θεωρούσαμε τον κόκκο του φιλμ, σαν την στοιχειώδη μονάδα οπτικής 
πληροφορίας. Στην περίπτωση αυτή με τον όρο «ανάλυση» ορίζουμε την ικανότητα 
του φιλμ να καταγράφει τις λεπτομέρειες της εικόνας και εξαρτάται από το μέγεθος 
(ή την πυκνότητα) των κόκκων του αργύρου.
Ψηφιακή εικόνα: Η στοιχειώδης «μονάδα οπτικής πληροφορίας» εδώ, είναι το 
εικονοστοιχείο. Όμως αυτό, διαφέρει από τον κόκκο του φιλμ, διότι όλα τα εικο-
νοστοιχεία σε μία εικόνα είναι ισομεγέθη και ευρίσκονται σε κανονική διάταξη το 
ένα δίπλα στο άλλο, όπως φαίνεται και στην Εικόνα 1.4. Όσο περισσότερα εικονο-
στοιχεία έχουμε σε μία εικόνα, τόσο περισσότερο ακριβής είναι η αναπαραγωγή. 
Όσο περισσότερο ακριβής είναι η αναπαραγωγή, τόσο περισσότερο μπορούμε να 
μεγεθύνουμε την εικόνα χωρίς απώλεια πληροφορίας.
Πώς μετράμε την «ανάλυση» μιας ψηφιακής εικόνας;

		  •	� Αν η εικόνα εμφανίζεται στην οθόνη η ανάλυση μετράται σε εικονοστοι-
χεία ανά μονάδα μήκους (pixels / inch ή pixels / cm και με συντόμευση 
ppi ή ppcm).

	 •	� Αν μετράμε την ανάλυση μιας ψηφιακής φωτογραφικής μηχανής, ανα-
φέρουμε το συνολικό αριθμό που διαθέτει ο αισθητήρας CCD. Παραδείγ-
ματος χάρη, λέμε ότι η μηχανή μας έχει ανάλυση 3200 επί 2400 εικο-
νοστοιχεία που σημαίνει 3200x2400=7.680.000 δηλαδή 7,7 megapixels 
(Mpixel). Δηλαδή η κάθε φωτογραφία μας με την συγκεκριμένη μηχα-
νή έχει 7.680.000 pixels.

		  •	� Αν η εικόνα εισάγεται με την βοήθεια του σαρωτή, η ανάλυση σάρωσης 
ορίζεται και πάλι με pixels / inch (ή pixels / cm) και καλείται ανάλυση 
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εισόδου (image input resolution). Ανάλογα με την ακρίβεια κατασκευ-
ής της κεφαλής του σαρωτή, αυτή δημιουργεί λιγότερα ή περισσότερα 
εικονοστοιχεία, άρα μικρότερη ή μεγαλύτερη ανάλυση αντίστοιχα, για 
την εικόνα που εισάγεται. Προσοχή! Πολλοί, μετράνε την ανάλυση σά-
ρωσης με dots / inch (dpi) ταυτίζοντας την, με την ανάλυση εξόδου.

	 •		� Όλες οι συσκευές εξόδου, όπως είναι οι εκτυπωτές, χαρακτηρίζονται από 
την ανάλυση εξόδου (output device resolution). Εκφράζεται σε κουκκί-
δες ανά μονάδα μήκους δηλαδή dots / inch (dpi). Αυτό το χαρακτηριστι-
κό όμως, αναφέρεται στην συγκεκριμένη συσκευή και όχι αναγκαστικά 
και στις εικόνες που εμφανίζει. Ένα κρίσιμο ερώτημα για την ανάλυση 
της εικόνας, είναι τι είδους εκτυπωτής χρησιμοποιείται, άμεσης αντιστοί-
χησης ή με χρήση κουκκίδας; Αυτό το ερώτημα, και η αλληλεξάρτηση της 
ανάλυσης με τις φυσικές διαστάσεις της εικόνας, θα μας απασχολήσουν 
σε επόμενο κεφάλαιο.

Ανακεφαλαίωση 1ου Κεφαλαίου

Η εξέλιξη της φωτογραφίας στα 170 χρόνια από την εμφάνισή της ήταν, κυρίως, 
αποτέλεσμα της βελτίωσης των υλικών και των φωτοευαίσθητων φιλμ.
Η εμφάνιση όμως της ψηφιακής φωτογραφίας, άλλαξε ριζικά την τεχνολογία 
φωτογράφησης, επεξεργασίας, εκτύπωσης και διαχείρισης των εικόνων. Ένα 
νέο λεξιλόγιο άρχισε να δημιουργείται για να περιγράψει τις νέες μεθόδους 
και τεχνικές, όπως εικονοστοιχείο, ανάλυση εικόνας οθόνης, βάθος χρώματος, 
ανάλυση εισόδου / εξόδου, ανάλυση εκτύπωσης.
Η εκμάθηση και η κατανόηση αυτών των όρων είναι απαραίτητη προϋπόθεση 
για τους χρήστες της νέας τεχνολογίας. Αυτό όμως που παραμένει αναλλοίωτο 
ανεξαρτήτως τεχνολογικών καινοτομιών είναι η ανθρώπινη φαντασία που δη-
μιουργεί τα έργα τέχνης.
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Ασκήσεις 1ου Κεφαλαίου

1. Πόσες αποχρώσεις αποδίδει βάθος χρώματος 8-bit, και πόσες 24-bit;
2. Εξηγήστε με δικά σας λόγια την έννοια της ανάλυσης εικόνας (image resolution).
3. Ποιες εικόνες μπορούμε να χαρακτηρίσουμε συνεχών τόνων;
4. Τι εννοούμε όταν λέμε ότι έχουμε ανάλυση 72 ppi;
5. Εξηγήστε το λόγο ύπαρξης των ημιτονικών κουκκίδων.
6. Αφού η οθόνη Η/Υ είναι συσκευή άμεσης αντιστοίχησης, εξηγήστε τι σημαίνει το 
ποσοστό 100% (1:1) στο παράθυρο εμφάνισης μιας φωτογραφίας, στα προγράμμα-
τα επεξεργασίας εικόνας.
7. Με αφετηρία την εμπειρία σας, προσπαθήστε να καταγράψετε τα πλεονεκτήματα 
και τα μειονεκτήματα της ψηφιακής φωτογραφίας. Πιθανά στοιχεία για την έρευνά 
σας είναι:
	 -	 Αναλώσιμα υλικά (φιλμ, χημικά κλπ.)
	 -	 Ποιότητα απεικόνισης
	 -	 Αμεσότητα στο αποτέλεσμα της φωτογράφησης
	 -	 Διαθεσιμότητα εξαρτημάτων (φακοί, φλας)
	 -	 Κόστος
	 -	 Αντοχή στο χρόνο
	 -	 Υπάρχουσα εμπειρία στις συμβατικές τεχνικές φωτογράφησης
	 -	 Αποθήκευση και αναζήτηση φωτογραφιών

Δραστηριότητες 1ου Κεφαλαίου

1. Με τη βοήθεια των καθηγητών σας, αναγνωρίστε τον εξοπλισμό, τον αναγκαίο για 
την επεξεργασία εικόνων, που διαθέτει το εργαστήριο. Ποιες συσκευές είναι άμεσης 
αντιστοίχισης;
2. Συγκεντρώστε τέσσερα διαφορετικά δείγματα φωτογραφιών από ισάριθμα έντυ-
πα: Α/Μ φωτογραφία εφημερίδας, έγχρωμη φωτογραφία περιοδικού, από εκτυπωτή 
ψεκασμού, απλή τυπωμένη φωτογραφία. Με τη βοήθεια ενός μεγεθυντικού φακού 
(οι γραφίστες χρησιμοποιούν τη «λούπα»), εξετάστε προσεκτικά τις φωτογραφίες 
και τις κουκκίδες που τις σχηματίζουν. Συζητήστε στη συνέχεια με τους συμμαθητές 
και τους καθηγητές(τριες) τις διαφορές ή ομοιότητες που παρατηρούνται.
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Σχετικές ηλεκτρονικές διευθύνσεις

Για πληροφορίες, σχετικά με προγράμματα, ιδέες, συμβουλές και διευθύνσεις για 
ομάδες συζητήσεων σχετικές με την ψηφιακή επεξεργασία εικόνας:
Adobe Systems Inc. www.adobe.com
Digital Imaging Group, www.digitalimaging.org
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Κεφάλαιο 2ο
Η αποθήκευση των εικόνων

Στόχοι:

Μετά τη μελέτη αυτού του κεφαλαίου οι μαθητές θα είναι σε θέση να:

	 •	 �Αναγνωρίσουν και περιγράψουν τις βασικές μορφές αρχείων ψηφια-
κών εικόνων

	 •	 �Κατανοήσουν τις βασικές τεχνικές συμπίεσης εικόνων

	 •	 �Υπολογίσουν το μέγεθος των ψηφιακών εικόνων

2.1 Εισαγωγή - Εικόνα και ψηφιακή πληροφορία

Είναι σημαντικό να καταλάβουμε ότι τα αρχεία εικόνων που έχουμε αποθηκεύσει 
στο σκληρό δίσκο του υπολογιστή μας δεν είναι πραγματικές εικόνες, αλλά μόνο 
ψηφιακές πληροφορίες. Οι πληροφορίες αυτές είναι οι εντολές και τα δεδομένα 
που χρησιμεύουν για να εμφανίσουν την εικόνα στην οθόνη του υπολογιστή ή σε 
οποιοδήποτε εκτυπωτή. Οι εντολές αυτές και τα δεδομένα ελέγχουν για παράδειγ-
μα, μέσω του υλικού και του λογισμικού, τη ροή του μελανιού στην περίπτωση του 
εκτυπωτή ή τη δέσμη φωτός στην οθόνη μας. Αυτή η επισήμανση δεν πρέπει να πε-
ράσει απαρατήρητη. Τα αρχεία είναι για τις ψηφιακές εικόνες, ό,τι είναι τα σχέδια 
μηχανικού στις οικοδομές. Γνωρίζουμε ότι τα σχέδια αυτά περιέχουν λεπτομέρειες 
και οδηγίες για την κατασκευή του κτηρίου που κανείς δεν μπορεί να αγνοήσει. Το 
ίδιο είναι λοιπόν και τα αρχεία. Οδηγίες για τη σωστή κατά περίπτωση απεικόνιση 
των εικόνων στις οποίες αντιστοιχούν.

Αποθηκεύοντας τις ψηφιακές πληροφορίες στην κατάλληλη μορφή δημιουργούμε 
τις προϋποθέσεις για την ομαλή μετάβαση από την καλλιτεχνική δημιουργία στην 
πραγματική παραγωγή. Η καλλιτεχνική δουλειά μας δε θα είναι ποτέ ολοκληρωμέ-
νη αν το τελικό αποτέλεσμα, δηλαδή η φωτογραφία που τυπώνουμε, δεν πληροί τις 
προδιαγραφές που είχαμε θέσει εκ των προτέρων.
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Πολύ συχνά οι εργαζόμενοι με τους υπολογιστές τείνουν να θεωρούν ως τελική την 
εικόνα που βλέπουν στην οθόνη και να αγνοούν το επόμενο βήμα, αυτό της εκτύπω-
σης (εκτός φυσικά αν η απεικόνιση στην οθόνη είναι το τελικό στάδιο, όπως συμβαί-
νει στις εφαρμογές πολυμέσων).

Όπως θα δούμε παρακάτω, υπάρχουν πολλές μορφές αρχείων που χρησιμοποιού-
νται για την αποθήκευση των εικόνων, π.χ. TIFF, PCX, JPEG, RIFF, GIF κλπ. Εντού-
τοις, όλες αυτές οι μορφές κατατάσσονται στις παρακάτω τέσσερις βασικές κατηγο-
ρίες αρχείων εικόνας, ανάλογα με τον τρόπο που κωδικοποιούνται οι πληροφορίες 
της εικόνας:
1.	 Με εικονοστοιχεία (bitmapped ή raster images) π.χ. TIFF, BMP και PCX.
2.	� Με γραμμές και καμπύλες Bezier. Τα αρχεία αυτά ονομάζονται διανυσματικές 

εικόνες (vector graphics). Η ονομασία διανυσματική εικόνα είναι πιο αντιπρο-
σωπευτική γιατί αναφέρεται σε εικόνες που σχηματίζονται με γραμμές και πε-
ριγράφονται μαθηματικά ως διανύσματα, δηλαδή μεγέθη που ορίζονται με το 
μέτρο, τη διεύθυνση και τη φορά τους.

3.	� Βασισμένα σε γλώσσες περιγραφής σελίδας (page description languages), π.χ. 
Postscript, PDF, MIF, TeX. Με τις εντολές που διαθέτουν καθοδηγούν τις συ-
σκευές στο πώς να εμφανίσουν μία σελίδα σημείο προς σημείο, που καθορίζεται 
από την ανάλυση της συσκευής.

4.	�Με συνδυασμό των δύο πρώτων κατηγοριών (bitmapped και vector graphics), 
όπως για παράδειγμα το EPS.

Στις γλώσσες περιγραφής σελίδας κατατάσσεται το TeX, που ανήκει στην κατηγο-
ρία του ανοικτού λογισμικού, δηλαδή στα προγράμματα εκείνα που η χρήση τους 
είναι ελεύθερη και δωρεάν και η ανάπτυξή τους βασίζεται στην εθελοντική εργασία 
και συνεισφορά των προγραμματιστών, επαγγελματιών ή μη, σε όλο τον κόσμο. Το 
αναφέρουμε δε ιδιαιτέρως, διότι αποτελεί ένα πλήρες περιβάλλον στοιχειοθεσίας 
και σελιδοποίησης που μπορεί οποιοσδήποτε να το προμηθευθεί δωρεάν μέσω του 
διαδικτύου και να πειραματισθεί.
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2.2 Η δομή των αρχείων

Κάθε αρχείο εικόνας αποτελείται από τέσσερα μέρη: την επικεφαλίδα (header), την 
παλέτα (color palette), τα δεδομένα (data) και την «ουρά» (footer). Χωρίς να υπει-
σέλθουμε σε λεπτομέρειες, είναι χρήσιμο να αναφέρουμε τη σημασία του κάθε μέ-
ρους (Εικόνα 2.1).

Εικόνα 2.1: Δίνοντας «ανθρώπινη» μορφή στο αρχείο, μπορούμε ευκολότερα να απομνημονεύ-
σουμε τα μέρη που το αποτελούν.

- Η επικεφαλίδα είναι σαν ταυτότητα του αρχείου. Περιλαμβάνει το μέγεθός του 
σε εικονοστοιχεία, τη μορφή του (TIFF ή GIF κλπ), αν έχει συμπιεστεί και στοιχεία 
αναγνώρισης μεταξύ διαφορετικών συστημάτων, PC και Macintosh.
- Η παλέτα περιλαμβάνει το σύστημα χρωμάτων και το βάθος χρώματος. Σε ορισμέ-
νες μορφές αρχείων η παλέτα να περιλαμβάνεται στην επικεφαλίδα.
- Τα δεδομένα, όπως το λέει και η λέξη, είναι τα στοιχεία της εικόνας που θα χρησι-
μοποιηθούν για την απεικόνισή της.
- Η «ουρά» περιέχει στοιχεία της δομής του αρχείου, ώστε να εξασφαλίζεται η 
αναγνώρισή του από παλαιότερες εκδόσεις των προγραμμάτων αλλά και στοιχεία 
συμβατότητας, γενικά.

Το μέγεθος των αρχείων εικόνων μετριέται σε bits, bytes(B) ή Kilobytes(KB).
Ας επαναλάβουμε εδώ από τις γενικές μας γνώσεις πληροφορικής ότι:
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1 Byte(B) = 8 bits
1 Kilobyte(KB) = 1024 bytes
Για τον υπολογισμό του μεγέθους μιας ψηφιακής εικόνας σε bytes, πολλαπλασιά-
ζουμε την ανάλυσή της (δηλαδή το πλάτος επί το ύψος εκφρασμένα σε pixels) με το 
βάθος χρώματος. Στη συνέχεια, διαιρούμε το αποτέλεσμα με 8 για να το μετατρέ-
ψουμε σε bytes. Ο τύπος είναι:

Μέγεθος Φωτογραφίας (σε bytes) =
(Ύψος φωτογραφίας x Πλάτος φωτογραφίας x Βάθος χρώματος) / 8

2.3 Οι μορφές των αρχείων

Όταν αποθηκεύουμε εικόνες για μελλοντική χρήση, οι παράγοντες που καθορίζουν 
τον τρόπο ή τη μορφή των αρχείων είναι η ποιότητα των χρωμάτων που θέλουμε 
να διατηρήσουμε και τα αποθηκευτικά μέσα που έχουμε στη διάθεσή μας. Παρα-
δείγματος χάριν, για την αποθήκευση μιας διανυσματικής εικόνας στο πρόγραμμα 
CorelDraw, θα επιλεγεί αποθήκευση σε μορφή CDR που διατηρεί όλες τις ιδιότητες 
των διανυσματικών εικόνων και όχι TIFF ή JPEG που είναι κατάλληλες μόνο για μη 
ανυσματικά γραφικά. Τα περισσότερα προγράμματα, αν όχι όλα, διαθέτουν ένα βα-
σικό τρόπο αποθήκευσης για εσωτερική χρήση και αρκετούς άλλους για παραπέρα 
επεξεργασία με άλλα προγράμματα.

Το μέγεθος του αρχείου αποθήκευσης εξαρτάται και από τον όγκο της πληροφορίας 
χρώματος που περιέχει. Έτσι, εικόνα τύπου RGB με βάθος χρώματος 24-bit είναι 
μικρότερη από άλλη τύπου CMYK με βάθος χρώματος 32-bit, του ίδιου αριθμού ει-
κονοστοιχείων (ή ίδιων διαστάσεων). Σε πολλά προγράμματα υπάρχει η δυνατότητα 
επεξεργασίας εικόνων που δεν ανήκουν σε καμία από τις γνωστές μορφές. Πρόκειται 
για τις λεγόμενες εικόνες RAW format που, προκειμένου να τις «δούμε», θα πρέπει 
να γνωρίζουμε το συνολικό αριθμό των εικονοστοιχείων τους, την ανάλυση και το 
βάθος χρώματος, πληροφορίες που συνήθως περιλαμβάνονται στην επικεφαλίδα των 
αντίστοιχων αρχείων.
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2.4 Οι πιο διαδεδομένες μορφές αρχείων εικόνας

Tagged Image File Format (TIFF): Η πιο συνηθισμένη μορφή αποθήκευσης ψη-
φιακών εικόνων τύπου RGB και CMYK. Υποστηρίζεται από όλα τα προγράμματα 
και συστήματα και επιτρέπει τη διακίνηση φωτογραφιών μεταξύ των συστημάτων. 
Επιτρέπει συμπίεση LZW (βλέπε επόμενη παράγραφο) που διευκολύνει την απο-
θήκευση. Όμως, αν πρόκειται να ενσωματώσουμε τη φωτογραφία σε πρόγραμμα 
σελιδοποίησης, θα πρέπει να βεβαιωθούμε ότι το συγκεκριμένο πρόγραμμα σελι-
δοποίησης δέχεται εικόνες με συμπίεση LZW.

Encapsulated Postscript (EPS)–Desktop Color Separation (DCS): Πρόκειται για 
αρκετά δημοφιλή μορφή αρχείων, ιδιαίτερα στον τομέα της ηλεκτρονικής τυπογρα-
φίας. Όταν μετατρέψουμε μία φωτογραφία σε CMYK μπορούμε να την αποθηκεύ-
σουμε είτε σε EPS ή DCS1 ή DCS2. To EPS είναι το μικρότερο και από τα τρία. To 
DCS1 διαχωρίζει την εικόνα σε τέσσερα αρχεία για τα βασικά χρώματα (cyan, ma-
genta, yellow, black) και ένα πέμπτο, μικρότερου μεγέθους, που διευκολύνει την 
εργασία σελιδοποίησης των γραφιστών που σχεδιάζουν έντυπα και χρειάζεται να 
βλέπουν τις σελίδες με τις φωτογραφίες τους στην οθόνη τους γρήγορα και με ακρί-
βεια διαστάσεων. To DCS2 είναι μία βελτιωμένη μορφή του DCS1, γιατί επιτρέπει 
την αποθήκευση επιπλέον πληροφοριών, που δίνουν τη δυνατότητα εκτυπώσεων 
όχι μόνο τετραχρωμιών αλλά και πενταχρωμιών, εξαχρωμιών κτλ.

Graphic Interchange Format (GIF): Μορφή αποθήκευσης που χρησιμοποιείται 
αποκλειστικά σε εφαρμογές πολυμέσων και στο διαδίκτυο.

Portable Display Format (PDF): Μία ακόμη μορφή αποθήκευσης εικόνων αλλά και 
κειμένων σε ένα ενιαίο αρχείο που επιτρέπει τη διακίνησή του μέσω του Διαδικτύου. 
Τα αρχεία αυτά μπορεί να είναι CMYK, RGB ή μαυρόασπρα, με ή χωρίς συμπίεση. 
Το μεγάλο πλεονέκτημα της μορφής αυτής είναι ότι μπορούμε να εμφανίσουμε στην 
οθόνη ή να τυπώσουμε σε οποιοδήποτε εκτυπωτή ή εικονοθέτη, την εικόνα, χωρίς 
να είναι αναγκαία γι’ αυτό το σκοπό η εγκατάσταση του προγράμματος που τη δη-
μιούργησε. Το αποτέλεσμα διατηρεί άριστη πιστότητα χρωμάτων και τυπογραφικών 
χαρακτηριστικών. Τα τελευταία χρόνια η μορφή αυτή έχει κυριαρχήσει και στο χώρο 
της ψηφιακής τυπογραφίας και υποστηρίζεται από όλα τα εμπορικά προγράμματα.

Portable Network Graphics (PNG καλείται «πινγκ»): Μία σχετικά πρόσφατη 
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μορφή αποθήκευσης για εικόνες RGB προορισμένες για διανομή στο διαδίκτυο. Υπερ-
τερεί έναντι των JPEG και GIF γιατί υποστηρίζει βάθος χρώματος 32-bit και αναγνω-
ρίζει τις ρυθμίσεις χρωμάτων ώστε να εμφανίζονται σωστά στην οθόνη μας.
Η αποθήκευση σε μια από τις παραπάνω μορφές, γίνεται με την εντολή Αποθήκευση 
Ως..(Save As..) τoυ καταλόγου εντολών Αρχείο (File). Εκεί, στην θυρίδα Τύπος Αρχεί-
ου (File Type) επιλέγεται η κατάλληλη μορφή. Συνήθως χρησιμοποιούνται οι TIFF 
και EPS για τις γραφικές τέχνες και GIF και JPEG για το διαδίκτυο και τα πολυμέσα.

2.5 Συμπίεση αρχείων

Η ιδέα να αποθηκεύουμε περισσότερες πληροφορίες σε μικρότερο χώρο έχει μεγά-
λη εφαρμογή στην πληροφορική και, φυσικά, αφορά και τη συμπίεση ψηφιακών ει-
κόνων. Θα μπορούσαμε να παρομοιάσουμε τη συμπίεση ενός αρχείου με αυτή ενός 
σφουγγαριού στο χέρι μας. Μπορεί το σφουγγάρι να γίνει το ένα δέκατο του όγκου, 
αλλά η μάζα του παραμένει ίδια. Μόλις χαλαρώσουμε την πίεση επανέρχεται στον 
αρχικό του όγκο χωρίς απώλειες.
Υπάρχουν πολλοί αλγόριθμοι συμπίεσης. Οι περισσότεροι διατηρούν απόλυτα την 
ακρίβεια των δεδομένων (loss-less compression), ενώ ορισμένοι επιτυγχάνουν με-
γαλύτερη συμπίεση, όμως με απώλεια (lossy compression) συνήθως στην ποιότητα 
των χρωμάτων. Στη συνέχεια, θα περιγράψουμε μερικούς από αυτούς:

Run-Length Encoding (RLE): Με το όνομα αυτό είναι γνωστή μία απλή μέθοδος 
συμπίεσης που θα αναφέρουμε χωρίς όμως να μπούμε σε λεπτομέρειες. Ο αλγόριθμος 

Εικόνα 2.2: Η μέθοδος συμπίεσης RLE βασίζεται στην ομαδοποίηση των εικονοστοιχείων με 
ίδιο χρώμα. 

RLE είναι χωρίς απώλεια δεδομένων και βασίζεται στην ιδέα της ομαδοποίησης των 
χρωμάτων. Αν σε μία εικόνα υπάρχουν συνεχόμενα εικονοστοιχεία με ίδια χρώμα-
τα, αντί η αποθήκευση να γίνεται με περιγραφή του χρώματος του κάθε ενός χω-
ριστά, ο RLE αποθηκεύει το χρώμα ενός εικονοστοιχείου σημειώνοντας παράλληλα 
και το πλήθος των ιδίων εικονοστοιχείων (Εικόνα 2.2).
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Έτσι, το αρχείο της εικόνας καταλαμβάνει μικρότερο χώρο αποθήκευσης στο σκλη-
ρό δίσκο. Είναι φανερό ότι όσο μεγαλύτερη επιφάνεια με όμοια χρώματα έχουμε, 
τόσο μεγαλύτερη συμπίεση επιτυγχάνουμε.

LZW (Lempel-Ziv-Welch): Είναι μία πολύ συνηθισμένη μέθοδος συμπίεσης χωρίς 
απώλειες, που τη βρίσκουμε ενσωματωμένη στις μορφές αρχείων TIFF και GIF. Ο 
αλγόριθμος LZW συλλέγει ομάδες ομοειδών χρωμάτων και τα αποθηκεύει σε συ-
μπιεσμένη, αλλά απολύτως ισοδύναμη με την αρχική μορφή. Θεωρείται πιο «έξυ-
πνος» τρόπος συμπίεσης από τον RLE, παρόλο που δεν είναι και αυτός πολύ αποτε-
λεσματικός, όταν έχουμε εικόνες με μεγάλη ποικιλία χρωμάτων.

JPEG (Joint Photographic Expert Group): Ένας ακόμη δημοφιλής τρόπος συμπί-
εσης, αλλά με απώλειες στην πιστότητα αποθήκευσης των χρωμάτων. Παρά την 
ύπαρξη αρκετών διαφορετικών αλγορίθμων JPEG μη συμβατών μεταξύ τους, η κοι-
νή ιδέα όλων είναι η εξής: Χωρίζει την εικόνα σε ορθογώνια διαστάσεων 8 επί 8 
pixel και στη συνέχεια τα μετασχηματίζει και τα ομαδοποιεί, ώστε να γίνεται εύκο-
λα η αποθήκευσή τους σε μικρότερο χώρο στο σκληρό δίσκο. Για τους ...λάτρεις του 
προγραμματισμού καλείται αλγόριθμος Discrete Cosine Transform (DCT). Υπάρχει 
η δυνατότητα να ρυθμίσουμε εκ των προτέρων το βαθμό συμπίεσης του αρχείου 
JPEG, με έναν αριθμό από 1 έως 100. Όσο μικρότερος είναι ο αριθμός, τόσο μεγαλύ-
τερη συμπίεση επιτυγχάνουμε, αλλά με περισσότερες απώλειες. Το ζητούμενο είναι 
να βρίσκουμε τη «χρυσή τομή», δηλαδή το μέγιστο ποσοστό συμπίεσης με την ελά-
χιστη δυνατή απώλεια ποιότητος. Συνιστάται μία τιμή από 80-100 για εκτυπώσεις 
και περίπου 20 για εφαρμογές πολυμέσων και διαδικτύου.
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Ανακεφαλαίωση 2ου Κεφαλαίου

Τα αρχεία εικόνων δεν είναι πραγματικές φωτογραφίες, αλλά ψηφιακές πληρο-
φορίες. Κάθε ψηφιακό αρχείο εικόνας αποτελείται από τέσσερα βασικά μέρη: 
την επικεφαλίδα, την παλέτα χρωμάτων, τα δεδομένα και την ουρά.
Η ανάγκη τόσο της αποθήκευσης, όσο και της μεταφοράς εικόνων μεταξύ δια-
φορετικών υπολογιστικών συστημάτων, αλλά και χρήσεων, επέβαλε την καθιέ-
ρωση συγκεκριμένων προτύπων αποθήκευσης και συμπίεσης, ώστε να γίνεται 
καλύτερη εκμετάλλευση του αποθηκευτικού μέσου και να διευκολύνεται η επι-
κοινωνία των Η/Υ.
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Ασκήσεις 2ου Κεφαλαίου

1.	 Αναφέρατε ποιες μορφές αποθήκευσης εικόνων χρησιμοποιούμε στο διαδίκτυο.
2.	� Προετοιμάζουμε ένα έντυπο με έγχρωμες εικόνες. Πώς θα τις αποθηκεύσουμε 

στον υπολογιστή μας, ώστε να τις χρησιμοποιήσουμε στη σελιδοποίηση του εντύ-
που αργότερα;

3.	� Θέλουμε να αποστείλουμε σε συνεργάτη μας που βρίσκεται σε απόσταση 200 
χλμ, το γρηγορότερο δυνατόν, φωτογραφία μεγέθους 28 MB. Αναφέρατε τον 
προσφορότερο τρόπο για αυτή την αποστολή, επιχειρηματολογώντας για την 
επιλογή σας.

4.	�Ποιο είναι το μέγεθος σε bytes μιας φωτογραφίας, που δεν έχει συμπιεστεί, δια-
στάσεων 100 επί 100 pixels αν είναι:

	 α) grayscale (8-bit)
	 β) true colour (24-bit)

Δραστηριότητες 2oυ κεφαλαίου

1.	� Επιλέξατε μία συγκεκριμένη φωτογραφία και αποθηκεύστε την, τουλάχιστον με 
δέκα διαφορετικούς τρόπους αποθήκευσης με ή χωρίς συμπίεση, έτσι ώστε ο 
κάθε τρόπος να δημιουργήσει τελικά ένα αρχείο διαφορετικού μεγέθους. Εκτι-
μήστε αν το μέγεθος που βλέπετε στις πληροφορίες του αρχείου ταιριάζει με 
αυτό που εσείς υπολογίσατε. Συζητήστε με τον (την) καθηγητή(τρια) σας τις 
τυχόν διαφορές που βρήκατε και τα πλεονεκτήματα της κάθε κατηγορίας.

Σχετικές ηλεκτρονικές διευθύνσεις

Image Permanence Institute: www.rit.edu/IPI
Optical Storage Technology Association: www.osta.org
SWOP Inc: www.swop.org
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Κεφάλαιο 3ο
Τα εργαλεία και οι τεχνικές επεξεργασίας εικόνας

Στόχοι:

Μετά τη μελέτη αυτού του κεφαλαίου οι μαθητές θα είναι σε θέση να:

	 •	� Αναγνωρίσουν το περιβάλλον εργασίας των προγραμμάτων επεξεργα-
σίας εικόνας.

	 •	 �Κατανοήσουν τους τρόπους επέμβασης για την αλλαγή των χαρακτηρι-
στικών μιας ψηφιακής φωτογραφίας.

	 •	 �Επιλέξουν τα κατάλληλα εργαλεία για την προσαρμογή, αλλαγή ή προ-
σθήκη ιδιαίτερων χαρακτηριστικών μιας ψηφιακής εικόνας.

3.1 Εισαγωγή

Μέχρι πρόσφατα, οι περισσότερες προεκτυπωτικές εργασίες, όπως, διαχωρισμοί 
χρωμάτων φωτογραφιών, οπτικές διορθώσεις, σύνθεση φωτογραφιών, γινόντουσαν 
από εξειδικευμένο προσωπικό σε ακριβά μηχανήματα και με ειδικό λογισμικό. Η διά-
δοση όμως των προγραμμάτων επεξεργασίας εικόνας, όπως το Photoshop της Adobe, 
ή το Corel PhotoPaint, είχε ως αποτέλεσμα τα όρια μεταξύ τεχνικών και δημιουργών 
να γίνουν δυσδιάκριτα. Οι καλλιτέχνες που έχουν τις γνώσεις και ένα προσωπικό 
υπολογιστή μπορούν πλέον, με κάποιο από τα προαναφερθέντα προγράμματα, να 
εκτελέσουν και τις πιο δύσκολες προεκτυπωτικές εργασίες που είναι απαραίτητες για 
την έκδοση ενός εντύπου.

Είναι πρακτικά αδύνατον στα πλαίσια αυτού του βιβλίου να περιγράψουμε, έστω 
και με συντομία, όλα τα γνωστά προγράμματα επεξεργασίας εικόνας. Επειδή όμως 
η φιλοσοφία τους είναι, βασικά ίδια, η παρουσίαση των χαρακτηριστικών ενός από 
αυτά θα διευκολύνει και τη μετάβαση στα υπόλοιπα προγράμματα.

24-0151 Book.indb   3924-0151 Book.indb   39 27/10/2021   12:17:21 µµ27/10/2021   12:17:21 µµ



40

Ε Φ Α Ρ Μ Ο Γ Ε Σ  Η Λ Ε Κ Τ Ρ Ο Ν Ι Κ Ω Ν  Υ Π Ο Λ Ο Γ Ι Σ Τ Ω Ν

3.2 Η προετοιμασία της οθόνης εργασίας

Ανοίγοντας οποιοδήποτε πρόγραμμα επεξεργασίας εικόνας, θα μας εντυπωσιάσει το 
πλήθος των μικρών εικονιδίων εντολών στις διάφορες εργαλειοθήκες (tool palettes).

Στις παρακάτω εικόνες εμφανίζονται οι οθόνες τριών δημοφιλών προγραμμάτων 
επεξεργασίας εικόνας αμέσως μετά την έναρξη της λειτουργίας τους. Όπως φαίνε-
ται, σε κάθε μία από αυτές υπάρχουν πολλές εργαλειοθήκες, διευθετημένες με δια-
φορετικούς τρόπους, που όμως και στις τρεις περιπτώσεις καταλαμβάνουν μεγάλο 
μέρος της συνολικής επιφάνειας της οθόνης (Εικόνα 3.1).

Εικόνα 3.1: Η αρχική οθόνη εργασίας μερικών προγραμμάτων επεξεργασίας εικόνας

Σύντομα θα ανακαλύψουμε ότι η τακτοποίηση των εργαλειοθηκών στην οθόνη του 
υπολογιστή, ώστε να βρίσκονται σε εύχρηστες θέσεις και, κυρίως, να μη κρύβουν 
τμήματα της εικόνας που επεξεργαζόμαστε είναι πολύ σημαντική, σχεδόν εξ ίσου 
σημαντική με τη γνώση της χρήσης τους. Ένα από τα πρώτα βήματα που θα πρέ-
πει, λοιπόν, να κάνουμε στην εφαρμογή ενός προγράμματος επεξεργασίας εικόνας, 
είναι να διευθετήσουμε κατάλληλα τις εργαλειοθήκες που θα χρησιμοποιήσουμε. 
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Σχετικά, τα ίδια τα προγράμματα μας προσφέρουν πολλές δυνατότητες. Έτσι, εκτός 
από την επιλογή των εικονιδίων εντολών που θα περιέχονται σε κάθε εργαλειοθή-
κη, μπορούμε να τις εμφανίζουμε ή να τις εξαφανίζουμε κατά βούληση, να τις με-
τακινούμε επάνω στην οθόνη, να αυξομειώνουμε τις διαστάσεις τους κ.τ.λ.

Στο επάνω οριζόντιο μέρος και των τριών οθονών υπάρχουν τα μενού εντολών 
των αντίστοιχων προγραμμάτων (menu bar). Το μενού Αρχείο (File), έχει τις εντο-
λές Άνοιξε (Open) και Κλείσε (Close) το αρχείο εργασίας, που στην προκειμένη 
περίπτωση είναι μια εικόνα. Στο μενού Επεξεργασία (Edit) υπάρχουν οι εντολές 
Αντιγραφή (Copy) και Επικόλληση (Paste). Στο μενού Εικόνα (Image) υπάρχουν 
οι εντολές ρύθμισης των διαστάσεων της εικόνας και του χρωματικού συστήματος 
απεικόνισης και εκτύπωσης. Με το μενού Φίλτρα (Filter) εφαρμόζουμε οπτικά εφέ 
στην εικόνα. Τέλος, στο Παράθυρο (Window) έχουμε τη δυνατότητα να αποκρύ-
ψουμε ή να εμφανίσουμε τις διάφορες εικόνες που, ενδεχόμενα, επεξεργαζόμαστε 
παράλληλα.

Βέβαια, είναι κατανοητό ότι στόχος μας δεν είναι να παρουσιάσουμε λεπτομερώς τα 
μενού και τις εντολές αλλά να περιγράψουμε γενικά την εμφάνιση των οθονών. Πά-
ντως, εύκολα μπορεί να διαπιστώσει κανείς ότι τα μενού όλων των προγραμμάτων 
είναι παρόμοια, παρόλο που σε μερικά από αυτά χρησιμοποιούνται διαφορετικές 
ονομασίες.

Για να εμφανισθεί στην οθόνη μια εικόνα, επιλέγουμε από το μενού Αρχείο>Άνοιξε  
(File>Open...) και στη συνέχεια το όνομά της. Στο επάνω μέρος της εικόνας που 
εμφανίζεται σημειώνεται το όνομα και το σύστημα χρωμάτων της. Το ποσοστό επί 
τοις εκατό που σημειώνεται μαζί με τα υπόλοιπα στοιχεία δείχνει τη σχέση μεταξύ 
των εικονοστοιχείων της εικόνας και αυτών της οθόνης, π.χ. 100% σημαίνει ότι για 
κάθε εικονοστοιχείο της φωτογραφίας αντιστοιχεί ένα εικονοστοιχείο της οθόνης.

Στο μενού Προβολή (View) υπάρχει η εντολή Μέγεθος εκτύπωσης (Print size) που, 
συνήθως, δεν κάνει αυτό που εννοεί, δηλαδή να εμφανίζει τη φωτογραφία στις δια-
στάσεις που θα τυπωθεί. Ας δούμε γιατί: Στις απαρχές της επιτραπέζιας τυπογραφί-
ας, το 1984, η ανάλυση των οθονών ήταν 72 ppi (δηλαδή, τετράγωνα εικονοστοιχεία 
με πλευρά 0,014 ίντσες) και η εντολή Print size έπαιρνε αυτό σα δεδομένο για να 
εμφανίσει την εικόνα στην οθόνη. Σήμερα, με την ποικιλία των καρτών γραφικών 
και οθονών, οι αναλύσεις δεν είναι πια μόνο 72 ppi. Αν δούμε την ίδια φωτογρα-
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φία σε διαφορετικούς υπολογιστές, η εντολή θα εμφανίζει στην οθόνη εικόνα με 
φαινομενικά διαφορετικές διαστάσεις. Για να ελέγξουμε τις πραγματικές διαστάσεις 
εκτύπωσης επιλέγουμε από το μενού Προβολή > Χάρακες (View>Show Rulers). Στη 
συνέχεια, ορίζουμε τη μονάδα μέτρησης, εκατοστά ή άλλη, από το μενού Επεξεργα-
σία >Προτιμήσεις>Μονάδες και χάρακες (Edit>Preferences>Units & Rulers). Μετά, 
επιλέγουμε View>Print Size και διαβάζουμε τις ενδείξεις του χάρακα. Αν κρατήσου-
με τώρα ένα πραγματικό χάρακα δίπλα, θα μπορέσουμε να κρίνουμε την ακρίβεια με 
την οποία η οθόνη μας απεικονίζει την πραγματικότητα, δηλαδή αν είναι WYSIWYG 
(What You See Is What You Get – Αυτό που βλέπεις είναι αυτό που θα έχεις).

Η εργαλειοθήκη που συνήθως βρίσκεται στο αριστερό μέρος της οθόνης, είναι η πα-
λέτα εργαλείων (tool palette). Τα εικονίδια που περιέχει συμβολίζουν τα εργαλεία 
επεξεργασίας που κατά περίπτωση ενεργοποιούνται και προσπαθούν να δώσουν 
το αποτέλεσμα που θα έδινε και το αντίστοιχο πραγματικό εργαλείο (Εικόνα 3.2).

Adobe Photoshop 5.5

Corel Photopaint  9

MetaCreations Painter 6

Εικόνα 3.2: Οι εργαλειοθήκες των κυριοτέρων προγραμμάτων επεξεργασίας εικόνων.

3.3 Η εργαλειοθήκη

Στην Εικόνα 3.3 εμφανίζεται μία τυπική παλέτα εργαλείων προγράμματος επεξερ-
γασίας εικόνας. Οι δύο βασικές της στήλες σημειώνονται με τα Α και Β, ενώ οι 
γραμμές με απλή αρίθμηση 1, 2, 3,...Σε πολλά εργαλεία στην κάτω δεξιά τους γωνία 
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υπάρχει ένα μικρό τρίγωνο, που αν το επιλέξουμε με το πλήκτρο του ποντικιού, 
ξεδιπλώνεται ένα δεύτερο μενού - «υπομενού» με συμπληρωματικά εργαλεία. Οι 
στήλες αυτές σημειώνονται με τους λατινικούς αριθμούς I, II, III, IV,...κτλ. Έτσι, για 
να αναφερθούμε σε κάποιο εργαλείο, θα το ονομάζουμε με τον αριθμό της στήλης 
και της γραμμής που ανήκει.

Εικόνα 3.3: Η παλέτα εργαλείων ενός προγράμματος επεξεργασίας εικόνας σε πλήρη ανάπτυξη. 
Σύντομη περιγραφή κάθε εργαλείου δίδεται στον πίνακα που ακολουθεί.

Στη συνέχεια θα παρουσιάσουμε επιγραμματικά αυτά τα εργαλεία, ομαδοποιημένα 
με βάση τις ομοιότητες του αποτελέσματός τους. Στην παρούσα φάση της παρουσία-
σης ίσως, δεν θα γίνει αμέσως κατανοητή η χρήση μερικών εργαλείων, ιδιαίτερα αν 
είναι η πρώτη φορά που έρχεται κανείς σε επαφή με προγράμματα επεξεργασίας 
εικόνας. Με λίγη εξάσκηση και υπομονή όμως, όλα θα ξεκαθαρίσουν σύντομα.
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Εργαλεία επιλογής:

A-1: Εργαλείο επιλογής ενός συνόλου pixel με 
ορθογώνιο σχήμα. Το ΙΙΙ-1 είναι για κυκλική 
επιλογή, ενώ τα IV-1 και V-1 για επιλογή μιας 
στήλης ή γραμμής, αντίστοιχα, πλάτους ενός 
pixel. To VI-1 τετραγωνίζει κόβοντας μία φωτο-
γραφία στο μέγεθος που θέλουμε.
Α-2: Θηλιά ή «Λάσο». Εργαλείο επιλογής μιας 
περιοχής με ελεύθερη γραμμή.
V-2: Θηλιά, επιλογή με τεθλασμένη γραμμή.
Α-12 & Β-16: Τα εργαλεία αυτά χρησιμοποιού-
νται για τη δημιουργία «μάσκας». Η μάσκα είναι 
μία πολύ διαδεδομένη τεχνική για την επιλογή 
μιας περιοχής φωτογραφίας, αν κριθεί ότι τα 
άλλα εργαλεία επιλογής δε διευκολύνουν.
Β-25: «Μαγικό ραβδάκι». Εργαλείο επιλογής με 
βάση το χρώμα των pixels. Με επιλογή (με το 
ποντίκι) σε ένα σημείο μιας εικόνας επιλέγεται 
αμέσως όλη η περιοχή με τα ομοιόχρωμα pixels.

Εργαλεία επεξεργασίας:

Α-6 και Β-21: Εργαλεία για διορθώσεις φωτο-
γραφιών τοπικά.
Β-20: Εργαλείο κειμένου.
Α-5: Γόμα.
Β-26: Εργαλείο μετακίνησης.
Α-8: Ηλεκτρονικός χάρακας.
A-10: «Χεράκι». Όταν δεν είναι δυνατόν να δού-
με ολόκληρη στην οθόνη μας μία μεγάλων διαστά-
σεων φωτογραφία, με το εργαλείο αυτό μπορούμε 
εύκολα να μετακινήσουμε το παράθυρο της οθό-
νης σε άλλο σημείο της φωτογραφίας, χωρίς να 
χρησιμοποιήσουμε τις μπάρες κύλισης.
A-13 & Β-15: Ρύθμιση του τρόπου εμφάνισης της 
φωτογραφίας στην οθόνη του υπολογιστή μόνο, 
χωρίς μεταβολή των χαρακτηριστικών της.
Β-17: Φακός. Μεγεθύνει ή σμικρύνει τη φωτο-
γραφία στην οθόνη. Δεν αλλάζει τις πραγματι-
κές διαστάσεις της. Έχει το ίδιο αποτέλεσμα με 
την εντολή του μενού (View>Zoom In και Zoom 
Out).

Εργαλεία χρωματισμού:

Απαραίτητη προϋπόθεση για το χρωματισμό μιας γραμμής ή μιας επιφάνειας είναι να έχουμε ορίσει 
το χρώμα προσκηνίου δηλαδή, το χρώμα στο οποίο επιθυμούμε να γίνονται οι χρωματικές επεμ-
βάσεις.
A & Β-11: Στη θέση αυτή ο χρήστης ορίζει το χρώμα που επιθυμεί. Το χρώμα στο ''πλακάκι'' που 
βρίσκεται μπροστά είναι το χρώμα προσκηνίου (ΠΡ) (foreground color). Το χρώμα στο πλακάκι που 
ευρίσκεται πίσω από το πρώτο είναι το χρώμα παρασκηνίου (ΠΑ) (background color), δηλαδή το 
χρώμα που αποκαλύπτεται κατά τον αποχρωματισμό μιας περιοχής της εικόνας. Με το μικρό διπλό 
βέλος, που βρίσκεται επάνω δεξιά, εναλλάσσονται τα χρώματα προσκηνίου (ΠΡ) και παρασκηνίου 
(ΠΑ). Κάτω δεξιά υπάρχει ένα μικρό μαύρο και ένα λευκό τετράγωνο. Με ένα ‘κλικ’ επάνω τους, 
ανεξάρτητα από τα χρώματα που υπάρχουν στο ΠΡ και το ΠΑ, τα χρώματα επιστρέφουν στη βασική 
τους ρύθμιση, που είναι μαύρο για το ΠΡ και λευκό για το ΠΑ.
Α-3: Αερογράφος. Βαφή με υφή σπρέι. Το Β-24 υφή πινέλου.
Α-4: Σφραγίδα. Αντιγράφει μία περιοχή της φωτογραφίας σε κάποιο άλλο σημείο της ίδιας ή και 
άλλης φωτογραφίας. 
Β-22: Μολύβι. Γράφει με υφή μολυβιού.
Α-7: Πένα. Σχεδιάζει καμπύλες Bezier, όπως τα προγράμματα διανυσματικής σχεδίασης. Στα προ-
γράμματα επεξεργασίας ψηφιακής εικόνας οι γραμμές αυτές είναι γνωστές ως paths.
Α-9: Κουβάς βαφής. Όταν έχουμε επιλέξει μία περιοχή της εικόνας, μπορούμε να τη χρωματίσουμε 
με το εργαλείο αυτό, με το ήδη επιλεγμένο χρώμα.
Β-18: Σταγονόμετρο. Με επιλογή (με το ποντίκι) σε διαφορετικές περιοχές της φωτογραφίας, αλλά-
ζει συγχρόνως το χρώμα ΠΡ της εργαλειοθήκης. Επομένως, αν δε θυμόμαστε το χρώμα σε ένα ση-
μείο της φωτογραφίας, προκειμένου να βάψουμε με το ίδιο και μια άλλη περιοχή, μπορούμε εύκολα 
να το εντάξουμε στην εργαλειοθήκη, «απορροφώντας» το με το σταγονόμετρο.
Β-19: Διαβάθμιση χρώματος. Μία επιλεγμένη περιοχή βάφεται με σταδιακή ανάμιξη χρωμάτων, 
δύο ή περισσότερων, και με τη μορφή που θέλουμε από τα VII, VIII, IX, X-19.
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Η παλέτα επιλογής ιδιοτήτων (Options palette) των εργαλείων (αναφέρεται και σαν 
παλέτα προδιαγραφών), είναι μία εργαλειοθήκη που βρίσκεται στο επάνω μέρος της 
οθόνης και εμφανίζει τις βασικές ιδιότητες του εκάστοτε ενεργού εργαλείου, επιτρέ-
ποντας παράλληλα και την αλλαγή τους. Για παράδειγμα, εμφανίζει και επιτρέπει τη 
ρύθμιση της ευαισθησίας ενός εργαλείου επιλογής, ή του τρόπου «αναρρόφησης» 
του χρώματος από το σταγονόμετρο. Η παλέτα αυτή κάθε φορά προσαρμόζεται στην 
επιλογή του εργαλείου, από την παλέτα εργαλείων (Εικόνα 3.4 Α).

Η παλέτα πλοήγησης (Navigator palette), που συνήθως βρίσκεται στο δεξιό μέρος 
της οθόνης, επιτρέπει τη μετακίνηση του ορατού μέρους της φωτογραφίας στην 
οθόνη, ίσως πιο εύκολα από το εργαλείο «χεράκι» (Α-10) (Εικόνα 3.4 Β).

Α

Β

Εικόνα 3.4: (Α) Η παλέτα προδιαγραφών (Options palette) βρίσκεται κάτω από το μενού του 
προγράμματος. Εδώ εμφανίζονται οι ιδιότητες του πινέλου χρωματισμού.
(Β) Η παλέτα Navigator. Το κόκκινο μικρό πλαίσιο στην μικρογραφία οριοθετεί το ορατό τμήμα 
της εικόνας.

3.4 Τα εργαλεία επιλογής περιοχής και η χρήση τους

Πριν από οποιαδήποτε επέμβαση σε μία εικόνα, είναι αναγκαίο να επιλέξουμε την 
περιοχή που θα εργασθούμε. Όσοι έχουν δει φανοποιούς να βάφουν ένα αυτοκίνη-
το, ξέρουν ότι καλύπτουν με χαρτί τα μέρη που δε χρειάζονται βάψιμο (παράθυρα, 
λάστιχα) κολλώντας το προσεκτικά με αυτοκόλλητη ταινία. Με αυτό τον τρόπο τα 
καλυμμένα μέρη του αυτοκινήτου προστατεύονται από το χρώμα που ψεκάζεται με 
το πιστόλι βαφής. Αυτή ακριβώς είναι και η ιδέα των επιλογών στα προγράμματα 
επεξεργασίας εικόνας.
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Αν χρησιμοποιήσουμε ένα από τα εργαλεία επιλογής, η περιοχή που επιλέγουμε 
αποκτά περίγραμμα με διακεκομμένη γραμμή μεταβλητής φωτεινότητας. Σ’ αυτή 
την περιοχή μπορεί να γίνει οποιαδήποτε επεξεργασία. Υπάρχουν δύο κατηγορίες 
εργαλείων επιλογής περιοχής, μία με «κοφτά» και μία «μαλακά» άκρα. Και οι δύο 
κατηγορίες ρυθμίζονται από την παλέτα προδιαγραφών του εργαλείου επιλογής αλ-
λάζοντας την τιμή στη θέση feather.

Α Β Γ

Εικόνα 3.5: (Α) Όλα τα εργαλεία που επιλέγουν μία περιοχή με βάση ένα σταθερό σχήμα, ορθο-
γώνιο ή έλλειψη.
(Β) Το εργαλείο επιλογής μίας ομοιόχρωμης και συνεχόμενης περιοχής.
(Γ) Τα εργαλεία επιλογής ενός τυχαίου σχήματος.

Στην Εικόνα 3.5 Α. φαίνεται η πρώτη ομάδα εργαλείων επιλογής περιοχής με βάση το 
σχήμα, ορθογώνιο ή ελλειπτικό. Αν συρθεί το ποντίκι διαγωνίως σε μία περιοχή της 
φωτογραφίας, ανάλογα με το σχήμα επιλέγεται η αντίστοιχη περιοχή. Αν συγχρόνως 
με το σύρσιμο πατάμε το πλήκτρο κεφαλαίων (Shift), τότε το σχήμα γίνεται τετρά-
γωνο ή κυκλικό. Αν επί πλέον πατάμε και το πλήκτρο Alt, τότε το σχήμα της περιοχής 
επιλογής έχει κέντρο το σημείο έναρξης του συρσίματος και μεγαλώνει ακτινωτά.

Στην 3.5 Β, φαίνεται το εργαλείο που επιλέγει μία ομοιόχρωμη περιοχή ανεξάρτητα 
με την πολυπλοκότητά της. Με επιλογή με το ποντίκι (κλικ) σε ένα σημείο της ει-
κόνας και με βάση την ευαισθησία (tolerance) που ρυθμίζεται από την παλέτα προ-
διαγραφών, επιλέγονται ταυτόχρονα όλα τα τμήματα της φωτογραφίας που έχουν 
παραπλήσιο χρώμα με αυτό που επιλέξαμε με το ποντίκι.

Στην Εικόνα 3.5 Γ, με τη θηλιά ή το «λάσο» επιλέγονται τμήματα με ελεύθερη γραμ-
μή οποιουδήποτε σχήματος. Η πολυγωνική θηλιά δημιουργεί περίγραμμα επιλογής 
με τεθλασμένη γραμμή. Ενώ η θηλιά με το μαγνήτη κάνει κατά κάποιο τρόπο αυτό-
ματα το περίγραμμα ενός σχήματος, αρκεί να διακρίνονται σαφώς τα όριά της προς 
επιλογή περιοχής.
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Συνήθως, προκειμένου να επιλέξουμε ένα πολύπλοκο σχήμα, απαιτείται η χρήση 
περισσοτέρων του ενός εργαλείων επιλογής. Παραδείγματος χάρη, μπορούμε να 
επιλέξουμε μία ομοιόχρωμη περιοχή με το ραβδάκι και στη συνέχεια να την επε-
κτείνουμε για να συμπεριλάβει μία ευρύτερη περιοχή. Η προσθήκη μπορεί να γίνει 
με οποιοδήποτε εργαλείο, πατώντας συγχρόνως το πλήκτρο Shift. Για να αφαιρέ-
σουμε από μία προϋπάρχουσα επιλεγμένη περιοχή πατάμε το πλήκτρο Alt.

Για μεγαλύτερη ευελιξία στη χρήση των εργαλείων επιλογών υπάρχει στο μενού η 
εντολή Επιλογή (Select) που προσθέτει μερικές επί πλέον επιλογές και δυνατότητες 
στις εντολές που γνωρίσαμε.

3.5 Τα βασικά εργαλεία χρωματισμού και επεξεργασίας και η χρήση τους

Απαραίτητη προϋπόθεση, όπως ήδη αναφέραμε και σε προηγούμενη παράγραφο, 
για να γράψουμε ή να βάψουμε με οποιοδήποτε εργαλείο γραφής ή χρωματισμού 
είναι η επιλογή του χρώματος της αρεσκείας μας, ως χρώματος προσκηνίου. Ο ευ-
κολότερος τρόπος γι’ αυτό το σκοπό είναι να επιλέξουμε με το ποντίκι μία απόχρω-
ση από αυτές που φαίνονται στο έτοιμο χρωματολόγιο. (Εικόνα 3.6).

Εικόνα 3.6: Η παλέτα χρωμάτων

Σε επόμενο κεφάλαιο θα αναφερθούμε εκτενέστερα στα χρώματα και στις μεθό-
δους επιλογής τους. Τώρα, θα αναφερθούμε κυρίως στον τρόπο με τον οποίο γίνε-
ται η εφαρμογή τους με τα εργαλεία χρωματισμού.
Στα προγράμματα επεξεργασίας εικόνας υπάρχει μια μεγάλη ποικιλία εργαλείων 
χρωματισμού και για κάθε ένα από αυτά διατίθενται πάμπολλες πρόσθετες επιλο-
γές. Για παράδειγμα, αν επιλέξουμε από την παλέτα προδιαγραφών τη βασική σει-
ρά πινέλων, θα διαπιστώσουμε ότι μπορούμε να ρυθμίσουμε τη διάμετρό τους κατά 
βούληση (Εικόνα 3.7 Α). Επίσης, στην Εικόνα 3.7 Β βλέπουμε και τη δυνατότητα να 
«χρωματίσουμε» όχι με απλό στρογγυλό πινέλο, αλλά με κάποιο σχήμα που υπάρ-
χει στην ίδια ή σε άλλη παλέτα.
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Α Β

Εικόνα 3.7: (A) Η βασική παλέτα των πινέλων με το κυλιόμενο μενού εισαγωγής της τεράστιας 
ποικιλίας τους.
(Β) Χρησιμοποιώντας σαν υφή πινέλου ένα φύλλο ή πεταλούδα ή άλλο σχήμα από την παλέτα, 
μπορούμε να δημιουργήσουμε εντυπωσιακά αποτελέσματα.

Κάθε εργαλείο χρωματισμού δίνει διαφορετική υφή στο ίχνος που αφήνει στην επι-
φάνεια γραφής. Μία προφανής διαφορά έχει να κάνει για παράδειγμα με την πυ-
κνότητα του ίχνους τους. Το μολύβι αφήνει “σκληρό” ίχνος, ενώ το πινέλο ή ο αερο-
γράφος “μαλακό” (Εικόνα 3.8). Παρόλα αυτά, όλα τα εργαλεία βαφής μοιράζονται 
λίγο – πολύ τις ίδιες βασικές ρυθμίσεις.

Εικόνα 3.8: Η πράσινη γραμμή έχει «μαλακά», ενώ η κόκκινη «σκληρά» άκρα.

Ιδιότητες εργαλείων χρωματισμού: Υπάρχουν ορισμένες κοινές ιδιότητες των ερ-
γαλείων χρωματισμού που, όμως, η διαφορετική τους ρύθμιση στην παλέτα προ-
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διαγραφών οδηγεί σε διαφορετικό αποτέλεσμα ως προς την υφή του ίχνους τους. 
Αυτές είναι:
Αδιαφάνεια (Opacity): Προσδιορίζει το βαθμό που η διάστρωση κάποιου χρώμα-
τος αφήνει ορατό το φόντο. Όταν η βαφή πχ. με το πινέλο έχει αδιαφάνεια 100%, 
δημιουργεί ομοιόμορφη στρώση χρώματος και δε διακρίνεται καθόλου το φόντο, 
ενώ όταν βάφει με αδιαφάνεια 50%, αφήνει να φαίνεται το φόντο κατά το ήμισυ.
Η αδιαφάνεια ενός εργαλείου χρωματισμού ρυθμίζεται και με την πίεση (pressure) 
ή ροή, ενώ, κάθε φορά που βάφουμε με αυτό δημιουργούνται επάλληλα στρώματα.
Τρόπος ανάμιξης (Blending mode): Στο κέντρο της παλέτας προδιαγραφών υπάρ-
χει μια λίστα επιλογών, που με τη βοήθειά τους, καθορίζουμε τον τρόπο ανάμιξης 
των χρωμάτων (Εικόνα 3.9).

Δεν εξαρτάται από το χρώμα
που βρίσκεται στο από κάτω
επίπεδο (layer).

Αλλάζει την φωτεινότητα της
εικόνας στο από κάτω επίπεδο.

Επιδρά και στην φωτεινότητα και
στο χρώμα της εικόνας που
βρίσκεται στο από κάτω επίπεδο.
Συγκρίνει το ενεργό επίπεδο με
την εικόνα που βρίσκεται στο
από κάτω επίπεδο.
Εφαρμόζει ορισμένα μόνο
χρωματικά χαρακτηριστικά στο
ενεργό επίπεδο.

Εικόνα 3.9: Το αναδιπλούμενο μενού εμφανίζει ομαδοποιημένους τους τρόπους ανάμιξης των 
χρωμάτων στο ενεργό με το αμέσως από κάτω επίπεδο.

Για να αλλάξουμε την απόχρωση ενός αντικειμένου με εμφανείς όλες τις λεπτομέ-
ρειες της επιφάνειάς του, θα πρέπει να το βάψουμε έχοντας προηγουμένως επιλέξει 
την ανάμιξη με βάση την απόχρωση (Hue). Επιλέγοντας ανάμιξη με βάση τη διά-
λυση (Dissolve) με το πινέλο, μπορούμε να μεταβάλλουμε την υφή των «μαλακών» 
άκρων της γραμμής που αυτό χαράσσει. Στις Εικόνες 3.10 φαίνονται σε παραδείγ-
ματα τα αποτελέσματα αυτών των εντολών.
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Ροή χρώματος (Flow): Με τη ρύθμιση αυτή ορίζουμε συγκεκριμένη συνολική δια-
φάνεια για τα επάλληλα στρώματα βαφής.
Διαβάθμιση χρώματος (Gradient Tool): Η σταδιακή ανάμιξη χρώματος δίνει εντυ-
πωσιακά αποτελέσματα για ρεαλιστικές φωτοσκιάσεις ή για χρωματισμό γραμμά-
των, συμβόλων και άλλων σχημάτων με μία όμως προϋπόθεση, να μη γίνεται κα-
τάχρηση. Στην επεξεργασία εικόνας θα διαπιστώσουμε ότι αυτό το εργαλείο είναι 
χρήσιμο και για τη χρήση των επιπέδων αλλά και για την κατασκευή μασκών. Μόλις 
επιλέξουμε το αντίστοιχο εικονίδιο στην παλέτα εργαλείων, εμφανίζεται η παλέτα 
των προδιαγραφών με την οποία επιλέγουμε την ανάμιξη (πολλές φορές λέγεται 
και «ντεγκραντέ») των χρωμάτων που θέλουμε (Εικόνα 3.11).

Εικόνα 3.11: Η παλέτα προδιαγραφών για το εργαλείο ανάμιξης χρώματος. Μπορούμε να επιλέ-
ξουμε μεταξύ χρώματος προσκηνίου και παρασκηνίου, μεταξύ προκατασκευασμένων χρωμάτων 
αλλά και τρόπου ανάμιξης. Στην εικόνα αυτή έχουμε γραμμική, κυκλική, σε σχήμα «διαμαντιού» 
και συμμετρική χρωματική διάταξη.

Εικόνα 3.10:
Η μεταβολή της ανάμιξης.
(Α) Αρχική εικόνα
(Β) Dissolve,
(Γ) Normal-soft edges,
(Δ) Hue (blending mode) αλλάζει την υφή
της βαφής του πινέλου.

Α

Δ

Β Γ
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Η γόμα: Είναι ένα εργαλείο με πολλαπλές ιδιότητες. Αν τη χρησιμοποιήσουμε για 

να σβήσουμε στο τρέχον επίπεδο εργασίας συμπεριφέρεται σαν «κανονική» γόμα 

αφήνοντας να διαφανεί ότι είναι στο αμέσως από κάτω επίπεδο. Αν όμως βρισκό-

μαστε στο βασικό επίπεδο εργασίας (background layer), όπως θα δούμε σε επόμενο 

κεφάλαιο, τότε η γόμα χρησιμοποιείται σαν το μολύβι ή το πινέλο, με μόνη διαφορά 

ότι χρησιμοποιεί το χρώμα παρασκηνίου αντί αυτό του προσκηνίου. Αυτή η ρύθμιση 

γίνεται από την παλέτα προδιαγραφών (Εικόνα 3.12).

Εικόνα 3.12: Η «συμπεριφορά» της γόμας ρυθμίζεται από την παλέτα προδιαγραφών.

3.6 Αυτοματοποίηση εντολών

Πολλές φορές χρειάζεται να εκτελέσουμε μια σειρά εντολών σε μία ή περισσότε-

ρες εικόνες, προκειμένου να επιβάλουμε μετατροπές η προσαρμογές, αναγκαίες 

σε μία εργασία μας. Αυτή η «χειροκίνητη» επανάληψη εντολών, που ενδεχομένως 

κουράζει, μπορεί να αποφευχθεί με τη δυνατότητα που δίνουν τα προγράμματα 

επεξεργασίας εικόνας, να καταγράφουν και να ενσωματώνουν αυτές τις εντολές 

σε ένα άλλο μικρό πρόγραμμα (script). Αυτό οδηγεί την εφαρμογή να εκτελέσει τις 

επαναλαμβανόμενες εντολές σε μία σειρά εικόνων χωρίς άλλη δική μας παρέμβαση 

πέρα από την εκκίνηση του μικρού προγράμματος.

Αν θέλουμε, μπορούμε να δημιουργήσουμε ένα αυτόνομο πρόγραμμα (droplet) με 

τις εντολές που θέλουμε και το οποίο θα εκκινεί με απόθεση επάνω στο εικονίδιό του, 

της εικόνας ή ενός φακέλου με περισσότερες εικόνες που θέλουμε να επεξεργαστού-

με. Τα προγράμματα CorelDraw και CorelPAINT χρησιμοποιούν για την αυτοματο-

ποίηση εντολών το εργαλείο ανάπτυξης Visual Basic for Applications (VBA).

To πρόγραμμα Adobe Photoshop διαθέτει την ειδική παλέτα αυτοματοποιημένων 

ενεργειών (Actions). (Εικόνα 3.13). Ο ενέργειες είναι μικρά προγράμματα που ανα-

γνωρίζει μόνο το Photoshop. Περιέχουν εντολές που εκτελούνται διαδοχικά. Πολλές 

ενέργειες μαζί σε φάκελο συνιστούν ένα σύνολο ενεργειών (Set). Όπως μπορούμε 

να δούμε από τους τίτλους που εμφανίζονται στην παλέτα, υπάρχει ένας αριθμός 

αρχικών ενεργειών (Default Actions) που προσφέρει ποικιλία μετατροπών, αλλά μπο-

ρούμε να επιλέξουμε και άλλες από το αντίστοιχο κυλιόμενο μενού που εμφανίζεται.

24-0151 Book.indb   5124-0151 Book.indb   51 27/10/2021   12:17:23 µµ27/10/2021   12:17:23 µµ



52

Ε Φ Α Ρ Μ Ο Γ Ε Σ  Η Λ Ε Κ Τ Ρ Ο Ν Ι Κ Ω Ν  Υ Π Ο Λ Ο Γ Ι Σ Τ Ω Ν

52

Ε Φ Α Ρ Μ Ο Γ Ε Σ  Η Λ Ε Κ Τ Ρ Ο Ν Ι Κ Ω Ν  Υ Π Ο Λ Ο Γ Ι Σ Τ Ω Ν

Για να ξεκινήσει μία ενέργεια, πρέπει να έχουμε ανοικτή την εικόνα μας και απλώς 

να επιλέξουμε την ενεργοποίηση (Play). Μπορούμε επίσης να καταγράψουμε και 

δικές μας ενέργειες με την εντολή καταγραφής (Record), δίνοντας και όνομα της 

επιλογής μας. Ακολουθώντας από το μενού Αρχείο > Αυτοματισμοί > Δημιουργία 

droplet  (File > Automate > Create droplet...) δημιουργούμε αντιστοίχως ένα αυτό-

νομο πρόγραμμα με τις ενέργειες της επιλογής μας.

Το κόκκινο σύμβολο υποδεικνύει 
ότι μερικές εντολές της ενέργειας 
δεν είναι ενεργοποιημένες

Η επλογή δίπλα σε εντολή 
υποδεικνύει ότι η εντολή είναι ενεργοποιημένη.

Η επιλογή (''τσεκάρισμα'') δίπλα σε ενέργεια
υποδεικνύει ότι η ενέργεια είναι ενεργοποιημένη. Σύνολο ενεργειών (Set)

Ενέργεια( Action)
Εντολή (Command)

Στάση (Stop)
Εγγραφή (Record)

Παίξιμο (Play)
Δημιουργία νέου 

συνόλου (set) ενεργειών
Δημιουργία νέας

 ενέργειας
Διαγραφή

Εικόνα 3.13: To πρόγραμμα Adobe Photoshop διαθέτει την ειδική παλέτα αυτοματοποιημένων 
ενεργειών (Actions)
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Ανακεφαλαίωση 3ου Κεφαλαίου

Οι εντολές, τα βασικά μενού και οι εργαλειοθήκες στα προγράμματα επεξεργα-
σίας εικόνας μοιάζουν αρκετά μεταξύ τους, αφού ο τρόπος εργασίας με αυτά 
είναι παρόμοιος. Κατά τη χρήση παρόμοιων προγραμμάτων βελτιώνει την πα-
ραγωγικότητά μας η σωστή διευθέτηση των παλετών εργασίας στην οθόνη μας, 
ώστε να τις εντοπίζουμε εύκολα και να μην εμποδίζουν το πεδίο εργασίας μας. 
Οι μεγάλες οθόνες βοηθούν για το σκοπό αυτό.
Για να επέμβουμε σε μία εικόνα, πρέπει πρώτα να επιλέξουμε το τμήμα της που 
μας ενδιαφέρει, να επεξεργαστούμε και στη συνέχεια, να το μετασχηματίσουμε 
ή και να το χρωματίσουμε κατά βούληση. Για το σκοπό αυτό, τα προγράμμα-
τα επεξεργασίας εικόνας προσφέρουν μεγάλη ποικιλία εργαλείων με τα οποία 
μπορούμε να επιλέγουμε περιοχές του θέματός μας και να τις επεξεργαζόμαστε 
κατάλληλα. Τα εργαλεία αυτά κατά κανόνα ενεργοποιούνται μέσα από σχετικές 
εργαλειοθήκες. Για όλα αυτά τα εργαλεία υπάρχουν επίσης δυνατότητες πολ-
λών πρόσθετων ρυθμίσεων των ιδιοτήτων τους.
Πολλές φορές χρειάζεται να εκτελέσουμε μια σειρά εντολών σε μία ή περισσό-
τερες εικόνες, προκειμένου να επιβάλουμε μετατροπές ή προσαρμογές, ανα-
γκαίες σε μία εργασία μας. Αυτή η «χειροκίνητη» επανάληψη εντολών, που 
ενδεχομένως κουράζει, μπορεί να αποφευχθεί με την δυνατότητα που δίνουν 
τα προγράμματα επεξεργασίας εικόνας, να καταγράφουν και να ενσωματώ-
νουν αυτές τις εντολές σε ένα άλλο μικρό πρόγραμμα (script). Αυτό οδηγεί την 
εφαρμογή να εκτελέσει τις επαναλαμβανόμενες εντολές σε μία σειρά εικόνων 
χωρίς άλλη δική μας παρέμβαση πέρα από την εκκίνηση του μικρού προγράμ-
ματος.
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Ασκήσεις 3ου Κεφαλαίου

1.	� Ανοίξτε το πρόγραμμα επεξεργασίας εικόνας του εργαστηρίου σας και αναγνω-
ρίστε τα εργαλεία και τα «μενού» που περιέχει.

2.	� Χωρίστε και καταγράψτε σε ένα χαρτί όλα τα εργαλεία σε τρεις βασικές ομάδες: 
(1) εργαλεία επιλογής, (2) εργαλεία χρωματισμού, (3) εργαλεία χειρισμού, δια-
χείρισης και πλοήγησης εικόνων.

3.	� Αναφέρατε τα αναγκαία βήματα, προκειμένου να χρωματίσουμε μία επιλεγμένη 
περιοχή. Πόσους τρόπους γνωρίζετε;

4.	�Αναφέρατε τα αναγκαία βήματα, προκειμένου να σβήσουμε, με το εργαλείο της 
γόμας, μία λανθασμένη κόκκινη γραμμή που φέραμε σε μία ήδη χρωματισμένη 
επιφάνεια (π.χ. πράσινη).

5.	� Γιατί τα χρώματα RGB μετρώνται με αρίθμηση από 0 έως 255 και τα CMYK με 
ποσοστά από 0 έως 100%;

Δραστηριότητες 3ου Κεφαλαίου

1.	 Εκκινήστε ένα πρόγραμμα επεξεργασίας εικόνας (π.χ. το Photoshop της Adobe).
2.	� Αναγνωρίστε τα εργαλεία και τις εντολές στην αρχική οθόνη εργασίας του προ-

γράμματος χωρίς να ανατρέξετε στο βιβλίο ή τις σημειώσεις σας.
3.	� Ανοίξτε μία φωτογραφία της επιλογής σας και αποθηκεύστε την με άλλο όνομα 

σε μία δισκέτα. Ποιο είναι το μέγεθος του αρχείου της φωτογραφίας σε ΚΒ αλλά 
και σε MB; Χωρά στη δισκέτα; Αν όχι χρησιμοποιήστε μία μορφή αποθήκευσης 
με συμπίεση.

4.	Ρυθμίστε τον εκτυπωτή σας για να τυπώσετε τη φωτογραφία. Εκτυπώστε την.
5.	� Μετρήστε τις διαστάσεις της τυπωμένης φωτογραφίας από την προηγούμενη 

άσκηση. Ταιριάζουν αυτές οι διαστάσεις, με αυτές από το μενού των διαστάσεων 
εικόνας (Image size...); Σε κάθε περίπτωση δικαιολογήστε την απάντησή σας.

6.	�Ανοίξτε ένα νέο έγγραφο, με διαστάσεις 10 εκ. επί 10 εκ. Επιλέξτε ένα-ένα τα ερ-
γαλεία χρωματισμού, γραφής και σβησίματος. Στη συνέχεια, χρωματίστε ή σβή-
στε με κάθε ένα από αυτά, μεταβάλλοντας τις ιδιότητές τους. Προσπαθήστε να 
ταξινομήσετε τις παραμέτρους που καθορίζουν την υφή του κάθε εργαλείου.

7.	� Τι πληροφορίες μας δίνει η παλέτα History; Προσπαθήστε, με διαδοχικές δοκι-
μές, να εκτιμήσετε τη χρησιμότητά της.
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Σχετικές ηλεκτρονικές διευθύνσεις

Για συμβουλές, ιδέες και διάφορα βοηθητικά προγράμματα επεξεργασίας εικόνων 
(Actions, scripts, φίλτρα κλπ.):
www.adobe.com
www. designer.com
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Κεφάλαιο 4ο
Το φως, οι σκιές και τα χρώματα

Στόχοι:

Μετά τη μελέτη αυτού του κεφαλαίου οι μαθητές θα είναι σε θέση να:

	 •	� Αντιληφθούν την υποκειμενική διάσταση της χρωματικής και τονικής 
αναπαραγωγής.

	 •	 �Κατανοήσουν τους τρόπους διόρθωσης μίας ψηφιακής φωτογραφίας.

	 •	 �Αντιληφθούν τους τρόπους οργάνωσης των χρωμάτων στην επεξεργα-
σία ψηφιακών εικόνων.

4.1 Εισαγωγή - Το φως

Το ορατό φως είναι ένα μικρό μέρος της ηλεκτρομαγνητικής ακτινοβολίας που εκ-
πέμπεται από τον ήλιο και τα άλλα άστρα του γαλαξία μας, ή από άλλους γαλαξίες. 
Το ηλεκτρομαγνητικό φάσμα εκτείνεται από τις ακτίνες γάμα έως τα ραδιοφωνικά 
κύματα. Το ορατό φάσμα, δηλαδή το μέρος εκείνο του φάσματος που γίνεται αντι-
ληπτό από το ανθρώπινο μάτι, είναι μικρό μόνο τμήμα του (Εικόνα 4.1 Α και Β).

Υπέρυθρη
ακτινοβολία

Υπεριώδης
ακτινοβολία

Ραδιοκύματα
AM    FM

Μικρο-
κύματα

Ορατό
φάσμα Ακτίνες  Χ Ακτίνες  Y

Εικόνα 4.1: (Α) Το ηλεκτρομαγνητικό φάσμα εκτείνεται από τις ακτίνες γάμα έως τα ραδιοφω-
νικά κύματα.
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Εικόνα 4.1:(Β) Το ορατό φάσμα.

Ο ήλιος εμφανίζεται να έχει ένα λευκό προς κίτρινο φως, όμως το αποτέλεσμα αυτό 
προκύπτει ως σύνθεση του συνόλου των χρωμάτων του ορατού φάσματος, από το 
ιώδες έως το ερυθρό, που αυτός εκπέμπει.

Η ακτινοβολία ως κύμα, χαρακτηρίζεται από το μήκος κύματος και το πλάτος κύ-
ματος. Το μήκος κύματος, προκειμένου για ακτινοβολία του ορατού φάσματος, κα-
θορίζει το χρώμα ή την απόχρωση της ακτίνας φωτός, ενώ το πλάτος καθορίζει τη 
φωτεινή ένταση της ακτίνας (Εικόνα 4.2).

Εικόνα 4.2: Το μήκος κύματος ισούται με την απόσταση 
δύο κορυφών του. Το πλάτος του κύματος ισούται με την 
απόσταση της κορυφής του, από τον οριζόντιο άξονα.

Όταν το φως πέφτει σε ένα αντικείμενο, μέρος της ακτινοβολίας ανακλάται από την 
επιφάνειά του, ενώ το υπόλοιπο είτε απορροφάται είτε διαθλάται από το αντικεί-
μενο. Αν η επιφάνεια είναι λεία, τότε η γωνία πρόσπτωσης του φωτός ισούται με τη 
γωνία ανάκλασής του, με αποτέλεσμα η επιφάνεια να γυαλίζει. Αν η επιφάνεια έχει 
ανωμαλίες, το ανακλώμενο φως διαχέεται προς όλες τις κατευθύνσεις, δίνοντας μία 
θαμπή υφή στην επιφάνεια.
	
Η σκιά μπορεί να θεωρηθεί ως το αντίστροφο του φωτός. Σχηματίζεται, όταν ένα 
αδιαφανές αντικείμενο παρεμβάλλεται μεταξύ της φωτεινής πηγής και μιας επιφά-
νειας, έτσι ώστε να εμποδίζει το φωτισμό της (Εικόνα 4.3). Όλα τα αντικείμενα που 
μας περιβάλλουν, φωτίζονται είτε άμεσα από τον ήλιο (ή άλλες τεχνητές πηγές), είτε 
έμμεσα από φως που διαχέεται εξ αντανακλάσεως από άλλα αντικείμενα είτε από 
τους κόκκους της σκόνης της ατμόσφαιρας, δημιουργώντας ένα διάχυτο φωτισμό.
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Φωτισμός Οφθαλμός

Το φως αντανακλάται
στα αντικείμενα

Εικόνα 4.3: Οι τρεις προϋποθέσεις για την ύπαρξη των χρωμάτων των αντικειμένων είναι: α) να 
υπάρχει φως, β) τα αντικείμενα να αντανακλούν και να απορροφούν το φως και γ) το ανθρώπινο 
μάτι να είναι ευαίσθητο στα διαφορετικά χρώματα του φωτός. Το μάτι μας έχει δύο ειδών οπτικά 
κύτταρα στον αμφιβληστροειδή χιτώνα, τους κώνους και τα ραβδία. Τα ραβδία είναι ευαίσθητα 
στις μεταβολές του φωτός χωρίς όμως δυνατότητα αναγνώρισης των χρωμάτων. Οι κώνοι είναι 
τριών ειδών, με το κάθε είδος ευαίσθητο σε κάθε ένα από τα βασικά χρώματα του φωτός, δηλαδή 
του κόκκινου, του πράσινου και του μπλε.

Το 1879, ο Θωμάς Έντισον ανακάλυψε την ηλεκτρική λάμπα πυρακτώσεως. Το νήμα 
της λάμπας πυρακτώνεται στη θερμοκρασία των 3000° Κ εκπέμποντας το γνωστό 
κιτρινωπό φως. Με βάση αυτή την παρατήρηση συνηθίζουμε να ορίζουμε το χρώμα 
μιας φωτεινής πηγής με τη θερμοκρασία σε βαθμούς Kelvin. Οι λυχνίες φθορισμού 
για παράδειγμα, που χρησιμοποιούνται ευρύτατα στην εποχή μας, εκπέμπουν πιο 
«λευκό» φως από τις κοινές λάμπες, με χρώμα θερμοκρασίας 4100° Κ. Ας σημειώ-
σουμε εδώ ότι ο ήλιος εκπέμπει φως με χρώμα θερμοκρασίας 5500° Κ.

Αξίζει να διευκρινιστεί ότι ο όρος θερμοκρασία χρώματος (color temperature) προ-
έρχεται από τις μετρήσεις ακτινοβολίας του μέλανος σώματος. Αυτές οι μετρήσεις, 
στα πλαίσια μιας σειράς σχετικών πειραμάτων φυσικής, θεμελίωσαν την κβαντική 
θεωρία στις αρχές του εικοστού αιώνα. Σύμφωνα με αυτές, κάθε αντικείμενο που 
θερμαίνεται, εκπέμπει, ανάλογα με τη θερμοκρασία του ακτινοβολία διαφορετικού 
μήκους κύματος (επομένως και διαφορετικού χρώματος). Το μήκος κύματος της 
ακτινοβολίας, ή διαφορετικά, το χρώμα που εκπέμπει σε κάθε θερμοκρασία εξαρ-
τάται μόνο από την τιμή της θερμοκρασίας του και όχι από τη χημική του σύσταση. 
Συνεπώς, το χρώμα των φωτεινών πηγών είναι ίδιο με το χρώμα της ακτινοβολίας 
του μέλανος σώματος στην ίδια θερμοκρασία.
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Μέλαν σώμα στη φυσική είναι ένα αντικείμενο που απορροφά το σύνολο της ακτι-
νοβολίας που πέφτει επάνω του. Πρακτικά, μπορούμε να το προσεγγίσουμε με ένα 
απόλυτα μαύρο αντικείμενο.

Η ανακάλυψη της φωτογραφίας έδωσε την ευκαιρία να μελετηθούν οι τεχνικές φω-
τισμού και επηρέασε πολλούς καλλιτέχνες. Ο Ε. Degas (1834-1917) για παράδειγμα, 
ζωγράφιζε τα θέματά του, που βρίσκονταν σε κίνηση, με τον τρόπο που ο φωτογρα-
φικός φακός αποθανατίζει την κίνηση. Οι φωτογράφοι γρήγορα ανακάλυψαν ότι ο 
τύπος και το χρώμα φωτισμού του θέματος είναι καθοριστικός για το τελικό απο-
τέλεσμα της φωτογράφησης, ενώ η ανάπτυξη της τεχνολογίας τους έδωσε τη δυνα-
τότητα να δοκιμάσουν γωνίες λήψεως και συνθήκες φωτισμού που ήταν άγνωστες 
στους ζωγράφους της εποχής.

4.2 Η φωτοσκίαση και οι τονικές της διαβαθμίσεις

Η σκιά και το χρώμα είναι αναπόσπαστα συνδεδεμένα με τα αντικείμενα που βλέ-
πουμε στην καθημερινή μας ζωή. Η σκιά περιγράφει, δηλαδή δίνει σχήμα στα αντι-
κείμενα, ενώ το χρώμα τα κάνει πιο ευδιάκριτα. Με άλλα λόγια, το χρώμα βοηθά 
την ανθρώπινη νόηση να αναγνωρίζει τα αντικείμενα, ενώ η φωτοσκίαση να καθο-
ρίζει το σχήμα τους.

Οι ασπρόμαυρες φωτογραφίες καθώς και οι παλιές ασπρόμαυρες ταινίες περιγρά-
φουν τα αντικείμενα με μεγάλη ακρίβεια, χρησιμοποιώντας τις τονικές διαβαθμί-
σεις της φωτοσκίασης. Έτσι, πριν από τη μελέτη των χρωμάτων είναι χρήσιμη η 
γνώση των φωτεινών τόνων των εικόνων και του τρόπου αναπαραγωγής τους, γιατί 
οι ίδιες αρχές χρησιμοποιούνται και στα χρώματα.

Στο σημείο αυτό ας εξετάσουμε πιο προσεκτικά μερικούς όρους που θα μας χρησι-
μεύσουν να κατανοήσουμε τον τρόπο που αντιλαμβανόμαστε τα αντικείμενα, όρους 
όπως τονική διαβάθμιση της φωτοσκίασης ή φωτεινοί τόνοι.

Τα μάτια μας έχουν την ικανότητα προσαρμογής στις συνθήκες φωτισμού (light-
ness constancy), έτσι ώστε να μπορούμε να διακρίνουμε (κατ’ ελάχιστον) μία μαύ-
ρη ή γκρι ή λευκή επιφάνεια, είτε βρισκόμαστε στο μεσημεριάτικο ηλιακό φως, είτε 
στο ημίφως μιας νύχτας με φεγγάρι.
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Μία άλλη ιδιότητα των ματιών μας είναι η ταυτόχρονη αντίθεση φωτεινότητας (si-
multaneous brightness contrast). Με τον όρο αυτόν περιγράφουμε το ότι μία γκρίζα 
επιφάνεια εκλαμβάνεται, συγχρόνως, πιο φωτεινή ή πιο σκούρα, αν την παρατη-
ρούμε σε σκούρο ή ανοιχτό γκρίζο φόντο αντιστοίχως (Εικόνα 4.4).

Εικόνα 4.4: Τα οκτώ ορθογώνια είναι ακριβώς ίδια. Όμως το φόντο που είναι τοποθετημένα τα 
ορθογώνια, παίζει καθοριστικό ρόλο για το πόσο ανοιχτό ή σκούρο γκρι εκλαμβάνονται από το 
ανθρώπινο μάτι.

Θα μπορούσαμε να πούμε ότι οι τονικές διαβαθμίσεις μιας φωτογραφίας δεν εί-
ναι παρά μία οφθαλμαπάτη. Αυτό συμβαίνει, γιατί ο εγκέφαλος επεξεργάζεται τα 
οπτικά ερεθίσματα με συγκεκριμένο τρόπο, προκειμένου να αναπαραστήσει την 
πραγματικότητα. Το μαύρο χρώμα της επίστρωσης του φωτογραφικού χαρτιού 
αντιστοιχεί σε συνθήκες «σκοταδιού» του θέματος, ενώ τα «φωτεινά» σημεία είναι 
λιγότερο ή περισσότερο γκρίζα.

Υπάρχουν δύο ακόμη παράγοντες που παίζουν καθοριστικό ρόλο στην οπτική αντί-
ληψη. Ο πρώτος είναι ότι ο εγκέφαλος υπολογίζει τη θέση της φωτεινής πηγής, λαμ-
βάνοντας υπόψη ότι επιφάνειες που είναι στραμμένες προς αυτή εμφανίζονται πιο 
ανοιχτόχρωμες από τις επιφάνειες που έχουν άλλη κλίση και δέχονται λιγότερο φως. 
Ο δεύτερος παράγων είναι ότι ο εγκέφαλος και πάλι λαμβάνει τον ανοιχτότερο τόνο 
ενός φωτογραφικού θέματος, ως ένα είδος σημείου αναφοράς, για να σταθμίσει όλους 
τους υπόλοιπους τόνους και να κρίνει αν η απεικόνιση είναι «καλή» ή «κακή».

Η έκταση των τόνων που αντιλαμβάνεται το ανθρώπινο μάτι (με τη βοήθεια των 
ραβδίων) από το δυνατό φως του ήλιου μέχρι το σκοτάδι είναι περίπου 1 εκατομμύ-
ριο. Επειδή δε 1.000.000 = 106, ανάγοντας το μέγεθος αυτό σε λογαριθμική κλίμα-
κα, λέμε ότι είναι μεγέθους 6. Βέβαια, στην πράξη, δε μπορούμε να δούμε όλη την 
έκταση των τόνων, αφού τις πιο πολλές φορές οι συνθήκες φωτισμού περιορίζουν 
την ορατότητα. Όσο μεγαλύτερη είναι η έκταση των τόνων, τόσο περισσότεροι σε 
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πλήθος είναι οι διακριτοί τόνοι. Η έκταση των τόνων που αποτυπώνεται στο φωτο-
γραφικό φιλμ είναι από 103 έως 104 κατά προσέγγιση και στην εκτύπωση offset από 
102.3 έως 102.5 . Είναι φανερό ότι καμιά μέθοδος αναπαραγωγής δεν πλησιάζει καν 
την έκταση των τόνων της ανθρώπινης όρασης (Εικόνα 4.5).

Εύρος των τόνων που αντιλαμβάνεται το ανθρώπινο μάτι
Απόλυτο
Σκοτάδι

Απόλυτο 
Λευκό

Υψηλή πυκνότητα Εύρος των τόνων της φωτογραφικής μηχανής Χαμηλή πυκνότητα

Πυκνότητα ''ράστερ'' 100% Πυκνότητα ''ράστερ'' 0%
Εύρος των τόνων της εκτύπωσης

Συμπίεση των φωτεινών τόνων

Συμπίεση των σκούρων τόνων

Εικόνα 4.5: Τα κόκκινα πλαίσια δείχνουν σχηματικά πως το εύρος των φωτεινών τόνων στη φύση 
συσχετίζεται με το εύρος των τόνων της φωτογραφίας και με το εύρος των τόνων των εκτυπώσεων.

Κάθε αναπαραγωγή από ένα οπτικό σύστημα σε κάποιο άλλο, περιορίζει ή «συμπιέ-
ζει» την έκταση των τόνων της αρχικής εικόνας. Η συμπίεση δίνει πολύ καλά απο-
τελέσματα, αν γίνει με μέτρο και, στην περίπτωση αυτή, περνά απαρατήρητη για το 
θεατή. Παραδείγματος χάρη, η τηλεοπτική εικόνα συγκρινόμενη με την πραγματι-
κότητα είναι «κακή», αλλά, κρίνοντάς την αυτόνομα, μπορεί να τη χαρακτηρίσουμε 
ως «άριστης» ποιότητας.

Ως συμπίεση εννοούμε τη διαδικασία κατά την οποία ελαττώνεται η έκταση των 
τόνων μιας εικόνας. Με τη συμπίεση στην ουσία χάνουμε τόνους. Συμπιέζοντας λοι-
πόν τους σκούρους τόνους, δε μπορούμε να διακρίνουμε τις λεπτομέρειες της φω-
τογραφίας σε αυτή την περιοχή. Επομένως, αν σε δεδομένη αναπαραγωγή έχουν 
σημασία οι λεπτομέρειες στους σκούρους τόνους, τότε η φωτογραφία μας θα είναι 
«κακή». Τα ίδια ισχύουν και για τους ανοιχτούς τόνους.

Επειδή είναι αδύνατη η μεταφορά όλων των τόνων μιας εικόνας από ένα σύστημα 
σε ένα άλλο, η προσπάθειά μας για «πιστή» αναπαραγωγή προϋποθέτει συμβιβα-
σμούς και αποφάσεις για την περιοχή τόνων που θα συμπιέσουμε.
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Αυτή η τελευταία πρόταση ίσως συμπυκνώνει τη φιλοσοφία της φωτογραφικής τεχνι-
κής. Σε κάθε τόνο της εικόνας αντιστοιχίζουμε μία τιμή η οποία περιγράφει, ως ποσο-
στό επί τοις εκατό, πόσο φωτεινό ή σκοτεινό είναι ένα συγκεκριμένο σημείο της φωτο-
γραφίας. Το ανθρώπινο μάτι μπορεί να διακρίνει χονδρικά πέντε τόνους, ενώ με λίγη 
εξάσκηση μπορεί να φθάσει στους δέκα, ξεχωρίζοντάς τους σε δέκα διακριτά βήματα.

Η βασική αυτή κλίμακα των πέντε βημάτων έχει ένα τόνο με 0% που αντιπροσω-
πεύει τα φωτεινά σημεία της εικόνας, ένα ακόμη τόνο με 100% που αντιστοιχεί 
στους σκούρους τόνους και τρία ενδιάμεσα βήματα με 25%, 50% και 75% αντίστοι-
χα (Εικόνα 4.6).

Α

Β

Εικόνα 4.6: (Α) Το μη εξασκημένο μάτι μπορεί εύκολα να διακρίνει πέντε τόνους από το μαύρο 
έως το λευκό.
(Β) Η γκρίζα σκάλα των 14 βημάτων, χρησιμοποιείται για το ποιοτικό έλεγχο των φωτογραφικών 
αναπαραγωγών, ώστε να τις ελέγχουμε οπτικά και αριθμητικά.

Με ανάλογο τρόπο κατασκευάζονται και οι κλίμακες με τα περισσότερα βήματα. Αυ-
τές οι «γκρίζες κλίμακες» (grayscales), όπως λέγονται, είναι χρήσιμα εργαλεία για 
τον έλεγχο της φωτογραφικής αναπαραγωγής από το ένα οπτικό σύστημα σε ένα 
άλλο. Αν, παραδείγματος χάρη, μετράμε σε ένα σημείο μιας ασπρόμαυρης φωτογρα-
φίας ποσοστό 20%, το ίδιο ποσοστό 20%, πρέπει να έχει το ίδιο σημείο μετά την ανα-
παραγωγή της φωτογραφίας στο νέο οπτικό σύστημα. Αν το ποσοστό αποκλίνει, τότε 
πρέπει να γίνουν οι αναγκαίες αναπροσαρμογές στη μέθοδο αναπαραγωγής, ώστε να 
εξαλείψουμε ή να μειώσουμε στο ελάχιστο τη διαφορά των δύο ποσοστών. Οι γκρίζες 
κλίμακες κατασκευάζονται και πωλούνται από τις μεγάλες εταιρείες φωτογραφικών 
ειδών σε ηλεκτρονική ή τυπωμένη μορφή και χρησιμεύουν για τον ποιοτικό έλεγχο 
των φωτογραφιών και την ευθυγράμμιση των συστημάτων επεξεργασίας εικόνας.
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4.3 Μέτρηση των τονικών διαβαθμίσεων

Σε κάθε αναπαραγωγή θα πρέπει να αναπαραστήσουμε όλους τους τόνους του 
πρωτοτύπου εκμεταλλευόμενοι το μέγιστο εύρος των τόνων της μεθόδου αναπα-
ραγωγής που χρησιμοποιούμε. Για αυτό το σκοπό μετράμε πόσο μαύρα (Dmax) 
είναι τα σκούρα και πόσο λευκά (Dmin) είναι τα φωτεινά σημεία της φωτογραφίας. 
Η διαφορά τους είναι το εύρος των τόνων της φωτογραφίας. Το εργαλείο που με-
τρά την πυκνότητα (density) σε ένα σημείο της φωτογραφίας λέγεται πυκνόμετρο 
(densitometer). Όλοι οι τόνοι έχουν πυκνότητα. Οι διαφάνειες (photo slides) έχουν 
πυκνότητα από 0 έως 3,4, ενώ, οι τυπωμένες φωτογραφίες σπάνια φθάνουν το 2,0.

Ως πυκνότητα ορίζεται η ικανότητα ενός σημείου μιας επιφάνειας, να απορροφά το 
φως.

Είναι φανερό τώρα πώς μετράμε το εύρος των τόνων σε μία πρωτότυπη φωτογρα-
φία κρίνοντας ότι η τυπογραφική αναπαραγωγή της με offset έχει μικρότερη έκτα-
ση και συμπεραίνουμε ότι έχουμε απώλεια ποιότητας (Εικόνα 4.7).

Εικόνα 4.7: Το εύρος των πυκνοτήτων του φωτογραφικού φιλμ είναι μεγαλύτερο από το εύρος πυ-
κνοτήτων του τυπωμένου χαρτιού, όπως δείχνει και η τιμή μεγίστης πυκνότητας Dmax =1.8. Οι πυ-
κνότητες πάνω από αυτή την τιμή δεν αναπαράγονται στο τυπωμένο, με την μέθοδο offset, χαρτί.

4.4 Το φως και το χρώμα

Το χρώμα είναι μία ιδιότητα με την οποία μπορούμε να περιγράψουμε το φως δια
φορετικού μήκους κύματος. Όταν βλέπουμε τα πολύχρωμα αντικείμενα που μας 
περιβάλλουν, στην ουσία βλέπουμε φως. Το φως εισέρχεται στο μάτι μας με τρεις 
τρόπους, (i) κατευθείαν από τη φωτεινή πηγή, (ii) εξ αντανακλάσεως από ένα αντι-
κείμενο, ή (iii) εκ διαθλάσεως, δηλαδή διαπερνώντας ένα διαφανές υλικό π.χ. χρωμα-
τιστό γυαλί. Το χρώμα που έχει ένα αντικείμενο εξαρτάται από τα μήκη κύματος του 
προσπίπτοντος φωτός, που αντανακλώνται ή απορροφώνται από αυτό. Ένα κίτρινο 
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λουλούδι είναι κίτρινο, επειδή αντανακλά το κίτρινο φως και απορροφά τα υπόλοιπα 
μήκη κύματος.  Το κόκκινο τζάμι ενός παραθύρου είναι κόκκινο επειδή διαπερνάται 
από το κόκκινο φως ενώ απορροφά τα υπόλοιπα μήκη κύματος (Εικόνα 4.8).

Εικόνα 4.8: «Βιτρώ», καλείται η σύνθεση έγχρωμων κρυστάλλων που δημιουργούν μία εικόνα 
σε ένα παράθυρο για διακοσμητικούς λόγους. Αποτελεί ένα παράδειγμα εικόνας που έχουμε τη 
δυνατότητα να τη δούμε, επειδή τη διαπερνά το φως.

Η αναγκαία προϋπόθεση για να αντιληφθούμε τα χρώματα με τον τρόπο που μόλις 
περιγράψαμε είναι η φωτεινή πηγή να είναι το φυσικό φως του ήλιου, ή έστω μία 
λάμπα με λευκό φως, δηλαδή να έχει όλα τα χρώματα του ορατού φάσματος. Ας 
σκεφθούμε το εξής πρόβλημα:

Αν φωτισθεί ένα κόκκινο γυαλί με μπλε φως από τη μία πλευρά του, τι 
χρώμα θα δει ο παρατηρητής που βρίσκεται στην άλλη πλευρά του;
Κανένα, αφού το μπλε φως της πηγής δε διαπερνά το κόκκινο γυαλί. 
Ο παρατηρητής θα σχηματίσει την εντύπωση ότι το τζάμι δε φωτίζεται.

Επομένως, οι συνθήκες φωτισμού ενός χώρου καθορίζουν τα χρώματα που αντι-
λαμβάνεται το ανθρώπινο μάτι.

4.5 Συστήματα χρωμάτων

Όπως το λεξιλόγιο είναι το μέσον της ανθρώπινης επικοινωνίας, έτσι και τα συστή-
ματα χρωμάτων είναι το μέσον δια του οποίου οι αποχρώσεις περιγράφονται και 
μεταφέρονται από ένα οπτικό σύστημα σε ένα άλλο. Όλοι οι τρόποι αναπαραγωγής 
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των χρωμάτων, δηλαδή εκτυπώσεις, φωτογραφικά φιλμ και οθόνες απαιτούν δια-

φορετικά, αλλά συμβατά μεταξύ τους χρωματικά συστήματα.

Σύστημα χρωμάτων είναι μία μέθοδος περιγραφής και ταξινόμησης όλων των απο-

χρώσεων του ορατού φάσματος. Υπάρχουν αρκετά τέτοια συστήματα, τα οποία δεν 

είναι ισοδύναμα. Δηλαδή οι αποχρώσεις του ενός δεν αντιστοιχούν ακριβώς στις 

αποχρώσεις του άλλου, με αποτέλεσμα κατά την μετάβαση από ένα σύστημα σε 

άλλο να υπάρχει απόκλιση από την αρχική απόχρωση. Αυτό είναι ένα συνηθισμένο 

πρόβλημα που αντιμετωπίζουμε στην τυπογραφία.

Ο Διεθνής Οργανισμός Τυποποίησης, Commission Internationale de l’Eclairage 

(CIE), δημιούργησε το σύστημα CIE L*a*b* που θεωρητικά περιέχει όλες τις απο-

χρώσεις του ορατού φάσματος.

Τα γνωστότερα χρωματικά συστήματα είναι τα RGB και CMYK. Τα συστήματα αυτά 

θα τα γνωρίσουμε με συντομία στη συνέχεια. Τα άλλα συστήματα HSL ή HSB, που 

αναφέρονται επίσης στα προγράμματα επεξεργασίας εικόνας, είναι περισσότερο 

υποκειμενικές περιγραφές και θα μας απασχολήσουν λιγότερο.

Σύστημα RGB (ή προσθετικό σύστημα χρωμάτων): Δημιουργείται από τα χρώμα-

τα κόκκινο (Red), πράσινο (Green) και μπλε (Blue) που είναι τα βασικά προσθετικά 

χρώματα του ορατού φάσματος φωτός. Η σύνθεση των τριών αυτών χρωμάτων σε 

ίσες ποσότητες παράγει λευκό (Εικόνα 4.9).

Μπλε Πράσινο

Κόκκινο

Cyan

YellowMagenta

Εικόνα 4.9: Το κόκκινο (R), το πράσινο (G) και το μπλε (Β) καλούνται προσθετικά βασικά χρώ-
ματα. Αν φωτεινές ακτίνες των τριών βασικών χρωμάτων προβληθούν σε μία επιφάνεια, η μία 
επάνω στην άλλη, τότε παράγεται λευκό φως.

Το χρωματικό αυτό σύστημα χρησιμοποιείται στη λειτουργία της οθόνης του υπο-

λογιστή και της τηλεόρασης. (Εικόνα 4.10 Α και Β). Τα αρχεία εικόνων RGB είναι 

μικρότερου μεγέθους από τα αρχεία CMYK.
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Κόκκινο
φως

Πράσινο
φως

Μπλε
φως

'' Ασπρόμαυρη'' εικόνα καναλιών

Έγχρωμη εικόνα RGB

Α Β

Εικόνα 4.10: (Α) Η σύγκλιση και η μίξη των τριών δεσμών χρωμάτων RGB με διαφορετικές εντά-
σεις στον καθοδικό σωλήνα έχει ως αποτέλεσμα την εμφάνιση της έγχρωμης εικόνας στις οθόνες 
των υπολογιστών.
(Β) Η διαφοροποίηση της έντασης των φωτεινών δεσμών των χρωμάτων RGB ρυθμίζεται από την 
οπτική πληροφορία της εικόνας που δεν περιέχει χρώμα (achromatic information). Εδώ εμφανί-
ζεται σχηματοποιημένα η αρχή της δημιουργίας μιας έγχρωμης φωτογραφίας στο σύστημα RGB.

Σύστημα CMYK: Αποτελεί το βασικό σύστημα εργασίας των γραφικών τεχνών. Το 

κυανό (Cyan), ή ματζέντα (Magenta), το κίτρινο (Yellow) είναι τα συμπληρωματι-

κά χρώματα (δηλαδή, καταλαμβάνουν διαμετρικά απέναντι θέσεις στο χρωματικό 

κύκλο που θα δούμε σε επόμενη παράγραφο) του κόκκινου, του πράσινου και του 

μπλε αντιστοίχως. Το μαύρο (Black) είναι βοηθητικό και χρησιμεύει για την ενίσχυση 

της έντασης των τόνων των υπολοίπων τριών (CMY). Τα χρώματα αυτά αντιστοιχούν 

στα τέσσερα χρώματα μελανιών που χρησιμοποιούνται στις εκτυπώσεις σε πιεστήριο. 

Καλούνται αφαιρετικά χρώματα γιατί, όταν παρατηρούμε μία τυπωμένη σελίδα, το 

χρώμα που βλέπουμε προέρχεται από την αντανάκλαση του φωτός επάνω της, ενώ το 

τυπωμένο μελάνι λειτουργεί ως φίλτρο, αφαιρώντας μέρος του ορατού φωτός. Όταν 

το λευκό φως πέσει στη σελίδα που είναι τυπωμένη π.χ. με κυανό μελάνι, βλέπουμε 

κυανό χρώμα, γιατί το μελάνι αφαιρεί την κόκκινη συνιστώσα από το λευκό φως και 

στο μάτι μας καταλήγουν μόνο το μπλε και το πράσινο. Για να τυπώσουμε κόκκινο 

χρώμα με CMYK, χρησιμοποιούμε μελάνι ματζέντα και κίτρινο. Η ματζέντα αφαιρεί 

την πράσινη συνιστώσα του φωτός και το κίτρινο την μπλε συνιστώσα. Επομένως 

εκείνο που μένει να επιστρέψει στο μάτι μας από το ορατό φως είναι μόνο το κόκ-

κινο. Στην Εικόνα 4.11 εμφανίζονται τα αφαιρετικά χρώματα, ενώ στην Εικόνα 4.12 

φαίνεται ο τρόπος εκτύπωσης των αποχρώσεων με τα αφαιρετικά βασικά χρώματα.
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ΠράσινοΜπλε

Κόκκινο

Magenta Yellow

Cyan

Εικόνα 4.11: Το κυανό, η ματζέντα και το κίτρινο είναι αφαιρετικά χρώματα. Αν τυπωθούν με 
πυκνότητα 100% το ένα επάνω στο άλλο, δίνουν, θεωρητικά τουλάχιστον, μαύρο χρώμα.

Λευκό φως
RGB Λευκό φως

RGB
Λευκό φως

RGB
Λευκό φως

RGB

Κυανό
Κίτρινο

Ματζέντα

Μαύρο

Λευκό

Κυανό Ματζέντα Κίτρινο

Κυανό Ματζέντα Κίτρινο

Λευκό φως 
RGB

Λευκό φως 
RGB

Λευκό φως 
RGB

Λευκό φως 
RGB

Κόκκινο

Κίτρινο
Ματζέντα

Κίτρινο
Κυανό

Κυανό
Κίτρινο

Πράσινο Μπλε

Εικόνα 4.12: Το φως ανακλάται στην επιφάνεια του χαρτιού. Τα στρώματα του μελανιού λει-
τουργούν ως φίλτρα στην ανακλώμενη ακτίνα φωτός. Στο διάγραμμα εμφανίζονται μερικοί βα-
σικοί συνδυασμοί αφαιρετικών χρωμάτων, για να γίνει κατανοητός ο τρόπος δημιουργίας όλων 
των αποχρώσεων που τυπώνονται.

Σύστημα L*a*b*: Το σύστημα αυτό περιέχει τα χρώματα του ορατού φάσματος. 
Χρησιμοποιείται εσωτερικά στα προγράμματα επεξεργασίας εικόνας και ο καθο-
ρισμός των χρωμάτων με αυτό είναι ανεξάρτητος από το μέσο που θα καταλήξει 
τελικά η εικόνα που επεξεργαζόμαστε.

Σύστημα HSL (ή HSV ή HSB): Το σύστημα αυτό ταξινομεί τα χρώματα με βάση 
την απόχρωση (hue), τον κορεσμό (saturation) και τη φωτεινότητα (lightness). Η 
απόχρωση αναφέρεται στα χρώματα του χρωματικού κύκλου. Ο κορεσμός προσ-
διορίζει πόσο έντονη είναι η απόχρωση, π.χ. το ζωηρό κόκκινο χρώμα θεωρείται 
κορεσμένο, σε σχέση με ένα λιγότερο ζωηρό χρώμα (Εικόνα 4.13 Α και Β). Η φωτει-
νότητα είναι η συνιστώσα που καθορίζει τις λεπτομέρειες της εικόνας. Με βάση τη 
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φιλοσοφία αυτών των συστημάτων μπορούμε να φαντασθούμε τη φωτεινότητα σαν 

μία ασπρόμαυρη φωτογραφία που τη χρωματίζουμε με τις κατάλληλες αποχρώσεις, 

δίνοντας συγχρόνως σε αυτές και τον κατάλληλο κορεσμό, προκειμένου να καταλή-

ξουμε στην έγχρωμη φωτογραφία.

Α Β

Α

Β Β Α

Γ
Γ

Εικόνα 4.13: (Α) Η παλέτα χρωμάτων HSV, όπου το V (Value) εμφανίζεται στη θέση του Lightness. 
Η περίμετρος του κύκλου εμφανίζει όλες τις αποχρώσεις. Κινούμενοι από την κορυφή Α του τρι-
γώνου προς την κορυφή Β, η απόχρωση που έχει επιλεγεί σε κάποιο σημείο της περιμέτρου γί-
νεται φωτεινότερη. Αν τώρα κινηθούμε προς την κορυφή Γ η απόχρωση γίνεται πιο σκούρα, ενώ 
κινούμενοι οριζοντίως γίνεται λιγότερο κορεσμένη.
(Β) Η παλέτα χρωμάτων αυτού του προγράμματος περιέχει συγκεντρωμένα τα περισσότερα συ-
στήματα χρωμάτων, συνολικά τέσσερα. Συνήθως έχουμε επιλέξει στο πρώτο σύστημα HSB την 
ένδειξη Η για να εμφανίζουμε όλες τις αποχρώσεις στην κάθετη μπάρα, ενώ κινούμενοι στο με-
γάλο τετράγωνο από το Α προς το Β ή το Γ δημιουργούμε αντίστοιχα φωτεινότερες ή σκουρότερες 
αποχρώσεις, όπως ακριβώς και στην προηγούμενη παλέτα. Ας σημειώσουμε ότι στο σύστημα HSB 
το Β σημαίνει Brightness (λαμπρότητα).

Το χρωματικό τρίγωνο: Είναι ένα χρήσιμο νοητικό εργαλείο για να κατανοήσουμε 

τη σχέση μεταξύ RGB και CMY. Αποτελείται από δύο ισόπλευρα τρίγωνα, εκ των οποί-

ων το ένα ανεστραμμένο. Οι κορυφές του ενός συμβολίζουν τα χρώματα RGB, ενώ 

του άλλου τα CMY (Εικόνα 4.14). Αν προσθέσουμε δύο κορυφές, παράγουν το χρώμα 

που βρίσκεται στην ενδιάμεση κορυφή. Π.χ. το κίτρινο με τη ματζέντα παράγουν το 

κόκκινο. Το χρώμα που δε συμμετέχει στη σύνθεση του κόκκινου βρίσκεται ακριβώς 

απέναντι και είναι το κυανό (που καλείται συμπληρωματικό του κόκκινου). Αν θέλου-

με το κόκκινο να γίνει πιο έντονο, έχουμε δύο επιλογές: (1) να προσθέσουμε περισσό-

τερο κίτρινο και ματζέντα, ή (2) να ελαττώσουμε το κυανό. Με τον ίδιο τρόπο αναλύο-

νται και τα υπόλοιπα χρώματα. Αν θέλουμε να μειώσουμε την ένταση του κίτρινου σε 

μια εικόνα μπορούμε: (1) να μειώνουμε το κίτρινο, (2) να μειώσουμε το πράσινο και 

το κόκκινο, ή (3) να αυξήσουμε το μπλε (το συμπληρωματικό του κίτρινου).
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Κόκκινο

Ματζέντα

Μπλε

Κυανό

Πράσινο

Κίτρινο

Εικόνα 4.14: Το χρωματικό τρίγωνο. Η διάταξη των χρωμάτων είναι ίδια με αυτή του χρωματικού 
κύκλου.

Μετατροπή από RGB σε CMY(K): Η μετατροπή αυτή παρά το γεγονός ότι είναι 
πολύ εύκολη στα προγράμματα επεξεργασίας εικόνας, εντούτοις κρύβει παγίδες. 
Τα τυπογραφικά μελάνια περιέχουν προσμίξεις που αλλοιώνουν την «καθαρότητα» 
της απόχρωσης (γίνονται λιγότερο κορεσμένα) με αποτέλεσμα να μην αναπαράγε-
ται όλη η χρωματική κλίμακα RGB με την κλίμακα CMY. Το μαύρο, που συμβολίζε-
ται με το γράμμα Κ, προστίθεται για να αυξήσει την ένταση των σκούρων τόνων και 
να ισοσκελίσει το μειωμένο κορεσμό των CMY που αδυνατούν στην πραγματικότη-
τα να αποδώσουν το μαύρο. Το αποτέλεσμα είναι τα χρώματα που φαίνονται στην 
οθόνη του υπολογιστή να μην αποδίδονται πιστά και στο χαρτί. Τα προγράμματα 
επεξεργασίας εικόνας διαθέτουν ένα εσωτερικό σύστημα ελέγχου, που επιτρέπει 
στο χρήστη να βλέπει αν η απόχρωση που επέλεξε είναι μέσα στο χρωματικό σύστη-
μα που εργάζεται εκείνη τη στιγμή.
Οι παλέτες των χρωμάτων εμφανίζουν τα χρώματα με έναν αριθμητικό προσδιορι-
σμό, για μεν τα RGB με έναν αριθμό από 0 έως 255, για δε τα CMYK με ποσοστό από 
0% έως 100% (Εικόνα 4.15).

Χρώματα που αντιλαμβάνεται
το ανθρώπινο μάτι

Χρώματα που αναπαράγονται στα 
φωτογραφικά φιλμ

Χρώματα που εμφανίζονται
στις οθόνες RGB

Χρώματα που αναπαράγονται με 
έκπτωση CMYK

Εικόνα 4.15: Το εύρος των χρωμάτων. Η θεωρία δεν έχει απόλυτη εφαρμογή στην πράξη. Είναι 
αδύνατον να αναπαράγουμε όλες τις αποχρώσεις RGB της οθόνης των υπολογιστών με τα τυ-
πογραφικά μελάνια. Το διάγραμμα δείχνει ακριβώς πως το χρωματικό εύρος διαμορφώνεται σε 
σχέση με τον τρόπο αναπαραγωγής.
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Ας παρατηρήσουμε την παλέτα χρωμάτων της Εικόνας 4.13 Β. Επιλέγουμε ένα χρώ-
μα κινούμενοι μέσα στο μεγάλο τετράγωνο προς την κατεύθυνση Α για πιο κορε-
σμένα χρώματα ή προς Β ή Γ για πιο ουδέτερες αποχρώσεις. Αμέσως δεξιά παρα-
τηρούμε το πλακάκι που εμφανίζει, το μεν χρώμα που επιλέγουμε εκείνη τη στιγμή 
στο επάνω ήμισυ, την δε αμέσως προηγούμενη επιλογή μας στο από κάτω ήμισυ. 
Σε ορισμένες αποχρώσεις θα δούμε προειδοποιητικά σύμβολα όπως φαίνονται στην 
Εικόνα 4.16. Πρέπει να είμαστε προσεκτικοί σε αυτά, γιατί οριοθετούν το εύρος του 
χρωματικού συστήματος με το οποίο εργαζόμαστε.

Εικόνα 4.16: Το τριγωνικό σύμβολο προειδοποιεί ότι το χρώμα που φαίνεται δεν αναπαράγεται 
με το εύρος των αποχρώσεων CMYK. Ο μικρός κύβος προειδοποιεί ότι το χρώμα δεν είναι κα-
τάλληλο για ιστοσελίδες (δηλ. δεν είναι «web-safe» χρώμα). Τα μικρά τετράγωνα κάτω από τα 
σύμβολα περιέχουν τις πλησιέστερες αποχρώσεις για την αντίστοιχη αναπαραγωγή.

Ανακεφαλαίωση 4ου Κεφαλαίου

Το φως είναι ένα μικρό τμήμα της ηλεκτρομαγνητικής ακτινοβολίας και το κάθε 
χρώμα του εξαρτάται από το μήκος κύματος. Τα αντικείμενα απορροφούν και 
συγχρόνως ανακλούν ή διαθλούν το φως που προσπίπτει επάνω τους. Ανάλογα 
με την ανάκλαση ή διάθλαση που υφίσταται το φως, τα αντικείμενα αποκτούν 
το χρώμα τους. Το ανθρώπινο μάτι διακρίνει τα χρώματα σε σχέση με τα διπλα-
νά τους και προσαρμόζεται στις συνθήκες φωτισμού. «Καλή», «κακή», «ωραία» 
φωτογραφία είναι υποκειμενικές έννοιες που βασίζονται στην αντίληψη που ο 
κάθε άνθρωπος έχει για τα χρώματα.
Οι μέθοδοι αναπαραγωγής με τους περιορισμούς που έχουν στην απόδοση των 
χρωμάτων, έχουν ως στόχο τη μετατροπή από ένα σε κάποιο άλλο σύστημα χρω-
μάτων με τέτοιο τρόπο, που να «ξεγελούν» το ανθρώπινο μάτι και να μην είναι 
εμφανής η χρωματική διαφοροποίηση. Το ρόλο του μεταφραστή των χρωμάτων 
παίζουν τα διάφορα χρωματικά συστήματα με τα οποία στην ουσία επιχειρείται η 
συστηματική περιγραφή και ταξινόμηση των αποχρώσεων του ορατού φάσματος.
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Ασκήσεις 4ου Κεφαλαίου

1.	� Αναφέρατε τα βήματα που πρέπει να κάνουμε προκειμένου να χρωματίσουμε 
μία επιφάνεια με χρώματα που σχηματίζουν ρόμβο (diamond gradient).

2.	Ποια λέγονται προσθετικά και ποια αφαιρετικά χρώματα;
3.	� Πότε χρειάζεται να μετατρέψουμε μία εικόνα από RGB σε CMYK; Έχει νόημα η 

αντίστροφη μετατροπή (από CMYK σε RGB);
4.	�Πώς καλείται η προηγούμενη διαδικασία; Αναφέρατε τα αναγκαία βήματα που 

χρειάζονται για τη μετατροπή.

Δραστηριότητες 4ου Κεφαλαίου

1.	� Εκκινήστε το πρόγραμμα επεξεργασίας εικόνας (π.χ. Adobe Photoshop). Επιλέξ-
τε χρώματα προσκηνίου και παρασκηνίου. Είναι κατάλληλα για τη χρήση που τα 
θέλετε;

2.	� Πώς μπορούμε να εμφανίσουμε ως χρώμα προσκηνίου μία απόχρωση που υπάρ-
χει σε φωτογραφία;

3.	� Αναφέρατε σύντομα τα βήματα για τη βαφή ενός τμήματος φωτογραφίας με 
χρώματα «ντεγκραντέ».

4.	�Αναφερθείτε στην Εικόνα 4.12 Β. Επιλέγουμε διαδοχικά τα «κουμπιά» Η, S, Β. 
Τι παρατηρείτε στην παλέτα χρωμάτων; Τι συμβολίζουν οι επιλογές αυτές; Μπο-
ρείτε να επιλέξετε την απόχρωση της επιλογής σας; Εξηγήστε τις μεταβολές που 
παρατηρείτε, δικαιολογώντας τις απαντήσεις σας.

Σχετικές ηλεκτρονικές διευθύνσεις

Για συμβουλές και οδηγίες, που εφαρμόζονται σε πολλές περιπτώσεις, αλλά χωρίς 
αναφορά σε συγκεκριμένα προγράμματα:
www. designer-info. com/DTP/dtp_tutorials.htm
http://desktoppub.about.com

24-0151 Book.indb   7124-0151 Book.indb   71 27/10/2021   12:17:24 µµ27/10/2021   12:17:24 µµ



72

Ε Φ Α Ρ Μ Ο Γ Ε Σ  Η Λ Ε Κ Τ Ρ Ο Ν Ι Κ Ω Ν  Υ Π Ο Λ Ο Γ Ι Σ Τ Ω Ν

Κεφάλαιο 5ο
Επεξεργασία σε πολλά επίπεδα

Στόχοι:

Μετά τη μελέτη αυτού του κεφαλαίου οι μαθητές θα είναι σε θέση να:

	 •	� Εξηγήσουν τι είναι τα επίπεδα στα προγράμματα επεξεργασίας εικόνας

	 •	 �Εκτελέσουν απλά οπτικά εφέ χρησιμοποιώντας τις ιδιότητες των επιπέδων

	 •	 �Εξηγήσουν τι είναι οι μάσκες και τι επιτυγχάνουμε με αυτές

5.1 Εισαγωγή

Στην πρώτη γνωριμία τα επίπεδα (image layers) στα προγράμματα επεξεργασίας 
εικόνας φαίνονται αρκετά πολύπλοκα. Όμως, η ιδέα είναι πολύ απλή. Με τη βοή-
θεια των επιπέδων μπορούμε να απομονώνουμε διαφορετικά τμήματα μιας εικόνας 
και να επεμβαίνουμε στο κάθε ένα από αυτά ξεχωριστά, διατηρώντας τα υπόλοιπα 
ανέπαφα. Μπορούμε, αν θέλουμε, να συσχετίσουμε δύο ή περισσότερα επίπεδα για 
να δημιουργήσουμε οπτικά εφέ εύκολα, χωρίς αλλοίωση της αρχικής εικόνας. Αν 
δούμε ότι τελικά δεν μας ικανοποιεί το αποτέλεσμα, μπορούμε να το αναιρέσουμε 
ή και να διαγράψουμε τα «προβληματικά» επίπεδα.

5.2 Σύνθεση επιπέδων

Αν τοποθετηθούν τρεις διαφάνειες (slides), η μία επάνω στην άλλη με ένα φως από 
κάτω, τότε, αν ένας παρατηρητής κοιτάξει από την άλλη πλευρά, θα δει μία νέα, 
τέταρτη εικόνα που προκύπτει από τη σύνθεση των τριών πρώτων (Εικόνα 5.1).
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Εικόνα 5.1: Το κάθε επίπεδο περιέχει ένα τμήμα της εικόνας που προκύπτει, αν κοιτάξουμε στη 
διεύθυνση του βέλους.

Στην πολύ απλή αυτή παρατήρηση βασίζεται η χρήση των επιπέδων που συναντάμε 
στα περισσότερα προγράμματα επεξεργασίας εικόνας.

5.3 Ιδιότητες των επιπέδων

Παρά το γεγονός ότι η ορολογία για τα επίπεδα διαφέρει από πρόγραμμα σε πρό-
γραμμα, τα βασικά χαρακτηριστικά και οι ιδιότητές τους είναι κατά βάση ίδιες. 
Συγκεκριμένα:

•	� Διατηρούνται με την αποθήκευση της εικόνας στη βασική μορφή αποθήκευ-
σης (δηλαδή μορφή Photoshop PSD, ή μορφή CorelPaint CPT, ή Painter RIFF).

•	� Μετακινούνται μπροστά ή πίσω σε σχέση με τα υπόλοιπα (επίπεδα), χωρίς 
περιορισμό.

•	� Μπορούμε να δημιουργήσουμε διαφάνεια ή ανάμειξη ενός ή περισσοτέρων 
επιπέδων, προκειμένου να επιτύχουμε οπτικά εφέ.

•	� Μπορούμε να δημιουργήσουμε «μάσκα», δηλαδή ένα επί πλέον επίπεδο, το 
οποίο αποκρύπτει επιλεκτικά μέρος της εικόνας με στόχο ένα νέο οπτικό εφέ.

Τα επίπεδα δημιουργούνται είτε από τις εντολές που βρίσκονται στην παλέτα επιπέ-
δων (layers), είτε αυτόματα, κάθε φορά που εκτελούμε την εντολή αντιγραφής και 
μετά επικόλλησης. Κάθε φορά που δημιουργείται ένα επίπεδο, παίρνει ένα όνομα 
από το πρόγραμμα του τύπου Layer n, όπου n ένας αριθμός. Η μετονομασία του 
γίνεται με διπλή πίεση του ποντικιού στο υπάρχον όνομα και χρησιμοποιούνται 
μόνο λατινικοί χαρακτήρες. Καλό είναι το όνομα να είναι αντιπροσωπευτικό των 
περιεχομένων του επιπέδου.
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Η μετακίνησή τους είναι πολύ εύκολη, αφού αρκεί για το σκοπό αυτό να σύρουμε 
με το ποντίκι το προς μετακίνηση επίπεδο στην παλέτα επιπέδων (Εικόνα 5.2).

ΒΑ

Εικόνα 5.2: (Α) Αν σύρουμε με το ποντίκι το επίπεδο, που περιέχει το κουβαδάκι, προς τα κάτω... 
(Β) εμφανίζεται το πράσινο φύλλο μπροστά. Αυτό συμβαίνει, γιατί αλλάζουμε τη σειρά των επι-
πέδων και επομένως, των εικόνων που βρίσκονται σε αυτά.

Ένα επίπεδο είναι ορατό αν στην παλέτα επιπέδων εμφανίζεται αριστερά από την 
ονομασία του το σύμβολο με το «μικρό μάτι». Το «μικρό πινέλο» συμβολίζει ότι το 
συγκεκριμένο επίπεδο είναι επιλεγμένο και η επέμβαση που πρόκειται να γίνει θα 
αφορά μόνο αυτό. Το «αλυσιδάκι» σε ένα επίπεδο δείχνει ότι αυτό είναι ομαδοποιη-
μένο με το επίπεδο που είναι ενεργό, ενώ το «λουκέτο» συμβολίζει ότι το επίπεδο 
είναι κλειδωμένο, δηλαδή δεν μπορούμε να επέμβουμε σε αυτό. Σε ένα επιλεγμένο 
επίπεδο μπορούμε να μετακινήσουμε τις εικόνες του σε άλλη θέση σε σχέση με τις 
εικόνες των άλλων επιπέδων.

Με την εντολή της παλέτας επιπέδων, Νέο επίπεδο ρύθμισης (New Adjustment Layer) 
επιτυγχάνουμε χρωματικές διορθώσεις σε ένα επίπεδο ή σε ομάδα, ή σε τμήμα επι-
πέδων (μέσω μάσκας).

Με τη χρήση των επιπέδων στα προγράμματα επεξεργασίας εικόνας επιτυγχάνου-
με σύνθεση και ανάμιξη εικόνων που με τις παραδοσιακές φωτογραφικές τεχνικές 
ήταν εξαιρετικά δύσκολο ή αδύνατον να γίνουν.

Ρύθμιση διαφάνειας επιπέδου (Layer opacity): Γίνεται εύκολα αλλάζοντας το πο-
σοστό διαφάνειας στην παλέτα επιπέδων (Εικόνα 5.3).
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Εικόνα 5.3: Έχουμε τη δυνατότητα να ρυθμίζουμε τη «διαφάνεια» ενός αντικειμένου που βρίσκεται 
σε ένα επίπεδο, σύροντας το δείκτη opacity, που εμφανίζεται με πατημένο το πλήκτρο του ποντικιού.

Μέθοδος ανάμιξης (Blend Mode – Εικόνα 5.4): Με τη ρύθμιση αυτή τα προγράμματα 
αναγνωρίζουν τις τιμές του χρώματος και της φωτεινότητας των εικονοστοιχείων της 
εικόνας και με μαθηματικούς υπολογισμούς αναμιγνύουν τις αντίστοιχες τιμές των 
εικόνων που βρίσκονται στα από κάτω επίπεδα. Ο πειραματισμός με τους διαφορε-
τικούς τρόπους ανάμιξης είναι ο καλύτερος τρόπος να φθάσουμε σε ένα επιθυμητό 
αποτέλεσμα.

Δεν εξαρτάται από το χρώμα
που βρίσκεται στο από κάτω
επίπεδο (layer).

Αλλάζει την φωτεινότητα της
εικόνας στο από κάτω επίπεδο.
Επιδρά και στην φωτεινότητα και
στο χρώμα της εικόνας που
βρίσκεται στο από κάτω επίπεδο.
Συγκρίνει το ενεργό επίπεδο με
την εικόνα που βρίσκεται στο
από κάτω επίπεδο.
Εφαρμόζει ορισμένα μόνο
χρωματικά χαρακτηριστικά στο
ενεργό επίπεδο.

Εικόνα 5.4: Η μέθοδος ανάμιξης των επιπέδων.

Φωτιστικά εφέ: Με ανάμιξη Πολλαπλασιασμού και Επικάλυψης (Multiply και 
Overlay) ρυθμίζουμε τη φωτεινότητα των επιπέδων, χρησιμοποιώντας ένα νέο 
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επίπεδο με φωτοσκιάσεις και προσομοιάζοντάς το με το πλέγμα που χρησιμοποιούσαν 
στις ειδικές φωτογραφικές τεχνικές οι φωτογράφοι. Δημιουργούνται δύο αντίγραφα 
του πλέγματος επάνω από την προς επεξεργασία φωτογραφία, που θα ρυθμιστούν 
στο πρώτο επίπεδο με ανάμιξη Overlay και στο δεύτερο με Multiply. Συγχρόνως με-
ταβάλλεται και η διαφάνεια των επιπέδων κατά βούληση (Εικόνα 5.5).

Overlay  Mode

Multiply  Mode

Εικόνα 5.5: Οι φωτογράφοι για να δώσουν την αίσθηση των φωτοσκιάσεων στο στούντιο, χρη-
σιμοποιούν ένα πλέγμα μπροστά από τους προβολείς. Εδώ για το ίδιο οπτικό αποτέλεσμα χρησι-
μοποιούμε δύο επίπεδα με τυχαία σχήματα επάνω από τη φωτογραφία, ρυθμίζοντας τη μίξ, του 
πρώτου με Overlay και του δεύτερου με Multiply. Η διαφάνεια και των δύο καθορίζεται στο 30%. 
Το αποτέλεσμα φαίνεται εδώ. Μπορούμε να πειραματισθούμε με διαφορετικά σχήματα ώστε να 
δημιουργούμε πάντα τη φωτοσκίαση της αρεσκείας μας.

Ρύθμιση διαφάνειας: Υπάρχει μία ακόμη ρύθμιση διαφάνειας των επιπέδων, που 
βασίζεται στη φωτεινότητα της αρχικής εικόνας. Με επιλογή με το ποντίκι στο όνο-
μα του επιπέδου στην παλέτα επιπέδων, εμφανίζεται το πλαίσιο διαλόγου Στυλ επι-
πέδου (Layer Style) με διπλή κυλιόμενη μπάρα ρύθμισης της διαφάνειας του ενερ-
γού ή του αμέσως από κάτω επιπέδου. Η διαφορά αυτής της ρύθμισης, με την απλή 
ανάμιξη που εμφανίζεται στην παλέτα επιπέδων, είναι ότι αφήνει ανεπηρέαστη την 
απόχρωση και τον κορεσμό, επιδρώντας μόνο στη διαφάνεια (Εικόνα 5.6 Α και Β).

Εικόνα 5.6: (Α) Με επιλογή με το ποντίκι στο όνομα του επιπέδου εμφανίζεται η παλέτα Layer Style.
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Πριν

Μετά

Εικόνα 5.6: (Β) Το αποτέλεσμα της ρύθμισης της διαφάνειας.

Οι κυλιόμενες μπάρες του πλαισίου διαλόγου Στυλ Επιπέδου (Layer Style) λειτουρ-
γούν μετακινώντας το λευκό μικρό τριγωνικό σύρτη επάνω σε αυτές. Π.χ. κατά τη 
μετακίνηση από το 255 στο 200 ένα τμήμα της γκρίζας σκάλας γίνεται πιο διαφα-
νές. Είναι σαν η μετακίνηση αυτή να υποδεικνύει: «Πάρε το εύρος των τόνων του 
επιπέδου αυτού από 255 έως 200 και κάνε τους σταδιακά διαφανείς». Τώρα, με πα-
τημένο το πλήκτρο Alt + επιλογή με το ποντίκι (Alt + κλικ) στην κυλιόμενη μπάρα, 
ο τριγωνικός σύρτης διασπάται στα δύο. Το αριστερό τμήμα σύρεται π.χ. στο 150 και 
το δεξιό τμήμα στο 255, κάνοντας ένα τμήμα της εικόνας διαφανές. Είναι δηλαδή 
σαν να υποδεικνύουμε: «Πάρε το εύρος των τόνων του επιπέδου που ευρίσκεται 
μεταξύ 150 έως 255 και κάνε τους σταδιακά διαφανείς.

Σημείωση: Ο σύρτης με την ένδειξη Underlying επιτρέπει στους τόνους που βρί-
σκονται στο από κάτω επίπεδο να εμφανισθούν στο αμέσως από πάνω επίπεδο. Σ’ 
αυτή την περίπτωση είναι σαν να υποδεικνύει: «Κάνε το εύρος των τόνων μεταξύ X 
και Ψ στο από κάτω επίπεδο ορατό στο από πάνω (επίπεδο)».
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Μερικές φορές είναι πιο εύκολο αντί να επιλέγουμε μέρη εικόνων με τα εργαλεία 
επιλογής για μια νέα σύνθεση, να χρησιμοποιούμε τις τεχνικές ανάμιξης των επιπέ-
δων (Εικόνα 5.7). Βάζουμε ένα φωτογραφικό θέμα ανάμεσα π.χ. σε δύο ίδιες φω-
τογραφίες του ουρανού που αντιστοιχούν σε διαφορετικά επίπεδα. Με επιλογή με 
το ποντίκι στο επάνω επίπεδο εμφανίζεται το πλαίσιο διαλόγου Επιλογές Επιπέδου 
(Layer Options).

Εικόνα 5.7: Τοποθετούμε τις φωτογραφίες με την κατάλληλη διάταξη σε διαφορετικά επίπεδα.

Με Alt+κλικ στο μαύρο τριγωνικό σύρτη, αυτός διασπάται σε δύο μέρη. Έτσι, μας 
επιτρέπει να μετατρέψουμε τους σκούρους μπλε τόνους σε διαφανείς, δίνοντας την 
εντύπωση ότι το θέμα μας είναι πίσω από τα σύννεφα (Εικόνα 5.8).

Διπλό κλικ

Εικόνα 5.8: Ποια είναι η «πραγματικότητα»; Είναι δύσκολο να διακρίνει κάποιος αν το αποτέλε-
σμα είναι τεχνητό ή όχι. (Αν παρατηρήσουμε προσεκτικά, θα δούμε τη διαφορετική γωνία φωτισμού 
των νεφών και των αερόστατων, πράγμα που αποδεικνύει το λάθος του ηλεκτρονικού μοντάζ).
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5.4 Φωτογραφικές μάσκες

«Μασκάρισμα» στο λεξιλόγιο των φωτογράφων σημαίνει τη διαδικασία κατά την 
οποία διαχωρίζεται, για επεξεργασία, ένα τμήμα μιας φωτογραφίας από το υπόλοιπο 
τμήμα, που θέλουμε να παραμείνει ανέπαφο. Στην πραγματικότητα, οι μάσκες είναι 
ένας άλλος τρόπος να επιλέγουμε τμήματα μιας εικόνας χωρίς να χρησιμοποιούμε τα 
εργαλεία επιλογής (Εικόνα 5.9). Το παράδειγμα που έχει αναφερθεί στην παράγρα-
φο των επιλογών, με τη βαφή ενός αυτοκινήτου, ταιριάζει απολύτως και εδώ.

Εικόνα 5.9: Αυτή είναι η πιο απλή μορφή μάσκας. Οι τρύπες στα χαρτόνια που έχουν τα σχήματα, 
τα λεγόμενα «στένσιλ», είναι οι οδηγοί που μας επιτρέπουν να σχεδιάσουμε με τα έγχρωμα μολύβια.

Από τη σύνθεση μέχρι τη βελτίωση των χρωμάτων των φωτογραφιών, οι σωστές επι-
λογές αποτελούν προϋπόθεση για τα επιθυμητά αποτελέσματα. Για αυτό το λόγο η 
κατανόηση των μεθόδων επιλογής με, ή χωρίς μάσκες, αποτελεί το «θεμέλιο λίθο» 
της ψηφιακής φωτογραφικής τέχνης (Εικόνα 5.10).

100% Μαύρο 0% Μαύρο

Alpha Channel

Εικόνα 5.10: Σε αντίθεση με την απλή μάσκα που είτε προστατεύει απολύτως είτε αφήνει ακά-
λυπτη τη φωτογραφία, οι μάσκες στα προγράμματα επεξεργασίας εικόνας (alpha channels, όπως 
ονομάζονται), έχουν μεταβλητή διαφάνεια. Το μαύρο εμποδίζει απολύτως κάθε μεταβολή στη 
φωτογραφία, ενώ το λευκό επιτρέπει κάθε επέμβαση. Το ενδιάμεσο γκρίζο 50%, επιτρέπει κατά 
50% τις επεμβάσεις. Αν ενεργοποιηθεί το alpha channel ως επιλογή με την εντολή Load selec-
tion..., μπορούμε να επέμβουμε στις επιλεγμένες περιοχές της φωτογραφίας και στα τμήματα 
που δεν «καλύπτονται» από τη μαύρη μάσκα.
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Οι μάσκες δεν είναι κάτι καινούριο για τους φωτογράφους. Στην Εικόνα 5.11 Α. φαί-
νεται ένα αρνητικό φιλμ των 35 χιλιοστών και μία μάσκα κατασκευασμένη με λιθο-
γραφικό φιλμ υψηλής αντίθεσης (high contrast film-mask). Ο λευκός κύκλος στο 
μέσον της μάσκας βρίσκεται επάνω από το τμήμα της φωτογραφίας που θα υποστεί 
την επεξεργασία και αντιστοιχεί στο διαφανές τμήμα του λιθογραφικού φιλμ.

Α

Γ

Β

Εικόνα 5.11: (Α) Η μάσκα τοποθετείται επάνω στο αρνητικό και γίνεται φωτογράφηση εξ επα-
φής. (Β) Η θετική εικόνα που τυπώνουμε έχει το στρογγυλό σχήμα του λευκού τμήματος της 
μάσκας. (Γ) Στην ηλεκτρονική επεξεργασία εικόνας επιτυγχάνουμε το ίδιο αποτέλεσμα αν δη-
μιουργήσουμε μία μάσκα σε ένα νέο κανάλι και την εφαρμόσουμε ως επιλογή στη φωτογραφία.

Η μάσκα τοποθετείται επάνω από το φιλμ και, αν παρατηρήσουμε τις δύο διαφάνει-
ες σε φωτοτράπεζα θα φαίνεται μόνο το θέμα μέσα στον κύκλο. Για τη μετατροπή 
της αρνητικής σε θετική εικόνα στο φωτογραφικό χαρτί προβάλλουμε το σύστημα 
των δύο φιλμ σε ένα μεγεθυντήρα. Στην ηλεκτρονική επεξεργασία εικόνας επιτυγ-
χάνουμε το ίδιο αποτέλεσμα, αν δημιουργήσουμε μία μάσκα σε ένα νέο κανάλι και 
την εφαρμόσουμε ως επιλογή στη φωτογραφία, σβήνοντας στην συνέχεια το τμήμα 
που δεν χρειαζόμαστε, δηλαδή το τμήμα έξω από την περιφέρεια.
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Δημιουργία μάσκας σε κανάλι: Ανεξάρτητα από τον αριθμό των επιπέδων που έχει 
μία φωτογραφία, έχει πάντα τρία κανάλια, αν είναι εικόνα RGB, ή τέσσερα στην περί-
πτωση της CMYK. Το κάθε κανάλι περιέχει την αχρωματική πληροφορία της εικόνας 
που αντιστοιχεί στο κάθε χρώμα, όπως μπορούμε να δούμε ξανά στην Εικόνα 4.9. Η 
παλέτα των καναλιών (channels) βρίσκεται δίπλα σε αυτή των επιπέδων (Εικόνα 5.12 
Α και Β). Μπορούμε να δημιουργήσουμε ένα νέο κανάλι με οποιοδήποτε όνομα και 
με ό,τι σχήματα θέλουμε. Αυτό το κανάλι εγκαθίσταται αμέσως μετά τα βασικά κανά-
λια της εικόνας και επιδρά στην εικόνα συνολικά και σε όλα τα επίπεδά της. Υπάρχει 
μόνο ένας περιορισμός. Τα κανάλια δεν είναι δυνατόν να έχουν χρώμα. Γι’ αυτό, όταν 
σχεδιάζουμε κάτι σε αυτά, η παλέτα χρωμάτων αποχρωματίζεται.

Μελάνι Cyan

Μελάνι Magenta

Μελάνι Yellow

Μελάνι Black

Κανάλι RGB

Κανάλι  Red

Κανάλι Green

Κανάλι  Blue

Τυπωμένη εικόνα με 
τετραχρωμία CMYK

Το κάθε χρώμα καταλαμβάνει
ξεχωριστό κανάλι στο Photoshop

ΒA

Εικόνα 5.12: (Α) Η διάταξη των καναλιών RGB. (Β) Η διάταξη των καναλιών CMYK.

Σημείωση: Δημιουργία καναλιών επιτυγχάνεται και με άλλο τρόπο. Κάθε φορά που 
χρησιμοποιούμε τα εργαλεία επιλογής, δημιουργείται ένα κανάλι που περιέχει την 
τρέχουσα επιλογή σε μορφή μάσκας. Όμως, για να γίνει μόνιμο αυτό το κανάλι, 
πρέπει να αποθηκευθεί με την εντολή Επιλογή > Αποθήκευση Επιλογής (Select > 
Save Selection...). Μετά από αυτό και αν ακόμη έχει «χαθεί» η επιλογή, είναι δυνα-
τόν να ανακληθεί με την εντολή Επιλογή>Κλήση επιλογής (Select > Load Selection).
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5.5 Μάσκες... επιπέδου

Όπως έγινε κατανοητό, καλύπτοντας μια φωτογραφία με την κατάλληλη μάσκα, 
μπορούμε να κάνουμε μία περιοχή της λιγότερο ή περισσότερο διάφανη με στόχο 
την εξάλειψη ατελειών ή τη δημιουργία οπτικής εντύπωσης. Η διαφορά της μάσκας 
επιπέδου με αυτή που αναφέρεται στην προηγούμενη παράγραφο είναι ότι αυτή 
δημιουργείται και εφαρμόζεται επιλεκτικά σε μεμονωμένα επίπεδα (Εικόνα 5.13).

Α Β
Εικόνα 5.13: (Α) Προκειμένου να εξαλείψουμε τα στηρίγματα της κορνίζας, δουλεύουμε με μά-
σκα επιπέδου που δεν επιφέρει μόνιμη αλλοίωση της αρχικής φωτογραφίας. Η μάσκα επιπέδου 
δημιουργείται με επιλογή με το ποντίκι στο εικονίδιο (με τον κόκκινο κύκλο) της μάσκας στην 
παλέτα επιπέδων. Αντίστοιχα, με επιλογή στο εικονίδιο με το καλάθι των αχρήστων που υπάρχει 
δεξιότερα, σβήνουμε τη μάσκα.
(Β) Η κορνίζα ενσωματώνεται αρμονικά στη φωτογραφική σύνθεση, ενώ η μάσκα αποκρύπτει 
τις ατέλειες.

Η μάσκα που χρησιμοποιείται στο παράδειγμα της Εικόνας 5.13 απομονώνει τα τμή-
ματα της (ή των) φωτογραφίας(ων), που δε θέλουμε να φαίνονται στη σύνθεσή 
μας. Π.χ. η κορνίζα έχει μερικά στηρίγματα που είναι περιττά για το τελικό αποτέ-
λεσμα. Μπορούμε να δούμε αυτά τα τμήματα, αν απομονώσουμε προσωρινά τη μά-
σκα (Shift + επιλογή με το ποντίκι, στο επίπεδο που βρίσκεται η μάσκα στην παλέτα 
επιπέδων). Το μεγάλο πλεονέκτημα αυτής της τεχνικής είναι ότι απομονώνουμε το 
θέμα, χωρίς μόνιμη αλλοίωση της αρχικής φωτογραφίας. Αν, επομένως, μία μάσκα 
δε χρειάζεται, μπορεί να αντικατασταθεί ή να προσαρμοστεί στις ανάγκες μιας νέας 
φωτογραφικής σύνθεσης.
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Σημείωση: Η μάσκα, αν κριθεί ότι είναι άχρηστη, μπορεί να πεταχτεί στον «κάλαθο 
των αχρήστων» που βρίσκεται στο κάτω μέρος της παλέτας επιπέδων.

Εφαρμόζοντας μάσκες με σταδιακή μεταβολή της φωτεινότητάς τους (από μαύρο 
σε άσπρο), μπορεί κανείς να διευρύνει τις δυνατότητες φωτογραφικής σύνθεσης 
(Εικόνα 5.14).

Εικόνα 5.14: Για να δημιουργήσουμε μία διαφορετική οπτική εντύπωση, μετακινηθήκαμε στη 
μάσκα επιπέδου που βρίσκεται το φύλλο και αλλοιώσαμε τη μάσκα, προκειμένου το μισό να 
«σβήνει» και να χάνεται.

Ανακεφαλαίωση 5ου Κεφαλαίου

Τα επίπεδα και οι μάσκες είναι δύο απλές στη φιλοσοφία τους τεχνικές με τις 
οποίες επιτυγχάνουμε να απομονώσουμε τμήματα μιας εικόνας και να τα επε-
ξεργαστούμε ξεχωριστά από τα υπόλοιπα.
Υπάρχουν δύο ειδών μάσκες, οι απλές που επιδρούν στην φωτογραφία συνολι-
κά και οι μάσκες επιπέδου που δημιουργούνται και συνοδεύουν αποκλειστικά 
ένα επίπεδο, ενεργώντας μόνο σε αυτό.
Με τις τεχνικές αυτές, αν τις εφαρμόσουμε σωστά στην ψηφιακή επεξεργασία, 
επιτυγχάνουμε σύνθεση και ανάμιξη εικόνων πολύ γρηγορότερα και με πολύ 
καλύτερα αποτελέσματα από τις παραδοσιακές φωτογραφικές μεθόδους.
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Δραστηριότητες 5ου Κεφαλαίου

1.	� Αναζητήστε μία φωτογραφία και ανοίξτε την σε ένα πρόγραμμα επεξεργασίας 
εικόνας. Στην παλέτα των επιπέδων μετατρέψτε το επίπεδο background σε επί-
πεδο. Ποιες διαφορές παρατηρείτε μετά αυτή την αλλαγή;

2.	�� Προσθέστε ένα νέο επίπεδο, δώστε του ένα όνομα της επιλογής σας και μετά δια-
γράψτε το.

3.	� Στην προηγούμενη φωτογραφία γράψτε το όνομά σας σε ένα νέο επίπεδο και στη 
συνέχεια ρυθμίστε σε διαφορετική τιμή τη διαφάνειά του. Συνεχίστε γράφοντας 
σε άλλο επίπεδο και το επίθετό σας. Προσπαθήστε να αλλάξετε τη σχετική τους 
θέση, ώστε να βρείτε αυτή της αρεσκείας σας. Πειραματιστείτε και με άλλες ρυθ-
μίσεις στα επίπεδα.

4.	�Αφού τελειώσετε τις ρυθμίσεις σας και είστε ικανοποιημένοι με το αποτέλεσμα 
των ...καλλιτεχνικών σας αναζητήσεων επιλέξτε την εντολή Flatten Image... Τι 
παρατηρείτε; Σημειώστε προσεκτικά τις απαντήσεις σας.

5.	� Έστω ότι ...αποφασίσατε να λάβετε μέρος σε ένα διαγωνισμό δημιουργίας διαφη-
μιστικής αφίσας με θέμα την προβολή ενός ταχύρυθμου σεμιναρίου ψηφιακής 
εικόνας. Επιλέξτε τις διαστάσεις αφίσας που επιθυμείτε και στη συνέχεια χρησι-
μοποιώντας διάφορες φωτογραφίες από το εργαστήριο του σχολείου σας ή από 
το δικό σας αρχείο, δημιουργήστε μία σύνθεση. Οι πειραματισμοί με διάφορες 
ρυθμίσεις ανάμιξης επιπέδων θα σας δώσουν εντυπωσιακά αποτελέσματα.

6.	�Επιλέξτε μία ομαδική φωτογραφία π.χ. της τάξης σας. Χρησιμοποιήστε την για 
να συνθέσετε μία αναμνηστική αφίσα. Μπορείτε να ενθέσετε και άλλες εικόνες 
ή γράμματα ή ότι άλλο κρίνετε σκόπιμο, για την επιτυχία της σύνθεσής σας.
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Κεφάλαιο 6ο
Είσοδος και Έξοδος

Στόχοι:

Μετά τη μελέτη αυτού του κεφαλαίου οι μαθητές θα είναι σε θέση να:

	 •	� Απαριθμήσουν τις συσκευές εισόδου/ εξόδου ενός συστήματος ψηφια-

κής φωτογραφίας.

	 •	 �Περιγράψουν τις βασικές αρχές λειτουργίας των συσκευών λήψης και 

εκτύπωσης ψηφιακών εικόνων.

	 •	 �Αξιολογήσουν τα ποιοτικά χαρακτηριστικά των συσκευών αυτών.

	 •	 �Ταξινομήσουν τις συσκευές εξόδου ανάλογα με την τεχνική εκτύπωσης 

που χρησιμοποιούν.

	 •	 �Υπολογίζουν την αναγκαία ανάλυση εικόνας για εμφάνιση στην οθόνη 

ή εκτύπωση.

6.1 Εισαγωγή

Με τη μέχρι τώρα μελέτη μας γνωρίσαμε τη βασική ορολογία και μερικές χρήσιμες 
μεθόδους επεξεργασίας των ψηφιακών εικόνων. Στο κεφάλαιο αυτό θα εξετάσουμε με 
ποιους τρόπους μπορούμε να εισαγάγουμε μία εικόνα στον υπολογιστή μας και, αφού 
την επεξεργασθούμε, να την τυπώσουμε. Η παρουσίασή μας θα είναι ποιοτική, αφού 
δε σκοπεύει να υπεισέλθει σε τεχνικές λεπτομέρειες. Θα ήταν χρήσιμο όμως να θυμη-

θούμε την έννοια της ανάλυσης εισόδου και εξόδου που μάθαμε στο πρώτο κεφάλαιο.

Ας φέρουμε για λίγο στο μυαλό μας τη χρήση του οικιακού video. Με μία μηχανή 
λήψεως μαγνητοσκοπούμε (recording) το θέμα μας και, όταν επιλέξουμε, βλέπου-
με αυτό που μαγνητοσκοπήσαμε στην τηλεόραση (playback). Η μαγνητοσκόπηση 
είναι η είσοδος στον κύκλο παραγωγής του έργου (ταινία video), ενώ η αναπαρα-

γωγή στην τηλεόραση είναι η έξοδος.

Οι ίδιες έννοιες εισόδου-εξόδου χρησιμοποιούνται και στην ψηφιακή φωτογραφία. 

Με τον όρο «είσοδος», εννοούμε οποιαδήποτε μέθοδο ή συσκευή εισαγωγής μιας 
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εικόνας στον υπολογιστή, ενώ με τον όρο «έξοδος» εννοούμε τη μέθοδο ή τη συ-
σκευή που θα αποτυπώνει την εικόνα που δημιουργήσαμε ή επεξεργαστήκαμε. 
Όμως η «συσκευή» αυτή μπορεί να είναι εκτυπωτής, οθόνη ή πιεστήριο.

6.2 Ψηφιακή φωτογραφική μηχανή

Υπάρχουν αρκετοί τύποι ψηφιακών φωτογραφικών μηχανών που όλες έχουν ένα σύ-
στημα φακών όμοιο με αυτό των συμβατικών μηχανών, αυτομάτων ή μη. Η εστίαση 
του θέματος όμως δεν γίνεται στο φιλμ, που φυσικά δεν υπάρχει, αλλά σε ένα σύ-
στημα φωτοδιόδων που βασίζεται στην τεχνολογία CCD (Charged-Coupled Device), 
όπου το υλικό κατασκευής τους και η πυκνότητά τους καθορίζει την ποιότητα φωτο-
γράφησης. Μια παρατήρηση σχετικά με το φακό έχει να κάνει με την πυκνή διάταξη 
των στοιχείων CCD, που επιβάλλει φακούς με μεγάλη αναλυτική δύναμη, ώστε να 
καταγράφουν καθαρά τις λεπτομέρειες του θέματος φωτογράφησης (Εικόνα 6.1).

Φακός

Πλέγμα 
αισθητήρων 
CCD

Κάρτα μνήμης RAM
Διάφραγμα

Ψηφιακή μηχανήΑ B

Εικόνα 6.1: (Α) Οι αισθητήρες CCD που βρίσκονται στις ψηφιακές μηχανές, αποτελούνται από 
ένα πλέγμα με τετράγωνα πλακάκια, σε διάταξη 2x2 με δύο πράσινα, ένα κόκκινο και ένα μπλε 
πλακάκι. Ορισμένες μηχανές διαθέτουν εξάγωνα πλακάκια, που έχουν το πλεονέκτημα να συγκε-
ντρώνουν περισσότερο φως σε σύγκριση με τα τετράγωνα και επομένως να προσφέρουν μεγαλύ-
τερη φωτεινότητα, δηλαδή υψηλότερη τιμή ISO για την ίδια πάντα ανάλυση.
(Β) Το ανεστραμμένο είδωλο του θέματος φωτογράφησης εστιάζεται στο πλέγμα των αισθητή-
ρων CCD.

Οι ψηφιακές φωτογραφίες αποτελούνται από εκατομμύρια τέτοιες φωτοδιόδους, που 
η κάθε μία αντιστοιχεί σε ένα εικονοστοιχείο. Ο μέγιστος αριθμός φωτοδιόδων του 
CCD καθορίζει τη μεγίστη ανάλυση της φωτογραφίας που μπορεί να δώσει η φωτο-
γραφική μηχανή. Παραδείγματος χάριν, όταν λέμε ότι μία φωτογραφική μηχανή είναι 
2 Megapixels, εννοούμε ότι διαθέτει 2 εκατομμύρια εικονοστοιχεία. Με αυτή την ανά-
λυση έχουμε άριστη ποιότητα φωτογραφιών για τις ιστοσελίδες μας, ενώ μπορούμε 
να τυπώσουμε με καλή ποιότητα φωτογραφίες μεγέθους 10 x 15 εκατοστών. Μία άλλη 
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κατηγορία είναι αυτή των 3 Megapixels. Με αυτή την ανάλυση παίρνουμε καλές εκτυ-
πώσεις φωτογραφιών σε διαστάσεις 13 x 18 εκατοστών. Όσο μεγαλώνει ο αριθμός των 
εικονοστοιχείων (δηλαδή η ανάλυση) τόσο βελτιώνεται η ευκρίνεια της εικόνας.
Στα βασικά πλεονεκτήματα των ψηφιακών φωτογραφικών μηχανών, συμπεριλαμ-
βάνεται και το ότι η φωτογραφία είναι σε ψηφιακή μορφή και εισάγεται αμέσως 
στον υπολογιστή για περαιτέρω επεξεργασία (Εικόνα 6.2).

Ψηφιακή 
Φωτογραφική Μηχανή

Φωτογραφική Μηχανή       
με φιλμ

Σαρωτής	

Ψηφιακή 
Εικόνα

Εικόνα 6.2: Με τη χρήση ψηφιακής φωτογραφικής μηχανής το θέμα μετατρέπεται σε εικόνα για 
άμεση επεξεργασία στον υπολογιστή.

Ο σαρωτής είναι απαραίτητος για την ψηφιοποίηση της φωτογραφίας που έχει τυ-
πωθεί σε διαφάνεια (slide) ή σε φωτογραφικό χαρτί.

6.3 Σαρωτής εικόνων

Η χρήση του σαρωτή εικόνων (scanner) είναι απαραίτητη, όταν η εικόνα που θέ-
λουμε να επεξεργασθούμε είναι ήδη τυπωμένη ή διαθέτουμε φωτογραφική μηχανή 
με φιλμ και είμαστε αναγκασμένοι να εμφανίσουμε και να τυπώσουμε τις φωτο-
γραφίες, πριν τις εισαγάγουμε στον υπολογιστή (Εικόνα 6.2).

Ο σαρωτής αναλαμβάνει να «ψηφιοποιήσει» εικόνες και φωτογραφίες που είναι 
ήδη τυπωμένες σε χαρτί ή φιλμ. Διαθέτει ένα σύστημα ανάγνωσης (σάρωσης) που 
μετατρέπει το αποτέλεσμα της ανάγνωσης σε ψηφιακό σήμα το οποίο στη συνέχεια, 
με τη βοήθεια του κατάλληλου προγράμματος, καταγράφεται στο σκληρό δίσκο του 
υπολογιστή. Οι σαρωτές διαθέτουν φίλτρα RGB που «ξεχωρίζουν» την εικόνα στα 
τρία βασικά χρώματα κατά το στάδιο της σάρωσης, εισάγοντάς τα στον υπολογιστή, 
μέσω του δικού τους επεξεργαστή, καταλαμβάνοντας τα αντίστοιχα κανάλια στα 
προγράμματα επεξεργασίας εικόνων.
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Γ

Γ Γ
Γ Δ

ΖΕ

Θ

Α

Β

Α

Υπάρχουν δύο είδη σαρωτών,
	 (i)	� με τύμπανο στον οποίο η φωτογραφία, είναι στερεωμένη στην κυλιν-

δρική επιφάνειά του και περιστρέφεται με μεγάλη ταχύτητα, ενώ η κε-
φαλή ανάγνωσης κινείται ισοταχώς παράλληλα με τον άξονα του τυ-
μπάνου και τη σαρώνει (Εικόνα 6.3 Α), και

	 (ii)	� ο επίπεδος με σύστημα ανάγνωσης όμοιο με αυτό ενός φωτοτυπικού 
μηχανήματος (Εικόνα 6.3 Β και Γ).

Εικόνα 6.3:
(Α) Σαρωτής τυμπάνου.
(Β) Επίπεδος σαρωτής (εγκάρσια τομή).
(Γ) Στον επίπεδο σαρωτή, το φως της 
πηγής Α ανακλάται από το θέμα 
που βρίσκεται στο τζάμι Θ. 
Τα κάτοπτρα Γ οδηγούν την 
δέσμη στον φακό Δ, ο οποίος 
με την σειρά του εστιάζει το 
είδωλο του θέματος στους 
αισθητήρες CCD στην θέση 
Ε, που στέλνουν την ψηφιακή 
εικόνα στα ηλεκτρονικά κυκλώματα Ζ.

Ένα κρίσιμο χαρακτηριστικό για την ποιότητα κάθε σαρωτή είναι το εύρος των τό-
νων (dynamic range) που μπορεί να καταγράψει το σύστημα ανάγνωσής του (βλέπε 
παραγράφους 4.2 και 4.3 για περισσότερες λεπτομέρειες για το εύρος των τόνων). 
Δηλαδή, αναφερόμαστε στην ικανότητα του σαρωτή να καταγράψει λεπτομέρειες 
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από τα φωτεινότερα έως τα σκοτεινότερα σημεία μιας φωτογραφίας. Χωρίς μεγάλο 
τονικό εύρος δε μπορούμε να καταγράψουμε τις λεπτομέρειες στους σκοτεινούς 
τόνους π.χ. μίας διαφάνειας. Επίσης, μπορούμε να παρατηρήσουμε ότι στους φθη-
νότερους επίπεδους σαρωτές χάνονται οι λεπτομέρειες στους ανοικτούς τόνους.

6.4 Ανάλυση και διαστάσεις εικόνας

Ας θυμηθούμε από το πρώτο κεφάλαιο ότι η ανάλυση είναι ένας έμμεσος τρόπος 
να ορίσουμε το μέγεθος του εικονοστοιχείου. Αυτό άλλωστε γίνεται κατανοητό, αν 
αναλογιστούμε και τον ορισμό της ανάλυσης ως «...το πλήθος εικονοστοιχείων ανά 
μονάδα μήκους», που σημαίνει πόσα εικονοστοιχεία χωράνε σε μία ίντσα ή σε ένα 
εκατοστό, ανάλογα με τις μονάδες μέτρησης που χρησιμοποιούμε.

Θα δούμε τώρα πώς εφαρμόζονται αυτά σε μία εικόνα. Έχουμε μία εικόνα διαστάσε-
ων 4 επί 6 ίντσες με ανάλυση 300 ppi. Με ένα απλό υπολογισμό μπορούμε να βρούμε 
πόσα εικονοστοιχεία θα έχουμε στο πλάτος και στο ύψος της. Αυτό προκύπτει αν πολ-
λαπλασιάσουμε την κάθε διάσταση επί 300, δηλαδή 1200 επί 1800 pixels.

Με αφετηρία τα προηγούμενα στοιχεία, ας δούμε την αντίστροφη πορεία και γνω-
ρίζοντας τις διαστάσεις σε pixels να βρούμε τις διαστάσεις σε ίντσες. Παίρνουμε το 
πλάτος και το ύψος, εκφρασμένα σε pixels, και τα διαιρούμε με την ανάλυση των 
300 ppi. Προκύπτουν, όπως είναι επόμενο, οι διαστάσεις 4 επί 6 ίντσες.

Αυτούς ακριβώς τους υπολογισμούς κάνει το πλαίσιο διαλόγου των προγραμμά-
των επεξεργασίας εικόνας, Εικόνα >Μέγεθος εικόνας (Image > Image Size) (Ει-
κόνα 6.4). Στο επάνω μέρος εμφανίζονται οι διαστάσεις σε pixels. Στο κάτω μέρος 
εμφανίζονται οι διαστάσεις με την αντίστοιχη ανάλυση, που συνήθως είναι αυτή 
που έχουμε ορίσει στον σαρωτή κατά το στάδιο της ψηφιοποίησης ή έχουμε ορίσει 
εμείς, αν επρόκειτο να δημιουργήσουμε μία νέα εικόνα.

Εικόνα 6.4:
Το πλαίσιο διαλόγου των προγραμμάτων
επεξεργασίας εικόνας,
Image > Image Size.
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Ας δούμε τώρα το θέμα της εκτύπωσης. Έχουμε την δυνατότητα να τυπώνουμε σε 
εκτυπωτές διαφορετικών τύπων, π.χ. ψεκασμού, εξάχνωσης, λέιζερ, ή πιεστήριο 
offset. Κάθε ένα από αυτά τα μηχανήματα δεν μπορεί να αναπαραγάγει ακριβώς 
αυτό που βλέπουμε στην οθόνη, διότι οι μεν αποχρώσεις αποδίδονται στο χαρτί με 
τετραχρωμία CMYK, οι δε τόνοι αποδίδονται με διαφορετικό τρόπο, χρησιμοποιώ-
ντας τα pixels της εικόνας.
Εκτυπωτές εξάχνωσης: Οι εκτυπωτές εξάχνωσης είναι συσκευές άμεσης αντιστοίχη-
σης, όπου το κάθε εικονοστοιχείο της εικόνας αντιστοιχεί σε μία κουκκίδα της μονάδος 
εξόδου. Έτσι η ανάλυση της εικόνας πρέπει να είναι ίση με την ανάλυση του εκτυπωτή.

Παράδειγμα: Έστω ότι θέλουμε να τυπώσουμε μία φωτογραφία στον καινούργιο 
μας εκτυπωτή εξάχνωσης (dye sublimation printer) ονομαστικής ανάλυσης 400 
dpi και διαστάσεων 8 επί 10 ιντσών (20,3 εκ επί 25,4 εκ). Ποια πρέπει να είναι η 
ανάλυση της εικόνας μας στον υπολογιστή, προκειμένου να έχουμε το καλύτερο 
δυνατό αποτέλεσμα, εκμεταλλευόμενοι την ανάλυση του νέου μας εκτυπωτή;

Αφού ο εκτυπωτής έχει ανάλυση 400 dpi για την απόδοση των τόνων μιας 
εικόνας και οι διαστάσεις του χαρτιού είναι 8 επί 10 ίντσες, ο αναγκαίος αριθ-
μός εικονοστοιχείων είναι 8 x 400 = 3.200 pixels και 10 x 400 = 4000 pixels 
αντιστοίχως. (Εικόνα 6.5).

3200 pixels

40
00
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8 ίντσες

Εικόνα 6.5: 0 αναγκαίος αριθμός εικονοστοιχείων για εκτύπωση στον εκτυπωτή εξάχνωσης. Για 
κάθε pixel της εικόνας, αντιστοιχεί μία κουκκίδα του εκτυπωτή.

Εκτυπωτές ψεκασμού: Η εκτύπωση γίνεται με την μέθοδο της παραλλαγής με διάχυ-
ση (diffusion dithering), (Εικόνα 6.6 Β), έχουμε κουκκίδες σταθερής διαμέτρου που 
πυκνώνουν ή αραιώνουν για να δώσουν την αίσθηση των σκούρων ή ανοικτών τόνων 
αντιστοίχως. Η κεφαλή του εκτυπωτή διαθέτει συνήθως τέσσερεις κασέτες μελανιών 
CMYK για την απόδοση των τόνων. Με τους εκτυπωτές αυτούς ψεκάζεται η επιφάνεια 
του χαρτιού με τα μελάνια της τετραχρωμίας σχηματίζοντας την εικόνα. Η αναγκαία 
ανάλυση που πρέπει να διαθέτει η φωτογραφία μας, για να έχουμε την καλλίτερη 
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δυνατή εκτύπωση, υπολογίζεται αν διαιρέσουμε την ονομαστική ανάλυση του εκτυ-
πωτή δια του τρία.

Παράδειγμα: Έστω ότι εκτυπωτής μας έχει ανάλυση 720 dpi. Ποια είναι η 
αναγκαία ανάλυση σάρωσης της εικόνας μας προκειμένου να έχουμε την βέλ-
τιστη ποιότητα εκτύπωσης;
Με βάση τα προηγούμενα, διαιρώ 720 δια 3 και το αποτέλεσμα 240 ppi, είναι 
η αναγκαία ανάλυση σάρωσης της εικόνας.
Διευκρίνιση: Με ένα σύγχρονο εκτυπωτή ονομαστικής ανάλυσης 2.880 dpi, αν 
χρησιμοποιήσουμε τον προηγούμενο τύπο προκύπτει ότι η ανάλυση σάρωσης 
είναι 2880 / 3 = 960 ppi. Όμως τα μάτια μας δεν μπορούν να αναγνωρίσουν 
τόσες λεπτομέρειες και είναι περιττό να δημιουργήσουμε τόσο μεγάλο αρχείο 
εικόνας. Έτσι, καλό είναι να θεωρήσουμε την ανάλυση των 960 ppi σαν την 
μέγιστη και να αρχίσουμε να πειραματιζόμαστε με χαμηλότερες τιμές μέχρις 
ότου βρούμε την ποιότητα που θέλουμε, χωρίς υπερβολικά μεγάλο αρχείο.

Εικόνα 6.6:
(Α) Η διάμετρος της (ημιτονικής) κουκκίδας 
στην offset μεγαλώνει προκειμένου να δώσει 
σκούρους τόνους, αλλά η απόσταση των 
κέντρων τους παραμένει πάντα σταθερή.
(Β) Η τεχνική εκτύπωσης τονικών εικόνων 
stochastic screening. Είναι περισσότερο 
γνωστή και με τον (επίσης αγγλικό) όρο 
diffusion dithering (που θα μπορούσαμε να 
μεταφράσουμε ως παραλλαγή με διάχυση). 
Έχουμε κουκκίδες σταθερού μεγέθους που 
πυκνώνουν ή αραιώνουν, για να δώσουν την 
αίσθηση των σκούρων ή ανοικτών τόνων 
αντιστοίχως.

Εικονοθέτες / Εκτυπωτές Laser: Για την απόδοση των τόνων μια εικόνας χρησιμο-
ποιούν διαφορετική μέθοδο από αυτή των προηγούμενων εκτυπωτών και καλείται 
ημιτονική (Halftoning). (Εικόνα 6.6 Α).
Είναι η κλασική μέθοδος εκτύπωσης με offset και των εκτυπωτών laser. (Εικόνα 6.7). 
Με αυτή τη μέθοδο τυπώνουμε κουκκίδες μεταβλητής διαμέτρου, που δίνουν την 
εντύπωση της τονικής διαβάθμισης. Οι κουκκίδες αυτές έχουν σταθερή απόσταση 

Β

Α
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μεταξύ τους, αλλά μεταβλητή διάμετρο. Όσο μεγαλύτερη πυκνότητα έχουν, τόσο 
ομαλότερη τονική διαβάθμιση δίνουν. Η πυκνότητά τους δίνεται από τον αριθμό 
των γραμμών που σχηματίζουν ανά ίντσα (lpi).

Α Β

Εικόνα 6.7: (Α) Η ημιτονική κουκκίδα αποτελείται πάντα από περισσότερες της μιας κουκκίδες 
του εικονοθέτη. Αυτός είναι ο λόγος άλλωστε που οι εικονοθέτες, ενώ έχουν σταθερή κουκκίδα 
που καθορίζεται από τον αριθμό dpi, είναι σε θέση να δώσουν μεταβλητής διαμέτρου ημιτονική 
κουκκίδα που ορίζεται από τον αριθμό lpi.
(Β) Η απόσταση των κέντρων των ημιτονικών κουκκίδων είναι πάντα σταθερή. Η διαβάθμιση 
από σκούρους σε ανοικτούς τόνους γίνεται με σταδιακή μείωση της διαμέτρου των κουκκίδων. Ο 
αριθμός των «κελιών» ανά ίντσα είναι ο αριθμός lpi.

Η ποιότητα της κάθε ημιτονικής κουκκίδας εξαρτάται από την ανάλυση της συ-
σκευής εξόδου, δηλαδή του εικονοθέτη. Οι εικονοθέτες, προκειμένου να έχουν την 
ευελιξία να τυπώνουν οτιδήποτε, φθάνουν και σε ανάλυση 3500 dpi (dots per inch).

Εμείς ως χρήστες των προγραμμάτων επεξεργασίας εικόνων πρέπει να έχουμε την 
ανάλυση της εικόνας που χρειάζεται, για να τυπώσουμε με ημιτονική κουκκίδα, δεν 
ενδιαφερόμαστε άμεσα για την ανάλυση του εικονοθέτη.

Δεδομένου ότι ο εικονοθέτης είναι συσκευή εξόδου με αντιστοιχία 2:1 θα πρέπει να 
γνωρίζουμε ότι:

Η ανάλυση σε pixels ανά ίντσα (pixels per inch) της ψηφιακής εικόνας πρέπει να εί-
ναι διπλάσια από την ανάλυση σε γραμμές ανά ίντσα (lines per inch) που πρόκειται 
να τυπώσουμε.

Ο ορισμός αυτός αφορά εικόνες ίδιων διαστάσεων. Αν πρόκειται να μεγεθύνουμε ή 
να σμικρύνουμε την αρχική φωτογραφία, θα πολλαπλασιάσουμε την προκύπτουσα 
ανάλυση με το αντίστοιχο ποσοστό.
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Παράδειγμα: Έστω ότι πρόκειται να τυπώσουμε διαφημιστικό φυλλάδιο, χρη-
σιμοποιώντας για τις εικόνες «ράστερ» 150 lpi. Υπολογίστε:
(Α) Ποια είναι η αναγκαία ανάλυση των εικόνων μας αν πρόκειται να τυπω-
θούν στο ίδιο μέγεθος;
(Β) Ποια είναι η αναγκαία ανάλυση των εικόνων, αν θέλουμε συγχρόνως να τις 
μεγεθύνουμε 200%;
(Α) Χρειαζόμαστε 150 x 2 = 300 ppi για το ίδιο μέγεθος (1:1).
(Β) Χρειαζόμαστε 150 x 2 × 200/100 = 600 ppi για το διπλάσιο μέγεθος (2:1).

6.5 Εκτύπωση εικόνων

Στην προηγούμενη παράγραφο αλλά και σε άλλα σημεία του βιβλίου, αναφερθή-
καμε στις συσκευές εξόδου καθώς και σε ειδικότερα θέματα που σχετίζονται με την 
εκτύπωση ψηφιακών εικόνων.

Με τον πίνακα 6.1, όπου εμφανίζονται ταξινομημένες όλες οι τεχνικές εκτύπωσης, 
μας προσφέρεται η δυνατότητα να επαναφέρουμε στη μνήμη μας πολλά από αυτά 
τα σημεία της σχετικής ύλης του Βιβλίου.

Να σημειώσουμε μόνο ότι η κατασκευή δοκιμίων δεν είναι μία νέα μέθοδος εκτύ-
πωσης, αλλά ένας τρόπος να απεικονίζονται τα χρώματα σε μία χάρτινη επιφάνεια 
πριν την εκτύπωση, ώστε να ελέγχουμε το αποτέλεσμα των εργασιών της προεκτύ-
πωσης και να χρησιμοποιούνται, ως οδηγοί, για τον ποιοτικό έλεγχο των χρωμάτων 
στην εκτύπωση. 

Επίσης, η εκτύπωση χωρίς να χρησιμοποιήσουμε φιλμ επιτυγχάνεται, με φωτογρά-
φηση των πλακών εκτύπωσης κατ’ ευθείαν από τον εικονοθέτη.
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Έξοδος σε εκτυπωτή συνεχών τόνων

Εκτύπωση σε χαρτί

Εκτύπωση με υλικά οξειδίων του αργύρου

Εκτυπωτές εξάχνωσης

Εκτύπωση σε διαφάνεια

Film Recorders

Εκτύπωση με ''ράστερ''

Ημιτονική εκτύπωση

Εικονοθέτης (απαραίτητος για εκτύπωση offset)

''Εξυπνο'' ράστερ (Dithering/Dithered output or stochastic screening)

Εκτυπωτές ψεκασμού

Θερμικοί εκτυπωτές

Άλλοι τρόποι εκτύπωσης

Τυπογραφικά δοκίμια (CHROMALIN κ.λ.π.)

Εκτύπωση χωρίς φιλμ (Computer- to -Plate techniques)

Πίνακας 6.1: Τεχνικές εκτύπωσης ψηφιακών εικόνων

ΤΕΧΝΙΚΕΣ ΕΚΤΥΠΩΣΗΣ ΨΗΦΙΑΚΗΣ ΕΙΚΟΝΑΣ
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Ανακεφαλαίωση 6ου Κεφαλαίου

Κάθε σύστημα επεξεργασίας φωτογραφίας αποτελείται από τα μέρη:
Είσοδος – Επεξεργασία – Έξοδος.
Η ψηφιακή φωτογραφική μηχανή και ο σαρωτής εισάγουν την οπτική πληρο-
φορία στον υπολογιστή.
Ο εκτυπωτής αποτυπώνει «πιστά» την εικόνα στην επιφάνεια που θέλουμε, 
που συνήθως είναι το χαρτί (φωτογραφικό ή άλλο) ή φιλμ στην περίπτωση του 
εικονοθέτη. Όλες οι συσκευές εισόδου και εξόδου έχουν κάποιες ιδιότητες και 
κάποια χαρακτηριστικά ''απόδοσης'' που εξαρτώνται από τον κατασκευαστή 
τους. Παράλληλα, όμως, επιδέχονται ρυθμίσεις και προσαρμογές σύμφωνα με 
τις επιθυμίες του χρήστη αλλά και τις προδιαγραφές της εκτύπωσης.
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Ασκήσεις 6ου Κεφαλαίου

1.	� Αναζητήστε τα τεχνικά χαρακτηριστικά τεσσάρων ψηφιακών φωτογραφικών μη-
χανών μαζί με αντίστοιχα δείγματα φωτογραφιών. Καταγράψετε την ανάλυσή 
τους (σε Megapixels) πίσω από την αντίστοιχη φωτογραφία. Βλέπετε διαφορά 
στην ποιότητα των φωτογραφιών; Αν ναι, πώς εξηγείται αυτό;

2.	� Αναφέρατε και περιγράψτε τα μέρη που αποτελούν ένα σύστημα επεξεργασίας 
ψηφιακής φωτογραφίας.

Δραστηριότητες 6ου Κεφαλαίου

1.	� Συζητήστε με τον(ην) καθηγητή(τριά) σας πώς θα μπορούσατε να ελέγχατε το 
εύρος των τόνων, που είναι σε θέση να καταγράψει ο σαρωτής που έχετε στη 
διάθεσή σας στο εργαστήριό σας. Το ιδανικό θα ήταν να επαναλαμβάνατε τον 
έλεγχο και για άλλους σαρωτές και να συγκρίνατε το τονικό τους εύρος.

2.	� Αποφασίζετε να εκδώσετε σχολική εφημερίδα μεγέθους A3. Το πρώτο βήμα για 
αυτό τον σκοπό είναι να βρείτε τα θέματα που θα περιέχει. Το δεύτερο βήμα 
είναι να σχεδιάσετε το προσχέδιο της κάθε σελίδας ξεχωριστά (το «κασέ»). Αν 
υποθέσουμε ότι η εφημερίδα θα περιέχει μόνο Α/Μ φωτογραφίες με ανάλυση 
80 lpi, βρείτε τις κατάλληλες, και διαμορφώστε τις σύμφωνα με το κασέ και την 
ανάλυση εκτύπωσης.

Σχετικές ηλεκτρονικές διευθύνσεις

Για συμβουλές, βοηθητικά προγράμματα, δημιουργικές ιδέες και σχέδια: 
www.serif.com 
www.dtp.com
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2η Ενότητα
Ψηφιακή Σχεδίαση
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Κεφάλαιο 7ο
Αρχές και αλγόριθμοι επεξεργασίας γραφικών

Στόχοι:

Μετά τη μελέτη αυτού του κεφαλαίου οι μαθητές θα είναι σε θέση να:

	 •	� Αντιληφθούν το εύρος εφαρμογών και τις δυνατότητες που προσφέρει 

η σχεδίαση μέσω ηλεκτρονικού υπολογιστή.

	 •	 �Κατανοήσουν τα θεωρητικά και πρακτικά προβλήματα που παρουσιάζει 

η ψηφιακή σχεδίαση στην αναπαραγωγή των βασικών σχημάτων.

	 •	 �Αντιληφθούν τα πλεονεκτήματα και μειονεκτήματα των βασικών προ-

γραμμάτων της αγοράς που χρησιμοποιούνται στην ψηφιακή σχεδίαση 

από τους γραφίστες.

7.1 Εισαγωγή

Τα σχεδιαστικά πακέτα διαθέτουν δύο κατηγορίες προγραμμάτων: τα προγράμματα 
επεξεργασίας εικόνας και ψηφιακής σχεδίασης. Τα προγράμματα αυτά μπορεί να έχουν 
μεταξύ τους αρκετές ομοιότητες, με παρόμοιες εντολές που διαθέτουν, διαφέρουν όμως 
ριζικά στην διαχείριση του προς επεξεργασία θέματος. Αυτά της πρώτης κατηγορίας, 
που ονομάζονται ψηφιογραφικά, βασίζονται στην περιγραφή των εικόνων με εικονο-
στοιχεία. Σε αντίθεση, τα δεύτερα, που ονομάζονται και διανυσματικά, βασίζονται στην 
περιγραφή των εικόνων, με μαθηματικό τρόπο. Στην παράγραφο αυτή θα επανεξετά-
σουμε τα βασικά χαρακτηριστικά τους δίνοντας έμφαση στα διανυσματικά γραφικά.

•	� Ψηφιογραφικές εικόνες (raster images) ονομάζονται αυτές που η απει-
κόνισή τους γίνεται με βάση τις πληροφορίες που αναφέρονται για το 
σύνολο των εικονοστοιχείων τους. Δηλαδή, το βασικό δομικό στοιχείο 
μιας ψηφιογραφικής εικόνας είναι το εικονοστοιχείο. Για να περιγρα-
φούν στον υπολογιστή, χρησιμοποιούνται 16 ή 32 bits, αν περιέχεται 
χρώμα και, 1 ή 8 bits, αν δεν περιέχεται χρώμα. Η ποιότητα μιας εικόνας 
εξαρτάται από την πυκνότητα των εικονοστοιχείων ή αλλιώς την ανάλυ-
ση, και τον αριθμό των χρωμάτων, ή αλλιώς το βάθος χρώματος που έχει. 
Καθώς η εικόνα μεγαλώνει, μεγαλώνει επίσης και το μέγεθος του αρχείου 
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που παράγεται, μια και οι γεωμετρικές διαστάσεις της επηρεάζουν άμε-
σα το πλήθος των εικονοστοιχείων που τη συνθέτουν. Τα ψηφιογραφικά 
αρχεία είναι απαραίτητα, όταν επεξεργαζόμαστε εικόνες που είναι δύ-
σκολο να μετατραπούν σε γεωμετρικά σχήματα, π.χ. η φωτογραφία ενός 

προσώπου. Το ίδιο συμβαίνει με τις αεροφωτογραφίες.

•	� Διανυσματικές εικόνες (vector graphics) είναι τα σχέδια που αποτε-
λούνται από γραμμές (όλων των ειδών) και περιγράφονται από τις μα-
θηματικές καμπύλες Bezier. Στα αρχεία τους ο υπολογιστής αποθηκεύει 
μόνο αριθμούς μαζί με εντολές για τη χάραξη κάθε γραμμής από αυτές 
που συνθέτουν τη συνολική εικόνα. Για παράδειγμα, μια ευθεία γραμ-
μή ορίζεται από τις συντεταγμένες των σημείων αρχής και τέλους και 
από κάποια άλλα χαρακτηριστικά, όπως το πάχος, το χρώμα της κλπ. Για 
να περιγραφεί ένας κύκλος απαιτούνται μόνο οι συντεταγμένες του κέ-
ντρου του και η ακτίνα. Τα αρχεία που δημιουργούνται μπορούν να απο-
θηκεύσουν πάρα πολλά γεωμετρικά σχήματα σε πρακτικά απεριόριστη 
ανάλυση εκτύπωσης. Τα αρχεία αυτού του τύπου είναι μικρά σε μέγεθος, 
γεγονός που συνεπάγεται τη γρήγορη ανάκτηση και εμφάνισή τους στην 
οθόνη. Επί πλέον απαιτούν λιγότερη μνήμη, μεταφέρονται ευκολότερα 
και, φυσικά, είναι πιο εύκολα στη διαχείρισή τους από τον υπολογιστή.

Οι καμπύλες Bezier αποτελούν ένα σύνθετο είδος γεωμετρικών σχημάτων που ορί-
ζονται κατά διεύθυνση και φορά από πολλά σημεία ελέγχου, (τους κόμβους και τις 
εφαπτόμενες γραμμές σε αυτούς).

Στα διανυσματικά προγράμματα οι αλγόριθμοι σχεδίασης είναι εξαιρετικά απλοί, 
όταν πρόκειται για απλά γεωμετρικά σχήματα, έως εξαιρετικά πολύπλοκοι, όταν πρό-
κειται για σύνθετα σχήματα, όπως τα στερεά ή σχήματα που προκύπτουν από την 
ένωση στερεών. Για παράδειγμα, για τη χάραξη ενός ευθύγραμμου τμήματος αρκούν, 
σύμφωνα με όσα γνωρίζουμε από τη γεωμετρία, οι συντεταγμένες των σημείων αρ-
χής και τέλους του. Για τη χάραξη παραλληλογράμμων και ελλείψεων, τα προγράμμα-
τα υπολογίζουν τις συντεταγμένες του κέντρου του σχήματος, το μήκος των πλευρών 
ή της ακτίνας, με βάση τα στοιχεία που εισάγονται από το χρήστη. Για πιο πολύπλοκα 
σχήματα με σύνθετες καμπύλες χρησιμοποιείται το εργαλείο της πένας και οι κα-
μπύλες Bezier. Οι καμπύλες αυτές ορίζονται από μη εκτυπώσιμα σημεία «αγκύρω-
σης» και σημεία ελέγχου, που καθορίζουν τη γωνία και το βάθος της καμπύλης. Για 
ευκολία χειρισμού του σχήματος τα σημεία αγκύρωσης και ελέγχου συνδέονται με μη 
εκτυπώσιμες γραμμές κατεύθυνσης, που λέγονται λαβές και εφάπτονται των κόμβων. 
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Στις Εικόνες 7.1 και 7.2 φαίνονται οι λαβές των καμπυλών Bezier. Μπορεί η χρήση 

τους να φαίνεται πολύπλοκη, όμως μετά τις πρώτες δοκιμές, η διαμόρφωση των κα-

μπυλών γίνεται εύκολα και γρήγορα. Στις επόμενες παραγράφους θα έχουμε την 

ευκαιρία να εξασκηθούμε στον χειρισμό των καμπυλών και κόμβων Bezier.

Εικόνα 7.1: Στο πρώτο σχήμα φαίνονται σημεία αγκύρωσης και λαβές κατεύθυνσης
που δεν εμφανίζονται στην εκτύπωση.

Εικόνα 7.2: Το μήκος και η γωνία των λαβών καθορίζουν τη μορφή των καμπυλών.

Συγκριτικά, λοιπόν, μεταξύ των διανυσματικών και χαρτογραφικών προγραμμάτων 

βλέπουμε ότι υπάρχουν αρκετές διαφορές. Ένας κύκλος που έχει δημιουργηθεί από 

ένα διανυσματικό πρόγραμμα, έχει ένα κέντρο με συγκεκριμένες συντεταγμένες, 

μια ακτίνα που αντιπροσωπεύει την απόσταση της περιμέτρου από το κέντρο, η πε-

ρίμετρός του αναπαρίσταται από μια γραμμή συγκεκριμένου πάχους και χρώματος 

ενώ μπορεί να γεμίσει με ένα οποιοδήποτε χρώμα. Φυσικά, όλα αυτά μπορούν να 

αλλαχτούν οποτεδήποτε επιθυμεί ο χρήστης.
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Αντίθετα, στα ψηφιογραφικά προγράμματα ο κύκλος είναι ένα σύνολο από «ανε-
ξάρτητα» σημεία, τα εικονοστοιχεία, που έχουν διαφορετικό χρώμα ώστε να καθο-
ρίζουν την περίμετρο και το φόντο του. Τα σημεία αυτά μπορεί να έχουν τη μορφή 
κύκλου ή οποιουδήποτε άλλου γεωμετρικού σχήματος, αλλά δεν έχουν καμία άλλη 
από τις μαθηματικές ιδιότητές του. Στην ουσία πρόκειται για έναν ηλεκτρονικό τρό-
πο σχεδίασης, μια μεταφορά δηλαδή των εργαλείων κλασικής σχεδίασης στον υπο-
λογιστή. Θα μπορούσαμε να το πούμε ένα ηλεκτρονικό μολύβι. Κάθε μετατροπή του 
αρχικού σχήματος είναι αρκετά δύσκολη στο μέτρο που δεν είναι διαθέσιμες από το 
πρόγραμμα οι γεωμετρικές του ιδιότητες.

7.2 Προγράμματα διανυσματικών και ψηφιογραφικών εικόνων

Γενικά, τα διανυσματικά προγράμματα έχουν τα παρακάτω χαρακτηριστικά που τα 
διαφοροποιούν από τα ψηφιογραφικά:

•	� Υψηλή ανάλυσης εκτύπωσης: Όταν γίνονται εκτυπώσεις, μπορεί να χρησι-
μοποιηθεί η υψηλότερη (ευκρινέστερη) ανάλυση του εκτυπωτή. Στην ουσία τα 
προγράμματα αυτά υποδεικνύουν στον εκτυπωτή: «Τύπωσε αυτά τα σχήματα 
ακολουθώντας τα μαθηματικά που τα περιγράφουν και χρησιμοποίησε όσο πε-
ρισσότερες κουκκίδες μπορείς, για να τα σχηματίσεις».

•	� Ταχύτερη εμφάνιση στην οθόνη και στον εκτυπωτή: Επειδή δεν περιγράφουν 
σχήματα από ανεξάρτητα σημεία αλλά καμπύλες, οι πληροφορίες που στέλνουν 
στην κεντρική μονάδα επεξεργασίας του υπολογιστή είναι απλά τύποι, οι οποίοι 
επιλύονται από αυτόν ταχύτατα, μειώνοντας έτσι το χρόνο σχηματισμού τους 
στην οθόνη αλλά και στον εκτυπωτή.

•	� Ευκολία στις μετατροπές: Επειδή όλα τα αντικείμενα είναι καμπύλες που πε-
ριγράφονται από μαθηματικούς τύπους, κάθε αλλαγή σε αυτά είναι και μια αλ-
λαγή στον τύπο. Αυτή μπορεί να γίνει οποιαδήποτε χρονική στιγμή με εφαρμογή 
απλών εργαλείων του προγράμματος. Τίποτα δεν είναι σταθερό και τα πάντα 
μπορούν να τροποποιηθούν εύκολα. Όπως θα φανεί από τα επόμενα, ένα χαρα-
κτηριστικό πλεονέκτημα αυτών των προγραμμάτων είναι οι μετατροπές που μπο-
ρούν να γίνουν στις γραμματοσειρές, δηλαδή σε λέξεις ή κείμενα που ενδέχεται 
να σχηματίζουν ένα σήμα ή λογότυπο.

•	 �Μη ρεαλιστική απεικόνιση: Σε σύνθετες εικόνες πολλών φυσικών αντικειμένων, 
τα ανύσματα δεν μπορούν να φτάσουν το ρεαλισμό της φωτογραφικής απεικόνισης.

24-0151 Book.indb   10124-0151 Book.indb   101 27/10/2021   12:17:26 µµ27/10/2021   12:17:26 µµ



102

Ε Φ Α Ρ Μ Ο Γ Ε Σ  Η Λ Ε Κ Τ Ρ Ο Ν Ι Κ Ω Ν  Υ Π Ο Λ Ο Γ Ι Σ Τ Ω Ν

�Σε αντιδιαστολή με τα προγράμματα σχεδίασης τα προγράμματα επεξεργασίας ει-
κόνας, «συνθέτουν ένα άλλο κόσμο». Η εφαρμογή ενός τέτοιου προγράμματος στην 
επεξεργασία των χρωμάτων ενός ζωγραφικού έργου, για παράδειγμα, διαφέρει ρι-
ζικά από τη σχεδίαση ενός λογότυπου. Τα προγράμματα επεξεργασίας εικόνας λοι-
πόν έχουν τα εξής χαρακτηριστικά:

•	 �Περιορισμένη ανάλυση: Τα σημεία μιας ψηφιογραφικής εικόνας έχουν συ-
γκεκριμένο μέγεθος και βρίσκονται σε συγκεκριμένη μεταξύ τους απόσταση. Ο 
εκτυπωτής που θα τα εκτυπώσει, δεν μπορεί να προσθέσει μόνος του νέα σημεία. 
Επομένως, η εκτύπωση θα γίνει στην ανάλυση που δημιουργήθηκε η εικόνα. Αν 
προστεθούν εικονοστοιχεία με την μέθοδο της δειγματοληψίας (resampling), η 
ποιότητα δεν βελτιώνεται.

•	 �Μεγάλο μέγεθος αρχείων: Επειδή τα ψηφιογραφικά αρχεία είναι σύνολα, συ-
νήθως πολλών σημείων, απαιτούν μεγάλους χώρους για την αποθήκευσή τους 
στο σκληρό δίσκο, πολλή κύρια μνήμη για την επεξεργασία τους και ισχυρή κάρ-
τα γραφικών.

•	 �Δυνατότητα επεξεργασίας των εικονοστοιχείων: Εδώ, φυσικά, δεν υπάρχουν 
καμπύλες που να περιγράφονται από μαθηματικούς τύπους, δίνεται όμως η δυ-
νατότητα επεξεργασίας κάθε σημείου που σχηματίζει την εικόνα. Για παράδειγ-
μα η τροποποίηση ενός κύκλου είναι δύσκολη, εύκολα όμως αλλάζουν χρώμα οι 
κόρες των ματιών σε ένα πρόσωπο ή σβήνονται κάποιες ρυτίδες από αυτό.

Στην Εικόνα 7.3, υπάρχει λεπτομέρεια του ίδιου αντικειμένου σε διανυσματική και 
ψηφιογραφική μορφή. Η δεύτερη δημιουργήθηκε από την πρώτη σε σταθερή ανά-
λυση 300 dpi που είναι η συνηθέστερη ανάλυση ενός έγχρωμου εκτυπωτή. Στη 
λεπτομέρεια φαίνεται καθαρά το «σκαλοπατάκι» που έχει το περίγραμμα του σχή-
ματος. Όσο και να αυξηθεί η ανάλυση του εκτυπωτή, αυτό θα παραμείνει ως έχει. 
Αντίθετα, όσο και να μεγεθύνουμε το διανυσματικό, δε θα παρατηρηθεί ποτέ ανά-
λογο φαινόμενο. Η ανάλυση θα αυξάνει συνέχεια και η ομαλότητα των καμπυλών 
θα παραμένει αναλλοίωτη. Έτσι, μπορούμε να χρησιμοποιήσουμε τη μεγαλύτερη 
ευκρίνεια που διαθέτει ο εκτυπωτής, στον οποίο θα τυπώσουμε το τελικό δοκίμιο.
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Εικόνα 7.3: Το αριστερό αντικείμενο είναι διανυσματικό ενώ το δεξί ψηφιογραφικό, έχοντας ως 
χαρακτηριστικά το θόλωμα το «σκαλοπατάκι» στο περίγραμμά του.

Η μετατροπή μιας σύνθετης εικόνας σε διανυσματική μπορεί να αυξάνει τις δυνα-
τότητες εκτύπωσης, μειώνει όμως σημαντικά το ρεαλισμό της εικόνας. Στην Εικόνα 
7.4, βλέπουμε πάλι δύο εικόνες, την πρώτη σε χαρτογραφική και τη δεύτερη σε δια-
νυσματική μορφή. Η μετατροπή της έχει γίνει με ειδικό λογισμικό που συνοδεύει τα 
σχεδιαστικά προγράμματα. Φαίνεται καθαρά ο περιορισμός των χρωμάτων, καθώς 
και η ολική απουσία ενδιάμεσων τόνων σε διαφορετικές χρωματικές περιοχές. Παρ’ 
όλα αυτά, παρόμοιες μετατροπές μπορούν να χρησιμοποιηθούν, με ικανοποιητικά 
αποτελέσματα, σε απλούστερα φωτογραφικά θέματα.

Εικόνα 7.4: Η επάνω εικόνα έχει δημιουργηθεί με την ψηφιοποίηση μιας καλοκαιρινής φωτο-
γραφίας. Κατόπιν, με ειδικό πρόγραμμα μετατράπηκε σε καμπύλες δίνοντας όχι τόσο ρεαλιστικά 
αποτελέσματα.
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Εντυπωσιακός είναι ο τρόπος με τον οποίο τα σχεδιαστικά προγράμματα χειρίζονται τα 
γράμματα. Με τα σχεδιαστικά είναι δυνατή η απομόνωση των καμπυλών που απαρτί-
ζουν ένα γράμμα, γεγονός που προσφέρει τεράστια περιθώρια δημιουργικής παρέμβα-
σης στο χρήστη. Στην Εικόνα 7.5, βλέπουμε το λογότυπο του σχεδιαστή Tim Girvin για 
την ταινία Matrix. Ξεκίνησε τη δημιουργία του λογότυπου τοποθετώντας τον τίτλο σε 
γραμματοσειρά Times New Roman. Κατόπιν, μετέτρεψε τα περιγράμματα των γραμμά-
των σε καμπύλες και τις έσπασε σε κομματάκια. Με μετακίνηση των κομματιών αυτών 
και τη διαγραφή ή προσθήκη απλών τετραγώνων δημιούργησε το λογότυπο με γράμ-
ματα που η τελική τους μορφή δεν έχει καμία σχέση πλέον με την Times New Roman.

Εικόνα 7.5: Τα γράμματα μετατρέπονται σε απλές επεξεργάσιμες καμπύλες

Συμπερασματικά, πέρα από την ευκολία στη διαχείρισή τους από τους υπολογιστές 
που προσφέρουν τα διανύσματα, τα παραγόμενα αρχεία είναι, σε κάθε περίπτωση, 
σημαντικά μικρότερα σε όγκο από τα ψηφιογραφικά αρχεία. Σήμερα οι δύο αυτές 
κατηγορίες γραφικών (διανυσματικές και ψηφιογραφικές εικόνες) μπορούν να συ-
νυπάρχουν στο ίδιο αρχείο ή έγγραφο. Με τον τρόπο αυτό επιτυγχάνεται η υπέρ-
βαση των μειονεκτημάτων και η καλύτερη αξιοποίηση των πλεονεκτημάτων που 
προσφέρουν και τα δύο αυτά συστήματα απεικόνισης.

7.3 Προγράμματα ψηφιακής σχεδίασης

Στην εποχή μας μία μεγάλη ποικιλία προγραμμάτων επεξεργασίας εικόνων και σχε-
δίων διατίθεται στην αγορά για τις (διαφορετικές) ανάγκες μιας μεγάλης μερίδας 
κοινού. Τα περισσότερα από αυτά είναι εξειδικευμένα. Για παράδειγμα, το Auto-
CAD το χρησιμοποιούν οι μηχανικοί και οι σχεδιαστές, ενώ το Illustrator ή το Corel 
οι γραφίστες. To Photoshop και το CorelPaint, που είναι προγράμματα ψηφιογρα-
φικών εικόνων, χρησιμοποιούνται επίσης από τους γραφίστες.
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Η εξειδίκευση αυτή προκύπτει από τα ιδιαίτερα χαρακτηριστικά του κάθε προγράμ-
ματος. Παρά τις ιδιαιτερότητές τους όμως έχουν πολλά κοινά στοιχεία που επι-
τρέπουν σε κάποιον που θα μάθει σωστά ένα από αυτά, να μπορεί εύκολα και σε 
σύντομο χρόνο να μεταβεί σε κάποιο άλλο.

Μετά λοιπόν από την αποσαφήνιση των βασικών διαφορών μεταξύ των προγραμμάτων 
ανάλογα με τον κύριο προσανατολισμό τους (σε επεξεργασία εικόνας ή σε σχεδία-
ση), θα παρουσιάσουμε στη συνέχεια, περιληπτικά, δύο από τα πιο διαδεδομένα και 
προσφιλή στο χώρο των γραφιστών προγράμματα, το CorelDraw και το Illustrator. 
Φυσικά, εκτός από τα δύο αυτά προγράμματα υπάρχουν και πολλά άλλα ακόμη που, 
παρά τις μικροδιαφορές στην εφαρμογή τους, προσφέρουν ανάλογες δυνατότητες.

CorelDraw

To CorelDraw είναι ένα εξαιρετικά δημιουργικό πρόγραμμα σχεδίασης (Εικόνα 
7.6). Θεωρείται το ψηφιακό ισοδύναμο των μολυβιών, ραπιτογράφων, παραλληλο-
γράφων, στένσιλ οργάνων που χρησιμοποιούνται σε ένα σχεδιαστήριο. Για τα σχε-
διαστικά αυτά όργανα μπορούμε να παραδεχθούμε ότι ο τρόπος χρήσης τους είναι, 
γενικά, απλός και εύκολα αντιληπτός. Για παράδειγμα, ο τρόπος λειτουργίας ενός 
μολυβιού είναι προφανής. To Corel, βέβαια, διαχειρίζεται τα εργαλεία αυτά με ένα 
διαφορετικό τρόπο - μέσω εντολών και της χρήσης του ποντικιού - που, όμως, μας 
δίνει τη δυνατότητα να σχεδιάσουμε δημιουργικά στην οθόνη μας χωρίς ιδιαίτερη 
δυσκολία, σε σύντομο χρόνο και με μηδενικό κόστος.

Εικόνα 7.6:
Ο χώρος εργασίας του Corel
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Απευθύνεται κυρίως σε γραφίστες, καθώς έχει άριστη διαχείριση των χρωμάτων, 
διαθέτει εύκολο χειρισμό των σχημάτων και πάρα πολλά εφέ και δυνατότητες εκτύ-
πωσης τετραχρωμίας.

Χρησιμοποιείται κυρίως για σχήματα στις δύο διαστάσεις, γιατί οι ικανότητές του 
στην τρισδιάστατη σχεδίαση είναι περιορισμένες. Μπορεί να αποδώσει ικανοποιη-
τικά την αίσθηση της προοπτικής. Η ακρίβεια που διαθέτει είναι μέτρια, το ίδιο και 
τα βοηθήματα για την ακριβή σχεδίαση. Χαρακτηριστικό του είναι ότι στο βασικό 
πακέτο περιλαμβάνονται πολλά βοηθητικά προγράμματα, που δημιουργούν ένα 
πλήρες σύνολο για το ηλεκτρονικό σχεδιαστικό γραφείο.

Illustrator

Το πρόγραμμα αυτό κινείται σε ανάλογους με το CorelDraw χώρους (Εικόνα 7.7). 
Απευθύνεται κατεξοχήν στους γραφίστες. Διαθέτει ένα πλήρες σετ εργαλείων για 
τη δημιουργία μακετών. Διαθέτει επίσης πολλά εφέ σχημάτων και γραμμάτων. Με 
την προοπτική και εδώ μπορεί να δοθεί η αίσθηση των τριών διαστάσεων, με ανά-
λογα του CorelDraw αποτελέσματα.

Εικόνα 7.7: Ο χώρος εργασίας του Illustrator.

Το μεγάλο πλεονέκτημα του προγράμματος είναι τα εργαλεία που διαθέτει. Οι ερ-
γαλειοθήκες του είναι πλήρεις και μπορούν να προσαρμοστούν στις ανάγκες κάθε 
χρήστη. Ενδεικτικά, μόνο για την επιλογή των αντικειμένων διαθέτει πέντε διαφο-
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ρετικά εργαλεία. Βέβαια, και τα άλλα προγράμματα διαθέτουν παρόμοιες εντολές 
και εργαλεία, αλλά ο τρόπος που αυτά λειτουργούν στο Illustrator θεωρείται από 
πολλούς αρτιότερος και απλούστερος.

Κάνει άριστη διαχείριση των χρωμάτων και επιτρέπει στο χρήστη, με ελάχιστες κι-
νήσεις, να χρωματίσει περιοχές του θέματός του με όποιον τρόπο θέλει. Ακόμη, 
διαθέτει πλήθος από χρωματικά φίλτρα, με τα οποία μπορούν να γίνουν διάφορα 
εφέ. Η συνεργασία του με το Photoshop είναι άριστη. Σχετικά, δέχεται την απευθεί-
ας εισαγωγή ψηφιοποιημένων εικόνων του Photoshop και διαθέτει φίλτρα για την 
επεξεργασία τους.

Η διαχείριση των κειμένων στο Illustrator είναι παρόμοια του Corel. Και τα δύο 
προγράμματα μπορούν να επεξεργαστούν με επάρκεια πολύστηλα κείμενα, με φω-
τογραφίες και λεζάντες, στις οποίες έχουν γίνει διάφορα εφέ.

Ανακεφαλαίωση 7ου Κεφαλαίου

Τα προγράμματα διανυσματικής σχεδίασης είναι προσανατολισμένα κυρίως 
στην ηλεκτρονική σχεδίαση σε αντίθεση με τα ψηφιογραφικά, που προσφέρο-
νται για την ηλεκτρονική επεξεργασία ψηφιοποιημένων εικόνων.
Κάθε σχήμα μπορεί να αναλυθεί σε ένα σύνολο γραμμών, π.χ. ευθειών, καμπυ-
λών, κύκλων, παραλληλογράμμων.
Τα διανυσματικά προγράμματα αξιοποιούν αυτό το γεγονός και προσφέρουν 
πολλές δυνατότητες στον τελικό χρήστη, όπως την ευκολία τροποποίησης των 
χαρακτηριστικών των σχημάτων ή γραμμάτων. Συνεπάγονται επίσης αρχεία μι-
κρού μεγέθους, που μπορούν να τυπωθούν στη μέγιστη ανάλυση του εκτυπωτή.
Τα προγράμματα αυτά χωρίζονται σε δύο μεγάλες κατηγορίες, αυτά που απευ-
θύνονται στους γραφίστες με κυριότερους εκπροσώπους το CorelDraw και το 
Illustrator και αυτά που απευθύνονται στους μηχανικούς και στους σχεδια-
στές εσωτερικών χώρων, με κυριότερο εκπρόσωπο το AutoCAD. Πέρα από αυτά 
υπάρχουν πολλά άλλα προγράμματα, που χρησιμοποιούνται για πιο εξειδικευ-
μένες εργασίες.
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Ασκήσεις 7ου Κεφαλαίου

1.	 Ποια είναι τα κύρια χαρακτηριστικά των προγραμμάτων ηλεκτρονικής σχεδίασης;

2.	� Γιατί οι διανυσματικές εικόνες απαιτούν μικρότερο χώρο στο σκληρό δίσκο από 

τις χαρτογραφικές;

3.	� Ποια είναι η αρχή σχεδίασης στα διανυσματικά προγράμματα και ποια στα ψη-

φιογραφικά;

Δραστηριότητες 7ου Κεφαλαίου

1. �Υπάρχουν πολλά σχεδιαστικά προγράμματα με μεγαλύτερη εξειδίκευση. Για πα-

ράδειγμα, μια κατηγορία είναι αυτή που δημιουργεί τρισδιάστατα κείμενα με διά-

φορες υφές και φωτορεαλισμό. Για όποιον θέλει να πάρει μια γεύση από τα προ-

γράμματα αυτά, μία καλή διεύθυνση στο διαδίκτυο είναι η http://tucows.otenet.gr. 

Εκεί υπάρχουν διάφορα προγράμματα, τα οποία μπορούν να αντιγραφούν και να 

εγκατασταθούν στον υπολογιστή μας. Τα προγράμματα αυτά έχουν αξιολογηθεί 

από τους υπεύθυνους του site και έχουν βαθμολογηθεί ανάλογα, με το πλήθος 

των συμβόλων της αγελαδίτσας που έχουν στο πλάι τους. Υπάρχει ακόμα ένας 

δείκτης ο οποίος υποδεικνύει αν κάποιος μπορεί να τα χρησιμοποιήσει ελεύθερα 

ή όχι. Αναλυτικότερα αυτοί οι χαρακτηρισμοί σημαίνουν:

-	� Freeware είναι πρόγραμμα κάποιας εταιρείας, που δίνεται ελεύθερο προς 

χρήση κάτω από τις συνθήκες που επιτρέπει αυτή, που συνήθως είναι η προ-

σωπική χρήση μόνο. Οι εταιρείες που θα το χρησιμοποιήσουν για κάποιο 

εμπορικό σκοπό, πρέπει να πληρώσουν ένα αντίτιμο.

-	� Public Domain Software είναι προγράμματα που δεν ανήκουν σε κανέναν. 

Τοποθετήθηκαν στη διεύθυνση που βρίσκονται από τους δημιουργούς τους 

για δημόσια χρήση. Δεν υπάρχει κανένα copyright και μπορεί να τα χρησιμο-

ποιήσει οποιοσδήποτε για όποιον σκοπό θέλει.

-	� Shareware είναι προγράμματα που, συνήθως, είναι καταξιωμένα. Είναι ελεύ-

θερα στη χρήση τους για κάποιο περιορισμένο χρονικό διάστημα. Αν σας ικα-

νοποιούν και θέλετε να συνεχίσετε να τα χρησιμοποιείτε και μετά το χρονι-

κό αυτό διάστημα, πρέπει να τα αγοράσετε. Ταυτόχρονα, συμπληρώνετε και 

στέλνετε στην εταιρία που τα διαθέτει μία φόρμα εγγραφής, με την οποία 

εξασφαλίζεται τεχνική υποστήριξη και δωρεάν αναβαθμίσεις.
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-	� Cripple ware είναι μια shareware ή demo έκδοση ενός εμπορικά πετυχη-
μένου προγράμματος. Η λειτουργία του συνήθως σταματάει όταν περάσει η 
δωρεάν περίοδος χρήσης, εκτός και αν δηλώσετε τη χρήση του (αγοράζοντάς 
το). Μερικές φορές είναι κλειδωμένες βασικές εντολές, όπως η αποθήκευση 
της εργασίας ή η λειτουργία του απενεργοποιείται αυτόματα, μετά από έναν 
αριθμό εκτελέσεων του προγράμματος.

Συνδεθείτε λοιπόν με το διαδίκτυο στη διεύθυνση http://tucows.otenet.gr και προ-
σπαθήστε, με τη βοήθεια των καθηγητών σας, να κατεβάσετε και να εγκαταστήσετε 
ένα πρόγραμμα της επιλογής σας.

Σχετικές ηλεκτρονικές διευθύνσεις

Για ομάδες συζητήσεων, ιδέες, εφαρμογές στα γνωστότερα προγράμματα διανυ-
σματικής σχεδίασης:
www.planetpdf.com
http://users.belgacom.net/prepresspanic
www.corel.com
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Κεφάλαιο 8ο
Χρήση τεχνικών ακριβούς σχεδίασης

Στόχοι:

Με τη μελέτη αυτού του κεφαλαίου οι μαθητές θα είναι σε θέση να:

	 •	� Γνωρίσουν το χώρο εργασίας των σχεδιαστικών προγραμμάτων.

	 •	 �Κατανοήσουν τις βασικές τεχνικές και τα εργαλεία της ψηφιακής σχε-
δίασης.

	 •	 �Γνωρίσουν τις παραμέτρους ακριβούς ψηφιακής σχεδίασης.

8.1. Εισαγωγή

Στο περιβάλλον εργασίας των προγραμμάτων επεξεργασίας διανυσματικών εικό-
νων αναφερθήκαμε και σε προηγούμενο κεφάλαιο.
Στο κεφάλαιο αυτό θα περιγράψουμε με περισσότερες λεπτομέρειες την επιφάνεια 
εργασίας των σχεδιαστικών προγραμμάτων και τις παραμέτρους που πρέπει να κα-
θορίσουμε για μια ακριβή σχεδίαση. Στόχος μας είναι να δώσουμε μια συνοπτική 
άποψη της διαμόρφωσης και των δυνατοτήτων των σχετικών προγραμμάτων, κα-
θώς και των διάφορων εργαλείων που αυτά χρησιμοποιούν.

Οι τεχνικές που παρουσιάζονται στο κεφάλαιο αυτό, καλό είναι να εφαρμόζονται σε 
κάθε νέο σχέδιο. Σκοπός τους είναι να βελτιώσουν την ακρίβεια στη σχεδίαση και 
ταυτόχρονα να διευκολύνουν το χειρισμό των εργαλείων σχεδιασμού.

8.2. Η εκκίνηση του προγράμματος

Η εκκίνηση των σχεδιαστικών προγραμμάτων γίνεται με τον ίδιο τρόπο, όπως σε όλες 
τις εφαρμογές των Windows, δηλαδή από το αντίστοιχο εικονίδιο – αν υπάρχει – στην 
επιφάνεια εργασίας ή από τη σχετική εντολή του μενού Προγράμματα. Αν θεωρήσουμε, 
για παράδειγμα, το πρόγραμμα Corel, στο οποίο αναφερθήκαμε και προηγούμενα, η 
ενεργοποίησή του έχει ως συνέπεια να εμφανισθεί στην οθόνη το μενού της Εικόνας 8.1.
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Εικόνα 8.1: Το εισαγωγικό 
μενού επιλογών. Με μία αρχική 
ρύθμιση, κάτω αριστερά, 
μπορούμε να το παρακάμ-
ψουμε και το πρόγραμμα να 
εκκινήσει με την επιφάνεια 
εργασίας.

Όταν επιλέξουμε με το ποντίκι ένα από τα εικονίδια που σημειώνονται επάνω στο 
μενού, ενεργοποιείται η αντίστοιχη εντολή. Έτσι, με το Νέα Εργασία (New Graphic) 
γίνεται η εκκίνηση ενός νέου σχεδίου με το Τελευταία Εργασία (Open Last Edited) 
ανοίγει το τελευταίο σχέδιο που ήταν ενεργοποιημένο, με το Άνοιγμα Εργασίας (Open 
Graphic) ανοίγει μια οποιαδήποτε εργασία που υπάρχει στο σκληρό δίσκο σαν αρχείο 
CDR, με το Άνοιγμα Πρότυπου (Open Template) ανοίγει ένα από τα πρότυπα που δια-
θέτει το πρόγραμμα. Ενδιαφέρον έχουν και τα άλλα δύο εικονίδια. Με το πρώτο από 
αυτά (CorelTutor) εκκινεί ένα πρόγραμμα αυτοδιδασκαλίας (συνήθως για προχωρη-
μένους χρήστες), ενώ με το τελευταίο (What’s new?) ξεκινάει μία ενημέρωση για τις 
νέες δυνατότητες της συγκεκριμένης έκδοσης του προγράμματος. Συνήθως, αυτές τις 
δύο εντολές τις συναντάμε σε όλες τις εφαρμογές του υπολογιστή.

Μετά την έναρξη του προγράμματος, (Εικόνα 8.2), εμφανίζεται η επιφάνεια εργα-
σίας, το «ηλεκτρονικό σχεδιαστήριο» μας, με τα εξής διακριτά τμήματα στην οθόνη:

•	 �Η γραμμή του τίτλου.

•	 �Βασικό μενού εντολών.

•	 �Οι εργαλειοθήκες με τα εικονίδια. Όταν ο δείκτης του ποντικιού βρεθεί 
επάνω από κάποιο από αυτά, τότε εμφανίζεται ένα πλαίσιο με μια σύντο-
μη επεξήγηση της λειτουργίας του (balloon help).

•	 �Η γραμμή κατάστασης, στην οποία εμφανίζονται διάφορες χρήσιμες 
πληροφορίες για την κατάσταση του προς επεξεργασία θέματος και του 
συστήματος.

•	 �Η οριζόντια και κατακόρυφη γραμμή κύλισης. Με αυτές μπορούμε να εμ-
φανίσουμε το τμήμα που μας ενδιαφέρει από ένα σχέδιο που δε χωράει 
ολόκληρο στην οθόνη.
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Ο χώρος εργασίας, όπως γνωρίζουμε, μπορεί να τροποποιηθεί, ώστε ο κάθε χρή-
στης να τον προσαρμόζει όπως τον εξυπηρετεί ή όπως του αρέσει περισσότερο. Σε 
γενικές γραμμές:

Στο επάνω τμήμα της οθόνης βρίσκεται η μπλε γραμμή τίτλου, που εμφανίζει το όνομα 
του προγράμματος το οποίο εκτελείται και το όνομα του προς επεξεργασία αρχείου.

Κάτω ακριβώς βρίσκεται το βασικό μενού εντολών (menu bar). Κάθε φορά που 
επιλέγεται μια εντολή, αναδιπλώνεται η λίστα που περιέχει ένα σύνολο ομοειδών 
εντολών. Όταν υπάρχει ένα βέλος δίπλα από κάποια εντολή, τότε ακολουθεί μια νέα 
λίστα. Αν υπάρχουν αποσιωπητικά, οδηγεί σε κάποιο διαλογικό παράθυρο εντολών.

Σχήμα 8.2: Τα κυριότερα χαρακτηριστικά του χώρου εργασίας. Το πλαίσιο στο κέντρο της επιφά-
νειας εργασίας συμβολίζει το χαρτί σχεδίασης με τις διαστάσεις που έχουμε επιλέξει. Στο κάτω 
μέρος της οθόνης ευρίσκεται η γραμμή κατάστασης που εμφανίζει πληροφορίες σχετικές με κά-
ποιο επιλεγμένο αντικείμενο που έχουμε σχεδιάσει.

Κάτω από τις εντολές υπάρχει η ζώνη με τα πλήκτρα εντολών (standard toolbar). 
Η ζώνη αυτή με τα σημαντικότερα εργαλεία πρέπει να υπάρχει πάντα, ώστε να συ-
ντομεύονται οι βασικές εργασίες, όπως το άνοιγμα των αρχείων κτλ. Οι εργασίες 
γίνονται με επιλογή του αντίστοιχου εικονιδίου, στα οποία η απεικόνιση προσπαθεί 
να «περιγράψει» την εντολή που κατά περίπτωση εκτελείται. Για παράδειγμα, το 
εικονίδιο που έχει μορφή δισκέτας όταν επιλεγεί αποθηκεύει την εργασία μας.
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Κάτω από τα πλήκτρα εντολών υπάρχει η ζώνη των ιδιοτήτων των αντικειμένων. 

Είναι εξαιρετικά χρήσιμη, όταν τροποποιούνται διάφορες ομάδες αντικειμένων.

Αριστερά υπάρχει η βασική εργαλειοθήκη με τα κύρια εργαλεία σχεδίασης. Με τις 

εργαλειοθήκες, που ο χρηστής μπορεί να τις μετακινήσει οπουδήποτε στην οθόνη, 

εκτελούνται πλήθος εντολών. Στην ουσία, κάθε εικονίδιό τους αντιστοιχεί σε μία 

εντολή σχεδίασης.

Στο δεξί μέρος της οθόνης βρίσκεται η παλέτα των χρωμάτων. Η επιλογή ενός χρώ-

ματος γίνεται με το πάτημα πάνω του με το ποντίκι. Το επιλεγμένο αντικείμενο 

αποκτάει γέμισμα με το χρώμα. Ο χρωματισμός των γραμμών γίνεται με πάτημα με 

το δεξί πλήκτρο του ποντικιού.

Οι εργαλειοθήκες (toolbars), που προσφέρονται για χρήση είναι πολλές. Επιλέγο-

ντας με το ποντίκι, από το μενού Παράθυρο>Εργαλειοθήκες (Window>Toolbars), 

εμφανίζεται ένας κατάλογος με τις διάφορες εργαλειοθήκες. Όσες έχουν ένα ''v'' 

αριστερά από το όνομά τους είναι ενεργές και ορατές στην οθόνη. Για την εμφάνιση 

οποιασδήποτε άλλης αρκεί η επιλογή του ονόματός της.

Η περιοχή σχεδίασης αποτελεί το μεγαλύτερο μέρος της οθόνης. Στο κέντρο της 

οθόνης υπάρχει η σελίδα σχεδίασης με την σκίαση πίσω της. Μπορεί να γίνει σχεδία-

ση οπουδήποτε στην οθόνη αλλά μόνο η περιοχή της σελίδας σχεδίασης θα τυπω-

θεί. Συχνά είναι βολικό να σχεδιάζουμε στο χώρο εκτός της σελίδας. Για παράδειγ-

μα, πολλές φορές κάνουμε ένα μεγάλο και πολύπλοκο αντικείμενο και μετά γίνεται 

η κατάλληλη σμίκρυνση για να χωρέσει στην σελίδα.

Για την επιλογή κάποιου εργαλείου της εργαλειοθήκης αρκεί να οδηγηθεί ο δείκτης 

του ποντικιού πάνω από το αντίστοιχο εικονίδιο και να το ενεργοποιήσουμε. Σε ορι-

σμένες περιπτώσεις αλλάζει και ο δείκτης του ποντικιού, συμβολίζοντας το επιλεγέν 

εργαλείο. Το ίδιο συμβαίνει και με την παλέτα των χρωμάτων, είναι ο πιο εύκολος 

τρόπος για να επιλέξουμε κάποιο χρώμα από αυτήν, με το ποντίκι, αρκεί να υπάρχει 

φυσικά το χρώμα που θέλουμε.

Στο κάτω μέρος της οθόνης υπάρχει η γραμμή κατάστασης (status bar), όπου οι 

εμφανιζόμενες ενδείξεις μας πληροφορούν για τις διαστάσεις του σχήματος ή των 

σχημάτων που είναι επιλεγμένα, το επίπεδο που βρίσκονται, ενώ στο αριστερό 

μέρος εμφανίζονται οι συντεταγμένες της τρέχουσας θέσης του σταυρονήματος κα-

θώς αυτό κινείται στη σχεδιαστική επιφάνεια.
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8.3 Η οργάνωση της εργασίας

Η πρώτη εργασία που γίνεται συνήθως, είναι ο καθορισμός των ιδιοτήτων της σε-
λίδας. Αυτό γίνεται συνήθως με την εντολή Διαμόρφωση Σελίδας (Layout>Page 
Setup...). (Εικόνα 8.3). Εκεί καθορίζονται βασικά χαρακτηριστικά της σελίδας, όπως 
το μέγεθος, ο προσανατολισμός, το χρώμα του φόντου κτλ. Η διαμόρφωση είναι μια 
από τις αρχικές εργασίες, καθώς η εκ των υστέρων αλλαγή των χαρακτηριστικών 
της σελίδας μπορεί να δημιουργήσει προβλήματα στις εκτυπωτικές εργασίες.

•	� Στην επιλογή Χαρτί (Paper) μπορούμε να καθορίσουμε ένα τυποποιημέ-
νο μέγεθος του χαρτιού σαν το Α4 που χρησιμοποιείται συχνά. Τίποτα 
όμως δεν μας εμποδίζει να επιλέξουμε οποιεσδήποτε διαστάσεις θέλου-
με. Αυτό γίνεται από τις επιλογές Πλάτος (Width) και Ύψος (Height).

•	� Ο προσανατολισμός μπορεί να είναι κάθετος ή οριζόντιος. Στην πρώτη πε-
ρίπτωση η μικρή διάσταση της σελίδας είναι στο επάνω μέρος, όπως την 
κοιτάζουμε. Στη δεύτερη στο επάνω μέρος βρίσκεται η μεγάλη διάσταση.

Εικόνα 8.3:
Η διαμόρφωση της 
σελίδας πρέπει να 
γίνεται στην αρχή 
των εργασιών.

Αφού γίνουν αυτές οι εργασίες καλό είναι να ακολουθήσει η αποθήκευσή της. Η 
διαδικασία είναι απλή. Γίνεται με την εντολή Αποθήκευση (Save) από το μενού Αρ-
χείο (File). Την πρώτη φορά που θα γίνει η αποθήκευση απαιτείται κάποιο όνομα 
που πρέπει να είναι μοναδικό. Το όνομα αυτό εμφανίζεται στην ζώνη τίτλου, δίπλα 
από το όνομα του προγράμματος, κάθε φορά που επεξεργαζόμαστε το αντίστοιχο 
σχέδιο. Σε κάθε προσθήκη ή αλλαγή που γίνεται στο σχέδιο θα πρέπει να γίνε-
ται επανάληψη της διαδικασίας αποθήκευσης, γιατί αλλιώς αυτές χάνονται. Ένας 
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απρόβλεπτος τερματισμός της λειτουργίας του προγράμματος ή του υπολογιστή (π.χ. 

διακοπή ρεύματος) συνεπάγεται απώλεια της μη αποθηκευμένης εργασίας μας.

Θα πρέπει να συνηθίσουμε κατά την εκτέλεση κάποιας εργασίας να αποθηκεύουμε 

τα διάφορα στάδιά της. Για παράδειγμα, στη δημιουργία μιας κάρτας επισκεπτηρί-

ου, όπου υπάρχουν κείμενο και γραφικά, μπορούμε το αρχείο που αντιστοιχεί στην 

ολοκλήρωση των κειμένων να το αποθηκεύσουμε σαν karta1, με την προσθήκη του 

λογότυπου να το αποθηκεύσουμε και πάλι σαν karta2 και την τελική εργασία να την 

αποθηκεύσουμε σαν kartateliki. Έτσι, δε χάνεται κανένα ενδιάμεσο στάδιο και, αν 

αλλάξουμε γνώμη για το εικαστικό τμήμα της, μπορούμε να μεταβούμε εύκολα σε 

ένα από τα προηγούμενα στάδια. Η αποθήκευση με νέο όνομα γίνεται από τον κατά-

λογο Αρχείο με την εντολή Αποθήκευση Ως... (Save As...) όπου, σε σχετική ερώτηση 

του υπολογιστή, δίνεται το νέο όνομα του αρχείου. Να αναφέρουμε εδώ, ότι στην πε-

ρίπτωση που θα ενσωματώσουμε το γραφικό μας σε σελίδα κάποιου προγράμματος 

σελιδοποίησης, στο τέλος και ανεξάρτητα από την αποθήκευση, θα πρέπει να αποθη-

κεύσουμε την εικόνα μας με την εντολή Αρχείο > Εξαγωγή (File > Export...) επιλέγο-

ντας μορφή αρχείου συμβατή με τα προγράμματα ηλεκτρονικής τυπογραφίας.

8.4 Έλξη στον κάνναβο

Όταν ο βασικός χειρισμός των εντολών και των σχεδιαστικών εργαλείων γίνεται με 

το ποντίκι απαιτούνται κάποια βοηθήματα για την ακριβή σχεδίαση. Δύο βοηθή-

ματα που χρησιμοποιούνται από σχεδόν όλα τα σχεδιαστικά προγράμματα είναι ο 

κάναβος ή πλέγμα (grid) και οι γραμμές – οδηγοί (guides). Δουλεύουν σαν αόρατοι 

μαγνήτες στην οθόνη και διευκολύνουν την τοποθέτηση ενός επιλεγμένου αντικει-

μένου σε μια οριζόντια ή κατακόρυφη θέση ή και τα δύο.

Η έλξη στον κάνναβο, είναι μία ρύθμιση του προγράμματος, που αναγκάζει τα αντι-

κείμενα που σχεδιάζουμε να έλκονται από την γραμμή του κάνναβου που είναι πλησι-

έστερα στο αντικείμενο. Αυτό διευκολύνει την στοίχιση, αν χρειάζεται, των σχημάτων.

Πριν την διαδικασία διαμόρφωσης μιας σελίδας οι γραμμές του κάνναβου και των 

οδηγών σχεδιάζονται για να λειτουργήσουν όλοι μαζί, ως οδηγοί. Περιγράφουν το 

χώρο όπου θα αναπτυχθούν τα στοιχεία της σύνθεσης, τις διαστάσεις των περιθω-

ρίων, τον αριθμό των στηλών και τις θέσεις των εικόνων.
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Η επιλογή της εντολής Εμφάνιση> Κάνναβος (View> Grid) από τον αναδιπλού-
μενο κατάλογο στο μενού των εντολών εμφανίζει τελείες στην οθόνη. Δεν τυπώ-
νονται στο χαρτί, υπάρχουν στην οθόνη μόνο ως σημεία αναφοράς. Οι ρυθμίσεις 
του πλέγματος γίνονται από το μενού Εργαλεία>Επιλογές...>Κάνναβος (Tools> 
Options...>Grid) (Εικόνα 8.4). Με την εντολή Έλξη στον κάνναβο (Snap to Grid) 
οι συντεταγμένες του πλέγματος ενεργούν σα μαγνήτες που τραβούν το δρομέα 
του ποντικιού την ώρα της σχεδίασης. Η πυκνότητα του πλέγματος είναι μεταβλη-
τή. Στα πεδία εγγραφής καθορίζουμε πόσες τελείες θα υπάρχουν ανά μονάδα μέ-
τρησης μήκους. Η επιλογή θα πρέπει να είναι μελετημένη, καθώς ιδιαίτερα πυκνό 
πλέγμα δεν είναι πρακτικό μια και προσφέρει έλξη σε πολλά σημεία, ενώ αντίθετα, 
το πολύ αραιό πλέγμα είναι δύσχρηστο και αναγκάζει σε συχνή απενεργοποίηση 
της εντολής.

Εικόνα 8.4:
Από τον κατάλογο 
Tools>Options…>Grid 
μπορούμε να καθορί-
σουμε την πυκνότητα 
του πλέγματος.

8.5 Τα βοηθητικά εργαλεία της σχεδίασης

Χάρακες: Όλα σχεδόν τα σχεδιαστικά προγράμματα έχουν δύο χάρακες (rulers), 
έναν οριζόντιο, που βρίσκεται πάνω από το χώρο σχεδίασης και έναν κατακόρυφο, 
που βρίσκεται στο αριστερό μέρος του. Ο λόγος είναι ότι, κάθε σχήμα που σχεδιάζε-
ται θεωρείται μια ξεχωριστή οντότητα, η οποία θα τοποθετηθεί «κάπου» στο χαρτί. 
Η διαφορά μεταξύ ηλεκτρονικής και σχεδίασης με το χέρι είναι ότι με τη δεύτερη 
αυτό το «κάπου» είναι σταθερό, αμετάβλητο. Με την ηλεκτρονική σχεδίαση όμως 
κάθε αντικείμενο ή ομάδα αντικειμένων μπορεί να τοποθετηθεί σε άλλο σημείο, αν 
απαιτηθεί κάτι τέτοιο.
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Επομένως, οι χάρακες αλλά και οι γραμμές - οδηγοί αποκτούν ξεχωριστό ενδιαφέ-
ρον. Τους αρχάριους χρήστες τους ξενίζει το γεγονός ότι οι μονάδες μέτρησης στην 
οθόνη του υπολογιστή εμφανίζονται διαφορετικές (συνήθως μεγαλύτερες) από ό,τι 
στην πραγματικότητα. Αν επιχειρήσουμε να μετρήσουμε μια μονάδα μήκους (π.χ. ένα 
εκατοστό) στον χάρακα του προγράμματος με ένα πραγματικό, θα διαπιστώσουμε ότι 
δεν ταυτίζονται. Αυτό συμβαίνει γιατί στην ουσία δε χρησιμοποιείται ποτέ η κλίμακα 
1:1. Όταν ένα αντικείμενο στην οθόνη έχει μεγεθυνθεί, οι διαστάσεις του είναι μεγα-
λύτερες από τις φυσικές. Η εμφάνιση των χαράκων, λοιπόν, βοηθάει στο να γνωρί-
ζουμε τις φυσικές διαστάσεις και αποστάσεις των αντικειμένων της οθόνης.

Η αρχή των αξόνων μπορεί να μην είναι κοινή σε όλα τα προγράμματα. Οι συντε-
ταγμένες (0,0) στο CorelDraw είναι στο κάτω αριστερό άκρο της σελίδας. Μπορεί 
να μεταφερθεί το σημείο αρχής των αξόνων σε οποιοδήποτε σημείο της σελίδας, 
επιλέγοντας το σημείο τομής του οριζόντιου με τον κάθετο χάρακα και με το πλή-
κτρο πατημένο κινώντας το ποντίκι στο επιθυμητό σημείο. Στην Εικόνα 8.5 γίνεται 
μεταφορά της αρχής των αξόνων στην κορυφή κάποιου παραλληλόγραμμου.

Εικόνα 8.5:
Η αρχή των 
αξόνων μεταφέρεται 
σε οποιοδήποτε
σημείο του σχεδίου.

Οι μονάδες μέτρησης τώρα αναγράφονται στους κανόνες, οι δε αριθμοί που βλέπου-
με αντιστοιχούν στις αποστάσεις των σημείων από την αρχή των αξόνων (0,0). Οι 
μονάδες μέτρησης, αν δεν είναι, μετατρέπονται στο μετρικό σύστημα με τις εντολές 
από τον αναδιπλούμενο κατάλογο εντολών Εμφάνιση (View), Πλέγμα (Grid) και 
Καθορισμός Χαράκων (Ruler Setup...). Εμφανίζεται το αντίστοιχο διαλογικό πλαί-
σιο, όπου στην περιοχή Μονάδες (Units) μπορούμε να προσδιορίσουμε τις μονάδες 
μέτρησης των κανόνων που επιθυμούμε.
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Γραμμές Οδηγοί: Οι προσαρμοσμένες γραμμές - οδηγοί είναι μη εκτυπώσιμες και 
χρησιμοποιούνται όχι μόνο για την έλξη, αλλά και για την στοίχιση του δρομέα σε 
συγκεκριμένα σημεία. Είναι τριών ειδών, οι οριζόντιοι, οι διαγώνιοι και οι κατα-
κόρυφοι. Η εισαγωγή ενός οριζόντιου οδηγού γίνεται με επιλογή και σύρσιμο του 
ποντικιού στο χάρακα και τη μεταφορά του στο επιθυμητό σημείο της επιφάνειας 
εργασίας. Οι κατακόρυφοι οδηγοί δημιουργούνται με τον ίδιο τρόπο, όπως οι ορι-
ζόντιοι, με επιλογή και σύρσιμο όμως, από τον κατακόρυφο άξονα. Στην Εικόνα 8.6 
βλέπουμε δύο κάθετους και έναν οριζόντιο οδηγό. Η ενεργοποίηση της έλξης γίνεται 
από την εντολή Έλξης (Snap to Guidelines) του καταλόγου Προβολής (View). Πρό-
σθετες ιδιότητες των οδηγών μπορούν να ρυθμιστούν από τις επιλογές της εντολής 
Επιλογών (Options) (Εικόνα 8.7) που βρίσκεται στο μενού των εργαλείων. Η χρήση 
τους είναι συμπληρωματική του χάρακα αλλά και του καννάβου.

Εικόνα 8.7: 
Από τον 
κατάλογο 
Options 
μπορούν να 
καθοριστούν οι 
λεπτομέρειες 
για τους 
οδηγούς, αν σε 
έναν οριζόντιο 
δοθεί κλίση 
γίνεται 
αυτόματα 
διαγώνιος.

Εικόνα 8.6: 
Με τη χρήση της έλξης στους οδηγούς 
ευκολύνεται η σχεδίαση.

24-0151 Book.indb   11824-0151 Book.indb   118 27/10/2021   12:17:28 µµ27/10/2021   12:17:28 µµ



119

Χ Ρ Η Σ Η  Τ Ε Χ Ν Ι Κ Ω Ν  Α Κ Ρ Ι Β Ο Υ Σ  Σ Χ Ε Δ Ι Α Σ Η Σ

8.6 Η έλξη στα αντικείμενα

Έλξη στα αντικείμενα. Η έλξη στα αντικείμενα είναι, επίσης, μια λειτουργία εξί-
σου εύκολη και αποδοτική στα σχεδιαστικά προγράμματα, όπως και η έλξη στον 
κάνναβο. Ενεργοποιείται με παρόμοιο τρόπο και έλκει το δρομέα πάνω σε κάποιο 
αντικείμενο. Πέρα από αυτές υπάρχουν και άλλα είδη έλξεων τα οποία χρησιμοποι-
ούνται λιγότερο. 
Στήσιμο σελίδας – Ομοιομορφία έκδοσης: Ένα έντυπο τώρα, που χρησιμοποιεί και 
πλέγμα αλλά και γραμμές – οδηγούς, θυμίζει λίγο πολύ έναν τοίχο που χτίζεται. Ο 
γραφίστας δεν έχει παρά να πάρει κάθε αντικείμενο της σελίδας και να το βάλει στη 
σωστή του θέση – όπως ο χτίστης κάθε τούβλο στον τοίχο – συμπληρώνοντας έτσι 
το «πάζλ» της σελίδας. Στην Εικόνα 8.8 βλέπουμε το στήσιμο μιας σελίδας, όπου οι 
οδηγοί έχουν μεγάλη σημασία, καθώς φέρνουν σε μια ομοιομορφία όλη την έκδοση.

Κουτί φωτογραφίας

Τίτλος

Υπότιτλος

Κυρίως κείμενο

Κουτί επεξηγήσεων

Υποσέλιδο

Αρχίγραμμα

Εικόνα 8.8: Η δομή μιας τυπικής σελίδας εντύπου. Αν όλα τα στοιχεία των σελίδων ευθυγραμμι-
σθούν στους οδηγούς, που είναι σταθεροί σε όλη την έκδοση, επιτυγχάνεται ομοιομορφία.
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Ας δούμε τη σελίδα της Εικόνας 8.8. Η σελίδα αυτή περιέχει κάποια βασικά δομικά 

στοιχεία. Στα στοιχεία αυτά, που σημειώνονται επάνω στην εικόνα, αξίζει να ανα-

φερθούμε με συντομία, εφόσον τα συναντάμε συχνά σε ανάλογες εργασίες:

•	� Τίτλος: Στη θέση αυτή σημειώνεται ο τίτλος του άρθρου. Συνήθως, έχει 

σταθερές αναλογίες οι οποίες διατηρούνται με αυξομείωση του μεγέ-

θους των γραμμάτων.

•	� Υπότιτλος: Εδώ γράφεται μια επιγραμματική περίληψη – αναφορά στα 

περιεχόμενα του άρθρου, για να προκληθεί το ενδιαφέρον του αναγνώ-

στη. Δίνει δηλαδή περισσότερες πληροφορίες από τον τίτλο.

•	� Κουτί επεξηγήσεων: Παρατίθενται διάφορες επεξηγήσεις για το άρθρο. 

Συνήθως επαναλαμβάνεται σε όλες τις σελίδες είτε με επεξηγήσεις είτε 

με κύρια σημεία (hotspots) που κεντρίζουν το ενδιαφέρον.

•	� Κουτί φωτογραφίας: Στη θέση αυτή τοποθετείται κάποιο λογότυπο, το 

οποίο μπορεί να έχει σχέση με το άρθρο, την οργάνωση του εντύπου, την 

εταιρεία που το εκδίδει κλπ.

•	� Υποσέλιδο: Περιλαμβάνει τουλάχιστον την αρίθμηση των σελίδων. Μπο-

ρεί ακόμη να περιλαμβάνει το όνομα του συντάκτη, την ημερομηνία σύ-

νταξης, τον τίτλο κλπ.

•	� Κυρίως κείμενο: Εδώ τοποθετείται το καθαρό κείμενο του συγγραφέα.

•	� Αρχίγραμμα: Είναι το πρώτο γράμμα ολόκληρου του άρθρου, της πρώτης 

παραγράφου κάθε κεφαλαίου και μερικές φορές κάθε παραγράφου. Το 

μέγεθός του συνήθως είναι 2-3 γραμμές.

8.7 Μεγεθύνσεις

Ένα από τα βασικότερα εργαλεία για την ακριβή σχεδίαση είναι αυτό των μεγεθύν-

σεων – σμικρύνσεων. Συνήθως έχει το σχήμα του φακού με το σύμβολο ''+'' όταν 

είναι ενεργοποιημένο για μεγέθυνση και το σύμβολο ''-'' για σμίκρυνση. Με την 

ενεργοποίηση του εργαλείου μεγεθύνσεων και επιλογή με το ποντίκι ενός αντικει-

μένου γίνεται η μεγέθυνσή του στην οθόνη, και μόνο στην οθόνη, κατά 100%. Όσες 

φορές πιέζουμε το ποντίκι, επαναλαμβάνεται η μεγέθυνση. Με τον τρόπο αυτό ένα 

μικρό γράμμα κάλλιστα μπορεί να μεγεθυνθεί και να καταλάβει ολόκληρη την οθό-

νη. Αν τυπωθεί βέβαια στο χαρτί, διατηρεί τις πραγματικές του διαστάσεις.

Έτσι γίνεται κατανοητό αυτό που αναφέρθηκε στο προηγούμενο κεφάλαιο περί κανόνων.
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Οι πραγματικές διαστάσεις ενός αντικειμένου μπορούν να είναι διαφορετικές από 
αυτές που φαίνονται στην οθόνη. Είναι σαν να κοιτάμε μια λεπτομέρεια μιας εικό-
νας με μεγεθυντικό φακό. Μόνον οι ενδείξεις στους κανόνες μπορούν να δώσουν 
την πραγματική απόσταση ή διάσταση.
Αν πατηθεί ταυτόχρονα το πλήκτρο Shift τότε γίνεται σμίκρυνση με ποσοστιαία βή-
ματα των 100% κάθε φορά.
Αν θέλουμε, μπορούμε να μεταβάλλουμε την συμπεριφορά του εργαλείου μεγεθύν-

σεων – σμικρύνσεων επιλέγοντας από το μενού των Εργαλείων (Tools > Options... 
Toolbox > Zoom).
Ενδιαφέρον υπάρχει και στην εξής διαδικασία (Εικόνα 8.9): Αν με ενεργοποιη-
μένο το εργαλείο μεγεθύνσεων, σχεδιασθεί ένα νοητό τετράγωνο γύρω από το 
αντικείμενο, τότε αυτό μεγεθύνεται τόσο, ώστε το νοητό τετράγωνο να καταλάβει 
ολόκληρη την οθόνη.

Εικόνα 8.9: Ο καλύτερος τρόπος μεγέθυνσης γίνεται με το σχεδιασμό ενός νοητού περιγράμμα-
τος γύρω από το αντικείμενο.

Πόσο μεγάλη μπορεί να είναι η μεγέθυνση; Συνήθως όση είναι και η ακρίβεια που 
προσφέρει το πρόγραμμα σχεδίασης. Σε όλα τα προγράμματα υπάρχει μια θυρίδα, 

η οποία δείχνει το ποσοστό της μεγέθυνσης – σμίκρυνσης. Εκεί μπορούμε να ορί-
σουμε αριθμητικά το επιθυμητό ποσοστό μεγέθυνσης ή σμίκρυνσης.

Όλα σχεδόν τα σχεδιαστικά προγράμματα για να ελέγχουν την ταχύτητα επανα-
σχεδίασης της οθόνης προσφέρουν διάφορα είδη προβολών. Οι πιο γνωστές είναι 
η προβολή εκτύπωσης (preview) και η προβολή περιγραμμάτων (outline). Με την 
πρώτη το έγγραφο παρουσιάζεται σε πλήρες χρώμα όπως πρόκειται να εκτυπωθεί 
στον εκτυπωτή, ενώ στη δεύτερη είναι ορατός μόνο ο σκελετός των αντικειμένων, 
δηλαδή χωρίς χρώμα και περίγραμμα. Με τη δεύτερη προβολή είναι ευκολότερη και 
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η επιλογή διαφόρων αντικειμένων. Φυσικά, προσφέρονται και ενδιάμεσες καταστά-
σεις προβολών. Οι εντολές αυτές βρίσκονται στο μενού Προβολή (View).

8.8 Διαστασιολόγηση

Η διαστασιολόγηση είναι ένα πολύ σημαντικό ζήτημα σε όλα τα είδη σχεδίασης, 
ειδικότερα στην τεχνική σχεδίαση: αρχιτεκτονική, μηχανολογική κτλ. Πριν γίνει η 
διαστασιολόγηση το σχέδιο είναι ασαφές και φτωχό σε πληροφορίες. Μόλις όμως 
προστεθούν σε αυτό οι διαστάσεις, εμπλουτίζεται σε πληροφορίες και πολλά σημεία 
του αποσαφηνίζονται. Αποκτούμε αίσθηση του μεγέθους. Φαίνεται αν ταιριάζουν 
μεταξύ τους τα διάφορα επί μέρους αντικείμενα της σχεδίασης ή αν συνεργάζονται 
σωστά. Στα σχεδιαστικά προγράμματα η διαστασιολόγηση έχει και μία ακόμη ση-
μασία, αυτή της πιστοποίησης της ποιότητας (δηλαδή της ορθότητας) των σχεδια-
ζόμενων αντικειμένων. Η διαστασιολόγηση μπορεί να γίνει σε ένα ξεχωριστό (όπως 
θα δούμε αργότερα) επίπεδο, το οποίο να μην είναι εκτυπώσιμο, αλλά να δείχνει 
την ορθότητα των μεγεθών.

Η εισαγωγή διαστάσεων σε ένα σχέδιο γίνεται με την πένα διαστασιολόγησης, που 
επιλέγεται από την εργαλειοθήκη και ανήκει στις πένες σχεδίασης. Συνήθως, στις 
διαστάσεις που εισάγονται υπάρχουν τα εξής στοιχεία (Εικόνα 8.10):

•	� Το κείμενο της διάστασης. Περιλαμβάνει οπωσδήποτε το μήκος ή, γενι-
κά, το μέγεθος της διάστασης. Μπορεί επί πλέον να περιλαμβάνει ανο-
χές, μονάδες μέτρησης ή και κείμενο.

•	� Τη γραμμή της διάστασης. Προσδιορίζει τη μετρούμενη διάσταση. Μπο-
ρεί να είναι μία συνεχής γραμμή που εκτείνεται παράλληλα της διάστα-
σης στην οποία αντιστοιχεί η μέτρηση ή δύο τμήματα γραμμής εκατέρω-
θεν του κειμένου της διάστασης. Και στις δύο περιπτώσεις καταλήγει σε 
δύο σύμβολα τέλους, συνήθως βέλη (έτσι προκύπτει η αγγλική ονομασία 
τους - arrowheads).

•	� Η βοηθητική γραμμή διάστασης. Ενώνει το αντικείμενο που μετριέται 
(την αρχή και το τέλος του) με την αρχή και το τέλος της γραμμής διάστα-
σης, ώστε να φαίνεται με την πρώτη ματιά πού αντιστοιχεί η μέτρηση.
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Εικόνα 8.10: Εργαλειοθήκη διαστασιολόγησης.

Υπάρχουν πολλοί τύποι και τρόποι διαστασιολόγησης. Ο πιο κοινός, που διαθέτουν 
όλα τα προγράμματα, είναι η μέτρηση των ευθυγράμμων τμημάτων.

Προσοχή! Χρειάζεται πρώτα να οριστεί η μονάδα μέτρησης.

Σε πιο εξειδικευμένα προγράμματα μπορούν να ορισθούν μεγέθη όπως η γωνία 
μεταξύ ευθυγράμμων τμημάτων, η ακτίνα κύκλου ή έλλειψης, η διάμετρος, η διά-
σταση συντεταγμένων σημείου κλπ.
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Ανακεφαλαίωση 8ου Κεφαλαίου

Η εκκίνηση των προγραμμάτων γίνεται είτε από την αντίστοιχη εντολή στο 
μενού Έναρξη, είτε από το εικονίδιό τους στην επιφάνεια εργασίας του υπο-
λογιστή.
Ο χώρος εργασίας των σχεδιαστικών προγραμμάτων αποτελείται από το μενού 
εντολών και διάφορες παλέτες εργαλείων. Όταν ενεργοποιείται ένα εργαλείο 
εμφανίζονται οι ιδιότητές του στην γραμμή ιδιοτήτων.
Οι πρώτες εργασίες που πρέπει να γίνουν σε ένα νέο έγγραφο, είναι ο καθορι-
σμός του είδους και του μεγέθους της σελίδας, το πλέγμα και η εμφάνιση των 
κανόνων ώστε να υπάρχει ακρίβεια στο σχεδιασμό και στην τοποθέτηση των 
διαφόρων αντικειμένων πάνω στη σελίδα.
Για τη λεπτομερή σχεδίαση χρησιμοποιείται η δυνατότητα της μεγέθυνσης. Ένα 
οποιοδήποτε αντικείμενο μπορεί να μεγεθυνθεί, θεωρητικά άπειρα, χωρίς να χά-
σει τίποτα από την ποιότητα εκτύπωσης τόσο στην οθόνη, όσο και στον εκτυπωτή.
Τέλος, η διαστασιολόγηση χρησιμοποιείται κυρίως για την πιστοποίηση των με-
γεθών διαφόρων αντικειμένων. Μπορεί να γίνει σε ένα δικό της επίπεδο το 
οποίο να μην είναι εκτυπώσιμο, αλλά να δείχνει την ορθότητα των μεγεθών.
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Ασκήσεις 8ου Κεφαλαίου

1.	 Πόσα είδη έλξης υπάρχουν και σε τι χρησιμεύει κάθε ένα από αυτά;
2.	� Πόσο μπορούν να μεγεθύνουν τα σχεδιαστικά προγράμματα και πώς επηρεάζεται 

η ανάλυση εκτύπωσης (τόσο στην οθόνη όσο και στον εκτυπωτή);

Δραστηριότητες 8ου κεφαλαίου

1.	� Δημιουργήστε ένα νέο σχέδιο με τα εξής χαρακτηριστικά:
- Μέγεθος σελίδας Α4
- Προσανατολισμός πλάγιος.
- Πλέγμα με βήμα κουκκίδας 0,5 εκατοστά οριζόντια και 1 εκατοστό κάθετα
- Οριζόντιοι και κάθετοι οδηγοί ανά 4 εκατοστά

2.	Αποθηκεύστε τη σελίδα αυτή με το όνομα ''Αρχικές Ρυθμίσεις''.
3.	� Μετρήστε τις διαστάσεις που έχουν οι θήκες των μουσικών CD και φτιάξτε τις 

ανάλογες σελίδες.
4.	�Καταγράψτε τα βήματα για να αλλάξουμε το βήμα του καννάβου. Πώς ορίζουμε 

αν ο κάνναβος θα σχηματίζεται με γραμμές ή κουκκίδες;
5.	� Δημιουργήστε ένα νέο αρχείο και προσπαθήστε να το αποθηκεύσετε σε έναν 

κατάλογο που έχει το όνομά σας. (Η δημιουργία νέου φακέλου γίνεται από το 
αντίστοιχο πλήκτρο που βρίσκεται δεξιά από τη θυρίδα Αποθήκευση σε...).

24-0151 Book.indb   12524-0151 Book.indb   125 27/10/2021   12:17:28 µµ27/10/2021   12:17:28 µµ



126

Ε Φ Α Ρ Μ Ο Γ Ε Σ  Η Λ Ε Κ Τ Ρ Ο Ν Ι Κ Ω Ν  Υ Π Ο Λ Ο Γ Ι Σ Τ Ω Ν

Κεφάλαιο 9ο
Οι διάφορες μέθοδοι σχεδίασης

Στόχοι:

Στο κεφάλαιο αυτό οι μαθητές θα μπορέσουν να:

	 •	� Κατανοήσουν τους δυνατούς τύπους και καταστάσεις της ψηφιακής 
σχεδίασης.

	 •	 �Κατανοήσουν τις τεχνικές και τα εργαλεία για τη δημιουργία και το σχε-
διασμό απλών δισδιάστατων σχεδίων.

9.1. Εισαγωγή

Τα σχεδιαστικά προγράμματα προσφέρουν τη δυνατότητα για διάφορα βασικά γεω-
μετρικά σχήματα να δημιουργηθούν με μια εντολή ή με το πάτημα ενός πλήκτρου. 
Για παράδειγμα, με την επιλογή του εικονιδίου των ελλείψεων από τη σχετική ερ-
γαλειοθήκη μπορεί να σχεδιασθεί μια έλλειψη. Αν πατηθεί ταυτόχρονα και το πλή-
κτρο Ctrl, τότε σχεδιάζεται ένας κύκλος. Το ίδιο ισχύει και με το παραλληλόγραμμο. 
Μπορεί να σχεδιαστεί με την επιλογή ενός αντίστοιχου εργαλείου. Με το ταυτόχρο-
νο πάτημα του Ctrl σχεδιάζεται ένα τετράγωνο.

Οι παλέτες των εργαλείων σχεδίασης βρίσκονται συνήθως στην αριστερή πλευ-
ρά του παράθυρου σχεδίασης. Η μετακίνηση του δείκτη του ποντικιού πάνω από 
οποιοδήποτε από τα εργαλεία της παλέτας προκαλεί την εμφάνιση μιας ετικέτας, 
που προσδιορίζει το εργαλείο. Μερικά εργαλεία έχουν ένα μικρό βέλος στην κάτω 
αριστερή γωνία. Αν κρατηθεί ο δείκτης πάνω σε αυτά τα εργαλεία, προκαλεί την 
εμφάνιση μιας λωρίδας με πρόσθετα εικονίδια που αντιστοιχούν σε άλλα εργαλεία. 
Συνήθως, στην εργαλειοθήκη αναπαρίσταται αυτό που χρησιμοποιήθηκε την τελευ-
ταία φορά.
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Στην Εικόνα 9.1.Α εμφανίζονται οι παλέτες των εργαλείων σχεδίασης δύο γνωστών 
προγραμμάτων επεξεργασίας διανυσματικής εικόνας. Και στις δύο από αυτές μπο-
ρούμε να αναγνωρίσουμε τα παρακάτω γνωστά εργαλεία σχεδίασης:

•	� Το εργαλείο της επιλογής αντικειμένων

•	� Το φακό, το εργαλείο μεγέθυνσης – σμίκρυνσης

•	� Το εργαλείο ελεύθερης σχεδίασης

•	� Το εργαλείο των παραλληλογράμμων

•	� Το εργαλείο των ελλείψεων.

Εικόνα 9.1.Α: 
Δύο διαφορετικές κύριες εργαλειοθήκες σχεδίασης.

Από τα εργαλεία σχεδίασης που περιλαμβάνονται στις εργαλειοθήκες της Εικόνας 
9.1.Α τα περισσότερα διαθέτουν και άλλες παραλλαγές που διαφοροποιούν την ερ-
γασία που εκτελείται με αυτό.
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Αναλυτικά αυτά φαίνονται στην εικόνα 9.1.Β

Εικόνα 9.1.Β: Η κύρια εργαλειοθήκη με τα αναπτύγματα των εργαλείων σχεδίασης.

Σήμερα, τα περισσότερα προγράμματα με την εντολή Προεπισκόπηση (Print preview) 
εμφανίζουν στην οθόνη τα διάφορα αντικείμενα που σχεδιάζουμε, όπως θα εκτυπω-
θούν στον εκτυπωτή. Έτσι, δεν υπάρχει λόγος αμφιβολίας για το τελικό αποτέλεσμα.

9.2 Τα εργαλεία σχεδίασης γραμμών

Ανεξάρτητα από το συγκεκριμένο εργαλείο αυτής της ομάδας που χρησιμοποιούμε, 
πάντα θα προκύπτει μια ευθεία ή καμπύλη ή και μια μικτή γραμμή. Στην συνέχεια, 
αφού σχεδιάσουμε την γραμμή, μπορούμε να εφαρμόσουμε ιδιότητες όπως χρώμα 
και πάχος γραμμής. Αν συμπίπτει η αρχή και το τέλος, λέμε ότι η γραμμή είναι κλει-
στή. Αν δεν συμβαίνει αυτό λέμε ότι η γραμμή είναι ανοικτή.
Τα πιο συνηθισμένα εργαλεία είναι αυτά της ελεύθερης σχεδίασης (Freehand tool) 

24-0151 Book.indb   12824-0151 Book.indb   128 27/10/2021   12:17:28 µµ27/10/2021   12:17:28 µµ



129

Ο Ι  Δ Ι Α Φ Ο Ρ Ε Σ  Μ Ε Θ Ο Δ Ο Ι  Σ Χ Ε Δ Ι Α Σ Η Σ

και των γραμμών Bezier. Το όνομά τους το πήραν προς τιμήν του γάλλου μηχανικού 
Pierre Bezier της εταιρίας αυτοκινήτων Renault, που πρώτος αυτός μελέτησε και 
χρησιμοποίησε το 1960 σε συστήματα σχεδίασης με Η/Υ (Computer Aided Design).
Κάθε γραμμή αποτελείται από διαδρομές και κόμβους (ή σημεία αγκύρωσης), κάθε 
διαδρομή συνδέει δύο κόμβους. Οι κόμβοι αποτελούν τα θεμέλια κάθε διανυσματι-
κού γραφικού. Με αφετηρία τους κόμβους, όπως θα δούμε στην συνέχεια, διαμορ-
φώνουμε τις γραμμές ή τα σχήματα.
Ανάλογα με την αρχική ρύθμιση του προγράμματος μπορούμε να χρωματίζουμε την 
επιφάνεια που περικλείεται από μια κλειστή ή ανοικτή γραμμή ή διαδρομή. Συνή-
θως η αρχική ρύθμιση επιτρέπει το χρωματισμό μόνο κλειστών γραμμών.

Γ

Α Β

Εικόνα 9.2: (Α) Με την ελεύθερη σχεδίαση, ανάλογα με την κίνηση του ποντικιού, χαράσσεται 
μία ανοικτή γραμμή με αρχικό, τελικό και ενδιάμεσους κόμβους. Στην συνέχεια ενεργούμε στους 
κόμβους. (Β) και (Γ): Με το εργαλείο Bezier ή την πένα πιέζουμε διαδοχικά το ποντίκι στα διά-
φορα σημεία και αυτά ενώνονται με τη διαδρομή. Στην συνέχεια τροποποιούμε τους κόμβους στα 
σημεία ελέγχου.

Για να σχεδιάσουμε με το εργαλείο ελεύθερης σχεδίασης με το ποντίκι (Εικόνα 
9.2Α), ακολουθούμε τα παρακάτω βήματα:

•	� Πιέζουμε το ποντίκι στο αρχικό σημείο, και σύρουμε το εργαλείο μέχρι 
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το επόμενο επιθυμητό σημείο. Μόλις αφήσουμε το ποντίκι η γραμμή 

ολοκληρώνεται, δημιουργώντας μία διαδρομή. Ας σημειώσουμε εδώ ότι 

όσο ταχύτερα σύρουμε το ποντίκι, τόσο περισσότεροι κόμβοι παρεμβάλ-

λονται στην γραμμή.

•	� Για να χαράξουμε μία τέλεια ευθεία πιέζουμε το ποντίκι στο αρχικό ση-

μείο, το αφήνουμε και πατάμε ξανά στο τελικό σημείο.

Με τα εργαλεία Bezier σχεδιάζουμε διαφορετικά (Εικόνα 9.2Β). Δημιουργούμε ευ-

θύγραμμες ή καμπυλόγραμμες διαδρομές των οποίων ρυθμίζουμε την καμπυλότητα 

από τις λαβές των κόμβων. Όπως είδαμε και στο κεφάλαιο 7 μπορούμε να αλλάξου-

με το κέντρο αλλά και την ακτίνα καμπυλότητας, μετακινώντας την λαβή ή και τον 

κόμβο. Ας δούμε και πάλι τα βήματα:

•	� Πιέζουμε το ποντίκι στο αρχικό σημείο, ορίζοντας τον αρχικό κόμβο.

•	� Πιέζουμε ξανά σε ένα δεύτερο σημείο και σύρουμε συγχρόνως προς μία 

κατεύθυνση. Παρατηρούμε ότι οι κόμβοι συνδέονται με μία γραμμή μετα-

βαλλόμενης καμπυλότητας καθώς κινούμαστε αλλάζοντας την κατεύθυν-

ση και το μήκος της λαβής. Όσο αυξάνεται το μήκος της λαβής, τόσο με-

γαλώνει η καμπυλότητα της διαδρομής, σαν να είναι «κατασκευασμένη» 

από λάστιχο. Αφήνοντας το ποντίκι εξακολουθούμε να βλέπουμε τις λαβές 

στις ήδη σχεδιασμένες διαδρομές, ενώ μπορούμε να συνεχίσουμε να πιέ-

ζουμε και να σύρουμε το ποντίκι σχεδιάζοντας νέες σαν μονοκονδυλιά.

•	� Με την πένα τώρα, (Εικόνα 9.2Γ) καθώς κινούμαστε, εμφανίζεται μια 

προεπισκόπηση της επόμενης διαδρομής καθώς μετακινούμε τον δρο-

μέα, που σταθεροποιείται μόλις πιέσουμε ξανά το ποντίκι. Με διπλή πίε-

ση του ποντικιού ορίζουμε το τέλος της γραμμής μας.

•	� Αν με κάποιο από αυτά τα εργαλεία πιέσουμε στο αρχικό σημείο της 

γραμμής, προκύπτει μια κλειστή γραμμή, αφού ο πρώτος και ο τελευταί-

ος κόμβος ενοποιούνται αυτόματα.

Όταν σχεδιασθεί μια διαδρομή ή γραμμή, το πρόγραμμα την εμφανίζει με οκτώ λα-

βές γύρω από αυτήν. Όσο υπάρχουν οι λαβές, η γραμμή είναι επιλεγμένη. Με ενερ-

γό κάποιο άλλο εργαλείο εξαφανίζονται οι λαβές και η γραμμή σταματάει να είναι 

επιλεγμένη. Η επιλογή κάποιου ήδη σχεδιασμένου σχήματος γίνεται με το αντίστοι-

χο εργαλείο επιλογής, πιέζοντας στην γραμμή του περιγράμματος. Συνήθως, με το 

shift, γίνεται η επιλογή πολλαπλών αντικειμένων.

Μόνο όταν ένα σχήμα είναι επιλεγμένο, είναι δυνατόν να γίνει αλλαγή της θέσης ή 

του μεγέθους του.
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Η αλλαγή θέσης γίνεται με πίεση και σύρσιμο του ποντικιού πάνω στο χώρο σχεδίασης.
Όταν ο δείκτης του ποντικού τοποθετηθεί πάνω από μια λαβή και συρθεί τότε το 
σχήμα αλλάζει μέγεθος.
Ο σχεδιασμός οριζοντίων ή κατακόρυφων γραμμών γίνεται με πίεση του πλήκτρου 
Ctrl ταυτόχρονα με τη χρήση του ποντικιού, ανεξαρτήτως εργαλείου σχεδίασης.
Η σχεδίαση ενός απλού γεωμετρικού σχήματος μπορεί να γίνει με το αντίστοιχο 
γεωμετρικό εργαλείο της εργαλειοθήκης, ή ακόμη και με το εργαλείο των γραμμών, 
φροντίζοντας κάθε ευθύγραμμο τμήμα να ξεκινάει ακριβώς από το σημείο τέλους 
του προηγούμενου.

9.3 Ιδιότητες των κόμβων

Όπως διαπιστώσαμε στην προηγούμενη παράγραφο, η μορφή των διαδρομών, ή συνο-
λικά μιας γραμμής ελέγχεται από τις ιδιότητες των κόμβων. Μπορούμε να μεταβάλλου-
με τις ιδιότητες των κόμβων με το εργαλείο μορφής (Shape tool) της εργαλειοθήκης.
Το εργαλείο αυτό μας επιτρέπει να αλλάζουμε την θέση των κόμβων, αλλά και την 
καμπυλότητα των γραμμών μέσω των λαβών ή των σημείων ελέγχου των κόμβων. 
Με επιλεγμένο το εργαλείο διαμόρφωσης, εμφανίζονται κάτω από το βασικό μενού, 
στην γραμμή ιδιοτήτων, (Εικόνα 9.3) όλες οι δυνατές μορφές για την καμπύλη και 
τους κόμβους. Ανάλογα με την αρχική μορφή της διαδρομής ή του κόμβου ενεργο-
ποιούνται περισσότερες ή λιγότερες ιδιότητες.

Προσθήκη κόμβου
Διαγραφή κόμβου

Σύνδεση δύο κόμβων
Λύσιμο κόμβων

Μετατροπή καμπύλης σε ευθεία
Μετατροπή ευθείας σε καμπύλη

Κλιμάκωση κόμβων
Περιστροφή/παραμόρφωση κόμβων

Στοίχιση κόμβων
Ελαστική διαμόρφωση

Επιλογή όλων

Αυτόματο κλείσιμο διαδρομής
Εξαγωγή τμήματος διαδρομής

 Επέκταση διαδρομής για κλείσιμο
Αντιστροφή καμπύλης

Κόμβος συμμετρικός
Κόμβος ομαλός

Κόμβος οξύς
Εικόνα 9.3: Με επιλεγμένο το εργαλείο διαμόρφωσης, εμφανίζονται κάτω από το βασικό μενού, 
στην γραμμή ιδιοτήτων, όλες οι δυνατές μορφές για την καμπύλη και τους κόμβους. Ανάλογα με 
την αρχική μορφή της καμπύλης ή του κόμβου ενεργοποιούνται περισσότερες ή λιγότερες ιδιότη-
τες. Αν, παρ’ όλα αυτά, δεν εμφανίζονται τα παραπάνω, θα πρέπει το σχήμα να μετασχηματιστεί 
με την εντολή από το μενού Arrange > Convert to curves.
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Αφού δημιουργήσουμε με το εργαλείο Bezier την γραμμή, (Εικόνα 9.4), επεμβαίνουμε 
στον κόμβο με το εργαλείο διαμόρφωσης, επιβάλλοντας κόμβο οξύ (Cusp), ή και κόμβο 
ομαλό, στον οποίο όμως, η λαβή παραμένει άκαμπτη, ενώ αλλάζει η καμπυλότητα στην 
κατεύθυνση που αυξομειώνεται η απόσταση της λαβής από τον κόμβο. Τέλος, στον 
συμμετρικό κόμβο, οι λαβές εκατέρωθεν του κόμβου αυξομειώνονται συμμετρικά.

Α Β Γ

Εικόνα 9.4: (Α) Δημιουργούμε πρώτα με το εργαλείο Bezier την γραμμή, μετά επεμβαίνουμε 
στον κόμβο με το εργαλείο διαμόρφωσης, επιβάλλοντας κόμβο οξύ (Cusp).
(Β) Με τον ίδιο τρόπο σε κάποιο άλλο κόμβο επιβάλλουμε κόμβο ομαλό. Δηλαδή η λαβή παρα-
μένει άκαμπτη, ενώ αλλάζει η καμπυλότητα μόνο στην κατεύθυνση που αυξομειώνεται η λαβή.
(Γ) Στον συμμετρικό κόμβο οι λαβές εκατέρωθεν του κόμβου αυξομειώνονται συμμετρικά.

9.4 Η σχεδίαση απλών γεωμετρικών σχημάτων 

Ο σχεδιασμός ενός ορθογώνιου παραλληλόγραμμου και μιας έλλειψης, γίνεται με 
το αντίστοιχο εργαλείο της εργαλειοθήκης. Πιέζοντας συγχρόνως το πλήκτρο CTRL 
το παραλληλόγραμμο περιορίζεται σε τετράγωνο, η δε έλλειψη σε κύκλο.
Αν τώρα πατάμε και το πλήκτρο SHIFT ενώ σχεδιάζουμε νέα αντικείμενα, το σχήμα 
τους περιορίζεται έτσι ώστε να ξεκινά από το κέντρο.
Με το CTRL και SHIFT, τα σχήματα περιορίζονται να έχουν ίδιο μήκος και πλάτος 
και να ξεκινούν από το κέντρο.
Η μετατροπή του σε πλάγιο γίνεται με την επιλογή του περιγράμματός του με το 
εργαλείο επιλογής (βέλος). Οι λαβές που εμφανίζονται αλλάζουν το σχήμα ώστε 
να είναι δυνατή η επεξεργασία του. Με τη μεταφορά της μεσαίας από τις τρεις 
οριζόντιες, το παραλληλόγραμμο γίνεται πλάγιο. Με έναν απλό μετασχηματισμό 
ενός αρχικού σχήματος παράγεται ένα άλλο. Έτσι λειτουργούν όλα τα σχεδιαστικά 
προγράμματα.
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A B

Εικόνα 9.5: (Α) Μία κλειστή διαδρομή γίνεται ακόμη και με τα πιο απλά εργαλεία... 
(Β) ...όπως και μία ανοικτή, με αρχική ρύθμιση χρωματισμού ανοικτού σχήματος.

Το γέμισμα του σχήματος με χρώμα γίνεται από την παλέτα των χρωμάτων. Με επι-
λογή με το αριστερό πλήκτρο του ποντικιού πάνω από κάποιο χρώμα το σχήμα γε-
μίζει αυτόματα με το χρώμα αυτό, ενώ με επιλογή με το δεξί πλήκτρο χρωματίζεται 
και το περίγραμμα του σχήματος.
Το πάχος του περιγράμματος τώρα μπορεί να οριστεί από το πλήκτρο που έχει το 
σύμβολο της πένας. Όταν ξεδιπλωθεί, εμφανίζονται διάφορα πάχη, από μισό μέχρι 
24 στιγμές. Επιλέγοντας ένα από αυτά, αποδίδεται το πάχος στο περίγραμμα του 
επιλεγμένου αντικειμένου. Αυτός είναι ο πιο απλός τρόπος απόδοσης χρωμάτων 
στα σχήματα. Περισσότερα αναφέρονται σε επόμενο κεφάλαιο, όπου αναλύεται με 
λεπτομέρεια ο χρωματισμός των αντικειμένων.
Όλα τα σχεδιαστικά προγράμματα προσφέρουν έτοιμα διάφορα βασικά σχήματα, 
από ορθογώνια παραλληλόγραμμα και κύκλους, μέχρι σπείρες και πλέγματα ή 
πίνακες.
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9.5 Η κατασκευή ενός σήματος

Ακόμα και οι πιο απλές εικόνες μπορούν να κατασκευαστούν με πολλούς τρόπους. 
Το λογότυπο της Εικόνας 9.6 μπορεί να κατασκευαστεί με διάφορες μεθόδους. Δη-
μιουργήθηκε για ένα συνέδριο που ασχολείται με την επίδραση των νέων τεχνολο-
γιών ηλεκτρονικών υπολογιστών και τηλεπικοινωνιών στην ζωή μας, σε κοινωνικό 
αλλά και προσωπικό επίπεδο. Αυτή η απλή εικονική αναπαράσταση ενός ματιού 
είναι ένα καλό παράδειγμα για την παρουσίαση του τρόπου που σχεδιάζουμε.

Εικόνα 9.6: Μια εικόνα μπορεί να δημιουργηθεί με διάφορους τρόπους.

Το πιο δύσκολο για να δημιουργηθεί είναι το μάτι. Μπορεί να γίνει είτε με δύο ευ-
θύγραμμα τμήματα και έναν κύκλο, είτε με δύο ελλείψεις, όπου δύο κόμβοι έχουν 
μετασχηματιστεί σε οξείς και έχουν τροποποιηθεί με τις λαβές τους (Εικόνα 9.7). Η 
πρώτη έλλειψη έχει μαύρο χρώμα και η δεύτερη γκρι. Έτσι φαίνεται σαν μια έλλει-
ψη με παχύ περίγραμμα. Τα σχεδιαστικά προγράμματα διατάσσουν τα αντικείμενα, 
το πιο πρόσφατο σχεδιασμένο βρίσκεται πάνω από όλα τα άλλα, ενώ το πρώτο που 
σχεδιάστηκε πίσω από όλα. Αλλαγές στις διατάξεις γίνονται από την εντολή Τακτο-
ποίηση > Διάταξη (Arrange > Order...).

Τα υπόλοιπα τμήματα είναι εύκολο να γίνουν αφού στην ουσία πρόκειται για κύ-
κλους και τετράγωνα. Το μόνο δύσκολο είναι η σωστή κάλυψη των αντικειμένων, 
γιατί επηρεάζεται έτσι το πότε πρέπει να σχεδιαστεί κάθε αντικείμενο. Μια τακτική 
που μπορεί να εφαρμοστεί είναι η αντιγραφή κάποιου αντικειμένου και η επικόλλη-
σή του. Το αντίγραφο είναι το νεότερο σχήμα έτσι καλύπτει όλα τα άλλα.
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Εικόνα 9.7: Το μάτι έχει δημιουργηθεί απλά από τη διάταξη των δύο ελλείψεων και του κύκλου.

Η δημιουργία ενός λογότυπου πρέπει να γίνεται με τον τρόπο που φαίνεται ο πιο 
λογικός. Το μυαλό κάθε ανθρώπου λειτουργεί διαφορετικά και οι πιο προφανείς 
λύσεις για κάποιον φαίνονται πρωτοποριακές σε κάποιον άλλον.

Ανακεφαλαίωση 9ου Κεφαλαίου

Τα σχεδιαστικά προγράμματα διαθέτουν αρκετά εργαλεία για την κατασκευή 
απλών γεωμετρικών σχημάτων.
Σχήματα όμως μπορούν να γίνουν και με το εργαλείο ελεύθερης σχεδίασης 
αλλά και με τις καμπύλες Bezier. Οι τελευταίες αποτελούν ένα ισχυρό εργαλείο, 
γιατί τα σχήματα που σχεδιάζονται με αυτές, μπορούν να τροποποιηθούν με 
πολλούς τρόπους. Αυτό επιτυγχάνεται με τους κόμβους και τα σημεία – λαβές, 
καθώς με τη μετακίνησή τους μεταβάλλεται το σχήμα της καμπύλης γραμμής.
Ο συνδυασμός των εντολών αντιγραφής και διπλασιασμού επιτρέπουν στο χρή-
στη την αναπαραγωγή του ίδιου ακριβώς σχήματος όσες φορές θέλει στο χώρο 
εργασίας.
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Ασκήσεις 9ου Κεφαλαίου

1.	� Πώς μπορείτε να προσθέσετε και να αφαιρέσετε κόμβους σε ένα αντικείμενο; Σε 
τι χρησιμεύει κάτι τέτοιο;

2.	� Προσπαθήστε να τροποποιήσετε την συμπεριφορά των κόμβων της προηγούμε-
νης άσκησης ώστε από οξείς (Cusp) να γίνουν συμμετρικοί (symmetrical) κλπ. 
Δοκιμάστε κάθε δυνατό συνδυασμό. Είναι πάντα όλες οι μορφές των κόμβων 
διαθέσιμες;

3.	� Προσπαθήστε να αναλύσετε όλη την εργαλειοθήκη των καμπύλων Bezier χρησι-
μοποιώντας τη βοήθεια που μπορεί να δώσει το πρόγραμμα που χρησιμοποιείτε.

4.	�Βρείτε τις παραμέτρους της εντολής του διπλασιασμού (Duplicate) αντικειμένου, 
ώστε να επαναλαμβάνεται η επικόλληση με το επιθυμητό βήμα και το γέμισμα 
ενός συγκεκριμένου σχήματος με αντικείμενα.

Δραστηριότητες 9ου Κεφαλαίου

1.	� Χρησιμοποιώντας τα εργαλεία σχεδίασης προσπαθήστε να σχεδιάσετε ένα σπίτι 
με σκεπή, παράθυρα, πόρτα και διάφορα άλλα μικροαντικείμενα που μπορούν 
να γίνουν με τα απλά εργαλεία.

2.	� Δημιουργήστε μια πλευρά σκεπής σπιτιού και γεμίστε την με ένα αντικείμενο 
που θα θυμίζει κεραμίδι.

3.	� Από μια βιβλιοθήκη έτοιμων σχημάτων (Clip Arts) εισάγετε ένα, και προσπαθή-
στε να το αντιγράψετε με το εργαλείο των κόμβων.
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Κεφάλαιο 10ο
Διαχείριση αντικειμένων

Στόχοι:

Στο κεφάλαιο αυτό οι μαθητές θα μπορέσουν να:

	 •	� Αντιληφθούν τη σημασία των εργαλείων διαχείρισης αντικειμένων για 
τις ανάγκες της ψηφιακής σχεδίασης

	 •	 �Κατανοήσουν τους τρόπους και τις διαδικασίες δημιουργίας πολύπλο-
κων σχεδίων από απλά δισδιάστατα σχέδια μέσω των τεχνικών διαχεί-
ρισης των αντικειμένων.

10.1 Εισαγωγή

Όπως έχει φανεί μέχρι τώρα, ένα σχήμα δεν είναι κάτι στατικό στην οθόνη του υπο-
λογιστή, είναι κάτι τροποποιήσιμο και επεξεργάσιμο. Ένα απλό γεωμετρικό σχέδιο 
τροποποιημένο καταλήγει σε κάποιο άλλο τόσο διαφορετικό, ώστε να μη φαίνεται 
η αρχική του προέλευση.

Όταν επιλέγεται ένα σχήμα με το αντίστοιχο εργαλείο, εμφανίζεται η παλέτα προ-
διαγραφών του στη γραμμή ιδιοτήτων. Αυτές οι παλέτες προδιαγραφών διαφέρουν 
ελαφρά ανάλογα με το εργαλείο που επιλέγεται, αλλά οι περισσότερες επιλογές 
είναι ίδιες για όλα τα εργαλεία. Παρόμοια, οι επεξεργασίες είναι όμοιες σε όλα τα 
προγράμματα και ο τρόπος που γίνονται δεν παρουσιάζει μεγάλες διαφορές από 
πρόγραμμα σε πρόγραμμα. Καθοριστική σε κάθε περίπτωση είναι η ακρίβεια που 
διαθέτει κάθε πρόγραμμα.
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10.2 Ιδιότητες αντικειμένων

Κατά το σχεδιασμό ενός οποιουδήποτε σχήματος με το εργαλείο γραμμών Bezier 
έχουμε τις εξής κοινές λειτουργίες των γραμμών ιδιοτήτων, όπως φαίνονται αυτές 
στην Εικόνα  10.1.

Θέση αντικειμένου Κουμπί αναλογικού διαστήματος Πάχος γραμμής

Μέγεθος αντικειμένου

Συντελεστής Κλίμακας

Γωνία περιστροφής Είδος γραμμής Αναδίπλωση κειμένου 
παραγράφου

Εικόνα 10.1: Η γραμμή ελέγχου ιδιοτήτων αντικειμένου.

•	� Στη θυρίδα ''Θέση του αντικειμένου'' μπορεί να ορισθεί η ακριβής θέση 
των αντικειμένων στη σελίδα. Η θέση x και ψ ορίζει την οριζόντια και 
κάθετη απόσταση αντιστοίχως, του κέντρου του σχήματος, από την αρχή 
των αξόνων που συνήθως είναι στο κάτω αριστερό άκρο της σελίδας.

•	� Στη θυρίδα ''Μέγεθος αντικειμένου'' τίθεται το ακριβές μέγεθος του 
αντικειμένου.

•	� Εκατοστιαία γίνεται η αλλαγή του μεγέθους από τη θυρίδα ''Συντελε-
στού κλίμακας''.

•	� Με το πλήκτρο του ''Αναλογικού διαστήματος'' ό,τι μεταβολή γίνεται 
κατά τον άξονα των x, η ίδια γίνεται και κατά τον άξονα των ψ.

•	� Με τη θυρίδα ''Γωνία περιστροφής'' περιστρέφεται με ακρίβεια το αντι-
κείμενο.

•	� Άλλο κοινό εικονίδιο είναι το τελευταίο, αυτό της ''Αναδίπλωσης κειμέ-
νου παραγράφου''. Αν προστεθεί αργότερα κείμενο παραγράφου, με το 
πλήκτρο αυτό ορίζεται πώς θα «ρέει» το κείμενο γύρω από την παρά-
γραφο.

•	� Τα άλλα δύο εικονίδια, πάχος και είδος γραμμής, είναι αποκλειστικά για 
το σχεδιασμένο σχήμα.

•	� Τέλος με τα εικονίδια του κατοπτρισμού, γίνεται ο κατοπτρισμός ενός 
αντικειμένου είτε οριζόντιος είτε κάθετος, με το κέντρο του σχήματος να 
παραμένει στην ίδια θέση.
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10.3 Τρόποι επιλογής αντικειμένων

Ένα σχήμα είναι αυτόματα επιλεγμένο, όταν σχεδιάζεται. Σε ένα επιλεγμένο σχήμα 
μπορούμε να του αλλάξουμε θέση, να μεταβάλουμε το μέγεθος του ή να το διαγρά-
ψουμε πατώντας το πλήκτρο Del.
Η επιλογή των αντικειμένων, που το ένα καλύπτει το άλλο, συναρτάται με τη σει-
ρά σχεδίασής τους. Όταν σχεδιάζεται ένα νέο αντικείμενο, αυτό προστίθεται στο 
σύνολο των ήδη σχεδιασμένων. Μπορούμε να τα φανταστούμε σαν ένα σωρό αντι-
κειμένων, όπου το πιο πρόσφατα σχεδιασμένο βρίσκεται «επάνω», ενώ αυτό που 
σχεδιάσθηκε πρώτο είναι κάτω-κάτω στη διάταξη. Για τα τρία σχήματα σαν αυτά 
της Εικόνας 10.2 ισχύουν τα εξής:

•	� Όταν σχεδιαστεί και το τελευταίο, παραμένει επιλεγμένο αυτό.

•	� Πιέζοντας το πλήκτρο TAB, επιλέγεται αυτό που, χρονικά, σχεδιάστηκε 
δεύτερο.

•	� Επαναλαμβάνοντας, επιλέγεται το πρώτο. Συνεχίζοντας, επιλέγεται το 
τελευταίο.
Έτσι η σειρά επιλογής ταυτίζεται με τη σειρά σχεδίασης. Το ίδιο και η διάτα-
ξη των αντικειμένων. Το τελευταίο είναι σαν να βρίσκεται επάνω στη σειρά.

Εικόνα 10.2.
Η επιλογή των αντικειμένων που επικαλύπτονται σε
ένα σχέδιο συναρτάται με τη σειρά σχεδίασής τους.

Επιλογή αντικειμένων γίνεται με «πλαίσιο επιλογής», όπως συνηθίζεται να λέγεται. 
Με επιλεγμένο το εργαλείο επιλογής και σύρσιμο του ποντικιού διαγωνίως ώστε να 
δημιουργηθεί ένα νοητό πλαίσιο γύρω από κάποια αντικείμενα. Αυτό έχει ως απο-
τέλεσμα να επιλέγονται όσα περικλείονται σε αυτό. Συνήθως εμφανίζεται και ένα 
μπλε περίγραμμα που δείχνει την κίνηση του δείκτη του ποντικιού. Με το πλήκτρο 
Alt πατημένο τη στιγμή που σύρεται το ποντίκι, τότε επιλέγονται όσα αντικείμενα 
περικλείονται και τέμνονται από το πλαίσιο επιλογής.
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Με την επιλογή των αντικειμένων, η γραμμή ιδιοτήτων αλλάζει και προστίθενται 
δύο εικονίδια με τα οποία γίνεται η ομαδοποίηση (group) και από-ομαδοποίηση 
(ungroup) των αντικειμένων. Όταν είναι επιλεγμένο το εικονίδιο της ομαδικής επι-
λογής, κάθε σχήμα που επιλέγεται με το ποντίκι προστίθεται στην ομάδα των ήδη 
επιλεγμένων. Τα ομαδοποιημένα αντικείμενα τροποποιούνται ταυτόχρονα, σαν να 
είναι ένα αντικείμενο. Με την επιλογή του εικονιδίου της από-ομαδοποίησης τα 
αντικείμενα αποχαρακτηρίζονται από την ιδιότητα της ομάδας.

Άλλος τρόπος ομαδικής επιλογής είναι με το Shift + επιλογή, με το ποντίκι. Αν 
θέλουμε στην ήδη υπάρχουσα επιλογή να προσθέσουμε ακόμη ένα αντικείμενο, 
αυτό γίνεται με πατημένο το πλήκτρο Shift και επιλογή με το ποντίκι στο αντικεί-
μενο. Μια ομάδα αντικειμένων επιλέγεται με το ποντίκι πιέζοντας σε οποιοδήποτε 
περίγραμμα από τα αντικείμενα που το απαρτίζουν. Με το πλήκτρο Ctrl συνέχεια 
πατημένο γίνεται η επιλογή ενός μόνο αντικειμένου από το ομαδοποιημένο σύνολο.

Πολλές φορές οι εναλλακτικοί τρόποι επιλογής δίνονται με περισσότερα από ένα 
εργαλεία επιλογής. Για παράδειγμα, το Illustrator διαθέτει εργαλεία επιλογής απ’ 
ευθείας επιλογής σημείων, «μαγικό ραβδί» το οποίο επιλέγει αντικείμενα με παρό-
μοιο χρώμα (διαφέρει βέβαια η λειτουργία τους απ’ αυτήν του αντίστοιχου εργα-
λείου στα προγράμματα επεξεργασίας εικόνας) ακόμη και το εργαλείο του λάσου. 
Με τα εργαλεία αυτά επιτυγχάνεται κάθε τρόπος επιλογής αντικειμένων, ανάλογα 
με την ιδιότητα που μας ενδιαφέρει να έχουν.

Πότε χρησιμοποιούμε τις ομάδες των αντικειμένων;
Όταν αυτά έχουν γίνει αρκετά και θέλουμε να περιορίσουμε τον αριθμό τους. Πολ-
λά από αυτά έχουν άμεση σχέση μεταξύ τους. Για παράδειγμα, θέλουμε να κάνουμε 
ένα έντεχνο περίγραμμα σελίδας, που αποτελείται από διάφορα γεωμετρικά σχή-
ματα. Το μέγεθος πρέπει να είναι μεταβλητό, γιατί υπάρχουν παράμετροι της πα-
ραγωγής, τις οποίες δεν είναι απαραίτητο να ξέρουμε και που μπορεί να αλλάξουν, 
όπως το μέγεθος του χαρτιού και τα περιεχόμενα της σελίδας. Ομαδοποιώντας τα 
σχήματα, σαν ένα και μοναδικό αντικείμενο, μπορούμε να κάνουμε όποια στιγμή 
θέλουμε διάφορες μετατροπές στη γεωμετρία του. Αν θέλουμε να καταργήσουμε τις 
ομαδοποιήσεις, υπάρχουν οι εντολές Ungroup, που καταργούν κάποια συγκεκριμέ-
νη ομαδοποίηση, καθώς και η εντολή Ungroup All που καταργεί όλες τις ομάδες των 
αντικειμένων, είναι δηλαδή καθολική εντολή.

Τα σχεδιαστικά προγράμματα έχουν διάφορους τρόπους ομαδικής επιλογής. Βέ-
βαια, οι τρόποι αυτοί εξαρτώνται από το ίδιο το πρόγραμμα και τις μεθόδους που 
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διαθέτει για την επιλογή. Ο πιο κοινός πάντως τρόπος που βρίσκεται σχεδόν πα-
ντού, είναι από τον κατάλογο Επεξεργασία (Edit) η εντολή Επιλογή (Select). Για 
παράδειγμα, με την Επιλογή Κειμένων (Select Text) επιλέγονται όλα τα κείμενα 
που υπάρχουν σε μια σελίδα.
Στην ίδια κατηγορία με τις εντολές ομαδοποίησης ανήκουν και οι εντολές συνδυα-
σμού αντικειμένων. Η ομαδοποίηση επιτρέπει την ταυτόχρονη επεξεργασία αντικει-
μένων, αλλά δεν αλλάζει τα ίδια τα αντικείμενα τα οποία παραμένουν σαν οντότητες.

Κλωνοποίηση: Οι εντολές Αντιγραφής και Επικόλλησης είναι ήδη γνωστές από άλ-
λες εφαρμογές των υπολογιστών. Στα σχεδιαστικά προγράμματα όμως υπάρχει μια 
ενδιαφέρουσα εντολή, η Κλωνοποίηση (Edit>Clone) που διευρύνει τις ήδη γνωστές 
εντολές αντιγραφής-επικόλλησης.
Με αυτή δημιουργείται ένα αντίγραφο-κλώνος ενός σχήματος. Ό,τι αλλαγές γίνουν 
στο γονεϊκό αντικείμενο, οι ίδιες ακριβώς μεταφέρονται και στους κλώνους (Ει-
κόνα 10.3). Οι ιδιότητες που κληρονομούνται είναι το χρώμα γεμίσματος και το 
περίγραμμα με όλες τις ιδιότητές του (σχήμα, χρώμα, πάχος). Δεν ισχύει όμως το 
αντίθετο. Δηλαδή, αν αλλάξει κάποια από αυτές τις ιδιότητες σε έναν κλώνο, δεν 
επηρεάζονται τα άλλα αντικείμενα και συγχρόνως σπάει ο δεσμός της συγκεκριμέ-
νης ιδιότητας με το γονεϊκό αντικείμενο. Αν δηλαδή, αλλάξει χρώμα τότε οι αλλαγές 
του γονεϊκού δε θα επηρεάζουν το χρώμα του κλώνου. Ένας κλώνος είναι αδύνατο 
να κλωνοποιηθεί με τη σειρά του.

Εικόνα 10.3: Η επεξεργασία των κλώνων είναι εύκολη, αφού κάθε αλλαγή στο αρχικό (γονεϊκό), 
μεταφέρεται αυτομάτως και στα υπόλοιπα (κλώνους).

Αυτό όμως που έχει σημασία είναι η διευθέτηση των αντικειμένων που υπάρχουν 
στο σχήμα μας καθώς και οι διάφοροι συνδυασμοί που μπορούν να γίνουν. Πολλές 
φορές ένα ιδιαίτερα σύνθετο σχήμα μπορεί να γίνει από κάποια βασικά με διαδοχι-
κές αντιγραφές και επικολλήσεις. Σε πολλά σχεδιαστικά προγράμματα, ειδικότερα 
σε αυτά που ειδικεύονται στις τρεις διαστάσεις, είναι γνωστά τα αρχικά στερεά 
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(Primitives), δηλαδή στερεά, που αφού υποστούν διάφορες αλλαγές, προκύπτει το 
τελικό στερεό – νέο σχήμα. Στις δύο διαστάσεις βέβαια οι συνδυασμοί αυτοί είναι 
πιο απλοί, δίνουν όμως μια γενική ιδέα πώς από ένα σύνολο απλών σχημάτων μπο-
ρούμε να φθάσουμε σε κάτι σύνθετο.

10.4 Τα επίπεδα σχεδίασης

Ένα από τα πιο ενδιαφέροντα σημεία στα προγράμματα γραφικών είναι τα επίπεδα 
σχεδίασης (layers). Θα μπορούσαμε να τα παρομοιάσουμε με διαφάνειες. Κάθε δια-
φάνεια έχει ολοκληρωμένο κάποιο κομμάτι του σχεδίου ή της μακέτας. Αν θέλουμε 
να δούμε το σχέδιο ολοκληρωμένο, βάζουμε τις διαφάνειες την μία πάνω στην άλλη. 
Αν θέλουμε να επεξεργαστούμε κάποια από αυτές, βάζουμε στην άκρη όλες τις άλλες.
Σε προηγούμενο κεφάλαιο μελετήσαμε τα επίπεδα στα προγράμματα επεξεργασίας ει-
κόνας. Παρά το γεγονός ότι ο χειρισμός τους είναι διαφορετικός, ο λόγος ύπαρξής τους 
είναι ο ίδιος, η διευκόλυνση του σχεδιαστή κατά το στάδιο της δημιουργίας ή επεξερ-
γασίας σύνθετων γραφικών, επιτρέποντάς του να εργάζεται σε μεμονωμένα επίπεδα.
Κατά την εκκίνηση του προγράμματος εμφανίζεται ένα μοναδικό επίπεδο με κάποιο 
όνομα π.χ. background ή master layer. Κάθε νέο αντικείμενο προστίθεται σ’ αυτό. 
Κατόπιν, μπορεί να προστεθούν νέα επίπεδα με τα δικά τους αντικείμενα και άλλο 
όνομα. Τα νέα αντικείμενα που σχεδιάζονται προστίθενται πάντα στο ενεργό επίπεδο.

Κάθε επίπεδο μπορεί να έχει δικούς του τύπους γραμμής, χρώματα κτλ. Έτσι, είναι 
ιδιαίτερα εύκολο να φαίνεται σε ποιο επίπεδο ανήκει κάθε αντικείμενο. Ο καλύτερος 
τρόπος για το σχεδιασμό είναι να γίνεται μια συγκεκριμένη εργασία σε κάθε επίπεδο.

Συμπερασματικά, μπορούμε να πούμε ότι με τα επίπεδα:

•	� Μπορεί να οργανωθεί καλύτερα η εργασία σε πολύπλοκα σχέδια, βλέπο-
ντας και σχεδιάζοντας κάθε φορά σε ένα μέρος του σχεδίου που αποτε-
λεί ένα διαφορετικό επίπεδο.

•	� Ένα επίπεδο μπορεί να είναι μη επεξεργάσιμο. Με τον τρόπο αυτό «κλει-
δώνονται» τα διάφορα αντικείμενά του, ώστε να μη μπορούν να τροπο-
ποιηθούν εκ παραδρομής.

•	� Ένα επίπεδο μπορεί να διαγραφεί. Έτσι αντιγράφονται εκεί κάποια από 
τα αντικείμενα, γίνονται οι πειραματισμοί με διάφορα εφέ και, αν το τε-
λικό αποτέλεσμα δεν ικανοποιεί, απλά διαγράφεται το επίπεδο.

•	� Ένα επίπεδο μπορεί να μην είναι εκτυπώσιμο. Εκεί μπορεί να μεταφέ-
ρονται τα διάφορα βοηθητικά αντικείμενα που χρησιμοποιήθηκαν για το 
στήσιμο της σελίδας και που φυσικά πρέπει να μην εκτυπωθούν.
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•	� Ομαδοποιούνται εύκολα αντικείμενα. Μάλιστα, αντίθετα από τις ομάδες 
αντικειμένων κάθε επίπεδο έχει περισσότερες ιδιότητες. Για παράδειγ-
μα, οι επιλογές αντικειμένων ή ομάδων γίνονται πολύ ευκολότερα.

Η διαχείριση των επιπέδων, ανάλογα με το πρόγραμμα που χρησιμοποιούμε, γίνεται 
με το Διαχειριστής Αντικειμένων και επιπέδων (Object Manager) (Εικόνα 10.4). Συνή-
θως, η εμφάνιση του πρώτου γίνεται από το μενού Εργαλεία > Διαχειριστής Αντικειμέ-
νων (Tools> Object Manager). Με την ενεργοποίηση της εντολής εμφανίζεται στο δεξί 
τμήμα της οθόνης ο αντίστοιχος διαχειριστής, δείχνοντας αναλυτικά όλες τις σελίδες 
που απαρτίζουν το έντυπο, τα επίπεδα, τις ομάδες αντικειμένων που υπάρχουν σε 
κάθε επίπεδο και τέλος τα αντικείμενα. Όσο τα σχέδια γίνονται πιο σύνθετα, τόσο πιο 
αναγκαία γίνεται η χρησιμοποίηση των επιπέδων. Όταν κατασκευάζονται περίπλοκες 
εικονογραφήσεις, η καλή οργάνωση των επιπέδων αποκτά πολύ μεγάλη σημασία.

Εικόνα 10.4:
(A) Ο Διαχειριστής Επιπέδων. 
(Β) Ο Διαχειριστής Αντικειμένων.A

Β

Εκτός από τα κανονικά επίπεδα υπάρχουν και τα υπό-επίπεδα που μαζί με τις ομά-
δες αντικειμένων λειτουργούν σαν αποδέκτες για αντικείμενα ή εικόνες. Σε μερικές 
περιπτώσεις, όπως για παράδειγμα στις ομαδοποιήσεις των αντικειμένων, πρέπει 
τα αντικείμενα να είναι ομαδοποιημένα στο ίδιο υπό-επίπεδο. Γενικά καλό είναι 
στα σύνθετα σχήματα, όλα τα αντικείμενα που θα χρησιμοποιηθούν για το σχηματι-
σμό τους, να βρίσκονται στο ίδιο επίπεδο. Ο αριθμός των επιπέδων και υπό- επιπέ-
δων σε μια καλλιτεχνική εργασία μπορεί να είναι πολύ μεγάλος, όμως, απλουστεύει 
σημαντικά το χειρισμό των αντικειμένων.
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Ο Διαχειριστής αντικειμένων (Εικόνα 10.4Β) στο επάνω τμήμα έχει τέσσερα εικονί-
δια. Με το πρώτο εικονίδιο προστίθεται ένα νέο επίπεδο, με το δεύτερο εμφανίζονται 
οι ιδιότητες των αντικειμένων (πάχος, χρώμα γραμμής, γέμισμα), το τρίτο επιτρέπει 
ή όχι την επεξεργασία στα διάφορα επίπεδα και το τέταρτο εμφανίζει το διαχειριστή 
επιπέδων (εμφανίζονται μόνο τα επίπεδα και όχι τα αντικείμενα που το απαρτίζουν).

Εμφανίζονται επίσης όλες οι σελίδες που απαρτίζουν το έντυπο σε δενδρική κατα-
νομή. Κάτω από κάθε σελίδα υπάρχουν τα επίπεδα που την απαρτίζουν. Στην εικό-
να του βιβλίου φαίνονται δύο, το Layer 1 και το Κείμενα. Το επιλεγμένο επίπεδο, 
αυτό δηλαδή στο οποίο γίνονται αλλαγές και προσθήκες, εμφανίζεται με κόκκινο 
χρώμα. Ανάμεσα από το σύμβολο του επιπέδου και το όνομά του υπάρχουν τρία 
άλλα σύμβολα.

•	� Το πρώτο, δηλαδή το μάτι, αντιστοιχεί στην εντολή ορατό (visible) ή όχι. 
Όταν απενεργοποιηθεί, θα εξαφανιστούν από την οθόνη τα αντικείμενα 
που ανήκουν σ’ αυτό. Εξακολουθούν και υπάρχουν, απλώς δεν εμφανί-
ζονται σ’ αυτή.

•	� Το δεύτερο, ο εκτυπωτής, αντιστοιχεί στην εντολή «εκτυπώσιμο επίπε-
δο». Αν απενεργοποιηθεί, τότε το επίπεδο αυτό δεν θα εκτυπώνεται στο 
χαρτί, άσχετα αν εμφανίζεται ή όχι στην οθόνη.

•	� Το τρίτο αντιστοιχεί στην εντολή επεξεργάσιμο ή όχι. Όταν είναι απενερ-
γοποιημένο, απλώς δεν γίνεται καμία εργασία σ’ αυτό.

Κάτω από τα επίπεδα υπάρχουν τα ονόματα από τα αντικείμενα που βρίσκονται σ’ 
αυτά, καθώς και διάφορες πληροφορίες για τη σχεδίασή τους. Οι πληροφορίες αυ-
τές εμφανίζονται μόνο όταν είναι πατημένο το πλήκτρο Ιδιότητες (Properties) και 
εξαρτώνται από τον τύπο του επιλεγμένου αντικειμένου. Για παράδειγμα, αν επι-
λεγεί κείμενο, θα εμφανιστεί η γραμματοσειρά με την οποία έχει γραφεί, το χρώμα 
γεμίσματος και το περίγραμμα. Αν υπάρχει κάποια ομάδα αντικειμένων, εμφανίζε-
ται η λέξη group και κάτω από αυτήν τα αντικείμενα που το απαρτίζουν.

10.5 Η οργάνωση πολύπλοκων σχεδίων με τα επίπεδα

Η χρήση των επιπέδων για το συνδυασμό ή απομόνωση αντικειμένων εξοικονομεί 
παραγωγικό χρόνο καθώς διευκολύνει την απόκρυψη, επιλογή ή το κλείδωμα των 
αντικειμένων μέσα σε επίπεδα. Πολλές φορές η εικονογράφηση στηρίζεται σε αντι-
κείμενα, τα οποία βρίσκονται σε φωτογραφίες και η σύνθεση που προκύπτει από 
αυτά υλοποιεί την τελική ιδέα.
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Χρησιμοποιώντας επίπεδα για την εισαγωγή εικόνων και σχημάτων, είναι δυνατή η 
ομαδοποίηση των διάφορων τμημάτων της όλης εργασίας. Για την εφαρμογή της μπο-
ρεί να ακολουθηθεί η σειρά των βημάτων που περιγράφεται συνοπτικά στη συνέχεια:

•	� Συγκέντρωση και συναρμολόγηση όλων των αρχικών εικόνων ή τμημά-
των αυτών. Αυτά μπορεί να είναι υλικά που προέρχονται από τον περι-
βάλλοντα χώρο, δηλαδή, φωτογραφίες, έντυπο υλικό, αλλά και από άλ-
λες εργασίες που έχουν ήδη γίνει. Τέλος, με τις ψηφιακές φωτογραφικές 
μηχανές σήμερα μπορεί εύκολα να συγκεντρωθεί ψηφιακό υλικό από 
διάφορα αντικείμενα που υπάρχουν γύρω μας.

•	� Τοποθέτηση της εικόνας. Με ενεργό το Layer της πρώτης εικόνας που θα το-
ποθετηθεί, γίνεται η αντιγραφή της εικόνας στο σχέδιο. Αυτό μπορεί να γίνει 
είτε με αντιγραφή και επικόλληση από κάποιο πρόγραμμα επεξεργασίας ει-
κόνας ή μέσω της εντολής Εισαγωγή (Import ή Place). Κατόπιν, με τη δημι-
ουργία ενός νέου επιπέδου ξεκινάει η ιχνογράφηση με ένα από τα εργαλεία 
δημιουργίας γραμμών. Συνήθως, το επίπεδο με την εικόνα είναι κλειδωμένο 
ώστε να μη μπορεί να τροποποιηθεί από κάποιον λάθος χειρισμό.

•	� Προσθήκη νέων επιπέδων. Αφού ολοκληρωθεί η εργασία στο πρώτο επί-
πεδο, συνεχίζεται η εισαγωγή των επόμενων αντικειμένων με τον ίδιο 
τρόπο. Αν το πρόγραμμα διαθέτει υπο-επίπεδα καλό είναι τα αντικείμενα 
όλα να είναι οργανωμένα σε υπο-επίπεδα. Καθώς γίνεται η σχεδίαση, 
είναι καλό να γίνεται απόκρυψη ή κλείδωμα των υπο-επιπέδων της εικό-
νας, ώστε να απομονώνεται το αντικείμενο που σχεδιάζεται. Μπορεί να 
αλλάξει η ιεράρχηση των επιπέδων με την μετακίνηση του ονόματος, πριν 
ή μετά από κάποιο άλλο στην παλέτα επιπέδων. Αν το πρόγραμμα διαθέ-
τει τη δυνατότητα αποθήκευσης των προβολών, καλό είναι, όταν τελειώ-
νει η σχεδίαση ενός αντικειμένου, να αποθηκεύεται και η προβολή του.

•	� Διαγραφή επιπέδων ή υπο-επιπέδων. Καθώς τα επιπλέον επίπεδα, τα 
οποία δε χρησιμοποιούνται πλέον, καταλαμβάνουν περισσότερο χώρο 
στο σκληρό δίσκο και επιβραδύνουν τη λειτουργία του υπολογιστή, προ-
τείνεται η διαγραφή τους.

Τα επίπεδα δημιουργούν κάποιες φορές και προβλήματα. Το συνηθέστερο είναι η 
δύσκολη επιλογή ενός αντικειμένου. Αυτή μπορεί να συμβαίνει για ένα από τους 
παρακάτω λόγους:

•	� Το επίπεδο του αντικειμένου είναι κλειδωμένο.

•	� Το αντικείμενο είναι κλειδωμένο.

•	� Οι άκρες του είναι αποκρυμμένες.
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Η καλύτερη μέθοδος, για να ξεπεραστούν τα παραπάνω προβλήματα, είναι ο εντο-
πισμός του επιπέδου στην παλέτα, η αλλαγή των ιδιοτήτων και η επιλογή των αντι-
κειμένων από αυτήν.

10.6 Τρόποι επεξεργασίας των αντικειμένων

Η επεξεργασία ενός αντικειμένου σχεδίασης, μετά την επιλογή του, είναι ιδιαίτερα 
απλή όσον αφορά στη μετακίνηση, περιστροφή και κλιμάκωσή του.

Μετακίνηση με χρήση ποντικιού: Επιλέγοντας με το ποντίκι επάνω στο περίγραμ-
μα – και με το πλήκτρο πατημένο – είναι δυνατή η μεταφορά του σε οποιοδήποτε 
σημείο του χώρου σχεδίασης. Προφανώς, για την ακριβή του τοποθέτηση χειροκί-
νητα πρέπει να χρησιμοποιηθούν οι διάφορες έλξεις. Υπάρχουν βέβαια και οι θυ-
ρίδες στην γραμμή ιδιοτήτων, στις οποίες συμπληρώνονται οι συντεταγμένες που 
προσδιορίζουν τη θέση του αντικειμένου. Με τον ίδιο τρόπο γίνεται και η περιστρο-
φή. Για ακριβή περιστροφή, χρειάζεται η χρήση των πλαισίων διαλόγου, αλλά και 
χειροκίνητα, αρκεί η διπλή επιλογή με το ποντίκι σε ένα από τα χειριστήρια ελέγ-
χου, ώστε να ενεργοποιηθεί η δυνατότητα περιστροφής.

Κλιμάκωση: Η κλιμάκωση ενός αντικειμένου, είναι αρκετά πιο σύνθετη λειτουρ-
γία. Συνήθως, σχεδιάζεται ένα αντικείμενο σε κάποιο κενό χώρο του χώρου ερ-
γασίας και μετά μετακινείται στην ακριβή του θέση ενώ συγχρόνως αλλάζουμε το 
μέγεθος ώστε να εναρμονίζεται με τα υπόλοιπα αντικείμενα. Πέρα όμως από αυτόν 
το σκοπό, υπάρχουν οκτώ περίπου είδη κλιμάκωσης που μετατρέπουν ένα αντικεί-
μενο, όπως στην Εικόνα 10.5 (το έντονο μαύρο περίγραμμα είναι το αρχικό σχήμα, 
το αχνό δείχνει πώς θα γίνει).
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Εικόνα 10.5: Τα είδη της κλιμάκωσης.
	 1.	 Αναλογική κλιμάκωση ως προς την κορυφή.
	 2.	 Οριζόντια κλιμάκωση ως προς το κέντρο με ταυτόχρονη πίεση του Shift.
	 3.	 Κάθετη κλιμάκωση προς την κορυφή με μετακίνηση της μεσαίας λαβής της βάσης.
	 4.	Κάθετη κλιμάκωση και αντιστροφή του αντικειμένου.
	 5.	 Αναλογική κλιμάκωση ως προς το κάτω αριστερό σημείο.
	 6.	 Οριζόντια κλιμάκωση προς τα αριστερά με μετακίνηση της μεσαίας δεξιάς λαβής..
	 7.	 Αναλογική κλιμάκωση ως προς το κέντρο με ταυτόχρονη πίεση του Shift.
	 8.	Κάθετη κλιμάκωση προς τη βάση με μετακίνηση της μεσαίας λαβής της κορυφής.

Το σημαντικό, με το θέμα της κλιμάκωσης, είναι ότι μπορεί να γίνει και σε κείμενο. 
Έτσι, δεν ενδιαφέρει ιδιαίτερα το μέγεθος των γραμμάτων, καθώς αυτά μπορούν να 
πάρουν το επιθυμητό μέγεθος εκ των υστέρων (καλλιτεχνικό κείμενο).
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Χρήση του διαχειριστή αντικειμένων: Με το διαχειριστή των αντικειμένων η επιλο-
γή ενός αντικειμένου ή ομάδας γίνεται εξαιρετικά απλή, αρκεί η επιλογή του ονόματός 
του. Όπως αναφέρθηκε στην αρχή του κεφαλαίου, τα αντικείμενα αυτά διατάσσονται 
ανάλογα με το χρόνο κατασκευής τους. Το πρώτο βρίσκεται στο κάτω μέρος του σω-
ρού, ενώ το τελευταίο ή πιο πρόσφατο χρονικά βρίσκεται στην κορυφή. Αυτό φαίνεται 
και στο δέντρο του Διαχειριστή Αντικειμένων. Για την αλλαγή ενός αντικειμένου στο 
σωρό απλά ενεργοποιήστε το όνομα και με το πλήκτρο πατημένο σύρετε το ποντίκι 
προς τα επάνω ή κάτω. Θα αλλάξει και η διάταξη των αντικειμένων. (Εικόνα 10.6).

Με παρόμοιο τρόπο μετακινείται ένα αντικείμενο ή ομάδα από ένα επίπεδο σε ένα 
άλλο. Δεν είναι δυνατή η μετακίνηση άμεσα όμως, από μια σελίδα σε μια άλλη. Συ-
νήθως χρησιμοποιείται η μέθοδος της αποκοπής και επικόλλησης.

Εικόνα 10.6: Η μεταφορά και αντιγραφή σε νέα θέση ενός αντικειμένου.

Περιστροφή και στρέβλωση: Επιλέγοντας με διπλή επιλογή του ποντικιού το πε-
ρίγραμμα ενός σχήματος ή μια ομάδας, εμφανίζονται τα χειριστήρια στροφής και 
στρέβλωσης. Για την περιστροφή χρησιμοποιούνται τα τέσσερα γωνιακά. Το κέντρο 
περιστροφής του ή των αντικειμένων είναι ο κύκλος με την κουκκίδα, όπως φαίνε-
ται στην Εικόνα 10.7.
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Εικόνα 10.7: Η διπλή επιλογή του ποντικιού μιας ομάδας, που γίνεται ακριβώς όπως σε ένα 
αντικείμενο, εμφανίζει τα χειριστήρια περιστροφής.

Αν οδηγηθεί ο δείκτης του ποντικιού πάνω από το κέντρο περιστροφής, αλλάζει 
σχήμα και μετατρέπεται σε σταυρόνημα. Επιλέγοντας το σταυρόνημα με το ποντίκι 
και κρατώντας πατημένο το πλήκτρο του, μπορούμε να το μετακινήσουμε σε μια 
νέα θέση. Σύροντας το ποντίκι πάνω από τα χειριστήρια περιστροφής, αρχίζει και η 
στροφή των αντικειμένων γύρω από το κέντρο (Εικόνα 10.8)

Εικόνα 10.8: Η περιστροφή αντικειμένων.

Ακριβείς Μετασχηματισμοί: Όλοι αυτοί οι μετασχηματισμοί, μπορούν να γίνουν 
και από το δικό τους παράθυρο διαλόγου. Αυτό εμφανίζεται από τον κατάλογο εντο-
λών των Μετασχηματισμών (Arrange, Transformations...).
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Στο δεξί τμήμα του παράθυρου εργασίας εμφανίζεται ο αντίστοιχος διαχειριστής 
ενεργειών. (Εικόνα 10.9). Στις θυρίδες των Συντεταγμένων (Position) εισάγονται (αν 
είναι απαραίτητο) τα μήκη μετακίνησης για τους δύο άξονες. Σημασία έχει το κουτί 
των Σχετικών Συντεταγμένων (Relative Position), όταν εισάγονται αριθμητικές τιμές 
στις θυρίδες. Όταν είναι ενεργοποιημένο, οι συντεταγμένες είναι σχετικές, δηλαδή, η 
μέτρηση γίνεται όχι από την αρχή των αξόνων, αλλά από την προηγούμενη θέση του 
αντικειμένου. Επίσης, με το εικονίδιο Εφαρμογή σε Αντιγράφου (Apply To Duplicate) 
γίνεται αντιγραφή του αντικειμένου και μετασχηματισμός στο αντίγραφο.

Εικόνα 10.9:
To παράθυρο διαλόγου Μετασχηματισμών.

Ανακεφαλαίωση 10ου Κεφαλαίου

Τα σχεδιαστικά εργαλεία έχουν πολλές δυνατότητες για τη διαχείριση των αντι-
κειμένων. Από τη λωρίδα ιδιοτήτων τους, δίνονται πληροφορίες σχετικές με τη 
θέση του μέσα στο χώρο εργασίας, ώστε να είναι δυνατή η ακριβής μετακίνησή 
του. Αφού επιλεγεί ένα αντικείμενο είναι δυνατή η μετακίνησή του, η στροφή 
και η κλιμάκωση ή αλλαγή μεγέθους. Πολλές φορές είναι χρήσιμη η συνολική 
επεξεργασία αντικειμένων. Για το λόγο αυτόν τα σχεδιαστικά προγράμματα δια-
θέτουν πολλά εργαλεία επιλογής, ώστε να δίνουν εναλλακτικούς τρόπους για 
την ομαδοποίηση των αντικειμένων. Αφού επιλεγούν τα αντικείμενα μπορούν 
να οργανωθούν σε ομάδες με ονόματα. Αυτό καθιστά εύκολη την επιλογή τους 
και τροποποίησή τους κατά ομάδες. Όταν οι ομάδες αντικειμένων γίνουν πολλές, 
καλή είναι η οργάνωση του σχεδίου σε επίπεδα σχεδίασης. Κάθε επίπεδο διαθέ-
τει ομοειδή αντικείμενα. Για την επεξεργασία των αντικειμένων ενός επιπέδου 
είναι απαραίτητη η ενεργοποίησή του. Έτσι παρέχεται πρόσθετη ασφάλεια, κα-
θώς οι αλλαγές που γίνονται σε ένα επίπεδο δεν επηρεάζουν τα υπόλοιπα.
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Ασκήσεις 10ου Κεφαλαίου

1.	� Πόσοι τρόποι υπάρχουν για να επιλέξουμε ένα αντικείμενο; Πόσοι για να επι-
λέξουμε πολλά αντικείμενα; Ποια πλεονεκτήματα έχουμε με τη δημιουργία των 
ομάδων αντικειμένων;

2.	� Συνεχίστε να δημιουργείτε αντικείμενα σε επίπεδα με το δικό τους όνομα με αντι-
κειμενικό σκοπό τη δημιουργία ενός προσκλητηρίου, π.χ. σε πάρτι. Στο τέλος 
ομαδοποιήστε όλα τα αντικείμενα. Παρατηρήστε πόσο πιο εύκολα μπορούν να 
τοποθετηθούν σε χαρτιά διαφορετικών μεγεθών, καθώς επίσης ότι οι αλλαγές 
μπορούν να γίνουν ανεξάρτητα, σε διαφορετικά επίπεδα.

Δραστηριότητες 10ου Κεφαλαίου

1.	� Δοκιμάστε να δημιουργήσετε το χιονάνθρωπο της εικόνας του βιβλίου. Έχει δη-
μιουργηθεί από έναν κύκλο που αλλάζει συνέχεια μέγεθος και αντιγράφεται. Τα 
μόνα αντικείμενα που φτιάχνονται διαφορετικά είναι το καπέλο και τα χέρια. 
Ακόμη όμως και τα χέρια δημιουργούνται με διπλασιασμό και αντιστροφή.

2.	� Με αφετηρία την εικόνα 10.5 δοκιμάστε ποιες από τις εμφανιζόμενες κλιμακώ-
σεις γίνονται στο πρόγραμμα σχεδίασης του εργαστηρίου σας. Σημειώστε προ-
σεκτικά τα βήματα που ακολουθήσατε. Αν υπάρχει δυνατότητα, συγκρίνετε τα 
βήματα σε ομοειδή προγράμματα.

3.	� Βρείτε κάποιο λογότυπο της αρεσκείας σας από κάποιο έντυπο και προσπαθήστε 
να το αντιγράψετε.

4.	�Επιλέξτε φωτογραφία ενός φύλλου δένδρου, καρπού, ή όποιου άλλου αντικειμέ-
νου κρίνετε εσείς κατάλληλο. Εισάγετέ το με τον σαρωτή στο πρόγραμμα σχεδία-
σης του εργαστηρίου σας, και αντιγράψτε το με την πένα Bezier. Ο στόχος είναι 
να το στυλιζάρετε, με όποιο τρόπο θέλετε. Στην συνέχεια, με βάση το στυλιζαρι-
σμένο αντικείμενο, δημιουργήστε ένα εταιρικό σήμα.
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Κεφάλαιο 11ο
Μετασχηματισμοί γεωμετρίας και μορφής αντικειμένων

Στόχοι:

Μετά τη μελέτη αυτού  του κεφαλαίου οι μαθητές θα είναι σε θέση να:

	 •	� Αντιληφθούν τη σημασία και τις εφαρμογές των γεωμετρικών μετασχη-
ματισμών δισδιάστατων αντικειμένων στην ψηφιακή σχεδίαση.

	 •	 �Κατανοήσουν τις αρχές των γεωμετρικών μετασχηματισμών καθώς και 
των μετασχηματισμών μορφής δισδιάστατων αντικειμένων.

	 •	 �Επιλέξουν και εφαρμόσουν τους κατάλληλους μετασχηματισμούς ώστε 
να επιτύχουν το, ανάλογα με την περίπτωση, επιθυμητό αποτέλεσμα.

11.1 Εισαγωγή

Σε όλα τα σχεδιαστικά προγράμματα συχνά χρειάζεται, από τα βασικά γεωμετρικά 
σχήματα που διαθέτει, να δημιουργούνται εύκολα άλλα πιο πολύπλοκα. Βέβαια, θα 
παρατηρήσει κάποιος ότι αυτό μπορεί να γίνει και με τα εργαλεία της ελεύθερης 
σχεδίασης. Κάτι τέτοιο όμως συνήθως απαιτεί περισσότερο χρόνο και κόπο. Αντι-
γράφοντας και τροποποιώντας ένα αντικείμενο δημιουργείται εύκολα κάποιο άλλο.

Παραδείγματος χάρη, ένα σχήμα περιστρέφεται, μετά από την επιλογή του με το πο-
ντίκι, σύροντας κάποια από τις τέσσερις λαβές περιστροφής. Γίνεται επίσης περιστρο-
φή κατά 180 μοίρες οριζόντια ή κάθετα. Υπενθυμίζεται ότι, αν πατηθεί το δεξί πλήκτρο 
του ποντικιού ταυτόχρονα με το αριστερό, το πρότυπο αντικείμενο παραμένει ως έχει, 
ενώ ένα αντίγραφο δημιουργείται στη νέα θέση μαζί με την παραμόρφωση που τέθη-
κε. Οι χειρισμοί αυτοί γίνονται πιο κατανοητοί με τη βοήθεια της παρακάτω άσκησης:

•	� Δημιουργούμε ένα Π με το εργαλείο γραμμών Bezier, (Εικόνα 11.1 Α), 
χρησιμοποιώντας την έλξη στον κάνναβο και με τη χρήση του πλήκτρου 
Ctrl για τη δημιουργία ευθειών.

•	� Όταν παρουσιαστούν τα έξι χειριστήρια - λαβές, επιλέγουμε με το ποντίκι 
το μέσον της επάνω γραμμής. Κατόπιν, πιέζοντας το πλήκτρο Ctrl συνέ-
χεια ώστε η μετατροπή του αντικειμένου να γίνεται σε βήματα του 100%, 
σύρουμε το ποντίκι προς τα κάτω. (Εικόνα 11.1 Β). Όταν δούμε τη μπλε 
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γραμμή του αντικειμένου που πρόκειται να αντιγραφεί, να δημιουργείται 
συμμετρικά κάτω, πατάμε το δεξί πλήκτρο για να δημιουργηθεί αντίγραφο.

•	� Δημιουργείται ένα νέο κατοπτρικό. Πηγαίνουμε στην αριστερή κάθετη 
γραμμή και επιλέγουμε το μεσαίο χειριστήριο. Μετακινούμε το δείκτη 
του ποντικιού προς τα δεξιά, με το πλήκτρο Ctrl πατημένο και το αφή-
νουμε. (Εικόνα 11.1 Γ). Έτσι το δεύτερο ανεστραμμένο Π αναδιπλώνεται. 
Επαναλάβατε τη διαδικασία, ώστε να δημιουργηθεί ένας μαίανδρος.

Ο τρόπος σχεδίασης που περιγράφηκε στην άσκηση είναι αρκετά απλός. Υπάρχουν 
βέβαια και πλέον αυτοματοποιημένες μέθοδοι. Σημασία έχει ότι με απλές μεθόδους 
από ένα απλό σχήμα μπορούμε να φθάσουμε σε κάτι πολύ πιο σύνθετο.

A Β Γ

Εικόνα 11.1: (Α) Με την βοήθεια οδηγών σχεδιάζουμε ένα Π.
(Β) Πιέζοντας το πλήκτρο Ctrl συνέχεια, ώστε η μετατροπή του αντικειμένου να γίνεται σε βήμα-
τα του 100%, σύρουμε το ποντίκι προς τα κάτω.
(Γ) Μετακινούμε το δείκτη του ποντικιού προς τα δεξιά, με το πλήκτρο Ctrl πατημένο και το αφή-
νουμε.

11.2 Τεχνικές τροποποίησης των αντικειμένων με χρήση μετασχηματισμών

Οι κύκλοι, τα παραλληλόγραμμα, οι ελλείψεις, μπορούν να μετασχηματιστούν εύ-
κολα. Τα παραλληλόγραμμα στρογγυλεύουν, οι κύκλοι γίνονται τόξα ενώ ακόμα και 
οι απλές γραμμές μπορούν να αλλάξουν μορφή. Αυτοί οι μετασχηματισμοί δίνονται 
από τις διάφορες γραμμές εργαλείων που εμφανίζονται όταν το σχήμα είναι επιλεγ-
μένο. Στην Εικόνα 11.2 επιλέχθηκαν για το παραλληλόγραμμο τα εικονίδια Στρογγυ-
λοποίησης των γωνιών (Rectangle Corner Roundness) για τη στρογγυλοποίηση των 
γωνιών του. Επιλέγοντας το πλήκτρο Εφαρμογής της στρογγυλοποίησης σε όλες τις 
γωνίες (Round Corner Together) θα στρογγυλοποιηθούν όλες οι γωνίες.
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Εικόνα 11.2: Στρογγυλοποίηση γωνιών ορθογωνίου.

Στις ελλείψεις υπάρχουν τρία διαφορετικά πλήκτρα με τα οποία μια έλλειψη να μετα-
τρέπεται σε πίτα ή τόξο. Η αλλαγή της ακτίνας μιας πίτας ή ενός τόξου γίνεται με χρή-
ση του πλαισίου αυξομείωσης έναρξης της γωνίας (starting angle) στην επάνω θυ-
ρίδα και του πλαισίου αυξομείωσης τέλους της γωνίας (ending point) (Εικόνα 11.3).

Εικόνα 11.3: Οι διάφοροι τρόποι επεξεργασίας των ελλείψεων.

Με τον ίδιο τρόπο αλλάζει το πλήθος πλευρών ενός πολυγώνου ή αστεριού αλλά 
γίνεται και η μετατροπή από πολύγωνο σε αστέρι ή το αντίστροφο. Με τη χρήση της 
θυρίδας αριθμού πλευρών (Number of Polygon Sizes) αυξομειώνονται οι πλευρές 
ενός πολυγώνου, ενώ με το εικονίδιο που μοιάζει με αστέρι γίνεται η μετατροπή του 
σε αστέρι (Εικόνα 11.4).
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Εικόνα 11.4: Ο σχηματισμός ενός αστεριού από πεντάγωνο.

Οι ίδιες εργασίες μπορούν να γίνουν και με το εργαλείο επεξεργασίας των λαβών. Με 
το εργαλείο αυτό, μετακινώντας τη λαβή ο κύκλος μετατρέπεται σε πίτα, όπως στην 
Εικόνα 11.5.

Εικόνα 11.5: Η μετατροπή κύκλου σε πίτα.

11.3 Μετασχηματισμοί των στοιχειωδών γεωμετρικών αντικειμένων

Με τα κατάλληλα εργαλεία ένα στοιχειώδες γεωμετρικό σχήμα, ένα τρίγωνο ή ένας 
κύκλος μπορεί να αλλάξει ριζικά σχήμα ώστε να θυμίζει κάτι άλλο. Το καταλληλότε-
ρο εργαλείο είναι αυτό της διάπλασης κόμβων (shape tool). Ανάλογος με το σχήμα 
είναι και ο αριθμός των σχηματιζόμενων κόμβων. Για παράδειγμα, το τετράγωνο 
έχει τέσσερις κόμβους στις γωνίες του, ενώ τα πολύγωνα έχουν ένα για κάθε κορυ-
φή τους και από ένα ακόμη στο μέσο κάθε πλευράς. Όσο περισσότερους κόμβους 
έχει ένα αντικείμενο, τόσο πιο εύπλαστο είναι.
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Η μετακίνηση των κόμβων είναι ιδιαίτερα απλή με το εργαλείο τους. Στην Εικόνα 

11.6 δημιουργούμε ένα στρογγυλεμένο ορθογώνιο από τους κόμβους του. Θα μπο-

ρούσε βέβαια να γίνει και από το ειδικό εικονίδιο στην αντίστοιχη εργαλειοθήκη, 

αλλά μετακινώντας τα γωνιακά σημεία μπορούμε να δώσουμε στη γωνία την κα-

μπυλότητα που θέλουμε σε πραγματικό χρόνο.

Εικόνα 11.6: Ρύθμιση της καμπυλότητας των γωνιών του ορθογώνιου παραλληλεπίπεδου.

Εργαλείο για μετασχηματισμούς μέσω των κόμβων είναι και το μαχαίρι (knife tool). 

Αυτό «κόβει» ένα σχήμα προσθέτοντας τους αντίστοιχους κόμβους. Έτσι, από ένα 

τρίγωνο μπορούν να δημιουργηθούν δύο άλλα. Με τον ίδιο τρόπο από έναν κύκλο 

μπορούν να δημιουργηθούν δύο ημικύκλια (Εικόνα 11.7)

Εικόνα 11.7: Η επεξεργασία σχήματος με το «μαχαίρι».

Με το εργαλείο των κόμβων μπορούν να προστεθούν νέα σημεία κόμβοι. Στην ερ-

γαλειοθήκη του, αριστερά, υπάρχει ένα εικονίδιο με το σήμα της πρόσθεσης. Όταν 

επιλεγεί, προστίθεται ένας κόμβος στο αριστερό τμήμα του ενεργοποιημένου κόμ-

βου, αντίστροφα δηλαδή από την κίνηση των δεικτών του ρολογιού. Με τη μετακί-

νησή του το σχήμα μπορεί να αλλάξει ριζικά, όπως φαίνεται στην Εικόνα 11.8.
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Εικόνα 11.8: Αλλαγή του σχήματος με την προσθήκη νέων κόμβων.

Το διπλανό εικονίδιο, αυτό με το σήμα της αφαίρεσης, διαγράφει κάποιον επιλεγ-
μένο κόμβο από το σχήμα. Τα υπόλοιπα εικονίδια, ανάλογα με τη λειτουργία τους, 
μπορούν να ενώσουν δύο κόμβους κλείνοντας ένα σχήμα, να «σπάσουν» ένα κόμβο 
σε δύο για να «ανοίξουν» ένα σχήμα, να μετατρέψουν δύο κόμβους σε γραμμικούς, 
να τους μετατρέψουν σε συμμετρικούς κτλ.

Εργαλείο μετατροπής γεωμετρικών σχημάτων είναι και η γόμα, στην παλέτα ερ-
γαλείων Shape. Με αυτή αφαιρούνται τμήματα από ένα γεωμετρικό σχέδιο. Στην 
Εικόνα 11.9, αφαιρέθηκαν τμήματα από την έλλειψη, ώστε να φαίνεται το παραλ-
ληλόγραμμο πίσω από αυτήν.

Εικόνα 11.9: Με την αφαίρεση τμημάτων της έλλειψης φαίνεται το παραλληλόγραμμο από πίσω.
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Τρόπος μετατροπής σχημάτων θα μπορούσε να θεωρηθεί και η εντολή Αντιγρα-
φής Ιδιοτήτων (Copy Properties From...) που βρίσκεται στον κατάλογο εντολών της 
Επεξεργασίας (Edit). Με αυτή την εντολή, το επιλεγμένο σχήμα μπορεί να πάρει το 
πάχος και το χρώμα του περιγράμματος, καθώς και το χρώμα του γεμίσματος από 
κάποιο άλλο σχήμα (Εικόνα 11.10).

Εικόνα 11.10: To μενού Copy Properties From...

11.4 Χρωματισμός αντικειμένων

Εκτός από το μετασχηματισμό της μορφής των γεωμετρικών σχημάτων μπορεί να 
τους αποδοθεί κάποιο χρώμα ή να τροποποιηθεί το περίγραμμά τους. Τα σχεδιαστι-
κά προγράμματα προσφέρουν μια πληθώρα από στυλ περιγράμματος, μεταβλητού 
πάχους, διακεκομμένα ή διάστικτα.

Τα αντικείμενα μόλις σχεδιαστούν, αποκτούν το εξ ορισμού χρώμα, που είναι αυτό 
που ορίστηκε την τελευταία φορά. Ο διαφορετικός χρωματισμός αντικειμένων γί-
νεται με την επιλογή κάποιου χρώματος από την αντίστοιχη παλέτα. Τότε, το σχήμα 
αποκτά γέμισμα με το χρώμα αυτό. Με το δεξί πλήκτρο του ποντικιού στην παλέτα 
χρωμάτων αποκτά χρώμα στο περίγραμμα. Υπάρχουν πολλοί τρόποι για να δημι-
ουργηθούν πολύπλοκα περιγράμματα και γεμίσματα. Για να αλλαχτεί το εξ ορισμού 
χρώμα αρκεί η επιλογή κάποιου άλλου, χωρίς όμως να υπάρχει, εκείνη την στιγμή, 
επιλεγμένο αντικείμενο.

Περιγράμματα: Το πάχος της γραμμής αποδίδεται από το αντίστοιχο εργαλείο, που 
είναι το προτελευταίο εικονίδιο της εργαλειοθήκης. Αν επιλεχθεί, τότε φαίνεται η 
πτυσσόμενη παλέτα της (Εικόνα 11.11). Τα τελευταία έξι εικονίδια αντιπροσωπεύ-
ουν διάφορα πάχη περιγράμματος.
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Αυτός είναι ίσως ο γρηγορότερος τρόπος για να δώσουμε συγκεκριμένο πάχος στο 
περίγραμμα του επιλεγμένου αντικειμένου, αρκεί να επιλέξουμε με το ποντίκι το 

Εικόνα 11.11: Η εργαλειοθήκη περιγραμμάτων.

επιθυμητό πάχος από την εργαλειοθήκη περιγραμμάτων. Οι διαθέσιμες επιλογές 
είναι πολύ λεπτό (hairline), 2, 8, 16 ή 24 στιγμές. Περιγράμματα σε γραμμές απο-
δίδονται και από τη γραμμή ιδιοτήτων περιγράμματος (Εικόνα 11.12). Οι επιλογές 
στην αντίστοιχη παλέτα είναι:

•	� Η Αρχή Βέλους (Start Arrowhead Selector) ορίζει την εμφάνιση των βε-
λών στην αρχή της καμπύλης (αν υπάρχει).

•	� Η Μορφή Γραμμής (Outline Style Selector) ορίζει την εμφάνιση της 
γραμμής που μπορεί να είναι από διακεκομμένες και διάστικτες γραμμές 
έως και συνεχείς.

•	� Η Τέλος Βέλους (End Arrowhead Selector) ορίζει την εμφάνιση των βε-
λών στο τέλος της καμπύλης (αν υπάρχει).

•	� Με το Πάχος Γραμμής (Outline Width Selector) μπορούμε να επιλέξουμε 
από μια μεγαλύτερη ποικιλία παχών περιγραμμάτων.

Εικόνα 11.12: H γραμμή ιδιοτήτων περιγραμμάτων.

Επιλέγοντας το πρώτο εικονίδιο της παλέτας των περιγραμμάτων από την εργαλειοθήκη 
εμφανίζεται η πλήρης καρτέλα τους (Εικόνα 11.13). Εκεί γίνονται οι πλήρεις ρυθμίσεις.

Εικόνα 11.13:
Το πλήρες παράθυρο των περιγραμμάτων.
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Το παράθυρο διαλόγου Γραμμής (Outline Pen) δίνει έλεγχο πάνω στο πάχος της 
γραμμής (έως 1/1000 της ίντσας). Υπάρχει, επίσης, μια τεράστια ποικιλία από δια-
θέσιμες διάστικτες και διακεκομμένες γραμμές. Στην ενότητα Βέλη (Arrows) υπάρ-
χουν διάφορα ειδικά σύμβολα για την αρχή και το τέλος της γραμμής. Η περιο-
χή γωνίες (Corners) του παράθυρου δίνει τη δυνατότητα εφαρμογής στις γραμμές 
στρογγυλεμένων γωνιών. Η ενότητα Τέλος Γραμμών (Line Caps) ορίζει την εμφά-
νιση του τελειώματος των γραμμών. Η περιοχή Καλλιγραφία (Calligraphy) δίνει το 
εφέ της μετατόπισης ενός σημαδιού κατά μια γωνία, για να δώσει μια λεπτότερη 
γραμμή. Συνήθεις τιμές για τη θυρίδα Στροφής (Stretch) είναι 80 – 100% και για 
τη θυρίδα Γωνίας (Angle) από 0 μέχρι 20 μοίρες. Το πλαίσιο ελέγχου Πίσω Γέμισμα 
(Behind Fill) μετακινεί ένα περίγραμμα πίσω από το γέμισμα ενός σχήματος. Το 
πλαίσιο ελέγχου Κλιμάκωση με την εικόνα (Scale with Image) κάνει το περίγραμμα 
παχύτερο ή λεπτότερο, όταν το αντικείμενο αλλάζει μέγεθος για να διατηρήσει στα-
θερή σχέση αναλογίας μεταξύ πάχους περιγράμματος προς μέγεθος αντικειμένου.

Γεμίσματα: Το θέμα του γεμίσματος των αντικειμένων με χρώμα στα σχεδιαστικά 
προγράμματα είναι φαινομενικά μεν απλή υπόθεση. Μπορεί όμως να αποβεί περί-
πλοκη, γιατί οι δυνατότητες του εκτυπωτή επιδρούν καθοριστικά στον τρόπο με τον 
οποίο τυπώνονται τα γεμίσματα.
Υπάρχει ένα πλήθος γεμισμάτων που τυπώνονται σε οποιοδήποτε εκτυπωτή. Υπάρ-
χουν, όμως, πολύ περισσότερα που απευθύνονται σε συγκεκριμένους τύπους εκτυ-
πωτικών συσκευών και εικονοθετών.
Οποιαδήποτε κλειστή καμπύλη μπορεί να αποκτήσει γέμισμα. Σ’ αυτές συμπεριλαμ-
βάνονται τα κείμενα και οι πολύπλοκες καμπύλες καθώς επίσης και απλά αντικεί-
μενα, όπως τα ορθογώνια και οι ελλείψεις. Μια ανοιχτή καμπύλη θα πρέπει πρώτα 
να μετατραπεί σε κλειστή. Ισχύει και το αντίθετο, αν μια καμπύλη δεν μπορεί να 
«γεμίσει» με κάποιο χρώμα, τότε αυτή απλά είναι ανοιχτή. Η μετατροπή της σε 
κλειστή είναι εύκολη. Επιλέγοντας με το εργαλείο των κόμβων τον πρώτο και τε-
λευταίο, πιέζοντας το δεξί πλήκτρο του ποντικιού και ενεργοποιώντας την εντολή 
ένωσης (Join) (Εικόνα 11.14). Βέβαια, υπάρχουν και οι εξαιρέσεις, στο Illustrator 
αλλά και στο CorelDraw δεν απαιτείται μια καμπύλη να είναι κλειστή, μπορεί να 
πάρει γέμισμα και να φαίνεται σαν να έχει κλείσει. 
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Εικόνα 11.14:
Η ένωση λαβών με την εντολή Join.

Τα περισσότερα σχεδιαστικά προγράμματα έχουν πέντε βασικούς τύπους γεμισμά-
των, που μπορούν να εφαρμοστούν σε οποιοδήποτε επιλεγμένο, κλειστό αντικείμε-
νο. Αυτοί είναι:

•	� Ενιαίος – Πλακάτο (Uniform): Ομοιόμορφο γέμισμα με ένα χρώμα.

•	� Διαβάθμιση – Ντεγκραντέ (Fountain): Γεμίσματα, χρώματα δηλαδή που 
βαθμιαία αλλάζουν και μετατρέπονται από το ένα στο άλλο.

•	� Μοτίβα (Pattern): Γεμίσματα μοτίβων που γίνονται από ψηφιογραφικά 
ή διανυσματικά αρχεία.

•	� Υφή (Texture): Γεμίσματα υφής που γίνονται από ψηφιογραφικά αρχεία 
και μπορούν να αλλάξουν.

•	� Postscript: Γεμίσματα που χρησιμοποιούν τη γλώσσα προγραμματισμού 
Postscript για να δημιουργήσουν μοτίβα.

Από τους πέντε αυτούς τρόπους οι δύο πρώτοι είναι αυτοί που χρησιμοποιούνται 
περισσότερο. Οι άλλοι τρεις χρησιμοποιούνται για ειδικά εφέ. Ο απλούστερος και 
πιο συχνά χρησιμοποιούμενος τρόπος γεμίσματος είναι το γκρι. Επίσης είναι το γέ-
μισμα που θέλει το μικρότερο χρόνο εκτύπωσης, ενώ εκτυπώνεται από όλους τους 
εκτυπωτές, είτε έγχρωμοι είναι αυτοί είτε Laser.

Η απόδοση ενός τόνου του γκρι δίνεται από την παλέτα των χρωμάτων. Εκεί το 
πρώτο τετράγωνο, με ένα X μέσα του, αντιστοιχεί στην κατάσταση χωρίς γέμισμα ή 
περίγραμμα. 
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Στην συνέχεια, το δεύτερο τετράγωνο στην σειρά, είναι το μαύρο, το τρίτο 90% 
γκρι, το τέταρτο 80% κτλ., μέχρι το λευκό χρώμα. Στην Εικόνα 11.15 φαίνονται όλες 
οι αποχρώσεις του γκρι που δίνονται έτοιμες.

Εικόνα 11.15:
Οι έτοιμοι τόνοι του γκρι, εκτός του 
τετραγώνου που είναι χωρίς γέμισμα (0%).

100%

90% 40%

80% 30%

70% 20%

60% 10%

50% 0%

Ομοιόμορφο γέμισμα: Εκτός από τα σταθερά χρώματα που υπάρχουν στην εργαλειο-
θήκη, μπορεί να δημιουργηθούν άλλα, χρησιμοποιώντας τα βασικά. Η διαδικασία της 
ανάμειξης των χρωμάτων είναι παρόμοια στο παράθυρο Ομοιόμορφο γέμισμα (Uniform 
Fill) και στο παράθυρο Color Dockers, με το πλεονέκτημα του δεύτερου να παραμένει 
σταθερό στο χώρο εργασίας. Αν λοιπόν χρωματίζετε τα αντικείμενά σας αφού τα σχεδι-
άσετε, καλύτερα να χρησιμοποιείτε τους διαχειριστές Dockers. Η εμφάνισή τους γίνεται 
από τον πτυσσόμενο κατάλογο Παράθυρο>Διαχειριστές (Window>Dockers>Color).
Οι τέσσερις καρτέλες στο παράθυρο Uniform Fill μας δίνουν τέσσερις διαφορετι-
κούς τρόπους καθορισμού χρωμάτων. (Εικόνα 11.16). Οι πρώτες δύο μας επιτρέπουν 
να αναμειγνύουμε τα βασικά χρώματα κάθε κλίμακας για να δημιουργήσουμε ένα 
χρώμα της αρεσκείας σας. Οι άλλες δύο καρτέλες χρησιμοποιούνται για επιλογή 
χρωμάτων από σταθερές παλέτες.

Εικόνα 11.16:
To παράθυρο καθορισμού 
χρωμάτων.
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Με τις δύο πρώτες καρτέλες, δηλαδή αυτές των χρωματικών συστημάτων (Models) 
και της ανάμειξης (Mixers), μας δίνεται η δυνατότητα ανάμειξης χρωμάτων χρησι-
μοποιώντας τις τρεις πιο ευρέως χρησιμοποιούμενες μεθόδους για τον καθορισμό 
προσαρμοσμένων χρωμάτων, δηλαδή CMYK, RGB και HSB. Οι δύο καρτέλες δίνουν 
παρόμοιες επιλογές για την ανάμειξη. Έτσι, στην καρτέλα Models καθορίζουμε το 
χρώμα επιλέγοντας κάποιο με το ποντίκι στη μεγάλη παλέτα που γεμίζει την αρι-
στερή πλευρά της καρτέλας διαλόγου. Χρώματα δημιουργούνται και με την εισαγω-
γή αριθμητικών τιμών στις αντίστοιχες θυρίδες που βρίσκονται στη δεξιά πλευρά.

Όπως φαίνεται τα προγράμματα παρέχουν την άνεση εργασίας και εκτύπωσης είτε 
σε σύστημα χρωμάτων RGB είτε σε CMYK που είναι τα πλέον χρησιμοποιούμενα 
συστήματα χρωμάτων. Αυτό βέβαια είναι θετικό αλλά δημιουργεί και προβλήματα, 
γιατί το περιβάλλον εκτύπωσης δεν μπορεί να αποδώσει με ακρίβεια τα φωτεινά 
χρώματα RGB. Ως αποτέλεσμα, τα χρώματα αυτά εκτυπώνονται συνήθως θαμπά ή 
ξεθωριασμένα. Επομένως αν η τελική εργασία πρόκειται να τυπωθεί επιλέγουμε το 
σύστημα CMYK. Η εργασία στο RGB προτείνεται για δημιουργίες που θα προβλη-
θούν είτε μέσω της οθόνης, είτε μέσω προβολικού και φυσικά για το διαδίκτυο.

«Ντεγκραντέ»: Το σταδιακό γέμισμα, τώρα, ή «Ντεγκραντέ» (Fountain fill) είναι 
ένα από τα ωραιότερα εφέ που αποδίδονται σε γέμισμα αντικειμένων. Σ’ αυτό απλώς, 
ένα χρώμα μετατρέπεται βαθμιαία σε άλλο. Τα γεμίσματα του είδους, (Εικόνα 11.17), 
αποδίδονται χρησιμοποιώντας το παράθυρο διαλόγου Διαβάθμισης (Fountain Fill).

Εικόνα 11.17:
To μενού καθορισμού 
διαβαθμίσεων.
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Στη θυρίδα διαλόγου Τύπος (Type) ορίζεται το είδος της διαβάθμισης. Είναι τεσ-
σάρων ειδών: η γραμμική, η σφαιρική, η κωνική και η τετραγωνική. Επιλέγοντας 
κάποιον τύπο, βλέπουμε μια προεπισκόπησή του στο αντίστοιχο παράθυρο. Στην πε-
ριοχή Ανάμειξης (Color Blend) ορίζεται η ανάμειξη των χρωμάτων. Η πιο απλή είναι 
η ανάμειξη δύο χρωμάτων. Με το χειριστήριο Μέσον Ανάμιξης (Midpoint) μετατοπί-
ζεται το σημείο εναλλαγής των δύο χρωμάτων. Με το εικονίδιο Από (From) καθορί-
ζουμε το χρώμα με το οποίο ξεκινάτε, ενώ με το εικονίδιο Στο (Το) χρώμα στο οποίο 
καταλήγετε. Δίπλα ακριβώς υπάρχουν τρία εικονίδια και ο χρωματικός κύκλος. Με τα 
εικονίδια αυτά καθορίζονται τα χρώματα που θα εμφανίζονται στην ανάμειξη. Στον 
κύκλο φαίνεται ένα βελάκι, που δείχνει από ποια χρώματα περνάει η ανάμειξη. Τέ-
λος, στο κάτω τμήμα υπάρχει η θυρίδα Προκαθορισμένα Στυλ (Presets), στην οποία 
αναπαρίστανται πολλές όμορφες, προκατασκευασμένες διαβαθμίσεις.

        

Εικόνα 11.18:
Παρόμοιες διαβαθμίσεις γίνονται και
με το εργαλείο Interactive Fill Tool που
βρίσκεται στην κεντρική εργαλειοθήκη.

Μοτίβα: Εκτός από τα γεμίσματα των αντικειμένων με χρώμα, μπορεί να τους απο-
δοθεί η υφή και το μοτίβο. Ένα γέμισμα με μοτίβο θα αποτελείται από τόσες μικρές 
ορθογώνιες περιοχές, όσες απαιτούνται για να γεμίσει το αντικείμενο. Θυμίζει αρ-
κετά την ταπετσαρία ενός τοίχου. Το μέγεθός τους ορίζεται, έτσι ώστε να υπάρχει 
λογική αναλογία ανάμεσα στο μέγεθός τους και στο συνολικό μέγεθος της περιο-
χής. Τα μοτίβα μπορούν να προέλθουν από διάφορες πηγές, οι πιο συνηθισμένες 
είναι από τα ήδη υπάρχοντα στα προγράμματα και στις βιβλιοθήκες τους. Μπορούν 
όμως να δημιουργηθούν ξεχωριστά και από τον ίδιο το χρήστη (Εικόνα 11.19). Η 
χρήση τους θέλει λίγη προσοχή, καθώς τα πολύπλοκα «βαραίνουν» ιδιαίτερα την 
εκτύπωση, είτε αυτή γίνεται στην οθόνη είτε στον εκτυπωτή. Τέλος τα μοτίβα δεν 
επηρεάζονται από τους μετασχηματισμούς, τους οποίους υφίστανται τα αντικεί-
μενα που γεμίζουν. Ακόμη και αν γίνει περιστροφή στο αντικείμενο τα μοτίβα τα 
οποία είναι ορθογώνια, δεν θα πάρουν κάποια κλίση.
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Εικόνα 11.19: Το γέμισμα με μοτίβο είναι η επανάληψη κάποιου σχεδίου, ανεξάρτητου από το 
είδος του σχήματος που θα γεμίσει.

Υφή: Η υφή τώρα ενός αντικειμένου είναι διαφορετική. Με τυχαίο τρόπο γίνεται 
γέμισμα του αντικειμένου με διάφορα χρώματα και σχήματα. Υπάρχει, όμως, ένας 
αλγόριθμος που προσπαθεί να προσομοιώσει κάποιο από τα υλικά που μας περι-
βάλλουν. Για παράδειγμα το θέμα Aerial Clouds προσπαθεί να προσομοιώσει τον 
ουρανό με τα σύννεφα. Η επέμβαση που μπορεί να γίνει στο θέμα από το χρήστη 
είναι μεγάλη, με παραμέτρους όπως το είδος της υφής, η απαλότητά της, ο φωτι-
σμός της κλπ. Έτσι δημιουργούνται προσομοιώσεις μαρμάρων, μωσαϊκών, λάβας, 
θάλασσας και άλλων υλικών.
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Ανακεφαλαίωση 11ου Κεφαλαίου

Στα σχεδιαστικά προγράμματα τις περισσότερες φορές χρησιμοποιούνται απλά 
γεωμετρικά σχήματα, που με τους κατάλληλους μετασχηματισμούς προκύπτουν 
άλλα, πιο σύνθετα. Αυτό γίνεται με πολλούς τρόπους, ο πιο απλός είναι με με-
τακινήσεις των κόμβων που ορίζουν το γεωμετρικό σχήμα.
Τα προγράμματα, επίσης, με εντολές μπορούν να αλλάζουν στοιχεία των βα-
σικών σχημάτων. Σε συνδυασμό με την περιστροφή, μετακίνηση και αλλαγή 
μεγέθους, από ένα σχήμα μπορεί να προκύψει ένα άλλο πιο σύνθετο.
Εκτός από τους μετασχηματισμούς που μπορούν να γίνουν με τους κόμβους, 
υπάρχουν ειδικά εργαλεία τα οποία τροποποιούν ριζικότερα ένα γεωμετρικό 
σχήμα, αποκόπτοντας τμήματα και κάνοντάς το να χάσει τις αρχικές γεωμετρι-
κές ιδιότητες. Τα συνηθέστερα από αυτά είναι το μαχαίρι και η γόμα, τα οποία 
αποκόπτουν ή σβήνουν τμήματα των σχεδίων.
Στοιχεία των οχημάτων είναι τα περιγράμματα και τα γεμίσματα. Τα περιγράμ-
ματα μπορούν να έχουν πάχος, χρώμα και είδος. Τα γεμίσματα είναι πέντε ει-
δών, τετράχρωμα ή πλακάτα, ντεγκραντέ, με μοτίβο, με υφή και με ειδικό μο-
τίβο. Όλα αυτά ορίζονται από ειδικούς διαχειριστές, οι οποίοι δέχονται μεγάλη 
επέμβαση από το χρήστη.
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Ασκήσεις 11ου Κεφαλαίου

1.	 Ονομάστε τέσσερις διαφορετικές ιδιότητες ενός περιγράμματος.
2.	� Πώς ορίζεται ένα προκαθορισμένο απλό και πώς ένα σταδιακό (ντεγκραντέ) γέμισμα;
3.	Πώς γίνεται η ρύθμιση που αφαιρεί το περίγραμμα από ένα επιλεγμένο σχήμα;

Δραστηριότητες 11ου Κεφαλαίου

1.	� Με σχήματα γεωμετρικά ή ελεύθερα από το περιβάλλον και με την χρήση των 
βασικών και συμπληρωματικών χρωμάτων σχεδιάστε δύο αρμονικές συνθέσεις 
για δημιουργία ταπετσαρίας.

2.	� Σχεδιάστε λογότυπο για δημιουργικό γραφείο χρησιμοποιώντας τα αρχικά του 
ονόματός σας. Δημιουργήστε τουλάχιστον τρεις παραλλαγές. Προετοιμάστε μία 
παρουσίαση των ιδεών σας, προκειμένου να επιλεγεί το καλλίτερο.

3.	� Πολλές φορές ένα απλό γραφικό, που το σαρώνουμε στον σαρωτή και το σχεδιά-
ζουμε από πάνω, είναι η αφετηρία για μια νέα σύνθεση:
Το φύλλο από μία φωτοτυπία (Εικόνα 11.20), το εισάγουμε στο πρόγραμμα σχεδία-
σης και το αντιγράφουμε (η διαδικασία αυτή λέγεται tracing), με το πενάκι Bezier 
ή το μολύβι. Με την κατάλληλη παραμόρφωση και αντιγραφή σχηματίζουμε την 
«φθινοπωρινή» σύνθεση. Φυσικά η επιλογή των αποχρώσεων είναι καθοριστική 
για το τελικό αποτέλεσμα, όπως και η εξάλειψη των ατελειών της φωτοτυπίας.

Εικόνα 11.20: Δραστηριότητα 11.3

Για την σύνθεση «χειμώνας» χρησιμοποιούμε το σύμβολο του χιονιού της γραμ-
ματοσειράς Wingdings σε διαφορετικά μεγέθη και αποχρώσεις.
Παρατηρήστε τις κατωτέρω συνθέσεις στην εικόνα 11.21 και προσπαθήστε να 
σχεδιάσετε και τις εποχές που λείπουν, ώστε να δημιουργήσετε μία αφίσα με 
τίτλο «Τέσσερις Εποχές». Χρησιμοποιήστε αποχρώσεις της δικής σας επιλογής, ή 
κάντε οποιαδήποτε παραλλαγή επιθυμείτε.
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Εικόνα 11.21: Δραστηριότητα 11.3

4.	�Στο πρόγραμμα ψηφιακής σχεδίασης της επιλογής σας, κατασκευάστε τα παρα-
κάτω σήματα (Εικόνα 11.22), αφού η παρούσα μορφή τους παρουσιάζει ατέλειες.

Εικόνα 11.22: Δραστηριότητα 11.4
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Κεφάλαιο 12ο
Διευθετήσεις και συνδυασμοί αντικειμένων

Στόχοι:

Στο κεφάλαιο αυτό οι μαθητές θα μπορέσουν να:

	 •	� Αντιληφθούν τη σημασία και τις αρχές της ομαδοποίησης και της διευ-

θέτησης αντικειμένων στην ψηφιακή σχεδίαση.

	 •	 �Κατανοήσουν τις τεχνικές και διαδικασίες επίτευξης ακρίβειας και ελάτ-

τωσης του χρόνου σχεδίασης μέσω των μεθοδολογιών της ομαδοποίη-

σης, του συνδυασμού και της χρήσης πολλαπλών επιπέδων σχεδίασης.

12.1 Εισαγωγή

Πολλές φορές στα σχεδιαστικά προγράμματα χρειάζεται να επιλέξουμε για επε-

ξεργασία πολλά αντικείμενα ταυτόχρονα. Ήδη, έχει αναφερθεί η ομαδοποίηση των 

αντικειμένων με την οποία είναι εύκολο να αλλαχθούν κάποιες από τις ιδιότητές 

τους. Επίσης, είδαμε πώς μπορούν να ορισθούν σχέσεις μεταξύ των αντικειμένων ή 

πώς να τα συνδυάσουμε, ώστε να δημιουργηθεί ένα νέο σχήμα, χρησιμοποιώντας 

τις εντολές αναπαραγωγής και κλωνοποίησης.

Στο κεφάλαιο αυτό θα συνδυάσουμε όλες αυτές τις τεχνικές για να σχεδιάσουμε 

σύνθετα σχήματα. Συγχρόνως θα μάθουμε να χειριζόμαστε αυτά τα σχήματα, έτσι 

ώστε να εργαζόμαστε αποδοτικά.

12.2 Εργαλεία διευθέτησης αντικειμένων

Για την τοποθέτηση των αντικειμένων στο χώρο εργασίας έχει ήδη γίνει σχετική 

αναφορά σε προηγούμενο κεφάλαιο. Ας υποθέσουμε ότι έχουμε ένα σωρό αντι-

κειμένων. Στον πάτο του σωρού βρίσκεται το παλαιότερα κατασκευασμένο αντι-

κείμενο, ενώ επάνω το πιο πρόσφατο. (Εικόνα 12.1). Ως τώρα η επιλογή γινόταν 

είτε επιλέγοντας με το ποντίκι στο περίγραμμα είτε, από το διαχειριστή αντικει-
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μένων. Τώρα, όμως, που παρουσιάζεται αδιαφάνεια λόγω των γεμισμάτων και του 

μεγέθους τους, η απευθείας επιλογή τους με το ποντίκι γίνεται δύσκολη υπόθεση.

Εικόνα 12.1: Η επιλογή αντικειμένων είναι δύσκολη. Το μπλε αντικείμενο, λόγω μεγέθους, ενδέ-
χεται να καλύπτει το πράσινο. Πώς θα επιλέξουμε επομένως το πράσινο;

Η επιλογή γίνεται ευκολότερη με το Διαχειριστή Αντικειμένων. Εκεί τα αντικείμενα 

αναγράφονται στο σωρό με το όνομά τους. Η επιλογή μπορεί να γίνει επιλέγοντας 

με το ποντίκι το όνομα. Μπορεί να γίνει και αναδιάταξη, επιλέγοντας με το ποντίκι 

το αντικείμενο και σύροντάς το, σε νέα θέση στο σωρό. Αν τοποθετηθεί το αντικεί-

μενο με την βοήθεια του δείκτη του ποντικιού πάνω σε ένα άλλο αντικείμενο, τότε 

αυτόματα αυτά τα δύο αντικείμενα ομαδοποιούνται, όπως στην Εικόνα 12.2.

Εικόνα 12.2: Σύροντας, στον διαχειριστή αντικειμένων, με το ποντίκι το κίτρινο τρίγωνο, το το-
ποθετήσαμε στην σειρά επάνω από το κόκκινο παραλληλόγραμμο.
Στην συνέχεια ομαδοποιήσαμε το κόκκινο παραλληλόγραμμο με την πράσινη έλλειψη. 
Παρατηρήστε το σύμβολο της ομαδοποίησης στον διαχειριστή αντικειμένων.
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Το ίδιο μπορεί να γίνει και με το παράθυρο της εντολής Διάταξη (Order) που βρίσκεται 

στον κατάλογο Διευθέτηση (Arrange) (Εικόνα 12.3). Εκεί, με τη χρήση των εντολών:

•	� Μπροστά απ’ όλα (To Front): Μετακινείται το αντικείμενο στην κορυφή 

του σωρού.

•	� Πίσω απ’ όλα (To Back): Τοποθετείται το αντικείμενο τελευταίο στο σωρό.

•	� Μια θέση μπροστά (Forward One): Τοποθετείται το αντικείμενο μια θέση 

μπρος.

•	� Μια θέση πίσω (Back One): Τοποθετείται το αντικείμενο μια θέση πίσω.

•	� Εμπρός Από... (In Front of...): Τοποθετείται το αντικείμενο πάνω από 

κάποιο συγκεκριμένο που ορίζουμε.

•	� Πίσω Από... (Behind...): Τοποθετείται το αντικείμενο πίσω από κάποιο 

συγκεκριμένο που ορίζουμε.

•	� Αναστροφή Διάταξης (Reverse Order): Αναστρέφεται η διάταξη του σω-

ρού, πάνω είναι το αρχαιότερο και κάτω το πιο πρόσφατο.

Εικόνα 12.3:
Η λίστα εντολών Order

Ένα ενδιαφέρον θέμα είναι και η στοίχιση των αντικειμένων τόσο μεταξύ τους, όσο 

και σε σχέση με τη θέση τους στη σελίδα. Για να γίνει στοίχιση αντικειμένων ως προς 

το κέντρο τους, πρέπει να επιλεγούν όλα τα αντικείμενα με το εργαλείο επιλογής και 

μετά να ενεργοποιηθούν οι εντολές Στοίχιση και Κατανομή από το βασικό μενού Διευ-

θέτηση >Ευθυγράμμιση και κατανομή (Arrange>Align and Distribute). Στο παράθυρο 

διαλόγου που παρουσιάζεται υπάρχουν δύο καρτέλες, αυτή της Στοίχισης και αυτή της 

Κατανομής. Με την πρώτη, επιτυγχάνεται η στοίχιση των επιλεγμένων αντικειμένων 

ως προς τα κέντρα, την επάνω, την δεξιά και την αριστερή πλευρά τους, αντιστοίχως.

Με τη δεύτερη, κατανέμονται ομοιόμορφα τα επιλεγμένα αντικείμενα, είτε στο συ-

νολικό χώρο που καταλαμβάνεται από τα αντικείμενα είτε μέσα σε ολόκληρη τη 

σελίδα, ακολουθώντας τη γραμμή του οριζόντιου ή κάθετου άξονά τους.
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Μπορούν επίσης να τοποθετηθούν σε ίσες αποστάσεις μεταξύ τους. Στην Εικόνα 12.4, 

υπάρχουν δύο απλά γεωμετρικά σχέδια, στα οποία έγινε στοίχιση με επιλεγμένες τις 

θυρίδες, στοίχιση στις επάνω (top) και αριστερή (left) πλευρές του τετραγώνου.

Εικόνα 12.4: Η καρτέλα στοίχισης αντικειμένων. Δεξιά, τα αντικείμενα μετά την εφαρμογή της 
εντολής.

12.3 Σχηματισμοί αντικειμένων

Στην Εικόνα 12.5, βλέπουμε τα αντικείμενα να έχουν γίνει ομάδα με την εντολή group, 

να έχουν ενωθεί με την εντολή Ένωσης (Weld) και να έχουν συνδυαστεί με την εντο-

λή Συνδυασμού (Combine). Όλες αυτές βρίσκονται στον κατάλογο εντολών Διευθε-

τήσεων (Arrange). Το χαρακτηριστικό στην εντολή Ένωσης είναι ότι κάνοντας τα 

αντικείμενα ένα, το γέμισμα και το περίγραμμα γίνεται ενιαίο και δεν διαχωρίζονται. 

Τα συνδυασμένα αντικείμενα, όμως, διαχωρίζονται πάλι με την αντίστοιχη εντολή 

(Arrange> Break Apart), διατηρώντας τις αλλαγές που έγιναν, όταν συνδυάστηκαν.

	 group	 weld	 combine
Εικόνα 12.5: Τα αποτελέσματα της εφαρμογής των εντολών ομαδοποίησης (group), ένωσης (weld), 
συνδυασμού (combine) και οι διαφορές τους.
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Φυσικά, ισχύει πάντα ότι τα αντικείμενα μπορούν να επανέλθουν στην αρχική τους 
κατάσταση με την εντολή Αναίρεσης ή με τα πλήκτρα Ctrl + Ζ.
Στην εντολή Συνδυασμός (Combine) διαγράφεται η κοινή περιοχή των δύο αντικει-
μένων. Στη θέση της υπάρχει κενό, σαν να υπάρχει τρύπα, το οποίο δεν δέχεται ξανά 
γέμισμα. Στην ίδια κατηγορία, δηλαδή στη δημιουργία νέων σχημάτων από συνδυα-
σμούς άλλων, ανήκουν και οι εντολές Αποκοπής (Trim) και Τομής (Intersect). Η Απο-
κοπή χρησιμοποιείται για να αποκόπτει ένα τμήμα ενός αντικειμένου ή μιας ομάδας. 
Αν η επιλογή είναι πολλαπλή, τότε η αποκοπή γίνεται από το τελευταίο επιλεγμένο 
αντικείμενο. Το κομμένο τμήμα είναι το υποσύνολο των κοινών σημείων δύο αντικει-
μένων. Με την Intersect δημιουργείται ένα νέο αντικείμενο που είναι το υποσύνολο 
των κοινών σημείων των δύο αντικειμένων. Στην Εικόνα 12.6 βλέπουμε τα αποτελέ-
σματα της επίδρασης των εντολών σε έναν κύκλο και ένα τρίγωνο.

	 group	 trim	 intersect

Εικόνα 12.6: Η εφαρμογή των εντολών αποκοπής (trim) και τομής (intersect).

Οι εντολές Weld, Trim και Intersect εμφανίζονται από το μενού Διάταξη, Μορφο-
ποίηση (Arrange> Shaping) και εμφανίζεται η αντίστοιχη εντολή. Στο δεξί τμήμα 
της οθόνης εμφανίζεται το αντίστοιχο πλαίσιο διαλόγου ή Διαχειριστής (Docker) 
των εντολών (Εικόνα 12.7). Στο άνω τμήμα του είναι τα τρία πλήκτρα των εντολών, 
στο παράθυρο από κάτω υπάρχει μια προεπισκόπηση της ενέργειας της εντολής, 
ενώ ενδιαφέρον έχουν οι δύο θυρίδες Πηγαία Αντικείμενα (Source Objects) και 
Αντικείμενα Στόχος (Target Object). Αν είναι ενεργοποιημένες, τότε τα γονεϊκά σχή-
ματα παραμένουν αναλλοίωτα και εμφανίζονται στην οθόνη μαζί με το νέο σχήμα.
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Εικόνα 12.7: Ο Διαχειριστής των εντολών Weld, Trim, Intersect.

Ανακεφαλαίωση 12ου Κεφαλαίου

Τα σχεδιαστικά προγράμματα επιτρέπουν την εύκολη αντιγραφή και επικόλληση 
των αντικειμένων. Πολλές φορές υπάρχει η ανάγκη της πολλαπλής επικόλλησης 
κάποιου αλλά και της περαιτέρω ενημέρωσής του για τις αλλαγές, που θα συμβούν 
σ’ αυτό. Για την ανάγκη αυτή υπάρχει το εργαλείο των κλώνων που δημιουργεί 
αντίγραφα με κληρονομιά αρκετών ιδιοτήτων του γονεϊκού.
Τα αντικείμενα αρκετές φορές επικαλύπτονται από άλλα και γίνεται δύσκολη η 
επιλογή τους. Για τις περιπτώσεις αυτές υπάρχουν οι εντολές διάταξης, που ανα-
διατάσσουν τα αντικείμενα στο σχηματισμένο σωρό. Με τις εντολές ομαδοποίησης 
μπορούμε να συνδυάσουμε διάφορα αντικείμενα, για να παραχθεί ένα σύνθετο.
Με τις εντολές αυτές μπορούμε να βρούμε το σύνολο των σημείων δύο ή πε-
ρισσοτέρων σχημάτων, το κοινό τους υποσύνολο κλπ. Οι διαφοροποιήσεις των 
εντολών αυτών έγκεινται περισσότερο σε ιδιότητες του τελικού σχήματος, όπως 
είναι το γέμισμα και το περίγραμμα.
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Ασκήσεις 12ου Κεφαλαίου

1.	� Ποιες είναι οι ακριβείς διαφορές της Εντολής Αντιγραφής από την Εντολή των 
Κλώνων; Παρατηρήστε σε ποιες ενέργειες ενημερώνονται τα αντίγραφα των 
Κλώνων. Μήπως υπάρχουν εξαιρέσεις στον κανόνα;

2.	Η στοίχιση των αντικειμένων πού χρησιμεύει; Πόσοι τρόποι στοίχισης υπάρχουν;
3.	� Πόσοι τρόποι επιλογής αντικειμένων υπάρχουν; Τι επιτυγχάνουμε με την ομαδο-

ποίησή τους. Ποια η διαφορά ομαδοποίησης και τοποθέτησης σε επίπεδο (layer);
4.	�Ποιες είναι οι διαφορές και ποιες οι ομοιότητες ανάμεσα από τις εντολές Ένωσης 

(weld) και Συνδυασμού (combine); Πότε χρησιμοποιούμε την μια και πότε την άλλη;
5.	� Ποιες είναι οι διαφορές και ποιες οι ομοιότητες ανάμεσα από τις εντολές Αποκο-

πής (trim) και Τομής (intersect); Πότε χρησιμοποιούμε τη μια και πότε την άλλη;

Δραστηριότητες 12ου Κεφαλαίου

1. �Προσπαθήστε να εισαγάγετε τη φωτογραφία της ταυτότητάς σας ως ψηφιοποιη-
μένη εικόνα. Να την τοποθετήσετε σε ένα νέο επίπεδο και να την ιχνογραφήσετε 
σε ένα άλλο.

2.	� Τα περισσότερα σύνθετα σχήματα που σχεδιάζουμε αποτελούνται από μερικά βα-
σικά και τους συνδυασμούς τους, που έχουν κατάλληλη διάταξη και χρωματισμό. 
Δείτε την ανθρώπινη φιγούρα αριστερά και τα σχήματα που την συνθέτουν δεξιά. 
Προσπαθήστε να την δημιουργήσετε με πρόγραμμα σχεδίασης της επιλογής σας.

Εικόνα 12.8: Δραστηριότητα 12.2.
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3. �Σχεδιάστε τα αρχικά σχήματα με απλές γεωμετρικές μορφές και με τις εντολές 
ομαδοποίησης δημιουργήστε το τελικό.

Εικόνα 12.9: Δραστηριότητα 12.3.

4.	�Τα δύο σχήματα που εμφανίζονται παρακάτω αποτελούνται από ορισμένα βα-
σικά, κατάλληλα ενωμένα. Προσπαθήστε να τα σχεδιάσετε στο πρόγραμμα της 
επιλογής σας.

Εικόνα 12.10: Δραστηριότητα 12.4.
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5.	� Στην παρακάτω εικόνα 12.11, βλέπετε ένα σχήμα με κύβους, που ενώ εκ πρώτης 
όψεως φαίνεται «κανονικό», με τη δεύτερη ματιά είναι προφανές ότι υπάρχει 
πρόβλημα προοπτικής. Η σύνθεση αυτή είναι παρόμοια ανάλογων έργων του 
Ολλανδού σχεδιαστή Maurits Corneille Escher (1898-1972).

Η κατασκευή του πρώτου κύβου

Η τελική σύνθεση

Εικόνα 12.11: Δραστηριότητα 12.5.

Ας προσπαθήσουμε να το κατασκευάσουμε με τις εντολές Διευθέτηση>Μετασχημα-
τισμοί (Arrange>Transformations...):
i.	� Στο πρόγραμμα σχεδίασης του εργαστηρίου θα σχεδιάσουμε ένα τετράγωνο, 

επιβάλλοντας στρέβλωση (skew) -10° για την πρώτη πλευρά.
ii.	� Στο αρχικό τετράγωνο (που έχουμε φροντίσει να αναπαραγάγουμε μερικές φο-

ρές) επιβάλλουμε την συμμετρική στρέβλωση +10° για την δεύτερη πλευρά.
iii.	� Η επάνω πλευρά θα δημιουργηθεί εκ νέου με το εργαλείο σχεδιασμού γραμμών.
iv.	� Χρωματίζουμε με το χρώμα της επιλογής μας αλλά με τις κατάλληλες φωτοσκι-

άσεις για την κάθε πλευρά.
v.	 Προσεγγίζουμε τις πλευρές, ώστε να έλθουν σε ευθυγράμμιση (snap to points).
vi.	 Αναπαράγουμε τον αναγκαίο αριθμό κύβων.
vii.	� Η σύνθεση ολοκληρώνεται φέρνοντας τους κύβους στην κατάλληλη θέση ώστε 

να πετύχουμε τέλεια ευθυγράμμιση.
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6.	�Στην επομένη Εικόνα 12.12. βλέπουμε πώς λειτουργούν οι εντολές σχηματισμού 
αντικειμένων από δύο ξεχωριστά σχήματα. Προσπαθήστε να δημιουργήσετε 
ανάλογα σχήματα, στο πρόγραμμα σχεδίασης της επιλογής σας.

Εικόνα 12.12: Οι εντολές Pathfinder του Illustrator, είναι αυτές που χρησιμοποιήθηκαν στα σχή-
ματα αυτά. Η πρώτη και η τρίτη στήλη εμφανίζουν τα αρχικά σχήματα, ενώ η δεύτερη και η τέ-
ταρτη τα αντίστοιχα αποτελέσματα των εντολών. Δημιουργήστε τα στο πρόγραμμα που διαθέτει 
το εργαστήριό σας.
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3η Ενότητα
Ηλεκτρονική Τυπογραφία
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Κεφάλαιο 13ο
Η τυπογραφία σήμερα

Στόχοι:

Μετά τη μελέτη αυτού του κεφαλαίου οι μαθητές θα είναι σε θέση να:

	 •	� Συγκρίνουν τις μεθόδους της παραδοσιακής με αυτές της ηλεκτρονικής 
τυπογραφίας.

	 •	 �Επιλέγουν κατάλληλες γραμματοσειρές για το σύστημα Η/Υ που δια-
θέτουν.

	 •	� Χειρίζονται τα βασικά εργαλεία κειμένου και σχεδίασης.

	 •	� Συγκρίνουν τα βασικά προγράμματα ηλεκτρονικής τυπογραφίας.

13.1 Εισαγωγή

Είναι σε όλους φανερό πόσο οι υπολογιστές άλλαξαν τη ζωή μας. Ειδικότερα, σε 
πολλά επαγγέλματα, άλλαξαν τον τρόπο με τον οποίο αυτά γινόντουσαν μέχρι σή-
μερα. Οι γραφικές τέχνες ανήκουν στην κατηγορία των επαγγελμάτων, όπου οι υπο-
λογιστές επέφεραν κατακλυσμικές αλλαγές. Οι γραφίστες πρέπει πλέον να μάθουν 
να σχεδιάζουν με τα εργαλεία που διαθέτουν οι υπολογιστές (Εικόνα 13.1).

Εικόνα 13.1: Στα σύγχρονα συστήματα επιτραπέζιας τυπογραφίας ενσωματώθηκαν η τεχνική 
και η πείρα όλων των τυπογράφων από την εποχή του Γουτεμβέργιου!
(Από το βιβλίο του Donald Knuth ''Digital Typography'' έκδοση CSLI Publications Stanford,
California 1999).
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Η έκδοση ενός εντύπου, πριν την εμφάνιση και την επικράτηση της επιτραπέζιας 
τυπογραφίας (Desktop Publishing ή DTP) στη δεκαετία 1985-1995, απαιτούσε τη 
συνεργασία πολλών ανθρώπων. Ξεκινώντας από το συγγραφέα των κειμένων, τη 
σκυτάλη έπαιρνε ο γραφίστας που σχεδίαζε την εμφάνιση των σελίδων χρησιμοποι-
ώντας το κείμενο, που έχει γράψει ο στοιχειοθέτης και τις πιθανές φωτογραφίες. 
Όλα αυτά έπρεπε να γίνουν προσεκτικά, χωρίς λάθη ή κενά που κουράζουν τον 
αναγνώστη, και πάντα σύμφωνα με το γενικό σχέδιο της σελίδας. Στο επόμενο στά-
διο ο «σελιδοποιός» διαμόρφωνε την τελική μορφή των σελίδων με τις εικόνες και 
τα κείμενα στην τελική τους θέση κατασκευάζοντας τη «χαρτομακέτα». Στη συνέ-
χεια, ο φωτολιθογράφος έβγαζε τα αναγκαία φιλμ για το «μοντάζ» των χρωμοφάν. 
Ο εκτυπωτής-τυπογράφος έπαιρνε τα χρωμοφάν για να ετοιμάσει τις εκτυπωτικές 
πλάκες και να τυπώσει τις σελίδες στο πιεστήριο.

Στη σύντομη περιγραφή μας, εκτός από τον συγγραφέα, αναφέραμε τις ειδικότητες 
του γραφίστα, του στοιχειοθέτη, του σελιδοποιού, του φωτολιθογράφου και του τυπο-
γράφου. Για τον περισσότερο κόσμο όλες αυτές οι ειδικότητες θεωρούνται αδιακρίτως 
«τυπογράφοι» και, αντίστοιχα, οι χώροι που δουλεύουν «τυπογραφεία». Με τους 
υπολογιστές πλέον, τουλάχιστον θεωρητικά, ένα και μόνο πρόσωπο, που μπορούμε 
γενικά να ονομάσουμε «ο γραφίστας», είναι σε θέση να εκτελέσει τις περισσότερες 
από αυτές τις εργασίες, (εκτός φυσικά της εκτύπωσης στο πιεστήριο), χωρίς να 
απομακρυνθεί από το γραφείο του.

Δεν πρέπει όμως να ξεχνάμε ότι ο υπολογιστής είναι μόνο ένα εργαλείο τόσο ισχυ-
ρό, όσες είναι οι γνώσεις και η δεξιοτεχνία του χρήστη του. Κι αυτό το αναφέρου-
με, γιατί μέσω των διαφημίσεων οι κατασκευαστές των υπολογιστών και του λογι-
σμικού προσπαθούν να δώσουν την εντύπωση ότι αρκεί ο ισχυρός εξοπλισμός και 
μόνο, για να κάνει ο χρήστης θαύματα.
Τι είναι όμως αυτό που κάνει τον υπολογιστή αναντικατάστατο;
Τα πλεονεκτήματα της χρήσης των Η/Υ είναι η γρήγορη και ακριβής σχεδίαση, η εύ-
κολη διόρθωση, η ευελιξία σε διαδοχικές δοκιμές και αλλαγές κ.λ.π. Πιο συγκεκρι-
μένα, με τα προγράμματα σελιδοποίησης δοκιμάζει κανείς πολλές γραμματοσειρές, 
ώστε να επιλέξει την κατάλληλη. Επίσης, δοκιμάζει μονόστηλα, δίστηλα ή τρίστηλα 
για την αποδοτικότερη τοποθέτηση του κειμένου, ενώ οι θέσεις των φωτογραφιών με 
τις λεζάντες τους είναι καθορισμένες, χωρίς όμως να είναι αναγκαίο και να εμφανίζο-
νται. Αυτό δίνει τη δυνατότητα στο γραφίστα να δοκιμάζει πρακτικά άπειρες εναλλα-
κτικές μορφές σελιδοποίησης μέσα σε λίγα λεπτά της ώρας. Όμως μαζί με όλα αυτά τα 
πλεονεκτήματα υπάρχουν και τα μειονεκτήματα της τεχνολογίας! Μία ξαφνική βλά-
βη στη μνήμη ή το σκληρό δίσκο και όλα τα πολύτιμα σχέδια, αποτέλεσμα επίπονης 
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εργασίας, χάνονται οριστικά χωρίς καμιά ελπίδα ανάκτησής τους. Μοναδική ελπίδα 
σωτηρίας είναι η συστηματική δημιουργία αντιγράφων ασφαλείας σε άλλα αποθηκευ-
τικά μέσα, πριν την καταστροφή, και η βαθιά γνώση της λειτουργίας και των μεθόδων 
επίλυσης προβλημάτων του υπολογιστή μας.

13.2 Η σελιδοποίηση με τον υπολογιστή

Η σχεδίαση σελίδων με τη βοήθεια του υπολογιστή, υποχρεώνει τον γραφίστα να 
μάθει πρώτα-πρώτα, τα εργαλεία του προγράμματος (ή των προγραμμάτων) σελι-
δοποίησης. Να εξοικειωθεί με την αρχική οθόνη τους και με τα ειδικά σύμβολα και 
τα εικονίδιά τους. Έτσι αποκτά ο χρήστης την αίσθηση ότι γνωρίζει το περιβάλλον 
εργασίας του υπολογιστή του (user interface). Μερικά προγράμματα προσφέρουν 
περιβάλλον εργασίας στα ελληνικά για εκείνους που δε γνωρίζουν μία ξένη γλώσσα. 
Στην Εικόνα 13.2 παρουσιάζεται η αρχική οθόνη δύο γνωστών προγραμμάτων σελι-
δοποίησης. Και στις δυο περιπτώσεις διακρίνουμε τις γραμμές εντολών στο επάνω 
τμήμα της οθόνης και τις εργαλειοθήκες εκατέρωθεν του παράθυρου εργασίας.

1
9

Eργαλειοθήκη

8

5 2
3

1

7

3 6 4 346

3

2

98

Eργαλειοθήκη

Παλέτες

Εικόνα 13.2: Η προσπάθεια πολλών κατασκευαστών προγραμμάτων σελιδοποίησης είναι να 
προσφέρουν περιβάλλον εργασίας στις κυριότερες γλώσσες. Επίσης, τα εργαλεία είναι σχεδια-
σμένα έτσι ώστε να μοιάζουν με αυτά άλλων προγραμμάτων.

Στην Εικόνα 13.2 μπορούμε να διακρίνουμε τα παρακάτω χαρακτηριστικά γνωρί-
σματα της αρχικής οθόνης και των δύο προγραμμάτων:
1.	 Κανόνες (Χάρακες).
2.	� Επιφάνεια εργασίας, που μπορούμε να την παρομοιάσουμε με το χώρο του σχε-

διαστηρίου μας.
3.	Μπάρες ή γραμμές ολίσθησης της επιφάνειας εργασίας.
4.	Γραμμή κατάστασης, με πληροφορίες του εγγράφου (αριθμός σελίδας, ζουμ).
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5.	� Η ωφέλιμη («εκτυπώσιμη») περιοχή της σελίδας, βάσει των διαστάσεων που 
έχουμε ορίσει με την έναρξη του προγράμματος στο νέο έγγραφο.

6.	�Το ποσοστό μεγέθυνσης ή σμίκρυνσης (ζουμ) με το οποίο εμφανίζεται η σελίδα 
στην οθόνη.

7.	� Βοηθητικές γραμμές-οδηγοί που σύρονται κατά βούληση με το ποντίκι από την 
βάση τους.

8.	�Η Γραμμή τίτλου όπου φαίνεται το όνομα του εγγράφου που έχουμε δημιουργή-
σει και εμφανίζεται στην οθόνη.

9.	�Από το σημείο αυτό έχουμε τη δυνατότητα να μετακινήσουμε ολόκληρο το παρά-
θυρο του εγγράφου σε μία νέα θέση (με το πλήκτρο μεγιστοποίησης, ενοποιείται 
με την γραμμή τίτλου).

Κάτω ακριβώς από την γραμμή τίτλου βρίσκεται το βασικό μενού εντολών (menu 
bar). Κάθε φορά που επιλέγεται μια εντολή, αναδιπλώνεται η λίστα που περιέχει 
ένα σύνολο ομοειδών εντολών. Όταν υπάρχει ένα βέλος δίπλα από κάποια εντολή, 
τότε ακολουθεί μια νέα λίστα. Αν υπάρχουν αποσιωπητικά, οδηγεί σε κάποιο διαλο-
γικό παράθυρο εντολών.
Με την έναρξη του προγράμματος δημιουργούμε ένα νέο έγγραφο του οποίου έχου-
με τη δυνατότητα να ορίσουμε επακριβώς τη μορφή του.
Έγγραφο, είναι το αρχείο που έχει μία ή περισσότερες σελίδες.

Ανοίγοντας το πρόγραμμα, επιλέγουμε από την γραμμή των μενού:
Αρχείο>Νέο>Έγγραφο... (File>New>Document...) για τη δημιουργία ενός νέου εντύ-
που. Αν όμως θέλουμε να επέμβουμε σε ένα ήδη υπάρχον έγγραφο, επιλέγουμε:
Αρχείο>Άνοιγμα... (File>Open...).
Τα χαρακτηριστικά της σελίδας πληκτρολογούνται ή επιλέγονται στο πλαίσιο διαλό-
γου Νέο Έγγραφο (New Document) (Εικόνα 13.3).

Εικόνα 13.3: Χρησιμοποιούμε αυτό το πλαίσιο διαλόγου για την αρχική διαμόρφωση ενός νέου 
εντύπου.

Όταν είναι επιλεγμένο το κουτάκι των αντικριστών σελίδων, τότε οι σελίδες προε-
τοιμάζονται για εκτύπωση μπρος – πίσω, το αριστερό δηλαδή περιθώριο των μονών 
σελίδων είναι το δεξί των ζυγών.
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Προκειμένου να τοποθετήσουμε κείμενο στη σελίδα πρέπει πρώτα να σχεδιάσουμε 
ένα πλαίσιο κειμένου. Αντιστοίχως δημιουργούμε πλαίσιο εικόνας για να τοποθετή-
σουμε μία φωτογραφία.

Οι παλέτες ή εργαλειοθήκες: Με το όνομα αυτό καλούμε τις εργαλειοθήκες που 
συγκεντρώνουν βασικές ρυθμίσεις, όπως είναι η παλέτα χρωμάτων, η παλέτα ελέγ-
χου επιλεγμένου αντικειμένου (ή παλέτα μετρήσεων) ή η παλέτα διαμόρφωσης εγ-
γράφου. Όλες αυτές οι λειτουργίες υπάρχουν ως εντολές και στο μενού του προ-
γράμματος. (Εικόνα 13.4 Α).

A

1

2

3

4

5

6

6

7

7 Β

Εικόνα 13.4: (Α) Η βασική οθόνη με όλες τις παλέτες και εργαλειοθήκες ανοικτές.
(Β) Η κύρια εργαλειοθήκη.

Η κύρια εργαλειοθήκη: Συγκεντρώνει τα εργαλεία σχεδίασης και ροής κειμένου 
του προγράμματος (Εικόνα 13.4 Β) που επιλέγονται με το ποντίκι (απλό «κλικ»). 
Με διπλή επιλογή με το ποντίκι (διπλό «κλικ») σε ένα εργαλείο εμφανίζεται ένα 
διαλογικό παράθυρο που επιτρέπει τη ρύθμιση των ιδιοτήτων του.
Τα κυριότερα εργαλεία, που τα συναντάμε στην κύρια εργαλειοθήκη, είναι τα πα-
ρακάτω:

1.	� Εργαλείο επιλογής: Επιλέγει τα αντικείμενα στην επιφάνεια της σελίδας, προκειμένου να μετακι-
νηθούν ή να τροποποιηθούν.

2.	� Εργαλείο περιεχομένου: Με αυτό επεμβαίνουμε στο περιεχόμενο του πλαισίου, κειμένου ή εικόνας.

3.	� Εργαλείο περιστροφής: Χρησιμοποιείται για την περιστροφή των πλαισίων εικόνων ή κειμένων.
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4.	 Εργαλείο κειμένου: Δημιουργεί πλαίσια κειμένου ορθογωνίου σχήματος.

5.	� Εργαλεία πλαισίων εικόνας: Με τα εργαλεία αυτά δημιουργούμε πλαίσια εικόνων διαφόρων 
σχημάτων

6.	� Εργαλεία για χάραξη γραμμών: Το πρώτο το χρησιμοποιούμε για χάραξη οριζοντίων και καθέτων 
γραμμών, ενώ το δεύτερο για την δημιουργία γραμμών με οποιαδήποτε κλίση.

7.	� Η «Αλυσίδα»: Εργαλείο σύνδεσης ή αποσύνδεσης πλαισίων κειμένων. Επιτρέπει την δημιουργία 
συνδέσμων για την ροή του κειμένου από ένα πλαίσιο σε ένα άλλο. Το «σπασμένο αλυσιδάκι» κάνει 
την αποσύνδεση.

Στο βασικό μενού εντολών τώρα, εκτός από το Αρχείο (File), υπάρχει ο κατάλογος 
εντολών Επεξεργασία (Edit) που περιλαμβάνει εντολές αντιγραφής και επικόλλη-
σης όπως επίσης τις προτιμήσεις και αρχικές ρυθμίσεις του προγράμματος. Υπάρ-
χουν και εντολές επεξεργασίας τμημάτων του εγγράφου.
Ο κατάλογος εντολών Στυλ (Style) περιλαμβάνει εντολές επιλογής και μετατροπής, 
για τις γραμματοσειρές και τις παραγράφους.
Ο κατάλογος εντολών Αντικείμενο (Item) επιτρέπει τον χειρισμό των πλαισίων κει-
μένου και εικόνας, ως ανεξάρτητων στοιχείων της σελίδας. Αυτά ομαδοποιούνται 
με ορισμένα άλλα αντικείμενα ή ιεραρχούνται μεταξύ τους. Με τη Σελίδα (Page) 
προσθέτουμε, αφαιρούμε ή μετακινούμε σελίδες.
Ο κατάλογος εντολών Προβολή (View) επιτρέπει την εμφάνιση ή απόκρυψη των 
παλετών εργασίας και την εμφάνιση / απόκρυψη του καννάβου της σελίδας ή άλ-
λων βοηθητικών γραμμών.
Τα Βοηθήματα (Utilities) περιλαμβάνουν τα λεξικά ορθογραφίας, τις ρυθμίσεις πύ-
κνωσης / αραίωσης των γραμμάτων ή άλλα υποπρογράμματα που εγκαθίστανται 
ξεχωριστά από το βασικό πρόγραμμα.

Αν τοποθετήσουμε το δρομέα σε μία εντολή του καταλόγου, τότε εμφανίζεται ένας 
νέος κατάλογος στον οποίο οι ενεργές εντολές είναι με μαύρα και οι ανενεργές με 
γκρίζα γράμματα. Είναι ενδεχόμενο σε κάθε εντολή να υπάρχει και μία υπό-εντολή 
για περαιτέρω ρυθμίσεις. Στις εντολές που υπάρχουν αποσιωπητικά εμφανίζονται 
πλαίσια διαλόγου όπου στα πεδία εισαγωγής στοιχείων πληκτρολογούμε αριθμούς, 
μονάδες μέτρησης, κλπ.

13.3 Οι παλέτες μετρήσεων και διαμόρφωσης εγγράφων

Η παλέτα ελέγχου αντικειμένων ή μετρήσεων. Ένα από τα πλέον χρήσιμα εργαλεία 
είναι η παλέτα μετρήσεων. (Εικόνα 13.5). Το περιεχόμενο αυτής της παλέτας μετα-
βάλλεται προσαρμοζόμενο στο εργαλείο της εργαλειοθήκης και του αντικειμένου που 
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είναι επιλεγμένο μία συγκεκριμένη στιγμή. Σε διαφορετική περίπτωση η παλέτα 
παραμένει κενή. Εμφανίζεται από το βασικό μενού Προβολή>Εμφάνιση μετρήσεων 
(View>Show measurments).

A

Β

Γ
Εικόνα 13.5: (Α) Όταν ένα πλαίσιο κειμένου είναι επιλεγμένο, η παλέτα μετρήσεων δίνει τη 
δυνατότητα αλλαγής της γραμματοσειράς και του μεγέθους της, του διάστιχου, της πύκνωσης / 
αραίωσης και της στοίχισης των αράδων. Το πλαίσιο κειμένου μπορεί να μετακινηθεί, να περι-
στραφεί ή να αλλάξει διαστάσεις.
(Β) Όταν επιλέγεται ένα πλαίσιο εικόνας, η παλέτα μετρήσεων επιτρέπει τη μεταβολή του μεγέ-
θους, της θέσης και της γωνίας περιστροφής του. Αν έχουμε μία φωτογραφία, μπορούμε να τη 
μεταβάλουμε αντιστοίχως όπως κάναμε προηγουμένως με το πλαίσιό της.
(Γ) Με μία γραμμή επιλεγμένη η παλέτα μετρήσεων προσαρμόζεται για να επιτρέψει τις ανάλο-
γες μεταβολές στη θέση και τη μορφή της.

Παλέτα διαμόρφωσης εγγράφου (Document layout palette): Διευκολύνει την προ-
σθήκη, διαγραφή ή αναδιάταξη των σελίδων ενός εγγράφου (Εικόνα 13.6).

Εικόνα 13.6:
Η παλέτα διαμόρφωσης εγγράφου διευκολύνει την προσθήκη, δια-
γραφή ή αναδιάταξη των σελίδων σε ένα πολυσέλιδο έγγραφο. Επί-
σης, επιτρέπει τη δημιουργία ή μεταβολή των προτύπων σελίδων.
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Η εισαγωγή νέων σελίδων γίνεται είτε από το αντίστοιχο μενού Εισαγωγής (Insert) 
είτε από την παλέτα διαμόρφωσης του εγγράφου. Πολλές φορές σε ένα έντυπο μπο-
ρεί να χρειαστεί η εκ των υστέρων προσθήκη ή διαγραφή σελίδων. Σ’ αυτή την πε-
ρίπτωση, με την προηγούμενη εντολή προσθέτονται νέες σελίδες. Η εισαγωγή τους 
γίνεται από την ενεργοποιημένη σελίδα (π.χ. την 30ή σελίδα) και παρεμβάλλονται 
όσες σελίδες καθοριστούν. Αν τώρα μείνουν κάποιες κενές η διαγραφή τους γίνεται 
με την αντίστοιχη εντολή. Αν υπάρχει το εικονίδιο διαγραφής, απλώς επιλέγονται 

με το ποντίκι οι προς διαγραφή σελίδες και σύρονται στο αντίστοιχο εικονίδιο.

Επίσης, μπορούμε να δημιουργήσουμε πρότυπες σελίδες. Παραδείγματος χάριν, αν 
αποφασισθεί ότι σε ένα βιβλίο θα ήταν σκόπιμο να σχεδιασθούν περιθώρια σελίδας 
1,5 cm και το κείμενο να στοιχειοθετηθεί σε μορφή τρίστηλου, θα έπρεπε σε κάθε 
σελίδα του βιβλίου να σχεδιάζαμε τις συγκεκριμένες προδιαγραφές. Όμως, δημι-
ουργώντας μία πρότυπη σελίδα με τις συγκεκριμένες ρυθμίσεις, αυτές ισχύουν για 
όλο το έγγραφο ή για όσες σελίδες του εγγράφου εμείς επιθυμούμε. Άλλα στοιχεία 

που ορίζονται είναι η αρίθμηση, λογότυπο, τίτλος βιβλίου ή περιοδικού.

Μια από τις εργασίες που γίνονται στις πρότυπες σελίδες, είναι η σελιδαρίθμηση. Συ-
νήθως, δημιουργείται ένα πλαίσιο κειμένου, γράφουμε το κείμενο που θέλουμε πριν 
τους αριθμούς των σελίδων και με την εντολή Στήσιμο (ή Σελιδοποίηση) > Εισαγωγή 
Αριθμών Σελίδων (Layout > Page Numbering) εισάγονται οι αριθμοί σελίδων. Στο 
πρόγραμμα QXpress όμως συγκεκριμένα, γίνεται από το πληκτρολόγιο με τον συν-
δυασμό πλήκτρων CTRL+3. Φυσικά, υπάρχουν πολλές δυνατότητες. Να αριθμηθούν 
μόνο οι ζυγές ή μονές σελίδες, να μην υπάρχει σελιδαρίθμηση στην πρώτη σελίδα 
κάθε κεφαλαίου ή να υπάρχει αρίθμηση σε μεμονωμένες σελίδες. Στην τελευταία 

περίπτωση πρέπει να γίνει η εισαγωγή των αριθμών στις συγκεκριμένες σελίδες.

13.4 Οι μονάδες μέτρησης της τυπογραφίας

Παρά το γεγονός ότι σήμερα, με τη χρησιμοποίηση των συστημάτων επιτραπέζιας 

τυπογραφίας, μπορούμε να μετράμε τις διαστάσεις των σελίδων και των στηλών με 

οποιαδήποτε μονάδα μέτρησης, οι περισσότεροι τυπογράφοι είναι εξοικειωμένοι 

με τις στιγμές (points), που είναι μονάδα βασισμένη στην ίντσα. Στην Ευρωπαϊκή 

Ένωση μετράμε τα πλάτη των στηλών με εκατοστά, ενώ τα ύψη τους σε τετράγωνα 

(cicero). Στην Αμερική αντί για εκατοστό χρησιμοποιούν την ίντσα και αντί για τα 

cicero, το pica. Αυτός είναι ο λόγος που στο πλαίσιο διαλόγου των προτιμήσεων των 
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προγραμμάτων σελιδοποίησης έχουμε τη δυνατότητα να ρυθμίσουμε με διαφορε-
τικές μονάδες (της επιλογής μας), την οριζόντια και την κατακόρυφη διάσταση της 
σελίδας. Λόγος για τον οποίο θα ήθελε κάποιος να αλλάξει αυτές τις τιμές είναι ότι 
η ακριβής τιμή των στιγμών ανά ίντσα δεν είναι 72 αλλά 72,271742. Η διαφορά δεν 
είναι μεγάλη και ο λόγος της στρογγυλοποίησης είναι προφανής.

Αντιστοιχία τυπογραφικών μονάδων
1 ίντσα 2,54 cm

1 pica 12 στιγμές ή points
1 ίντσα 72 στιγμές ή points

1 cicero 12 στιγμές didot
1 cm 2,1967 cicero

1 cm 2,3723 pica

Τα προγράμματα σελιδοποίησης έχουν τη δυνατότητα να δέχονται στον πίνακα με-
τρήσεων και στα άλλα πλαίσια διαλόγου οποιαδήποτε μονάδα χωρίς κανένα περιο-
ρισμό, αρκεί να χρησιμοποιούμε το κατάλληλο σύμβολο:

Αν θέλουμε να βάλουμε... Πληκτρολογούμε... Παράδειγμα
στιγμές (points) pt ή p 6pt ή p6

τετράγωνα (pica) p 10p ή 2p6 (2 picas, 6 points)
τετράγωνα (cicero) c 2c ή 6c3 (6 ciceros, 3 points)

εκατοστά cm 3cm
χιλιοστά mm 210mm

13.5 Γραμματοσειρές και διαχείριση γραμματοσειρών 

Ας ασχοληθούμε τώρα με αυτά που καλύπτουν το 60% έως το 70% περίπου της 
συνολικής επιφάνειας ενός βιβλίου, τα γράμματα. Σε επόμενο κεφάλαιο θα δούμε 
πώς τα χρησιμοποιούμε στη μορφοποίηση της σελίδας.

Αν ρωτήσουμε έναν αναγνώστη (που δεν γνωρίζει τίποτα για την τέχνη της τυπογρα-
φίας) να μας περιγράψει τα χαρακτηριστικά των γραμμάτων που είναι τυπωμένα στο 
βιβλίο που μόλις διάβασε, θα βρεθεί σε δύσκολη θέση, γιατί δε θα μπορεί να θυμηθεί 
κανένα συγκεκριμένο χαρακτηριστικό τους. Αυτό δεν είναι περίεργο. Για πολλούς 
θεωρητικούς της αισθητικής οι σωστά σχεδιασμένοι τυπογραφικοί χαρακτήρες θα 
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πρέπει να περνούν απαρατήρητοι, να βοηθούν μόνο την ανάγνωση του κειμένου. 

Έτσι, ο αναγνώστης μας μπορεί να πει αν η ανάγνωση ήταν ευχάριστη και ξεκούρα-

στη, ανεξάρτητα από το ενδιαφέρον που μπορεί να του προκάλεσε το περιεχόμενο. 

Επίσης, είναι εύκολο να εκφράσει τη γνώμη του για την εμφάνιση του βιβλίου και 

το «χρώμα» που εκπέμπει η τυπωμένη σελίδα.

Όλα αυτά έχουν σχέση με το σχήμα των γραμμάτων και τη στοιχειοθεσία του κει-

μένου. Αυτός είναι ο λόγος άλλωστε που οι γραφίστες πρέπει να αφιερώνουν χρόνο 

στην επιλογή της γραμματοσειράς, το μέγεθος των γραμμάτων και των διαστημά-

των μεταξύ τους και μεταξύ των λέξεων. Το σχήμα των γραμμάτων και η στοιχειοθε-

σία έχουν τεράστια σημασία στην «αναγνωσιμότητα» και την αισθητική του βιβλί-

ου, αλλά γίνονται αντιληπτά με ασαφή τρόπο, στο υποσυνείδητο.

Βέβαια όλα τα προηγούμενα δεν εφαρμόζονται στα πολύχρωμα κείμενα των διαφη-

μίσεων και των ιστοσελίδων του διαδικτύου. Στις σύγχρονες αυτές εφαρμογές της 

στοιχειοθεσίας το μέσο όπου προβάλλονται τα κείμενα επιβάλλει νέους αισθητι-

κούς κανόνες. Περισσότερες πληροφορίες για τα γράμματα και τον σχεδιασμό τους, 

μπορείτε να βρείτε στο βιβλίο Γραμματογραφία του Τομέα Εφαρμοσμένων Τεχνών 

του Παιδαγωγικού Ινστιτούτου.

Με τον όρο γραμματοσειρά (font), παραδοσιακά, ορίζουμε το σύνολο των πεζών 

και κεφαλαίων γραμμάτων, αριθμών, σημείων στίξης και άλλων συμβόλων ενιαίου 

σχεδιασμού σε ένα συγκεκριμένο μέγεθος. Σήμερα οι γραμματοσειρές πωλούνται 

σε ψηφιακή μορφή πολλές μαζί σε CD-ROM, ή μέσω του διαδικτύου. Η ψηφιακή 

γραμματοσειρά περιέχει το βασικό σχέδιο των χαρακτήρων, ενώ σε συνεργασία με 

το πρόγραμμα σελιδοποίησης, σχηματίζονται τα διαφορετικά μεγέθη, πάντα όμως 

του ίδιου σχεδιασμού. Π.χ. λέμε Helvetica μαύρα (bold), ή Helvetica όρθια, χωρίς 

να αναφέρουμε συγκεκριμένο μέγεθος, αφού δεν έχει νόημα η άμεση αναφορά του.

TrueType και Postscript: Αυτές είναι οι δύο βασικές μορφές γραμματοσειρών σε 

ψηφιακή μορφή. Την πρώτη τη σχεδίασαν από κοινού οι εταιρείες Microsoft και 

Apple, γι’ αυτό οι υπολογιστές με λειτουργικό σύστημα Windows και οι υπολογιστές 

Macintosh διαθέτουν με την αγορά τους ένα σεβαστό αριθμό τέτοιων γραμματοσει-

ρών, έτσι ώστε ο μέσος χρήστης να μην ασχοληθεί με την αγορά άλλων. Οι ασχο-

λούμενοι με τις γραφικές τέχνες, όμως, προτιμούν γραμματοσειρές Postscript που 
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καθιέρωσε η Adobe (πολλές φορές καλούνται και γραμματοσειρές Type 1). Αυτές, 
συνεργάζονται καλλίτερα με τους εικονοθέτες και είναι συνήθως πιο καλοσχεδιασμέ-
νες. Όμως, μερικά προγράμματα σελιδοποίησης δεν εμφανίζουν ευκρινώς στην οθό-
νη αυτές τις γραμματοσειρές. Γι̕ αυτό η Adobe διαθέτει δωρεάν ένα πρόγραμμα, το 
Adobe Type Manager (ATM), που εμφανίζει στην οθόνη ωραίες και χωρίς «δοντάκια» 
τις γραμματοσειρές Postscript. Φυσικά, η εκτύπωση, με ή χωρίς ATM, δε διαφέρει.

Υπάρχει και μία τρίτη κατηγορία γραμματοσειρών, η μορφή OpenType που δημι-
ουργήθηκε από τη συνεργασία των Microsoft και Adobe και έχει αρκετά πλεονεκτή-
ματα έναντι των δύο προηγούμενων όπως κοινή γραμματοσειρά για τις πλατφόρμες 
Windows και Macintosh, δημιουργία βραχυγραφιών και συμπλεγμάτων, όπως και 
κλασμάτων. Η μορφή OpenType δεν υποστηρίζεται ακόμη από όλα τα προγράμματα 
σελιδοποίησης, αλλά πρόκειται για τη μελλοντική τεχνολογία γραμματοσειρών που 
θα κυριαρχήσει και αξίζει τον κόπο να τη γνωρίσουμε.

13.6 Σχεδίαση και επεξεργασία σχημάτων

Όλα τα προγράμματα διαθέτουν εργαλεία με τα οποία μπορούν να σχεδιαστούν 
απλά γεωμετρικά σχήματα. (Εικόνα 13.7). Τα σχήματα αυτά μπορούν να μετακινη-
θούν μέσα στο έγγραφο, να μεταβληθεί το μέγεθός τους, να αποκτήσουν γέμισμα 
και χρώμα, περίγραμμα με διαφορετικό πάχος και χρώμα.
Τα αντικείμενα τα οποία μπορούν να σχεδιαστούν είναι γραμμές, καμπύλες και πα-
ραλληλόγραμμα. Αυτά φυσικά μπορούν να έχουν περίγραμμα και γέμισμα. Η ρύθμισή 
τους γίνεται από την αντίστοιχη καρτέλα ιδιοτήτων. Εκεί μπορείτε να καθορίσετε το 
πάχος του περιγράμματος, το χρώμα, το γέμισμα και τη σκίασή του. Φυσικά αν γίνουν 
στην πρότυπη σελίδα, τότε θα επαναλαμβάνονται σε όλες τις σελίδες που εφαρμόζεται.

Ορθογώνιο Καμπύλες Bezier
Επικλινείς

Γωνίες

Ελεύθερη  
Σχεδίαση

Κυρτές Γωνίες Έλλειψη Στρογγυλεμένο 
Ορθογώνιο

Εικόνα 13.7: Η παλέτα εργαλείων σχεδίασης.

Αν εκτελεσθούν οι εντολές του περιγράμματος ή του γεμίσματος χωρίς να είναι επιλεγ-
μένο κανένα αντικείμενο, τα χαρακτηριστικά αυτά αποτελούν τις νέες προκαθορισμένες 

24-0151 Book.indb   19024-0151 Book.indb   190 27/10/2021   12:17:32 µµ27/10/2021   12:17:32 µµ



191

Η  Τ Υ Π Ο Γ Ρ Α Φ Ι Α  Σ Η Μ Ε Ρ Α

ρυθμίσεις. Όλα τα αντικείμενα που θα σχεδιαστούν μετά, θα συμφωνούν με τις 
ρυθμίσεις αυτές.

Για να γίνει αλλαγή σε κάποια από τα χαρακτηριστικά αυτά, πρέπει να γίνει η επι-
λογή του αντικειμένου με το εργαλείο δείκτη. Κατόπιν, με την εκτέλεση των εντο-
λών, αλλάζουν τα χαρακτηριστικά τους.

Μια ειδική κατηγορία αντικειμένων είναι τα πλαίσια. Ενώ η συμπεριφορά ενός 
πλαισίου μοιάζει με τη συμπεριφορά οποιουδήποτε άλλου αντικειμένου γραφικού, 
εν τούτοις διαφέρει σε δύο σημαντικά σημεία:

•	� Ένα πλαίσιο μπορεί να έχει περιεχόμενο – κείμενο ή γραφικά – ή απλώς 
να «κρατά τη θέση» για κάποιο συγκεκριμένο περιεχόμενο.

•	� Ένα πλαίσιο κειμένου μπορεί να συνδέεται με αλυσίδα με άλλα πλαίσια 
έτσι ώστε ένα κείμενο να ρέει σε πολλαπλά πλαίσια.

Η αναπαραγωγή τώρα ενός αντικειμένου μπορεί να γίνει μέσα σε ένα έγγραφο είτε 
με αντιγραφή και επικόλληση είτε με την τεχνική της πολλαπλής επικόλλησης. Με 
την πρώτη επιλογή το αντικείμενο αναπαράγεται σε νέα σελίδα ακριβώς όπως ήταν 
το αρχικό. Για την αναπαραγωγή ενός αντικειμένου με συγκεκριμένη απόκλιση γί-
νεται η μεταφορά του αντιγράφου προς την επιθυμητή κατεύθυνση και απόσταση 
και στην επανάληψη της αναπαραγωγής το νέο αντίγραφο θα έχει αποκτήσει την 
απόκλιση αυτή. (Εικόνα 13.8). Τα αντίγραφα, δηλαδή, κληρονομούν εκτός από τα 
περιεχόμενα και την ιδιότητα της απόκλισης.

Εικόνα 13.8: Στο πλαίσιο διαλόγου Πολλαπλή Κόλληση (επικόλληση) ορίζονται το πλήθος των 
αντιγράφων και η μεταξύ τους απόσταση. Στην εικόνα, τα τρία αντίγραφα, έχουν μεταξύ τους 
απόσταση 40 mm οριζόντια και 10 mm κατακόρυφα, με σημεία αναφοράς τις αριστερές γωνίες.
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Αν το αντικείμενο που αναπαράγεται είναι γραφικό, τότε αυτό «αγκιστρώνεται» με 
το κείμενο, δηλαδή μετακινείται μαζί με αυτό. Έτσι, εξασφαλίζεται η τοποθέτησή 
του μαζί με το κείμενο που αντιστοιχεί σε αυτό, στην περίπτωση που προστεθούν ή 
διαγραφούν λέξεις από το κείμενο.

Η διαγραφή αντικειμένων γίνεται απλά με την ενεργοποίηση του αντικειμένου με 
το ποντίκι και το πλήκτρο Del. Με τη διαγραφή του διακόπτονται όλες οι διασυνδέ-
σεις του αντικειμένου με το κείμενο. Αν διαγραφεί ένα πλαίσιο κειμένου που είναι 
συνδεδεμένο με άλλα πλαίσια κειμένου στο ίδιο θέμα, τότε το πλαίσιο που βρίσκε-
ται πριν από το διαγραμμένο, συνδέεται αυτόματα με το επόμενο πλαίσιο (αυτό που 
ακολουθούσε εκείνο που διαγράφηκε).

Για την ακριβή τοποθέτηση μπορεί να χρησιμοποιηθεί και το εργαλείο της μεγέθυν-
σης. Αυτό βρίσκεται στην κύρια εργαλειοθήκη και έχει το σχήμα του φακού. Με την 
ενεργοποίησή του γίνεται αυτόματα μεγέθυνση κατά 50%, ή σχεδιάζεται ένα νοητό 
τετράγωνο γύρω από το αντικείμενο που ενδιαφέρει και γίνεται αυτόματα τέτοια με-
γέθυνση, ώστε το αντικείμενο να καταλάβει όλη την οθόνη (Εικόνα 13.9). Η μέγιστη 
μεγέθυνση φθάνει το 4000% περίπου (ανάλογα με το πρόγραμμα). Η σμίκρυνση 
γίνεται με το ίδιο εργαλείο και με κάποιο βοηθητικό πλήκτρο (συνήθως με το Alt).

Εικόνα 13.9: Ο χώρος εργασίας με εμφάνιση κανάβου, χάρακες και μεγέθυνση 200%.
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Ανακεφαλαίωση 13ου Κεφαλαίου

Με την έναρξη του προγράμματος επιλέγουμε ένα νέο έγγραφο, του οποίου 
έχουμε τη δυνατότητα να ορίσουμε τη διάστασή του.
Προκειμένου να τοποθετήσουμε κείμενο στη σελίδα πρέπει πρώτα να σχεδιά-
σουμε ένα πλαίσιο κειμένου. Αντιστοίχως δημιουργούμε πλαίσιο εικόνας για να 
τοποθετήσουμε μία εικόνα.
Για πολυσέλιδα έγγραφα δημιουργούμε τις πρότυπες σελίδες. Δηλαδή μία ή 
περισσότερες σελίδες-υπόδειγμα, που περιέχουν όλα κοινά στοιχεία, όπως για 
παράδειγμα την αρίθμηση σελίδων.
Αντί να πληκτρολογούμε τον αριθμό κάθε σελίδας, ορίζουμε με ένα ειδικό χα-
ρακτηρισμό την θέση της αρίθμησης στην πρότυπη σελίδα και το πρόγραμμα 
αυτομάτως θέτει την πραγματική αρίθμηση στις σελίδες.
Η μονάδα μέτρησης στην τυπογραφία είναι η στιγμή (point). Στην Ευρωπαϊκή 
Ένωση μετράμε τα πλάτη των στηλών με εκατοστά, ενώ τα ύψη τους σε τετρά-
γωνα (cicero). Η μονάδα cicero έχει 12 στιγμές (points) του Didot.
Με τον όρο γραμματοσειρά (font), παραδοσιακά, ορίζουμε το σύνολο των πε-
ζών και κεφαλαίων γραμμάτων, αριθμών, σημείων στίξης και άλλων συμβόλων 
ενιαίου σχεδιασμού σε ένα συγκεκριμένο μέγεθος.
Τα εργαλεία για να σχεδιάσουμε απλά σχήματα και γραμμές Bezier, υπάρχουν 
και στα προγράμματα σελιδοποίησης. Όπως επίσης και όλα τα εργαλεία ακρι-
βούς σχεδίασης με την βοήθεια κανάβου και οδηγών.
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Ασκήσεις 13ου Κεφαλαίου

1.	� Με ποια έννοια οι υπολογιστές άλλαξαν τον τρόπο εργασίας του (της) γραφίστα, 
αλλά και γενικότερα τη ροή εργασίας των γραφικών τεχνών; Να δικαιολογείτε 
τις απαντήσεις σας.

2.	Ποια είναι τα πλεονεκτήματα της χρήσης υπολογιστών στις γραφικές τέχνες;
3.	Ποια είναι τα ενδεχόμενα προβλήματα στη χρήση των υπολογιστών;
4.	Τι καλείται «πλαίσιο διαλόγου»;
5.	� Αναφέρατε τα εργαλεία της εργαλειοθήκης, περιγράφοντας σύντομα πώς τα χρη-

σιμοποιούμε για τη σχεδίαση σελίδων.
6.	�Πάρτε μία εφημερίδα μεγάλου και μία μικρού σχήματος. Μπορείτε να διακρίνετε 

το πλήθος των στηλών που έχει η κάθε σελίδα; Ποια είναι τα λευκά περιθώρια 
της κάθε μιας;

Δραστηριότητες 13ου Κεφαλαίου

1.	 Εκκινήστε το πρόγραμμα σελιδοποίησης που διαθέτει το εργαστήριο.
2.	� Σχεδιάστε, στο πρόγραμμα σελιδοποίησης της επιλογής σας, τις δύο σελίδες εφη-

μερίδας που αναλύσατε σε προηγούμενη άσκηση χωρίς να πληκτρολογήσετε κεί-
μενα ή να τοποθετήσετε φωτογραφίες. Αυτό λέγεται προσχέδιο ή «κασέ» της 
σελίδας.

3.	� Με τη βοήθεια του(της) καθηγητή(τριάς) σας, αναζητήστε στο διαδίκτυο στη 
σελίδα www.adobe.com της Adobe το πρόγραμμα Adobe Type Manager (ATM). 
Εγκαταστήστε το στον υπολογιστή σας ακολουθώντας τις οδηγίες εγκατάστασης.

4.	�Αναζητήστε με τη βοήθεια των καθηγητών σας γραμματοσειρές Postscript στο 
διαδίκτυο. Εγκαταστήστε τις στον υπολογιστή σας.

5.	� Με τη βοήθεια των καθηγητών σας επισκεφθείτε το δικτυακό τόπο της Microsoft 
αφιερωμένο στην τυπογραφία http://www.microsoft.com/typography/default.
asp αφού αναζητήσετε τις κατάλληλες πληροφορίες, οργανώστε μία παρουσίαση 
για τους υπόλοιπους συμμαθητές σας των γραμματοσειρών TrueType και Open-
Type.
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Κεφάλαιο 14ο
Η Διαχείριση κειμένου

Στόχοι:

Στο κεφάλαιο αυτό οι μαθητές θα μπορέσουν να:

	 •	� Κατανοήσουν τις μεθόδους διαμόρφωσης της μορφής των χαρακτήρων 
και των παραγράφων.

	 •	 �Κατανοήσουν τις τεχνικές διαμόρφωσης του κειμένου σε στήλες.

	 •	� Γνωρίσουν τις εργασίες για την αποθήκευση και απλή εκτύπωση εγ-
γράφων.

14.1 Εισαγωγή

Στα προγράμματα σελιδοποίησης ένα βασικό στοιχείο είναι το πλαίσιο κειμένου του 
οποίου μπορούμε να αλλάξουμε ανά πάσα στιγμή, τη θέση και το σχήμα του. Στους 
κειμενογράφους η σελίδα και οι γραμμές είναι τα βασικά στοιχεία. Το κείμενο γεμί-
ζει τις σελίδες γραμμή-γραμμή, ενώ αυτές έχουν σταθερό μήκος.
Στα προγράμματα σελιδοποίησης δεν υπάρχει αυτή η σταθερότητα, το κείμενο μπο-
ρεί να εισαχθεί από κάποιο άλλο έγγραφο, να διακοπεί η ροή του, να συνεχιστεί 
από κάποιο σημείο και μετά, ή να μεταβληθεί ριζικά η μορφή της σελίδας. Αυτό 
συμβαίνει, γιατί το βασικό στοιχείο είναι το πλαίσιο κειμένου, που εύκολα αλλάζει 
μέγεθος και μορφή, αναπροσαρμόζοντας με την σειρά του το κείμενο που περιέχει.

Στους κειμενογράφους η επιφάνεια στην οποία γράφουμε, θυμίζει τη διαγραμμι-
σμένη σελίδα τετραδίου, χωρίς όμως τις γραμμές. Όταν γράφουμε σε αυτήν, πρέπει 
να ακολουθήσουμε τις εκτυπωμένες γραμμές.
Αντίθετα, ένα πρόγραμμα σελιδοποίησης μοιάζει περισσότερο με μια λευκή σελί-
δα. Το κείμενο μέσα στο πλαίσιό του μπορεί να τοποθετηθεί όπου θέλουμε και με 
όποιον τρόπο επιθυμούμε. Εδώ υπάρχει ο περιορισμός του αριθμού των σελίδων σε 
ένα έντυπο και όχι των γραμμών σε μια σελίδα.
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14.2 Η εισαγωγή κειμένου

Για να εμφανισθεί κείμενο στη σελίδα είναι αναγκαίο να ορίσουμε πρώτα ένα πλαί-
σιο κειμένου. Αμέσως ο δείκτης αναβοσβήνει μέσα στο πλαίσιο και μπορούμε να 
πληκτρολογήσουμε όπως ακριβώς σε ένα επεξεργαστή κειμένου. Για την πληκτρο-
λόγηση κεφαλαίου γράμματος θα πρέπει να πατάμε συγχρόνως και το πλήκτρο 
Shift. Στα κείμενα οι τόνοι πληκτρολογούνται πριν από το τονούμενο φωνήεν. Το 
ίδιο και τα διαλυτικά. Αν θελήσουμε να πληκτρολογήσουμε χαρακτήρες που δεν 
εμφανίζονται στο πληκτρολόγιο μας, θα πρέπει να χρησιμοποιήσουμε τα πλήκτρα 
Ctrl και Alt. Για παράδειγμα, το σύμβολο ® προκύπτει με Ctrl+Alt+R. Επίσης, η ει-
σαγωγή κειμένου μπορεί να γίνει από έναν οποιοδήποτε επεξεργαστή κειμένου και 
στη συνέχεια να διαμορφωθεί στο πρόγραμμα σελιδοποίησης.

Αφού γίνει ο βασικός ορισμός του εγγράφου ξεκινά η διαδικασία κατασκευής πλαι-
σίων κειμένου όπου με τις εντολές Τοποθέτηση ή Εισαγωγή (Place ή Import) που 
συνήθως βρίσκονται στο μενού Αρχείο (File) εισάγονται κείμενα (Εικόνα 14.1). Στο 
πλαίσιο διαλόγου που εμφανίζεται υπάρχουν όλοι οι τύποι αρχείων που αναγνωρί-
ζει το πρόγραμμα. Υπάρχουν διάφορες προαιρετικές επιλογές οι οποίες καθορίζουν 
τον τρόπο με τον οποίο θα γίνει η εισαγωγή (κειμένου):

•	� Διατήρηση Μορφοποίησης (Retain Format): με την επιλογή αυτή το κείμενο 
εισάγεται ακριβώς όπως έχει διαμορφωθεί στον επεξεργαστή κειμένου.

•	� Μετατροπή Εισαγωγικών (Convert Quotes): μετατρέπει τα εισαγωγικά (« ...») 
με τρόπο ενιαίο. Ένα περιοδικό μπορεί να έχει κείμενα από διάφορους συντά-
κτες, που να έχουν γραφεί με διαφορετικούς επεξεργαστές κειμένων. Με την 
επιλογή αυτή όλα τα εισαγωγικά μετατρέπονται σε ένα ενιαίο τρόπο εμφάνισης.

•	� Διατήρηση Στυλ (Tags): Ένα κείμενο το οποίο εισάγεται, μπορεί να έχει προκα-
τασκευασμένη μορφοποίηση (στυλ γραφής), δημιουργημένη από το συγγραφέα 
του. Αν διατηρηθούν τα στυλ των κειμένων που εισάγονται, μπορεί να αποφευ-
χθεί ο ορισμός τους εκ νέου από το χρήστη του προγράμματος. Συνήθως, γίνε-
ται σε βιβλία, όπου ο συγγραφέας έχει ήδη ορίσει την μορφοποίηση. Π.χ. Στην 
στοιχειοθεσία βιβλίου ορίζεται ένα στυλ για το κείμενο και ένα άλλο στυλ για 
τους τίτλους των κεφαλαίων. Έτσι ο σελιδοποιός καταλαβαίνει ότι ο συγγραφέας 
προτιμά το συγκεκριμένο τύπο γραφής και δεν τον αλλάζει.
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Εικόνα 14.1: Στο πλαίσιο εισαγωγής αρχείων (FiIe>Place...), εμφανίζονται όλοι οι τύποι αρχείων 
που είναι συμβατοί με το πρόγραμμα.

Αν πατηθεί το πλήκτρο Άνοιγμα (Open) εκκινεί η διαδικασία εισαγωγής του κει-
μένου και μετατροπής του ώστε να έρθει σε μορφή αναγνώσιμη διατηρώντας τα 
επιθυμητά χαρακτηριστικά. Το επόμενο στάδιο είναι η επιλογή ροής του κειμένου. 
Όταν το κείμενο εισάγεται στις σελίδες, στην ουσία «ρέει» στο πλαίσιο ή στις σελί-
δες που θα του υποδείξουμε. Υπάρχουν τρεις καταστάσεις ροής:

•	� Χειροκίνητη (Manual): Το κείμενο «φορτώνεται» στη μνήμη και περιμένει να του 
υποδειχθεί το σημείο εισαγωγής με το δείκτη του ποντικού. Όταν γίνει αυτό, το κεί-
μενο ρέει στο πλαίσιο ή στη στήλη ή στη σελίδα που του έχει υποδειχθεί, μέχρι να 
τη συμπληρώσει. Αν εμφανισθεί ένα μικρό κόκκινο τρίγωνο ή τετράγωνο, κάτω από 
το κείμενο που μόλις βάλαμε, σημαίνει ότι υπάρχει και άλλο που δεν χώρεσε. Επι-
λέγοντάς το με το ποντίκι, το υπόλοιπο κείμενο «φορτώνεται» εκ νέου στη μνήμη 
και το πρόγραμμα περιμένει να του υποδειχθεί το νέο σημείο εισαγωγής του κειμέ-
νου. Αυτό μπορεί να είναι σε διαφορετικό πλαίσιο, στήλη ή σελίδα. (Εικόνα 14.2)

Εικόνα 14.2.
To κόκκινο τετράγωνο δείχνει ότι 
υπάρχει κείμενο που πρέπει να το-
ποθετηθεί σε νέο πλαίσιο κειμένου.
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•	�� Αυτόματη (Auto): Με πίεση του πλήκτρου Ctrl. Αυτή η κατάσταση χρησιμοποι-
είται συνήθως, όταν το κείμενο εισάγεται σε σελίδες ή στήλες. Όταν επιλεγεί με 
το ποντίκι το σημείο εισαγωγής, το πρόγραμμα τοποθετεί το κείμενο συνέχεια, 
προσθέτοντας ακόμη και σελίδες, όταν δεν είναι επαρκείς. Σταματάει, αφού το-
ποθετήσει όλο το κείμενο στο έγγραφο. Είναι ο πιο σύντομος τρόπος εισαγωγής 
και ενδείκνυται στο στήσιμο βιβλίων. Αν μετά τη μορφοποίηση μείνουν κενές σε-
λίδες αυτές απλώς διαγράφονται. Στα προγράμματα υπάρχουν βοηθήματα, που 
αυτόματα εντοπίζουν τις κενές σελίδες και τις διαγράφουν.

•	� Ημιαυτόματη (Semi-Auto): Με πίεση του πλήκτρου Shift. Είναι μια ενδιάμεση 
κατάσταση, καθώς δεν ρέει το κείμενο αυτόματα αλλά όταν γεμίσει το πλαίσιο 
που του έχει υποδειχθεί, τότε αυτόματα «φορτώνεται» το υπόλοιπο στη μνήμη 
και περιμένει να του υποδειχθεί νέο σημείο εισαγωγής. Με επιλογή με το ποντί-
κι στο νέο σημείο εισαγωγής το κείμενο συνεχίζεται στο επόμενο πλαίσιο. Αυτό 
μπορεί να συνεχισθεί σε όσα πλαίσια είναι απαραίτητο. Στο τέλος όλα αυτά τα 
πλαίσια κειμένου συνδέονται σαν «συγκοινωνούντα δοχεία», δηλαδή, αν σβή-
σουμε έστω και μία λέξη από το πρώτο πλαίσιο, όλα τα κείμενα στα συνδεδεμένα 
πλαίσια μετακινούνται για να καλύψουν το κενό.

Ένας εναλλακτικός τρόπος για την εισαγωγή κειμένων και γραφικών είναι οι εντολές 
Αντιγραφή (Copy) και Επικόλληση (Paste). Καλό είναι η χρήση τους να περιορίζεται 
μόνο όταν γίνεται μεταφορά τμημάτων κειμένου. Η εντολή Τοποθέτηση διαθέτει 
καλύτερο έλεγχο των αντικειμένων που εισάγονται. Ενδιαφέρον έχει και η εντολή 
Επικόλληση Δεσμού (Paste Link) με την οποία το κείμενο ενημερώνεται για όποια 
αλλαγή γίνεται στο έγγραφο από το οποίο προήλθε. Πχ. διορθώσεις κειμένου.
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14.3 Η μορφοποίηση του κειμένου

Μορφοποίηση (Formatting) είναι η διαμόρφωση των σελίδων του έντυπου βάσει 
του προσχεδίου. Η μορφοποίηση αφορά τους μεμονωμένους χαρακτήρες, λέξεις, 
παραγράφους ακόμη και ολόκληρο το έντυπο. Για να εφαρμοστεί, πρέπει πρώτα να 
είναι επιλεγμένο το κείμενο του οποίου θα αλλάξει η μορφή. Στο επιλεγμένο κείμε-
νο λοιπόν είναι δυνατόν να αλλάξει η γραμματοσειρά, το μέγεθός της, οι χαρακτή-
ρες να γίνουν έντονοι, πλάγιοι ή υπογραμμισμένοι, να αλλάξει το χρώμα τους κτλ.

Ο καλύτερος τρόπος, για να αλλάξει η γραμματοσειρά, είναι από την παλέτα μετρή-
σεων. Με την επιλογή της κατάλληλης γραμματοσειράς από τη λίστα που περιέχει 
όλες τις γραμματοσειρές, που υποστηρίζει το πρόγραμμα σελιδοποίησης. Το μέγε-
θός τους αναγράφεται στην αριθμητική λίστα δίπλα από αυτήν με τα ονόματα των 
γραμματοσειρών. Εκτός από τα μεγέθη που βρίσκονται εκεί, μπορούμε να πληκτρο-
λογήσουμε και οποιοδήποτε άλλο αριθμό (Εικόνα 14.3).

Εικόνα 14.3: Η παλέτα μετρήσεων με τις εντολές διαμόρφωσης χαρακτήρων.

Η απόδοση τώρα του χαρακτηρισμού της έντονης (bold), πλάγιας (italic) και υπο-
γραμμισμένης (underlined) γραφής γίνεται από τα αντίστοιχα εικονίδια που δια-
θέτει το πρόγραμμα. Πρώτα επιλέγεται η λέξη ή η φράση και μετά αποδίδεται ο 
χαρακτηρισμός της γραφής. Συνήθως χρησιμοποιούνται, όταν μια λέξη ή φράση 
πρέπει να διαφοροποιηθεί από το υπόλοιπο κείμενο.

Ο χρωματισμός των χαρακτήρων μπορεί να γίνει με την επιλογή των λέξεων ή των 
χαρακτήρων και με την αντίστοιχη επιλογή ενός χρώματος από την χρωματική 
παλέτα. Η τελευταία – ανάλογα με το πρόγραμμα που χρησιμοποιείται – διαθέτει 
χρώματα σε διάφορα πρότυπα που έχουν προαναφερθεί (Pantone, Toyo κλπ) αλλά 
δίνεται στο γραφίστα η δυνατότητα να δημιουργήσει όποιο χρώμα θελήσει με την 
πρόσμιξη των τεσσάρων βασικών χρωμάτων της τετραχρωμίας.
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Διαστήματα μεταξύ των χαρακτήρων (Tracking): Ο όρος Tracking, εκφράζει 
τον κενό χώρο που υπάρχει ανάμεσα στους χαρακτήρες σε ένα κείμενο. (Εικόνα 
14.4 και 14.5). Χρησιμοποιώντας το σύμβολο (-) ή το (+) μπροστά από την τιμή, 
επιτυγχάνεται η μείωση ή η αύξηση του διαστήματος μεταξύ των χαρακτήρων. Τα 
προγράμματα καθορίζουν το διάστημα μεταξύ των χαρακτήρων σε βήματα 1/200 
(0,5%) ενός τετραγώνου Em. To Em αντιστοιχεί σε ένα τετράγωνο πλευράς μήκους 
του αντίστοιχου μεγέθους της γραμματοσειράς (ή του κεφαλαίου γράμματος Μ, 
στην αντίστοιχη γραμματοσειρά). Για παράδειγμα, στη γραμματοσειρά Bookman 
10 στιγμών, ένα Em έχει πλάτος 10 στιγμές. Συνεπώς, μειώνοντας τα διαστήματα 
μεταξύ των χαρακτήρων κατά 20 μονάδες (units) (ή 10%), οι χαρακτήρες ενός 
κειμένου με μέγεθος 10 στιγμές έρχονται 1 στιγμή πιο κοντά ο ένας στον άλλο, οι 
χαρακτήρες του κειμένου με μέγεθος 9 στιγμές έρχονται 0.9 στιγμές ο ένας πιο κο-
ντά στον άλλο.

Πύκνωση
Πύκνωση

Εικόνα 14.4: Η γραμματοσειρά Minion Pro εμφανίζει την λέξη Πύκνωση με διάστημα μεταξύ των 
γραμμάτων -100 μονάδες. Με επαναφορά του διαστήματος στο 0, επανέρχονται τα γράμματα στις 
κανονικές αποστάσεις.

Εικόνα 14.5: Η ειδική πύκνωση (kerning) του ζεύγους ΓΛ. Δεξιά, ο πίνακας για τα διαστήματα 
χαρακτήρων (tracking).
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Πύκνωση ζευγών χαρακτήρων ή διαγραμμάτωση (Kerning): Συχνά, ο κενός χώ-
ρος που υπάρχει ανάμεσα σε συγκεκριμένα ζεύγη χαρακτήρων χρειάζεται να προ-
σαρμόζεται, για να επιτυγχάνεται η καλύτερη δυνατή εμφάνιση. Αυτή η προσαρ-
μογή του κενού χώρου μεταξύ των χαρακτήρων είναι γνωστή με τον όρο πύκνωση 
ζευγών χαρακτήρων ή διαγραμμάτωση. (Εικόνα 14.5 και 14.6).

Τα Τα

Εικόνα 14.6: Η διαγραμμάτωση γίνεται σε ζευγάρια χαρακτήρων. Το ουδέτερο άρθρο στον πλη-
θυντικό εμφανίζεται με αραιούς χαρακτήρες. Η διαγραμμάτωση με -10 μονάδες, δεξιά, βελτιώνει 
την εμφάνισή του.

Κλίμακα χαρακτήρων (Scale): Η αλλαγή της κλίμακας συμπιέζει ή επεκτείνει τους 
ίδιους τους χαρακτήρες – αντί για το κενό ανάμεσά τους – σε ένα ποσοστό που μπο-
ρεί να κυμαίνεται από 25% έως 400%, με βήμα 0.1.
Ένας ειδικός αλγόριθμος (δημιουργία της εταιρείας Adobe), που καλείται Hinting, προ-
σαρμόζει αυτόματα τα χαρακτηριστικά μιας γραμματοσειράς ανάλογα με τα διάφορα 
μεγέθη. Κάθε γραμματοσειρά έχει διαφορετική εμφάνιση ανάλογα με το ποσοστό ορι-
ζόντιας και κατακόρυφης κλίμακας που θα εφαρμοστεί σ’ αυτήν. Για παράδειγμα, στην 
Εικόνα 14.4 βλέπουμε δύο διαφορετικές γραμματοσειρές (τις πιο εύχρηστες στους επε-
ξεργαστές κειμένου) με διαφορετικά ποσοστά οριζόντιας και κατακόρυφης κλίμακας.

Εικόνα 14.7: 
Η επίδραση οριζόντιας και
κατακόρυφης κλίμακας
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Μορφοποίηση παραγράφων: Εκτός από τους διάφορους τρόπους μορφοποίησης 
των χαρακτήρων, υπάρχει και η δυνατότητα μορφοποίησης παραγράφου. Αυτό γί-
νεται σε κάθε πρόγραμμα από την αντίστοιχη καρτέλα στο μενού των μορφοποιήσε-
ων. Θα μπορούσαμε να δούμε τέσσερις βασικές κατηγορίες μορφοποίησης: στοίχιση 
γραμμών, διάστιχο, απόσταση παραγράφων και εσοχές ή προεξοχές παραγράφων. 
Στη μορφοποίηση των παραγράφων μπορεί να οριστεί και ο χωρισμός των λέξεων.

Η στοίχιση των γραμμών της παραγράφου μπορεί να γίνει με πέντε τρόπους:

•	�� Η αριστερή στοίχιση (left alignment), όπου όλες οι γραμμές ισαπέχουν 
από το αριστερό περιθώριο.

•	�� Η δεξιά στοίχιση (right), όπου όλες οι γραμμές ισαπέχουν από το δεξί.

•	�� Η κεντρική στοίχιση (center), όπου όλες οι γραμμές είναι κεντραρισμέ-
νες και

•	�� Η πλήρης στοίχιση (justify), όπου όλες οι γραμμές είναι ισομήκεις.

•	�� Η υποχρεωτική πλήρης στοίχιση (forced justified) λειτουργεί όπως και η 
πλήρης, με την διαφορά ότι επιβάλλει ισομήκεις γραμμές ανεξαρτήτως πλή-
θους λέξεων, με αποτέλεσμα να δημιουργεί υπερβολικά κενά ή πυκνώματα.

Η στοίχιση συνήθως είναι προεπιλεγμένη και ό,τι γράφεται ή ό,τι εισάγεται στο 
πλαίσιο κειμένου έχει τη στοίχιση αυτή. Για να αλλάξουμε τη στοίχιση σε μια πα-
ράγραφο, αρκεί να τοποθετήσουμε το σημείο εισαγωγής στην παράγραφο και να 
πατήσουμε το αντίστοιχο πλήκτρο στην παλέτα μετρήσεων. Για την εφαρμογή στοί-
χισης σε περισσότερες από μια παραγράφους πρέπει πρώτα να γίνει η επιλογή των 
παραγράφων.

Στο κείμενο πρέπει να υπάρχει απόσταση μεταξύ των παραγράφων, μεταξύ των τίτ-
λων και του βασικού κειμένου. Η απόσταση αυτή (μετριέται είτε σε χιλιοστά είτε σε 
τυπογραφικές στιγμές), χωρίζεται σε δύο κατηγορίες, στην απόσταση πριν και στην 
απόσταση μετά, δηλαδή πόσο θα απέχει από την προηγούμενη παράγραφο και πόσο 
από την επόμενη. Οι αποστάσεις αυτές δρουν αθροιστικά, δηλαδή, αν η τρέχουσα 
απέχει από την επόμενη τρεις στιγμές και στην επόμενη έχει δηλωθεί ότι θα απέχει 
από την προηγούμενη έξι στιγμές, η συνολική απόσταση θα είναι εννέα στιγμές.

Το διάστιχο (leading): δηλαδή την απόσταση μεταξύ των γραμμών, μπορεί να ορί-
ζεται αυτόματα, ποσοστιαία ανάλογα με το μέγεθος των χαρακτήρων είτε να είναι 
σταθερό (Εικόνα 14.8).
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Εικόνα 14.8. Το αριστερό πλαίσιο περιέχει κείμενο με διάστιχο 14,4 στιγμές ενώ το δεξιό έχει 
ακριβώς τα ίδια χαρακτηριστικά, με διάστιχο 24.

Εσοχές: Πολλές φορές για να γίνει το κείμενο πιο ευανάγνωστο οι γραμμές μιας 
παραγράφου μπορεί να ξεκινούν δεξιότερα από τις άλλες. Η ρύθμιση αυτή γίνεται 
από τις εσοχές (indents). Υπάρχει δεξιά και αριστερή εσοχή. Θετικές τιμές στις αντί-
στοιχες αριθμητικές θυρίδες ορίζουν δεξιά και αριστερή εσοχή από τα αντίστοιχα 
περιθώρια. Η πρώτη γραμμή μπορεί να έχει τη δική της εσοχή ή προεξοχή. Συνηθί-
ζεται όταν δημιουργούμε αριθμημένες παραγράφους ή χρησιμοποιούμε κουκκίδες.

Εικόνα 14.9: Η καρτέλα ρύθμισης των εσοχών και των αποστάσεων. Από τις επιλογές γίνεται η 
ρύθμιση διατήρησης γραμμών στην αλλαγή σελίδας. Αριστερά στο Pagemaker. Δεξιά, στο πρό-
γραμμα QuarkXpress, οι ίδιες ρυθμίσεις από το μενού Style>Formats... (Paragraph Attributes).
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Στη μορφοποίηση παραγράφων περιλαμβάνεται και η τοποθέτηση πρωτογράμμα-
τος. Πρέπει να δηλωθεί πόσες γραμμές θα καταλαμβάνει, ορίζοντας έτσι το μέγεθος 
σε αναλογία με αυτές (Εικόνα 14.10).

Εικόνα 14.10: 
Από την αντίστοιχη θυρίδα της
καρτέλας της παραγράφου, μπο-
ρούμε να ορίσουμε αρχίγραμμα, 
καθώς και πόσες γραμμές θα 
είναι το μέγεθός του.

Συλλαβισμός: Ο σωστός συλλαβισμός θεωρείται ένα από τα σημαντικότερα θέματα 
στην τυπογραφία, ειδικότερα όταν υπάρχουν μικρές γραμμές κειμένου, όπως στις πο-
λύστηλες σελίδες. Υπάρχουν πολλοί τρόποι που καθορίζουν την ακρίβειά του (Εικόνα 
14.11). Το σημαντικότερο είναι να μην υπάρχουν πάρα πολλά ενωτικά που ζαλίζουν 
τον αναγνώστη, αλλά και λευκά διάκενα εγκαρσίως των αράδων του κειμένου που 
δημιουργούν άσχημη εντύπωση. Για το συλλαβισμό υπάρχουν οι παρακάτω επιλογές:

•	� ��Μικρότερη λέξη (Words Longer Than): Καθορίζει πόσο μεγάλη πρέπει να 
είναι μία λέξη για να τη συλλαβίσει το πρόγραμμά μας.

•	� ��Ελάχιστο πριν (After First): Καθορίζει πόσοι χαρακτήρες πρέπει να προη-
γούνται του ενωτικού σε μια συλλαβισμένη λέξη.

•	� ��Ελάχιστο μετά (Before Last): Η επιλογή αυτή καθορίζει το πλήθος των χα-
ρακτήρων που πρέπει να ακολουθούν μετά το ενωτικό σε μια συλλαβισμένη 
λέξη. Η προεπιλεγμένη τιμή των δύο χαρακτήρων είναι κοινή για τις εφημε-
ρίδες και συναντάται συχνά σε λέξεις με συγκεκριμένες καταλήξεις.
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Εικόνα 14.11: Η καρτέλα του συλλαβισμού των λέξεων, QuarkXpress (Edit > H&Js...(Edit)). Ο 
συλλαβισμός αποκτά ιδιαίτερη σημασία στην πλήρη στοίχιση, έτσι οι ρυθμίσεις του συλλαβισμού 
συνδυάζονται με τις παραμέτρους της στοίχισης.

Η εντολή “Break Capitalized Words”, καθορίζει αν το πρόγραμμα θα συλλαβίζει τις 
λέξεις με κεφαλαίους χαρακτήρες. Με κεφαλαίους χαρακτήρες γράφονται συνήθως 
οι τίτλοι και τα κύρια ονόματα. Ο συλλαβισμός ενός τίτλου ή ο λάθος συλλαβισμός 
ενός ονόματος (που συνήθως δεν περιέχεται στα λεξικά που χρησιμοποιούνται) 
έχει οπωσδήποτε άσχημο αισθητικά αποτέλεσμα.

14.4 Εισαγωγή στηλών

Αφού έχουμε ορίσει τα λευκά περιθώρια της σελίδας, ο χώρος που διατίθεται, το 
λεγόμενο «ψαχνό», είναι αυτός που θα δεχθεί το κείμενο και τις φωτογραφίες. Τον 
χωρίζουμε σε ίσες αποστάσεις με κάθετες γραμμές αφήνοντας ένα κενό διάστημα 
που συνήθως είναι 1 τετράγωνο (περίπου 0,5 cm). Έτσι δημιουργούμε τις στήλες 
ενώ το ενδιάμεσο κενό καλείται διάστηλο. Το πλάτος κάθε στήλης είναι το μήκος 
της γραμμής του κειμένου που θα μπει στην στήλη. Ο αριθμός των στηλών ποικίλλει 
ανάλογα με το έντυπο και το «στήσιμο» που έχει επιλέξει ο σχεδιαστής. Συνήθως οι 
εφημερίδες επιλέγουν εξάστηλο σχήμα ενώ τα περιοδικά τρίστηλο ή δίστηλο.
Ακόμη και αν έχουμε επιλέξει ένα συγκεκριμένο αριθμό στηλών, μπορούμε στην 
συνέχεια να μην χρησιμοποιήσουμε όλες τις στήλες ή να ενοποιήσουμε δύο ή τρεις, 
προκειμένου να δημιουργήσουμε την οπτική εντύπωση που θέλουμε. Δηλαδή, ένα 
εξάστηλο μπορεί να μετατραπεί σε τρία δίστηλα και να χρησιμοποιήσουμε τα δύο εξ 
αυτών για το κείμενο και το άλλο να μείνει κενό ή να βάλουμε φωτογραφίες.
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Στις εικόνες 14.12 και 14.13 βλέπουμε σελίδες με διαφορετικό αριθμό στηλών. Η 
εντύπωση που δίνει κάθε μία από αυτές είναι διαφορετική.

Εικόνα 14.12: Αριστερά, η σελίδα περιέχει μία στήλη ενώ το κενό χρησιμοποιείται για προεξοχή 
των τίτλων και για να «αναπνέει» η σελίδα. Το κείμενο έχει αριστερή στοίχιση.
Δεξιά, μπήκε δίστηλο και φωτογραφία στο κάτω μέρος της πρώτης στήλης. Στο δίστηλο χωρά 
περισσότερο κείμενο και έχει πλήρη στοίχιση. Παρατηρήστε το κείμενο σε προεξοχή πάνω από 
την φωτογραφία, καλείται βινιέτα και χρησιμεύει ως εισαγωγή του άρθρου, αλλά τραβά και την 
προσοχή του αναγνώστη.

Εικόνα 14.13: Αριστερά έχουμε τρίστηλο, όμως οι δύο στήλες χρησιμοποιούνται για ένα άρθρο, 
ενώ η τρίτη έχει άλλο θέμα. Στο διάστηλο υπάρχει διαχωριστική γραμμή. Η στοίχιση του κειμένου 
είναι πλήρης.
Δεξιά έχουμε τετράστηλο κείμενο με αριστερή στοίχιση. Εδώ η σελίδα χωρίζεται και οριζοντίως, 
για να συμπεριλάβει τα δύο άρθρα. Το πρωτόγραμμα δείχνει την αρχή κάθε άρθρου.
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Ας εξετάσουμε τώρα πώς εφαρμόζονται όλα αυτά στα προγράμματα σελιδοποίησης.

Η εισαγωγή των στηλών γίνεται είτε από τον αρχικό κατάλογο δημιουργίας νέου 

εγγράφου (File>New... >document), όπου όλες οι σελίδες θα έχουν τον ίδιο αριθμό 

στηλών, ή κατόπιν από τον κατάλογο επιλογών εντολών Στήσιμο (Layout) στις επι-

θυμητές σελίδες (Εικόνα 14.14).

Όταν γίνει αυτό, εμφανίζονται στην οθόνη κάποιοι μη εκτυπώσιμοι οδηγοί, οι οποί-

οι οριοθετούν τις στήλες. Οι οδηγοί στηλών χρησιμεύουν ως όρια για το κείμενο που 

τοποθετείται μεταξύ τους.

Εικόνα 14.14: Υπάρχουν πολλοί τρόποι εισαγωγής διαφορετικού αριθμού στηλών, ακόμη και σε 
κάθε σελίδα χωριστά. Αριστερά στο πρόγραμμα Pagemaker. Δεξιά στο QuarkXpress (Item>Modify... 
(Text)) γράφοντας στην αντίστοιχη θυρίδα τον αριθμό στηλών.

Κάθε σελίδα έχει τουλάχιστον μία στήλη, η οποία είναι η περιοχή μεταξύ των περι-

θωρίων. Όταν ορίζονται πολλαπλές στήλες (με την εντολή Στήσιμο > Οδηγοί Στηλών 

ή κατά τη δημιουργία ή επεξεργασία μιας πρότυπης σελίδας), το πρόγραμμα αυτο-

μάτως διαιρεί το χώρο μεταξύ των περιθωρίων σε στήλες ίσου μεγέθους. Για να δη-

μιουργηθούν στήλες άνισου μεγέθους, χρησιμοποιούμε το εργαλείο δείκτη για να 

σύρουμε τους οδηγούς στηλών στη θέση που θέλουμε. Όταν δεν υπάρχουν στήλες, 

το πρόγραμμα αντιμετωπίζει τη σελίδα σα μονόστηλο. Έτσι δεν υπάρχει διαφορά 

στους τρόπους δακτυλογράφησης ή εισαγωγής κειμένου ανάμεσα σε μονόστηλο και 

πολύστηλο κείμενο. Με την τοποθέτηση του εργαλείου κειμένου εκεί όπου πρέπει 

να βρίσκεται η κορυφή του πρώτου μπλοκ κειμένου και έπειτα, επιλέγοντας με το 

ποντίκι, αρχίζει να ρέει το κείμενο. Το κείμενο γεμίζει τις στήλες έως το κάτω περι-

θώριο και έπειτα μετακινείται στην κορυφή της επόμενης στήλης, (ή την επόμενη 

σελίδα). Το πρόγραμμα συνεχίζει να εισάγει κείμενο, προσθέτοντας σελίδες όπως 

είναι απαραίτητο, ωσότου τοποθετηθεί ολόκληρο το θέμα.
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14.5 Η αποθήκευση και εκτύπωση ενός έντυπου

Η αποθήκευση μιας εργασίας γίνεται με όμοιο τρόπο όπως σε όλες τις εφαρμογές 
των Windows. Θεωρητικά, αρκεί να της αποδοθεί κάποιο όνομα. Στην πράξη όμως, 
η αποθήκευση ενός μεγάλου έντυπου που έχει διάφορα κείμενα, εικόνες και σχέδια 
δεν είναι τόσο απλή υπόθεση. Ο λόγος είναι ένας και απλός: από τη στιγμή που για 
το στήσιμο ενός έντυπου απαιτείται ένας μεγάλος αριθμός εγγράφων, πρέπει να 
ακολουθείται μια συγκεκριμένη μεθοδολογία. Κάθε έντυπο πρέπει να αποθηκεύε-
ται στο δικό του φάκελο. Αυτός πρέπει να περιέχει δύο τουλάχιστον φακέλους, με 
ονόματα «κείμενα» και «εικόνες» μέσα στους οποίους θα αποθηκεύονται όλα τα 
κείμενα και οι εικόνες, που θα χρησιμοποιηθούν για το στήσιμο.
Πέρα από την καλή οργάνωση που προσφέρει αυτή η δομή των φακέλων ο βασικός 
λόγος είναι ότι οι εικόνες που τυχόν ευρίσκονται στην σελίδα δεν ενσωματώνονται 
σε αυτή, αλλά «συνδέονται» με το έγγραφο έτσι ώστε το πρόγραμμα να «θυμάται» 
την ακριβή θέση των εικόνων όταν εμφανίζει ή τυπώνει τη σελίδα. Αν σπάσει αυτός 
ο σύνδεσμος, π.χ. με την μεταφορά του εγγράφου σε άλλη θέση στον σκληρό μας 
δίσκο, το έγγραφο όταν θα ανοίξει θα έχει χάσει τις εικόνες του.
Με τον τρόπο αυτό είναι όλα αποθηκευμένα στον ίδιο φάκελο και έχουν κατηγο-
ριοποιηθεί στους αντίστοιχους φακέλους. Σε μια έκδοση μπορεί να υπάρχουν 200 
– 300 εικόνες, αριθμός εξαιρετικά μεγάλος για να είναι αποθηκευμένες σε διάφο-
ρους φακέλους του σκληρού δίσκου.

Εικόνα 14.15: Ένα έντυπο πρέπει να αποθηκεύεται σωστά οργανωμένο σε φακέλους με όλα τα 
έγγραφα που συμμετέχουν σ’ αυτό.

Στην Εικόνα 14.15, φαίνεται η οργάνωση αυτή. Η αποθήκευση γίνεται στο φάκελο 
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περιοδικό, που έχει τους φακέλους εικόνες και κείμενα όπου φυλάσσονται τα αντί-
στοιχα αρχεία. Η όλη εργασία αποθηκεύεται σε στάδια. Όταν ολοκληρωθεί κάποιο 
από αυτά, με την εντολή Save As.. το έντυπο αποθηκεύεται με νέο όνομα. Έτσι 
υπάρχουν όλα τα στάδια της σελιδοποίησης ώστε, αν κάτι πάει στραβά, να υπάρχει 
το προηγούμενο στάδιο. Τα ονόματα αυτά διαφέρουν συνήθως με κάποιον αριθμό, 
στην προηγούμενη εικόνα τα αρχεία τεύχος 1 και τεύχος 2 είναι εκδόσεις του ίδιου 
αρχείου, μόνο που το δεύτερο είναι μεταγενέστερο. Στο πρώτο θα μπορούσαν να 
υπάρχουν μόνο τα κείμενα ενώ στο δεύτερο να έχουν εντεθεί και οι φωτογραφίες. 
Έτσι, με την μεθοδολογία αυτή διασφαλίζεται η ακεραιότητα όλης της έκδοσης.

Οι εκτυπώσεις θα εξεταστούν στην απλή τους μορφή, σε έναν κοινό laser ή inkjet 
εκτυπωτή. Το μενού της εκτύπωσης αποτελείται από διάφορες καρτέλες, οι κυριό-
τερες επιλογές των οποίων είναι στην Εικόνα 14.16 και στην επόμενη 14.17.

Εικόνα 14.16:
Παράμετροι όπως
προσανατολισμός, 
αριθμός αντίτυπων,
ποιότητα εκτύπωσης
ρυθμίζονται από την
καρτέλα Εκτύπωση

•	� Στη θυρίδα Αντίγραφα (Copies) ορίζεται ο αριθμός των αντιτύπων του εγγράφου.

•	� Η επιλογή Όλες (All) εκτυπώνει το σύνολο των σελίδων του τρέχοντος εγγράφου. 
Σε περίπτωση που έχει ενεργοποιηθεί η επιλογή «Εκτύπωση Συνόλου», η επιλο-
γή Όλες θα εκτυπώσει το σύνολο των σελίδων όλων των εγγράφων που περιλαμ-
βάνει το Σύνολο πέρα από το τρέχον έγγραφο.

•	� Η επιλογή Εκτύπωση Λευκών (Empty Pages) αναγκάζει το πρόγραμμα να συ-
μπεριλάβει τις τυχόν κενές σελίδες του τρέχοντος εγγράφου στη σωστή τους 
σειρά και θέση.

•	� Η επιλογή Μέγεθος (Size) αναφέρεται στο συγκεκριμένο μέγεθος του χαρτιού. 
Οι διαθέσιμες τιμές προέρχονται από το PPD που έχει επιλεγεί.     
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•	�� Η επιλογή Σημεία κοπής (Crop Marks) προσθέτει στην εκτύπωση τα σημεία κοπής 
της σελίδας, τους σταυρούς σύμπτωσης των διαχωρισμών, το density control bar και 
ένα color control bar για τους διαχωρισμούς και τα δοκίμια. Τα στοιχεία αυτά είναι 
χρήσιμα για τον τυπογράφο ο οποίος θα μπορεί να εκτιμήσει την ακρίβεια αναπα-
ραγωγής του χρώματος και φυσικά το μοντάζ των διαχωρισμών. Η επιλογή αυτή 
απαιτεί χώρο 22.2 χιλιοστών (0.75 ίντσες), επιπλέον του μεγέθους του εγγράφου.

•	�� Η επιλογή Στοιχεία Σελίδας (Page Information) προσθέτει στην εκτύπωση το όνομα 
του εγγράφου, τον αριθμό της σελίδας, την ημερομηνία και το όνομα του φύλλου των 
διαχωρισμών κατά μήκος της (πραγματικής) οριζόντιας κάτω πλευράς της σελίδας.

Εικόνα 14.17:
Οι ρυθμίσεις της καρτέλας αυτής, 
ελέγχουν το μοντάζ, τα σημεία 
ξακρίσματος και την εκτύπωση 
χρωμάτων (συναρμογή).

Από την καρτέλα Επιλογές εκτύπωσης ορίζεται η δημιουργία ενός Postscript αρχεί-
ου, που θα σταλεί για εκτύπωση (Εικόνα 14.18). Εκεί μπορεί να καθοριστεί αν το 
αρχείο αυτό (ονομάζεται κλειστό), θα περιέχει τους διαχωρισμούς, τις εικόνες και 
γενικότερα τα στοιχεία που απαρτίζουν την έκδοση. Η αποστολή σε κλειστή μορφή 
έχει το πλεονέκτημα ότι η εκτύπωση μπορεί να γίνει ανεξάρτητα από το λογισμικό 
και τις γραμματοσειρές που υπάρχουν εκεί. Όμως, αυτά είναι ήδη αρκετά για τις 
εκτυπώσεις που μπορούν να γίνουν στο εργαστήριο. Οι εκτυπωτικές εργασίες θα 
μας απασχολήσουν περισσότερο στην επόμενη τάξη.
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Εικόνα.14.18: Από τις ρυθμίσεις Postscript γίνονται οι τελικοί διαχωρισμοί σε αρχείο. 

Ανακεφαλαίωση 14ου Κεφαλαίου

Η εισαγωγή κειμένου σε ένα πρόγραμμα σελιδοποίησης μπορεί να γίνει με πολ-
λούς τρόπους, ο συνηθέστερος όμως είναι με την εισαγωγή του αρχείου που πε-
ριέχει τα κείμενα γραμμένα ενδεχομένως σε επεξεργαστή κειμένου. Όταν γίνει 
αυτό, το πρόγραμμα περιμένει να του υποδείξει ο χρήστης πού θα το τοποθετήσει.
Κατόπιν, ξεκινάει η ροή του κειμένου στο πλαίσιό του, η οποία συνήθως είναι σε 
τρεις καταστάσεις: αυτόματη, ημιαυτόματη και χειροκίνητη. Ο τρόπος που θα επι-
λεχθεί έχει άμεση σχέση με το στήσιμο του έντυπου και τον τρόπο εργασίας. Αφού 
ολοκληρωθεί αυτή η εργασία, ακολουθεί η μορφοποίηση του κειμένου, η βελτίω-
ση δηλαδή της εμφάνισής του, έτσι ώστε να είναι ελκυστικό για τον αναγνώστη.
Η μορφοποίηση συνίσταται στην εύρεση της κατάλληλης γραμματοσειράς, στην 
απόδοση έμφασης σε ορισμένες λέξεις, στην εύρεση του κατάλληλου διαστή-
ματος ανάμεσα στα γράμματα, στην πύκνωση των ζευγών χαρακτήρων στους 
τίτλους, ακόμη και στην κλιμάκωση των ίδιων των χαρακτήρων.
Ακολουθεί η μορφοποίηση των παραγράφων, δηλαδή ο καθορισμός της απόστα-
σης των γραμμών, των παραγράφων, η στοίχισή τους, η δημιουργία περιθωρίων 
καθώς και η ειδική διαμόρφωση της πρώτης γραμμής. Το κείμενο στοιχειοθετεί-
ται σε στήλες. Το πόσες στήλες θα έχει κάθε σελίδα εξαρτάται από το μέγεθός 
της, το είδος του έντυπου, αλλά και από το ίδιο το κείμενο και τις εικόνες που 
το συνοδεύουν. Όλα αυτά όμως έχουν ήδη αποφασισθεί κατά το στάδιο της κα-
τασκευής του προσχεδίου των σελίδων.
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Ασκήσεις 14ου Κεφαλαίου

1.	 Με πόσους τρόπους εισάγεται κείμενο σε ένα έγγραφο;
2.	� Με ποιον τρόπο εισάγεται αρχίγραμμα σε μια παράγραφο στο πρόγραμμα που 

χρησιμοποιείς; Πώς ενεργοποιείται ο συλλαβισμός λέξεων.
3.	� Πώς μπορείτε να μεταβάλλετε την ειδική πύκνωση χαρακτήρων;

Ποια ζεύγη γραμμάτων του ελληνικού αλφάβητου απαιτούν ειδική μελέτη;
4.	�Στις κεφαλίδες και τα υποσέλιδα μπαίνουν πληροφορίες που πρέπει να εμφανί-

ζονται σε όλο το έγγραφο. Ποιες πρέπει να είναι αυτές;
5.	� Πότε χρησιμοποιούμε αυτόματο διάστιχο και πότε σταθερό; Τι θα γίνει σε μια 

γραμμή παραγράφου, όταν περιέχονται γράμματα διαφορετικού μεγέθους;
6.	�Σκεφτείτε να δημιουργήσετε τη σχολική σας εφημερίδα και αποφασίστε για το 

layout των σελίδων της. (Τίτλοι, γραμματοσειρές, παράγραφοι, αριθμοί στηλών).

Δραστηριότητες 14ου Κεφαλαίου

1.	� Στόχος μας είναι να δημιουργήσουμε ένα δειγματολόγιο γραμματοσειρών προ-
κειμένου να διαθέτουμε τυπωμένες όλες τις γραμματοσειρές του υπολογιστή και 
να διευκολύνεται η επιλογή για τα έντυπα που σχεδιάζουμε.
Πληκτρολογήστε ένα μικρό κείμενο και επαναλάβετέ το όσες φορές χρειάζεται 
χρησιμοποιώντας τις εντολές Αντιγραφή (Copy) και Επικόλληση (Paste), σε δια-
φορετικά μεγέθη και όλες τις γραμματοσειρές του συστήματός σας. Σελιδοποιήστε 
κατάλληλα τα κείμενα ώστε σε κάθε σελίδα να περιέχεται το κείμενο σε μία οικο-
γένεια, αλλά σε ποικιλία μεγεθών γραμμάτων, μήκους αράδων, διάστιχων. Αν μία 
σελίδα δεν είναι αρκετή, δημιουργήστε ένα «σαλόνι» για όλα τα παραπάνω.

2.	� Παρατηρήστε προσεκτικά τις σελίδες στις εικόνες 14.8 και 14.9 αυτού του κε-
φαλαίου. Σχεδιάστε στην συνέχεια, κατά προτίμηση σε «μιλλιμετρέ» χαρτί, το 
κασέ όλων των σελίδων. Προσπαθήστε τώρα να υλοποιείσετε και να στήσετε αυ-
τές τις σελίδες στο πρόγραμμα σελιδοποίησης της επιλογής σας. Για τα κείμενα 
χρησιμοποιήστε «τυφλό» κείμενο, με γραμματοσειρές που κατά την γνώμη σας 
ταιριάζουν περισσότερο.
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Σχετικές ηλεκτρονικές διευθύνσεις

Η επίσημη ιστοσελίδα του ομώνυμου προγράμματος με πολλές πληροφορίες.
www.quark.com
Πληροφορίες για ελληνικές γραμματοσειρές
www.magenta.gr

Για επεκτάσεις των προγραμμάτων σελιδοποίησης και ενδιαφέρουσες πληροφορίες 
www.nickhodge.com
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Κεφάλαιο 15ο
Διαχείριση εικόνων I

Στόχοι:

Μετά τη μελέτη αυτού του κεφαλαίου οι μαθητές θα είναι σε θέση να:

	 •	� Αναγνωρίζουν τους τύπους αρχείων που χρησιμοποιούνται στην ηλε-
κτρονική τυπογραφία

	 •	 �Τοποθετούν τις εικόνες με τα αντίστοιχα πλαίσιά τους στην κατάλληλη 
θέση

	 •	� Διαχειρίζονται πλήθος εικόνων σε βιβλία ή απλά έγγραφα

15.1 Εισαγωγή

Όπως το βασικό εργαλείο για την εισαγωγή κειμένου είναι το πλαίσιο κειμένου, 
έτσι και για τις εικόνες έχουμε το αντίστοιχο πλαίσιο εικόνας.
Η εικόνα μετατρέπεται σε ηλεκτρονική μορφή με το σαρωτή, αν φυσικά δεν την 
έχουμε σχεδιάσει στον υπολογιστή ή δεν είναι ήδη ψηφιοποιημένη. Αποθηκεύεται 
δε στη συνέχεια σε μία μορφή που αναγνωρίζουν τα προγράμματα σελιδοποίησης. 
Με την εμφάνιση της σελίδας στην οθόνη η ηλεκτρονική μορφή της εικόνας μετα-
τρέπεται σε οπτική πληροφορία για την οθόνη. Οι ίδιες πληροφορίες που περιέχο-
νται στην ηλεκτρονική μορφή μετασχηματίζονται στον εκτυπωτή ή εικονοθέτη για 
την απεικόνιση της εικόνας στο χαρτί.

15.2 Μορφές αρχείων εικόνων

Τρεις είναι οι τύποι των εικόνων που έχουμε σε ένα έντυπο και αυτούς δέχονται και 
τα προγράμματα σελιδοποίησης, ανεξαρτήτως της μορφής του αρχείου:

A Β Γ
Εικόνα 15.1: (Α) Γραμμική εικόνα. (Β) Τονική εικόνα. (Γ) Έγχρωμη τονική εικόνα
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•��	� Οι γραμμικές εικόνες (ασπρόμαυρες), δηλαδή οι εικόνες που έχουν μόνο 
άσπρο-μαύρο χωρίς ενδιάμεσους τόνους είναι ο πρώτος τύπος. Παρά-
δειγμα γραμμικής εικόνας είναι ένα λογότυπο ή ένα σκίτσο με πένα. 
(Εικόνα 15.1Α).

•��	� Ο δεύτερος τύπος είναι οι ασπρόμαυρες τονικές εικόνες (grayscale). Αυ-
τές οι εικόνες έχουν όλους τους ενδιάμεσους γκρίζους τόνους επιπλέον 
του άσπρου-μαύρου. Χαρακτηριστικό παράδειγμα αποτελούν οι μονό-
χρωμες φωτογραφίες. (Εικόνα 15.1Β).

•	 ���Οι έγχρωμες τονικές εικόνες έχουν επιπλέον των τονικών διαβαθμίσεων 
και πλήρες χρωματικό εύρος και αποτελούν τον τρίτο τύπο εικόνων. (Ει-
κόνα 15.1Γ).

Η εισαγωγή τους στα προγράμματα σελιδοποίησης απαιτεί τη μετατροπή των εικό-
νων σε κατάλληλη μορφή αρχείων, συμβατή με την τυπογραφική αναπαραγωγή. 
Παρά το γεγονός ότι τα προγράμματα σελιδοποίησης δέχονται πολλές μορφές, οι 
πλέον κατάλληλες γι’ αυτό το σκοπό είναι η TIFF και η EPS.

15.3 Η τοποθέτηση των εικόνων στη σελίδα

Πριν κατασκευασθεί η σελίδα στον υπολογιστή, είναι αναγκαίο να υπάρχει ένα προ-
σχέδιο που θα δίνει τη δυνατότητα στο γραφίστα να εκτιμήσει την αισθητική αρτιότητα 
της σελίδας, αλλά και συγχρόνως να πληροφορεί και για τις διαστάσεις και αναλογίες 
της. Με αφετηρία αυτό το προσχέδιο δημιουργούμε τα πλαίσια κειμένου και εικόνας.
Έχουμε τη δυνατότητα επιλογής ή και κατασκευής, του κατάλληλου πλαισίου εικό-
νας, ανάλογα με το σχήμα της φωτογραφίας (Εικόνα 15.2).

\

Ορθογώνιο πλαίσιο

Κυκλικό πλαίσιο Πολυγωνικό πλαίσιο

Εικόνα 15.2: Τα προγράμματα
σελιδοποίησης προσφέρουν τη
δυνατότητα επιλογής του
κατάλληλου πλαισίου εικόνας,
ανάλογα με το σχήμα της
φωτογραφίας.
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Εισαγωγή εικόνας: Με επιλεγμένο το πλαίσιο εικόνας και με το εργαλείο περιεχομέ-
νου («χεράκι»), στο μενού Αρχείο με την εντολή Επιλογή εικόνας... (Get Picture...) 
διαλέγουμε στο πλαίσιο διαλόγου την εικόνα που αντιστοιχεί στη συγκεκριμένη 
θέση. Η εικόνα που εμφανίζεται είναι χαμηλής ανάλυσης (περίπου 36 ppi) και χρη-
σιμεύει μόνο για την απεικόνιση της σελίδας στην οθόνη. Όπως αναφέραμε και στο 
προηγούμενο κεφάλαιο, η πρωτότυπη εικόνα υψηλής ανάλυσης δεν ενσωματώνεται 
στη σελίδα αλλά αποκτά ένα «σύνδεσμο» με την αντίστοιχη της χαμηλής ανάλυσης. 
Η διαδικασία της εκτύπωσης της τελικής σελίδας στον εικονοθέτη ή τον εκτυπωτή 
απαιτεί, μέσω του «συνδέσμου», την πρωτότυπη εικόνα.
Αν για οποιοδήποτε λόγο μετά την αρχική τους τοποθέτηση κάποια εικόνα έχει με-
τακινηθεί (π.χ. σε ένα άλλο φάκελο), ή μίας άλλης εικόνας έχουμε μεταβάλει το 
χρώμα, τότε κατά τη διαδικασία της εκτύπωσης ή της επανέναρξης του προγράμμα-
τος εμφανίζεται πλαίσιο διαλόγου για την επιβεβαίωση των αλλαγών των εικόνων 
και της νέας τους θέσης και, συνεπώς, επανασύνδεσής τους στη σελίδα.

15.4 Η προσαρμογή των εικόνων

Μέγεθος: Μόλις μία φωτογραφία εισαχθεί στη σελίδα, καταλαμβάνει τη θέση της 
μέσα στο πλαίσιο εικόνας που ήταν επιλεγμένο τη στιγμή της εισαγωγής της. Συ-
νήθως, η εικόνα θα πρέπει να προσαρμοσθεί στις διαστάσεις του προσχεδίου της 
σελίδας. Αυτό γίνεται εύκολα. Ένας τρόπος είναι να επιλεγεί στο μενού
Αντικείμενο > Αλλαγή... (Item>Modify...>Picture Box Specifications...)
όπου στο πλαίσιο διαλόγου που εμφανίζεται και στο πεδίο οριζόντια και κατακόρυ-
φη κλίμακα να εισαχθεί ένα ποσοστό από 10% έως 100%. Π.χ. η τιμή 50% και στα 
δύο πεδία μετασχηματίζει την εικόνα στο μισό της μέγεθος. Αν οι τιμές δεν είναι 
ίδιες και στα δύο πεδία, η εικόνα θα παραμορφωθεί (Εικόνα 15.3).

Το ίδιο επιτυγχάνεται, αν στην παλέτα μετρήσεων του QuarkXpress, στις θυρίδες Χ% 
και Υ% εισάγουμε το ίδιο ποσοστό σμίκρυνσης. Παρά το γεγονός ότι αυτές οι ρυθμί-
σεις γίνονται εύκολα, καλό θα ήταν όλες οι μεγάλες μεταβολές των διαστάσεων να γί-
νονται στο πρόγραμμα επεξεργασίας εικόνας και όχι στο πρόγραμμα σελιδοποίησης.

Θέση: Με το πρώτο εργαλείο της εργαλειοθήκης, όπου εκτός από εργαλείο επιλογής εί-
ναι και εργαλείο μετακίνησης, μπορούμε να επανατοποθετήσουμε τη φωτογραφία μας 
όπου θέλουμε στη σελίδα. Όμως για μεγαλύτερη ακρίβεια και πάλι στο μενού Αντικείμε-
νο > Αλλαγή... στα πεδία τετμημένη (οριζόντιος άξονας) και τεταγμένη (κατακόρυφος 
άξονας), πληκτρολογούμε τις συντεταγμένες της επάνω αριστερής γωνίας του πλαισίου 
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εικόνας. Ακόμη ευκολότερα, με επιλεγμένο το πλαίσιο εικόνας και χρησιμοποιώντας τα 
«βελάκια» κατεύθυνσης του πληκτρολογίου μετακινούμε την εικόνα με βήμα 1pt κατά 
τη διεύθυνση του βέλους. Πατώντας και το πλήκτρο Alt, επιτυγχάνουμε βήμα 0,1pt.

Εφαρμογή
παραμέτρων

επιλογή
συντεταγμένων

Συντεταγμένες της 
εικόνας ως προς το 
επιλεγμένο σημείο

Διαστάσεις Κλίμακα
οριζοντίως 

και καθέτως

Περιστροφή	
Στρέβλωση

Εικόνα 15.3: Εδώ συγκεντρώνονται όλες οι εντολές προσαρμογής μιας εικόνας. Επάνω στο πρό-
γραμμα QuarkXpress και κάτω στο Pagemaker.

Στο πρόγραμμα Pagemaker ορίζουμε τις συντεταγμένες του επιλεγμένου σημείου 
του πλαισίου. Όπως φαίνεται και στην Εικόνα 15.3, το σημείο αυτό αλλάζει με το 
ποντίκι στον αντίστοιχο κόμβο του εικονιδίου επιλογή συντεταγμένων.

Περιστροφή: Έχουμε τη δυνατότητα να περιστρέφουμε την εικόνα, αφήνοντας το 
πλαίσιό της αμετάβλητο. Στο μενού Αντικείμενο>Αλλαγή...εισάγουμε την επιθυμη-
τή γωνία στο πεδίο Γωνία εικόνας. Το ίδιο αποτέλεσμα επιτυγχάνουμε αν εισαγά-
γουμε τη γωνία περιστροφής στον πίνακα μετρήσεων στην αντίστοιχη θέση προσέ-
χοντας να έχουμε ενεργό το εργαλείο περιεχομένου στην εργαλειοθήκη.
Η περιστροφή του πλαισίου εικόνας γίνεται από την ένδειξη Γωνία πλαισίου και φυ-
σικά από την αντίστοιχη ένδειξη της παλέτας μετρήσεων σε όλα τα προγράμματα.

Παραμόρφωση: Με τις εντολές στρέβλωσης στο ίδιο μενού Αντικείμενο>Αλλαγή...
μπορούμε να παραμορφώσουμε μία εικόνα ή το πλαίσιό της. Οι ίδιες ρυθμίσεις γί-
νονται, όπως ασφαλώς συμπεραίνεται εύκολα, και στην παλέτα μετρήσεων σε όλα 
τα προγράμματα.
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Ανακεφαλαίωση 15ου Κεφαλαίου

Οι εικόνες που εμφανίζονται σε ένα έντυπο, θα ανήκουν σε μία από τις εξής 
μορφές: γραμμική, Α/Μ τονική ή έγχρωμη τονική.
Για την τοποθέτηση μιας εικόνας στην ηλεκτρονική σελιδοποίηση πρέπει να 
έχουμε ένα τελικό προσχέδιο της σελίδας ώστε να ξέρουμε την ακριβή θέση 
όλων των στοιχείων (εικόνων και κειμένων) της σελίδας. Το πλαίσιο εικόνας 
είναι αυτό που μας δίνει τη δυνατότητα με τις ρυθμίσεις που διαθέτει, να εντά-
ξουμε τις εικόνες στη σωστή θέση με το σωστό σχήμα.
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Ασκήσεις 15ου Κεφαλαίου

1.	 Πόσα είδη πλαισίων εικόνας έχουμε; Ποια είναι τα χαρακτηριστικά τους;
2.	� Αναφέρατε τρεις τρόπους με τους οποίους μπορούμε να διαμορφώσουμε μία ει-

κόνα. Ποια ακολουθία εντολών χρησιμοποιούμε;

Δραστηριότητες 15ου Κεφαλαίου

1.	� Δημιουργήστε προσχέδια διπλών σελίδων-«σαλονιών» ενός βιβλίου, ενός περιο-
δικού και ενός διαφημιστικού. Προσπαθήστε στο πρόγραμμα σελιδοποίησης να 
υλοποιήσετε αυτά τα προσχέδια δημιουργώντας τα κατάλληλα πλαίσια στις θέ-
σεις που καθορίζονται από το προσχέδιό σας.

2.	� Επιλέξατε πέντε φωτογραφίες που να παρουσιάζουν αντικείμενα ή πρόσωπα. Ανά-
λογα με το θέμα τοποθετήστε στη σελίδα τη φωτογραφία, επιλέγοντας το πιο κα-
τάλληλο πλαίσιο και ρυθμίζοντας αναλόγως και τις διαστάσεις της φωτογραφίας.

3.	� Δημιουργήστε ευχετήρια κάρτα με διαστάσεις (ξακρισμένη) 20 επί 14 εκατοστά. 
Επιλέξτε κατάλληλη φωτογραφία (σε διαστάσεις, θέμα, μορφή εικόνας) προκει-
μένου να τυπωθεί με εκτύπωση offset.

Σχετικές ηλεκτρονικές διευθύνσεις

Μηχανή αναζήτησης που μπορεί να χρησιμοποιηθεί για την αναζήτηση φωτογρα-
φιών με συγκεκριμένο θέμα. Απαιτείται η χρήση κατάλληλων λέξεων – κλειδιών 
σχετικών με το θέμα.
www.google.com.gr

Διευθύνσεις για προγράμματα σελιδοποίησης και όχι μόνο. 
www.find.com.au/tutorials
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Κεφάλαιο 16ο
Διαχείριση εικόνων II

Στόχοι:

Μετά τη μελέτη αυτού του κεφαλαίου οι μαθητές θα είναι σε θέση να:

	 •	� Μεταβάλλουν το εύρος των τόνων των φωτογραφιών

	 •	 �Προσαρμόζουν με ακρίβεια τις εικόνες, στις διαστάσεις του κασέ

16.1 Εισαγωγή

Έχουμε ήδη γνωρίσει τα εργαλεία σχεδίασης πλαισίων. Τα πλαίσια αυτά εκτός των 
φωτογραφιών μπορούμε να τα χρησιμοποιήσουμε και για σχεδίαση διαφόρων σχη-
μάτων. Τα σχήματα μπορούν να χρωματισθούν στη συνέχεια και σε συνδυασμό με 
άλλες εικόνες ή κείμενα να ολοκληρώσουν τη σύνθεση της σελίδας. Επίσης, μπο-
ρούμε να προσαρμόσουμε τη μορφή των πλαισίων κατάλληλα. Έτσι, αν συγχρόνως 
με τη χάραξη ενός ορθογώνιου πλαισίου έχουμε πατημένο το πλήκτρο κεφαλαίων 
(Shift), προκύπτει ένα τετράγωνο. Με τον ίδιο τρόπο σχεδιάζουμε και κύκλο, αν 
έχουμε επιλέξει το εργαλείο του ελλειψοειδούς πλαισίου.

16.2 Η επεξεργασία της εικόνας

Τα προγράμματα σελιδοποίησης προσφέρουν μερικές δυνατότητες επεξεργασίας 
εικόνων. Οι διορθώσεις αυτές πρέπει να γίνονται σε πρόγραμμα επεξεργασίας εικό-
νας, είναι όμως αναγκαίο να αναφέρουμε αυτές τις εντολές και εδώ, ώστε να έχου-
με μία ολοκληρωμένη ιδέα για τις δυνατότητες των προγραμμάτων σελιδοποίησης.

Αναγκαία προϋπόθεση, η μορφή της εικόνας να είναι TIFF ή και JPEG. Στη συνέχεια 
στο μενού Στυλ> Αντίθεση... μπορούμε να ρυθμίσουμε την αντίθεση της φωτογραφί-
ας. Με τον όρο αντίθεση αναφερόμαστε στο πόσο ανοιχτόχρωμα ή σκούρα εμφανί-
ζονται τα φωτεινά και σκοτεινά σημεία αντίστοιχα μιας φωτογραφίας (Εικόνα 16.1).
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Εικόνα 16.1: Αναγκαία προϋπόθεση, η μορφή της εικόνας να είναι TIFF ή JPEG. Στη συνέχεια στο 
μενού Στυλ> Αντίθεση... μπορούμε να ρυθμίσουμε την αντίθεση της φωτογραφίας.

Με την εντολή Άλλη αντίθεση... εμφανίζεται ένα διάγραμμα που δίνει περισσότερες 
δυνατότητες ρύθμισης της αντίθεσης (Εικόνα 16.2).

Εικόνα 16.2: Το διάγραμμα ρύθμισης της αντίθεσης

Μπορούμε επίσης να αλλάξουμε το χρώμα μιας ασπρόμαυρης φωτογραφίας, αν 
στο μενού Αντικείμενο > Αλλαγή > Πλαίσιο... (Item > Modify> Box...) αλλάξουμε το 
χρώμα των λευκών σημείων της εικόνας και στο Αντικείμενο > Αλλαγή > Εικόνα.. 
(Item > Modify> Picture...) αλλάζουμε το χρώμα των μαύρων σημείων της εικόνας.
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16.3 Η τοποθέτηση των φωτογραφιών

Με την εμπειρία που αποκτάται μόνο με το χρόνο, οι γραφίστες αποκτούν και την αί-
σθηση της ισορροπίας που τους επιτρέπει να «στήνουν» μία σελίδα έτσι, ώστε η θέση 
των κειμένων, των γραφικών και των εικόνων να φαίνεται η ιδανική. Να δίνει την εντύ-
πωση ότι δεν θα μπορούσε να γίνει με διαφορετικό τρόπο. Αυτό όμως δεν είναι ο κανό-
νας. Τις περισσότερες φορές πρέπει να δοκιμάζουμε πολλές εναλλακτικές θέσεις, πριν 
αποφασίσουμε την οριστική θέση των στοιχείων μιας σελίδας. Η ταχύτητα θα έλθει 
σιγά-σιγά με την πείρα. Συνήθως, το πρόβλημα ξεκινά ως εξής: έχουμε μερικές φωτο-
γραφίες, όλες διαφορετικών διαστάσεων, σχημάτων ή γωνίας λήψεως, που θα πρέπει 
να τις εντάξουμε μαζί, ώστε να εμφανίζονται ως σύνολο και να ισορροπούν στη σελίδα.

Εικόνα 16.3:
(Α) Εισάγεται η
φωτογραφία σε ένα
πλαίσιο που έχει
σχεδιασθεί
προηγουμένως.
Το μέγεθος φαίνεται 
σωστό αλλά η θέση της 
φωτογραφίας εντός του 
πλαισίου είναι λάθος. 
(Β) Με το εργαλείο
περιεχομένου
μετακινούμε τη
φωτογραφία, ώστε να 
φαίνεται στη θέση της.
Το πλαίσιο όμως
παραμένει αμετάβλητο. 
(Γ) Εισάγεται η δεύτερη 
φωτογραφία και
προσαρμόζεται όπως
και η πρώτη.
(Δ) Η πρώτη
φωτογραφία
μεγεθύνεται ελάχιστα, η 
δεύτερη σμικρύνεται 
λίγο για λόγους
ομοιογένειας με
μεταβολή των μεγεθών 
Χ% και Υ% του πίνακα 
μετρήσεων.

A

Γ

Β

Δ
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Πριν εισαγάγουμε τις φωτογραφίες στη σελίδα, σχεδιάζουμε τα αντίστοιχα πλαίσια με 
τις λεζάντες τους (Εικόνα 16.3). Αν θέλουμε να δώσουμε την αίσθηση της ταξινόμησης, 
τοποθετούμε τα πλαίσια το ένα κάτω από το άλλο με διαστάσεις που διατηρούν την ανα-
λογία 3:4, συνηθισμένη για πορτραίτα. Χρησιμοποιούμε την εντολή Αντικείμενο>Βήμα 
και επανάληψη για να δημιουργήσουμε πλαίσια ίδιων διαστάσεων που ισαπέχουν.
Με την εισαγωγή των φωτογραφιών προσαρμόζουμε, ελάχιστα, τις διαστάσεις τους 
με την εντολή Αντικείμενο>Αλλαγή... (Οριζόντια και κατακόρυφη κλίμακα), ώστε 
όλες οι φωτογραφίες να εμφανίζουν ομοιογένεια.

16.4 Βήματα για συνδυασμό κειμένου και εικόνας

Σε περιοδικά ή διαφημιστικά έντυπα ο στόχος του γραφίστα-σχεδιαστή πέρα από 
την ανάδειξη του κειμένου, είναι και ο εντυπωσιασμός του αναγνώστη. Το σωστό 
«καδράρισμα» του θέματος της φωτογραφίας και η ροή του κειμένου γύρω από 
τη φωτογραφία προσθέτει ποικιλία και ένταση στη σελίδα, πράγμα επιθυμητό για 
αυτού του είδους τα έντυπα.

Στη συνέχεια, παρουσιάζονται τα βασικά βήματα σε μία τυπική εργασία σελιδοποί-
ησης κειμένου και φωτογραφιών:

•	� Επιλογή και ανάλυση φωτογραφίας: Όλα τα έντυπα που εκδίδονται, αγοράζουν τα δικαι-
ώματα χρήσης των φωτογραφιών ή άλλων εικόνων που δημοσιεύουν από τους δημιουρ-
γούς τους ή από ειδικά πρακτορεία που έχουν συσταθεί γι̕ αυτό το σκοπό. Ανάλογα με τη 
χρήση και το θέμα πωλούνται φωτογραφίες υψηλής ή χαμηλότερης ανάλυσης. Για τα έντυπα 
η αναγκαία ανάλυση για καλή (με ράστερ 150 Ιpi) ποιότητα εκτύπωσης offset είναι 300 ppi 

στο ζητούμενο μέγεθος. Βλέπε και κεφάλαιο 6.4.

•	� Μετατροπή CMYK: Όλες οι εικόνες πρέπει, πριν τοποθετηθούν στη σελίδα, να έχουν μετα-

τραπεί από RGB σε χρώματα τετραχρωμίας CMYK.

•	 �Εισαγωγή στο πρόγραμμα σελιδοποίησης: Εισάγουμε την εικόνα μας που θα πρέπει να 

είναι σε μορφή TIFF ή EPS.

•	 �Τοποθέτηση εικόνων: Με την εισαγωγή της εικόνας στο πλαίσιό της, η παλέτα μετρήσεων 
προσαρμόζεται με τις διαθέσιμες εντολές γι̕ αυτού του είδους την εργασία (Εικόνα 16.4). 
Από τις ενδείξεις των διαστάσεων βλέπουμε ότι οι διαστάσεις του πλαισίου εικόνας είναι 
μικρότερες αυτών της φωτογραφίας. Έτσι, ένα τμήμα της εικόνας δεν εμφανίζεται. Αν το 
αποτέλεσμα μας ικανοποιεί αισθητικά, μπορούμε να το αγνοήσουμε χωρίς πρόβλημα στην 
πορεία της σελιδοποίησης. Αν αλλάξουμε γνώμη, έχουμε την δυνατότητα να το αλλάξουμε 

όποτε θέλουμε.
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Η τοποθέτηση του κειμένου μαζί με τις εικόνες, γίνεται εξαιρετικά απλά. Το κεί-
μενο «κυλά» γύρω από την εικόνα. Οι ρυθμίσεις του μενού Ροή γύρω από θέμα... 
(Runaround) γίνονται εύκολα κατανοητές μόλις κάνουμε μερικές δοκιμές. Τελειώ-
νοντας, να διευκρινίσουμε ότι αν για οποιοδήποτε λόγο θέλουμε να αλλάξουμε αυ-
θαίρετα τη ροή του κειμένου πηγαίνουμε στο μενού Αντικείμενο >Πλευρική ροή 
(Item> Edit >Runaround) και αμέσως δημιουργείται ένα πλαίσιο γύρω από την 
εικόνα με κόμβους, που αλλάζει όπως θέλουμε.

Εικόνα 16.4: Διακρίνουμε τις μπλε γραμμές του κασέ. Αν κριθεί ότι το αρχικό μέγεθος του πλαι-
σίου εικόνας δεν είναι το κατάλληλο για το μέγεθος της φωτογραφίας, θα προσαρμοσθεί μετακι-
νώντας τους αντίστοιχους κόμβους. Εδώ ο τίτλος Μουσική αποφασίσαμε ότι πρέπει να μπει κάτω 
από την φωτογραφία.

Αξίζει να παρατηρήσουμε, ότι η πρακτική της σελιδοποίησης απαιτεί σε πολύστηλα 
έγγραφα το πλάτος των εικόνων να καταλαμβάνει ακέραιο αριθμό στηλών. Π.χ. 
Λέμε φωτογραφία μονόστηλη, δίστηλη κλπ. Πρέπει επομένως να πάρουμε την από-
φαση της επιλογής της τελικής διάστασης της φωτογραφίας στην σελίδα.

16.5 Σχέση εικόνας και κειμένου

Στα παραδείγματα που ακολουθούν θα δούμε μερικές τεχνικές σελιδοποίησης με 
«αρνητικά» γράμματα και ροή κειμένου προσαρμοσμένη στη φωτογραφία.
Έστω ότι αποφασίζουμε, αλλάζοντας γνώμη, η φωτογραφία της Εικόνας 16.4 να γίνει 
δίστηλη με τον τίτλο μέσα στη φωτογραφία αρνητικό (λευκά γράμματα) (Εικόνα 16.5Β).
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Ξεκινώντας, αλλάζουμε το πλαίσιο ώστε να ευθυγραμμισθεί αριστερά με τον οδηγό. 
Στην συνέχεια αλλάζουμε το χρώμα των γραμμάτων σε λευκό. Στην συνέχεια, μετα-
κινούμε τον τίτλο μέσα στην φωτογραφία σε περιοχή που αυτός είναι ευανάγνωστος, 
επιλέγοντας από το μενού Αντικείμενο (Item)> Πλευρική ροή (Run Around)... >Κα-
μιά (None).

A

Β

Εικόνα 16.5: (Α) Αλλάζουμε το πλαίσιο ώστε να ευθυγραμμισθεί αριστερά με τον οδηγό. Στην 
συνέχεια αλλάζουμε το χρώμα των γραμμάτων σε λευκό.
(Β) Μετακινούμε τον τίτλο μέσα στην φωτογραφία σε περιοχή που είναι ευανάγνωστος, επιλέγο-
ντας από το μενού Αντικείμενο (Item)> Πλευρική ροή (Run Around)... >Καμιά (None).
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Αλλάζοντας, και πάλι, γνώμη για την εμφάνιση της σελίδας, θέλουμε να δοκιμά-
σουμε τη ροή του κειμένου γύρω από τη σιλουέτα του προσώπου της φωτογραφίας 
(Εικόνα 16.6). Τώρα θα πρέπει να πάμε πίσω στο πρόγραμμα επεξεργασίας εικόνας 
και να «ξεγυρίσουμε» τη φωτογραφία. Αυτό σημαίνει ότι στο πρόγραμμα επεξερ-
γασίας εικόνας πρέπει να επιλέξουμε με τον προσφορότερο τρόπο το περίγραμμα 
της κοπέλας που εμφανίζεται στη φωτογραφία. Αποθηκεύουμε τη φωτογραφία με 
τη νέα μορφή της EPS και επιστρέφουμε στη σελιδοποίησή μας.
Έχοντας «ξεγυρίσει» τη φωτογραφία, την εισάγουμε στη θέση της στην σελίδα. 
Στο μενού Αντικείμενο (Item>Modify>Runaround) επιλέγουμε την εντολή Same as 
Clipping, ενώ η απόσταση του κειμένου από την εικόνα ρυθμίζεται από το Outset 
στο ίδιο πλαίσιο διαλόγου.

Εικόνα 16.6: Έχοντας «ξεγυρίσει» τη φωτογραφία την εισάγουμε στη θέση της. Στο μενού 
Item>Modify>Runaround επιλέγουμε την εντολή Same as Clipping, ενώ η απόσταση του κειμέ-
νου από την εικόνα ρυθμίζεται από το Outset στο ίδιο πλαίσιο διαλόγου.
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Ανακεφαλαίωση 16ου Κεφαλαίου

Όλα τα προγράμματα σελιδοποίησης επιτρέπουν στοιχειώδεις ρυθμίσεις των 
εικόνων όπως μεταβολή της αντίθεσης, της φωτεινότητας κλπ. Είναι όμως προ-
τιμότερο όλες οι ρυθμίσεις να γίνονται στα προγράμματα δημιουργίας των ει-
κόνων αυτών. Οι μόνες μεταβολές που είναι επιβεβλημένες κατά το στάδιο της 
ηλεκτρονικής σελιδοποίησης είναι αυτές των διαστάσεων, πάντα με μέτρο.
Το κασέ της σελίδας είναι ο σκελετός της σελίδας. Το προσχέδιο επιβάλλει τον 
τρόπο που θα «ρέει» το κείμενο στις στήλες και γύρω από τις εικόνες. Οι συνε-
χείς δοκιμές με μετακίνηση και αλλαγές των διαστάσεων των κειμένων και των 
φωτογραφιών, μας δίδει στο τέλος το αποτέλεσμα που μας ικανοποιεί.

Δραστηριότητες 16ου Κεφαλαίου

1.	� Επιλέξτε το κασέ τριών διαφορετικών εντύπων, πχ. Εφημερίδας, περιοδικού, δια-
φημιστικού φυλλαδίου. Αντιγράψτε το, στο πρόγραμμα σελιδοποίησης που δια-
θέτει το εργαστήριό σας.

2.	� Τοποθετήστε στα προηγούμενα κασέ πλαίσια εικόνας και κειμένου σύμφωνα με 
τα δείγματα που έχετε επιλέξει.

3.	� Με τη βοήθεια των καθηγητών σας, βρείτε φωτογραφίες για να τις βάλετε στα 
πλαίσια εικόνων και «τυφλό» κείμενο για τα αντίστοιχα πλαίσια κειμένου. Προ-
σοχή όμως, δεν πρέπει στη θέση του κειμένου να πληκτρολογήσετε ένα ή δύο 
γράμματα επαναλαμβάνοντας τα συνεχώς, γιατί δεν θα έχει επιτυχία η ροή κει-
μένου γύρω από τις εικόνες.

4.	�Συγκρίνετε το αποτέλεσμα των προσπαθειών σας με το αντίστοιχο δείγμα που 
είχατε επιλέξει. Συζητήστε τα συμπεράσματά σας με τους καθηγητές και τους 
συμμαθητές σας.

Σχετικές ηλεκτρονικές διευθύνσεις

Μηχανή αναζήτησης που μπορεί να χρησιμοποιηθεί για την αναζήτηση φωτογρα-
φιών με συγκεκριμένο θέμα. Απαιτείται η χρήση κατάλληλων λέξεων – κλειδιών 
σχετικών με το θέμα. 
www.google.com.gr

Διευθύνσεις για προγράμματα σελιδοποίησης και όχι μόνο. 
www.find.com.au/tutorials
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Κεφάλαιο 17ο
Συνδυασμός κειμένων και φωτογραφιών

Στόχοι:

Οι μαθητές μετά τη μελέτη του κεφαλαίου αυτού θα είναι σε θέση να:

	 •	� Αντιληφθούν τις βασικές αρχές για το συνδυασμό κειμένων και φωτο-

γραφιών.

	 •	 �Τοποθετούν με ακρίβεια εικόνες μέσα σε κείμενα.

17.1 Εισαγωγή

Στα προηγούμενα κεφάλαια μελετήσαμε την εισαγωγή κειμένων και φωτογραφιών 

στη σελίδα και τη σχετική τους θέση. Η εισαγωγή των κειμένων γίνεται ευκολότερη, 

αν έχουμε ένα καλοσχεδιασμένο προσχέδιο. Τα πλαίσια κειμένου προσαρμόζονται στις 

διαστάσεις των στηλών, έτσι το κείμενο «ρέει» σε μορφή μονόστηλου, δίστηλου κτλ.

Τα πράγματα γίνονται λίγο δυσκολότερα με την τοποθέτηση των φωτογραφιών, που 

δεν ταιριάζουν πάντα στο κασέ. Ένας δοκιμασμένος τρόπος για να αντιμετωπίσου-

με το πρόβλημα είναι να τις ευθυγραμμίσουμε σε ίσες αποστάσεις μεταξύ τους και 

σε απόλυτη στοίχιση με κάποια στοιχεία που είναι ενταγμένα στις στήλες του κασέ. 

Με αυτό τον τρόπο οι φωτογραφίες ενσωματώνονται στη σελίδα και δε δίνουν την 

εντύπωση ότι είναι τυχαία τοποθετημένες.

17.2 Κείμενα και φωτογραφίες σε στήλες

Στο παράδειγμα της Εικόνας 17.1, αποφασίζουμε να κρατήσουμε σταθερή την από-

σταση μεταξύ των πλαισίων των φωτογραφιών. Το διάστηλο, το κενό μεταξύ των 

στηλών με το κείμενο, που είναι 1,5 τετράγωνο (1p6), είναι καλό να παραμείνει και 

μεταξύ των φωτογραφιών. Οι δύο φωτογραφίες στην κάτω σειρά ταιριάζουν ακρι-

βώς στις στήλες. Για τις υπόλοιπες δύο στην επάνω σειρά ρυθμίζουμε στο πλαίσιο 

διαλόγου Βήμα και Επανάληψη την απόσταση 1,5 τετράγωνο. Στο τέλος, ευθυγραμ-

μίζουμε και τη λεζάντα της επάνω δεξιάς φωτογραφίας, επιλέγοντας το πλαίσιο 
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αυτής αλλά και του κειμένου και καθορίζουμε το διάστημα των αριστερών άκρων 
των πλαισίων στα μηδέν τετράγωνα. Με αυτό τον τρόπο η σχετική τους απόσταση 
μηδενίζεται.

A

Β

Γ

Εικόνα 17.1:
(Α) Με τις συγκεκριμένες 
φωτογραφίες δεν είναι 
εύκολο να διατηρηθεί η 
ευθυγράμμιση των
φωτογραφιών  και 
συγχρόνως να έχουμε και 
μία αισθητικά αποδεκτή 
σελίδα.
(Β) Αυτή η λύση είναι 
καλύτερη με αυτές τις 
ρυθμίσεις.
(Γ) Το τελευταίο βήμα 
είναι η ακριβής
τοποθέτηση των
λεζάντων...Ιδού το
αποτέλεσμα!

17.3 Τα σημεία στήριξης σύνθετων σελίδων

Οι φωτογραφίες, και ιδιαιτέρως αυτές με πρόσωπα, είναι ιδανικές για να τραβή-
ξουν την προσοχή του αναγνώστη σε συγκεκριμένα σημεία της σελίδας. Αυτά τα 
σημεία, που καλούνται σημεία στήριξης, είναι τα σημεία «εισόδου» της σελίδας. 
Σε αυτά σταματά το μάτι του αναγνώστη και αρχίζει να διαβάζει τη σελίδα. Όλα 
αυτά είναι θέματα που απασχολούν κυρίως τους σχεδιαστές σελίδων εφημερίδων 
και περιοδικών. Αυτό γιατί περιέχουν πολλά στοιχεία, φωτογραφίες και άρθρα, που 
πρέπει να διευθετηθούν στην επιφάνεια της σελίδας.
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Μπορούμε επίσης, χρησιμοποιώντας τη γωνία λήψεως μιας φωτογραφίας, ή την 
κατεύθυνση που «βλέπει» το πρόσωπο της φωτογραφίας, να κατευθύνουμε την 
προσοχή του αναγνώστη.
Η εμπειρία έχει δείξει ότι το πρόσωπο μιας φωτογραφίας πρέπει να «κοιτά» προς το 
εσωτερικό της σελίδας. Στο παράδειγμα, η γυναίκα στην επάνω δεξιά φωτογραφία 
κοιτά προς την εξωτερική πλευρά της σελίδας, ενώ τα βλέμματα των υπολοίπων 
συγκλίνουν προς ένα κεντρικό σημείο της σελίδας. Αυτό θα το διορθώσουμε αντι-
στρέφοντας τη φωτογραφία στον πίνακα μετρήσεων. (Εικόνα 17.2).

Εικόνα 17.2: Αριστερά η φωτογραφία πριν την αντιστροφή. Δεξιά μετά την αντιστροφή

Το ίδιο συμβαίνει και στο επόμενο παράδειγμα (Εικόνα 17.3), όπου το πρόσωπο 
αριστερά φαίνεται να κοιτά έξω από το κείμενο της σελίδας. Ο γραφίστας αντιστρέ-
φει τη φωτογραφία και συγχρόνως διορθώνει το «καδράρισμά» της, ώστε τελικά να 
φαίνεται ότι κοιτά το κείμενο.
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Α

Β Γ

Δ Ε

Εικόνα 17.3: (Α) Η φωτογραφία δε φαίνεται να ταιριάζει. Η φωτογραφία μπορεί να είναι άρτια 
τεχνικά, αλλά δεν έχει το κατάλληλο «καδράρισμα» για τη σελιδοποίηση.
(Β) Περιστρέφεται αριστερόστροφα κατά 15 μοίρες και αντιστρέφεται συγχρόνως.
(Γ) περιστρέφουμε δεξιόστροφα κατά 15 μοίρες μόνο τη φωτογραφία και όχι το πλαίσιό της. 
(Δ) Προσαρμόζουμε το πλαίσιο της εικόνας με βάση το πλάτος της στήλης.
(Ε) Ολοκληρώνουμε το καδράρισμα.

17.4 Οι κορνίζες στις φωτογραφίες

Πολλοί βάζουν περίγραμμα σε κάθε εικόνα στις σελίδες των εντύπων που σχεδιά-
ζουν, ενώ άλλοι το αποφεύγουν. Όπου χρειάζεται να κατασκευασθεί περίγραμμα 
ορίζεται από την εντολή,
Αντικείμενο > Αλλαγή (Περίγραμμα) (Item > Modify (Frame)).
Στο πλαίσιο διαλόγου που εμφανίζεται, μπορούμε να ορίσουμε το είδος, το πάχος 
και το χρώμα του περιγράμματος.
Πολλές φορές, όπως στην περίπτωση μιας φωτογραφίας με ανοιχτόχρωμο φόντο, 
όπου τα όρια είναι δυσδιάκριτα, το περίγραμμα βοηθά στη σελιδοποίηση.
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Στην Εικόνα 17.4 φαίνονται δύο προτάσεις για εφαρμογή περιγράμματος, στην 
πρώτη με μαύρη γραμμή και στην δεύτερη με λευκή γραμμή. Ενώ στην Εικόνα 17.5 
δεν χρησιμοποιούμε καθόλου πλαίσιο.

Α

Β

Εικόνα 17.4: (A) To περίγραμμα της φωτογραφίας έχει πάχος μιας στιγμής, ενώ η απόσταση 
φωτογραφίας και κειμένου έχει ρυθμιστεί στις 4 στιγμές.
(Β) Μία διαφορετική προσέγγιση. Έχουμε ένα λευκό πλαίσιο που τονίζεται από το γραφικό που 
έχει μπει πίσω από τη φωτογραφία.
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Εικόνα 17.5:
Εδώ η φωτογραφία οριοθετείται 
μόνο από το κείμενο που την 
περιβάλλει.
(Α) Με την τετράγωνη
φωτογραφία η σελίδα φαίνεται 
πιο επίσημη.
(Β) Η στρογγυλή όμως δίνει ένα 
ανάλαφρο τόνο στη σελίδα.

Α

Β

17.5 Σελίδες με εικόνες χωρίς πλαίσιο

Στα προηγούμενα παραδείγματα χρησιμοποιήσαμε κορνίζες, ενώ στα επόμενα πα-
ραδείγματα των εικόνων 17.6 και 17.7 οι εικόνες οριοθετούνται χωρίς πλαίσια, αφού 
περιβάλλονται από τα κείμενα. Η μόνη αναγκαία ρύθμιση είναι αυτή της απόστα-
σης κειμένου και ορίων εικόνας.
Στην περίπτωση της Εικόνας 17.7 όπου οι φωτογραφίες έχουν μόνο σκιά, και εμφα-
νίζονται ελεύθερα στην σελίδα, πρέπει να ορίσουμε πόσο μεγάλο ή μικρό τμήμα της 
εικόνας θα εμφανίζεται, ώστε στην συνέχεια να προσαρμόζεται το κείμενο γύρω του.
Η ρύθμιση γι’ αυτό γίνεται από το μενού Προσαρμογή> Ψαλιδισμός... (Κατώφλι) 
(Modify>Clipping...(Threshold)) ορίζοντας μηδέν 0% για μηδενικό ψαλιδισμό της 
εικόνας. Κάθε άλλο ποσοστό εμφανίζει αναλόγως μεγαλύτερο ή μικρότερο τμήμα 
της εικόνας.
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Αυτό γίνεται μόνο στις νεότερες εκδόσεις των προγραμμάτων σελιδοποίησης, στις 
παλαιότερες είμαστε υποχρεωμένοι να δημιουργήσουμε στο πρόγραμμα επεξεργα-
σίας εικόνας το ξάκρισμα που θέλουμε χρησιμοποιώντας περίγραμμα ψαλιδισμού 
(clipping path).

Εικόνα 17.6: Όταν δεν έχουμε σαφή όρια φωτογραφίας, μπορούμε να εισαγάγουμε κείμενο 
γύρω από το θέμα μας με την κατάλληλη πλευρική ροή.

Εικόνα 17.7: Οι φωτογραφίες έχουν σκιά και εμφανίζονται ελεύθερα στην σελίδα. Πρέπει να ορί-
σουμε πόσο μεγάλο ή μικρό τμήμα της εικόνας ή της σκιάς θα εμφανίζεται, ώστε στην συνέχεια να 
προσαρμόζεται το κείμενο γύρω του. Το κείμενο δεν θα πρέπει να καλύπτει τμήμα της φωτογραφί-
ας ή της σκιάς της. Η ρύθμιση γι̕ αυτό γίνεται από το μενού Προσαρμογή> Ψαλιδισμός...(Κα-
τώφλι), Modify>Clipping... (Threshold) ορίζοντας μηδέν 0% για μηδενικό ψαλιδισμό της εικόνας.
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Εικόνα 17.8: Από το μενού Item>Edit>Clipping Path... εμφανίζουμε την πράσινη γραμμή που 
συμπεριφέρεται σαν καμπύλη Bezier με κόμβους. Η μεταβολή της καμπύλης γίνεται εύκολα τώρα 
με μετακίνηση των κόμβων ή με αλλαγή καμπυλότητας από τις αντίστοιχες λαβές.

Αν για οποιοδήποτε λόγο δεν είμαστε ικανοποιημένοι από την πλευρική ροή όπως 
την ορίσαμε και θέλουμε να αυξήσουμε την απόσταση εικόνας και κειμένου, μπο-
ρούμε να την αλλάξουμε μετακινώντας τους κόμβους γύρω από την εικόνα, αφού 
πρώτα τους εμφανίσουμε από το μενού Item > Edit > Clipping Path... όπως εμφα-
νίζεται και στην εικόνα 17.8. Με τον ίδιο τρόπο μπορούμε να μειώσουμε την από-
σταση του κειμένου, αν κρίνουμε ότι αισθητικά πρέπει το κείμενο να προσεγγίσει 
περισσότερο στην εικόνα.
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Δραστηριότητες 17ου κεφαλαίου

1.	� Δημιουργήστε δύο καταχωρήσεις καταναλωτικών προϊόντων με τυπογραφικά 
στοιχεία και εικόνες σε συγκεκριμένες διαστάσεις:
(α) για εφημερίδα μικρού σχήματος (tabloid),
(β) για περιοδικό διαστάσεων 23 x 29 εκατοστά

2.	Δημιουργήστε σελίδα (σαλόνι) περιεχομένων περιοδικού ποικίλης ύλης.
3.	� Σχεδιάστε σε μορφή τριπτύχου διαφημιστικό φυλλάδιο για κινητό τηλέφωνο. Το 

φυλλάδιο θα διανέμεται με το λογαριασμό τηλεφώνου του συνδρομητή σε ταχυ-
δρομικό φάκελο. Επιλέξτε τις κατάλληλες διαστάσεις του φυλλαδίου.

Σχετικές Ηλεκτρονικές διευθύνσεις

Μηχανή αναζήτησης που μπορεί να χρησιμοποιηθεί για την αναζήτηση φωτογρα-
φιών με συγκεκριμένο θέμα. Απαιτείται η χρήση κατάλληλων λέξεων – κλειδιών σχε-
τικών με το θέμα.
www.google.com.gr

Διευθύνσεις για προγράμματα σελιδοποίησης και όχι μόνο. 
www.find.com.au/tutorials

Ανακεφαλαίωση 17ου Κεφαλαίου

Και σ’ αυτό το κεφάλαιο αντιμετωπίζουμε το αισθητικό πρόβλημα της τοποθέ-
τησης κειμένων και φωτογραφιών. Ανάλογα με το αισθητικό αποτέλεσμα που 
επιθυμούμε, σχεδιάζουμε κορνίζα ή όχι.
Αν θέλουμε το κείμενο να ρέει γύρω από την εικόνα ελεύθερα, δεν χρησιμοποι-
ούμε κορνίζα και έχουμε την δυνατότητα να μεταβάλουμε την απόσταση της 
εικόνας από το κείμενο κατά βούληση.
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Εικονογραφικό υλικό

Στο βιβλίο χρησιμοποιήθηκαν εικόνες από τις εξής συλλογές:
-  Corel Gallery 380.000
-  Hemera Photo Objects, royalty free images.
-  Focus 20.000 Photos.

Η εικονογράφηση του βιβλίου έγινε από τους συγγραφείς Β. Καλαντζή και X. Τερζίδη.
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Αγγλικός
Όρος

Ελληνικός
Όρος Ερμηνεία

Ascender Ανιούσα κοντυλιά Το άνω τμήμα του γράμματος. Π.χ. λ ή d.
A/D converter Αναλογικός 

/ψηφιακός
μετατροπέας.

Συνήθως είναι ένα ολοκληρωμένο κύκλωμα που μετατρέπει αναλογικό 
σήμα σε ψηφιακό. Υπάρχει στα scanner, ψηφιακές φωτογραφικές 
μηχανές, κάρτες οθόνης κάρτες ήχου κ.λπ.

Alignment Στοίχιση Η τοποθέτηση ενός αντικειμένου σε ευθυγράμμιση με ένα άλλο 
αντικείμενο, πχ στα περιθώρια της σελίδας οι αράδες είναι 
ευθυγραμμισμένες αριστερά, δεξιά ή στο κέντρο.

Alley Απόσταση στηλών Το διάστημα που υπάρχει ανάμεσα από δύο στήλες κειμένου, που 
βρίσκεται σε πίνακα, μετριέται σε εκατοστά ή στιγμές.

ASCII ASCII Ακρωνύμιο του American Standard Code of Information Interchange, ο 
τρόπος που αποθηκεύονται τα αρχεία κειμένου. Αυτοί οι τύποι αρχείων 
αποθηκεύουν όλα τα γράμματα και τους ειδικούς χαρακτήρες αλλά καμιά 
άλλη πληροφορία σχετικά με την μορφοποίηση των χαρακτήρων ή της 
παραγράφου

Auto flow Αυτόματη Ροή Η αυτόματη τοποθέτηση κειμένου στα προγράμματα σελιδοποίησης, με 
την οποία το κείμενο ρέει συνεχώς από στήλη σε στήλη και από σελίδα 
σε σελίδα

Auto leading Αυτόματο Διάστιχο Είναι το διάστημα που υπάρχει ανάμεσα στις γραμμές, σε αναλογία με 
το μέγεθος γραμμάτων. Αν είναι 120%, τότε με γράμματα μεγέθους 10 
σημείων το διάστιχο είναι 12.

Baseline Γραμμή βάσης Μια εικονική γραμμή που πάνω της γράφονται τα γράμματα κατά τη 
στοιχειοθεσία.

Bezier Bezier Σύνθετο είδος καμπυλών που ορίζονται κατά διεύθυνση και φορά, από 
πολλά σημεία ελέγχου.

Binary number Δυαδικός αριθμός. Αριθμός που αποτελείται από μια ακολουθία ψηφίων 1 και Ο. Κάθε 
επιπλέον ψηφίο (bit) διπλασιάζει τους πιθανούς συνδυασμούς. Για 
παράδειγμα: δύο bit παράγουν τους εξής συνδυασμούς: 00,01,10,11. 
Τρία bit παράγουν τους συνδυασμούς 000,001,010,011,100,101,110, 111. 
Κάθε φυσικός αριθμός μπορεί να αναπαρασταθεί από τον αντίστοιχο 
δυαδικό. Επειδή το 1 και το Ο αντιστοιχούν στις καταστάσεις των 
ηλεκτρονικών κυκλωμάτων (ανοικτό - κλειστό) οι δυαδικοί αριθμοί είναι 
κατάλληλοι για να χρησιμοποιηθούν σε εφαρμογές σε επίπεδο γλώσσας 
μηχανής που ''μιλάει'' κατευθείαν στον υπολογιστή αποκλειστικά με 
δυαδικές ακολουθίες Ο και 1.

Bit Από τα αρχικά των 
αγγλικών λέξεων bina-
ry digit.

Η μικρότερη μονάδα πληροφορίας στον υπολογιστή. Είναι είτε 1 είτε Ο. 
Αντιπροσωπεύει δε τις δύο εναλλακτικές καταστάσεις των ηλεκτρικών 
κυκλωμάτων (ανοικτό - κλειστό). Τα προγράμματα των ηλεκτρονικών 
υπολογιστών είναι γραμμένα σε διάφορες γλώσσες υψηλού επιπέδου 
(C++, COBOL, Visual Basic, Delphi κλπ.) που στον πυρήνα τους 
ανάγονται σε γλώσσα μηχανής.

Bit depth Βάθος χρώματος κάθε 
pixel.

Ο αριθμός των bit που αντιπροσωπεύουν την τονική και χρωματική τιμή

Bitmap Χαρτογραφικό αρχείο Αρχείο εικόνας που περιγράφεται σημείο προς σημείο με μια 
συγκεκριμένη ακολουθία bits σχηματίζοντας τα εικονοστοιχεία. Είναι 
αντίθετο από τα διανυσματικά (vector) αρχεία εικόνας, τα οποία 
περιγράφονται μαθηματικά από τις καμπύλες Bezier.

Bitmapped Ψηφιογραφικό Η αναπαράσταση ενός γραφικού σε μια σειρά εικονοστοιχείων. Είναι ο 
τύπος αρχείων των ψηφιακών εικόνων.

Bleed art Κάθε φωτογραφία ή γραφικό ή λογότυπο που υπάρχει 
επαναλαμβανόμενο στο πάνω μέρος της σελίδας.

Border Περιθώριο Ένα, συνήθως λευκό, περιθώριο που μπορεί να υπάρχει γύρω από 
κείμενο, γραφικά ή ολόκληρη σελίδα

Bullet Κουκκίδα Ένας ειδικός χαρακτήρας που τυπώνεται στην αρχή μιας παραγράφου, 
για να της δίνει έμφαση.

Byte Ψηφίο Δυαδικός αριθμός των 8-bit που μπορεί να λάβει τιμές από Ο ως 255 
(28). Χρησιμοποιείται για μέτρηση του μεγέθους των αρχείων. 1 Kilo-
byte περιέχει 1.024 bytes και ένα Megabyte 1.024 Kilobytes ή 1.048.576 
bytes.

Callout Λεζάντα Ένα σύντομο κείμενο το οποίο περιγράφει ένα σχήμα ή μία φωτογραφία

CCD Από τα αρχικά Φωτοευαίσθητα στοιχεία που μετατρέπουν σε ηλεκτρικό φορτίο τo φως. 
Χρησιμοποιούνται στις ψηφιακές φωτογραφικές μηχανές και τα scanner.

Γλωσσάρι
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Charged Coupled 
Device.

CD ROM Από τα αρχικά των 
λέξεων Compact Disk 
Read Only Memory.

Περιφερειακό μέσο αποθήκευσης ψηφιακών δεδομένων παρόμοιο σε 
αρχιτεκτονική με το CD Audio. Η μεγάλη χωρητικότητα του CD ROM (πάνω 
από 650 MB) το κάνει κατάλληλο για αποθήκευση ψηφιακών εικόνων.

Center Axis Κέντρο Βάρους Ένα εικονικό κέντρο σε μια σελίδα, ή μπλοκ κειμένου ή σε ένα γραφικό.
Channels Κανάλια Ο διαχωρισμός της εικόνας στα βασικά χρώματα στην οθόνη του 

υπολογιστή.
Clip Art Έτοιμες εικόνες Διάφορες συλλογές εικόνων, ελεύθερης χρήσης ή και όχι, σε 

ηλεκτρονική μορφή ή τυπωμένες.
Clipboard Πρόχειρο Ένα μέρος της μνήμης του υπολογιστή που χρησιμοποιείται για να 

συγκρατούνται τα περιεχόμενα της Αντιγραφής και Αποκοπής
Clipping Ψαλιδισμός. Η αποκοπή ορισμένων τόνων είτε πιο ανοικτών από ένα ορισμένο 

επίπεδο και επάνω που γίνονται μαύροι είτε από ένα επίπεδο και 
κάτω που υποβιβάζονται στο μαύρο. Προκαλεί απώλεια λεπτομέρειας. 
Μπορεί να συμβαίνει και σε ένα μόνο κανάλι.

CMYK Τετραχρωμία Ακρωνύμιο των τεσσάρων βασικών χρωμάτων της τετραχρωμίας (cyan, 
magenta, yellow, black)

Color Management 
Systems

Συστήματα 
διαχείρισης 
χρώματος

Εργάζονται σε συνεργασία με τα λειτουργικά ή με ειδικές εφαρμογές 
ευθυγράμμισης, για σταθερά ομοιόμορφη απόδοση χρώματος στην 
οθόνη και την έξοδο (έγχρωμος printer, εικονοθέτης κλπ).

Color model Χρωματικό πρότυπο Συχνά αποδίδεται και με τους όρους color space ή color mode και 
υποδηλώνει τη μέθοδο απόδοσης των επιμέρους χρωμάτων. Στο RGB 
επιπλέον προσθήκη μονάδων αυξάνει φωτεινότητα. Στο αφαιρετικό 
CMYK συμβαίνει ακριβώς το αντίθετο, δηλ. όταν αυξάνουμε την 
συμμετοχή των χρωστικών το αποτέλεσμα είναι πιο σκούρο, επειδή 
ακριβώς μεγαλώνει η ποσότητα του μελανιού.

Color Palette Χρωματική Παλέτα Μια λίστα των χρωμάτων που χρησιμοποιούνται σε ένα γραφικό. Τα 
χρώματα αυτά παράγονται από κάποια βασικά.

Column guides Οδηγοί στηλών Μη εκτυπώσιμοι κάθετοι οδηγοί που χρησιμοποιούν τα σελιδοποιητικά 
προγράμματα, για να δείξουν τα όρια των στηλών

compression Συμπίεση Τεχνική, η οποία μειώνει το χώρο που καταλαμβάνουν τα δεδομένα 
στο σκληρό δίσκο ή σε άλλα αποθηκευτικά μέσα. Διακρίνουμε 
ανάμεσα στις μη απωλεστικές (non lossy) και τις απωλεστικές (lossy) 
μεθόδους συμπίεσης. Οι πρώτες ανακτούν ολόκληρο το πληροφοριακό 
περιεχόμενο μετά την αποσυμπίεση και είναι κατάλληλες για 
αρχεία προγραμμάτων, κείμενα, DTP κλπ. Οι απωλεστικές μέθοδοι 
εφαρμόζονται μόνο σε αρχεία εικόνων ή ήχων επιφέροντας μια 
υπαρκτή μεν αλλά όχι ενοχλητική υποβάθμιση της ποιότητας.

Condensed Type Συμπιεσμένη γραφή Γραφή κατά την οποία οι χαρακτήρες καταλαμβάνουν μικρότερο διάστημα 
από το κανονικό, ώστε να χωρούν περισσότεροι χαρακτήρες ανά αράδα

Copyright Δικαιώματα 
δημιουργού

Τα δικαιώματα που έχει ένας συγγραφέας – δημιουργός σε ένα βιβλίο, 
άρθρο, φωτογραφία, μακέτα και γενικότερα δημοσίευμα.

Crop Ξάκρισμα Η διαδικασία κοψίματος των άκρων μιας φωτογραφίας είτε γιατί δεν 
έχουν ιδιαίτερη σημασία για το θέμα, είτε για να χωρέσει η εικόνα σε 
ορισμένο χώρο της σελίδας.

Crop Marks Σημεία Ξακρίσματος Ειδικά σημεία σε μια τυπωμένη επιφάνεια που δείχνουν πού πρέπει 
να κοπεί μια σελίδα για να συρραφτεί σε βιβλίο ή περιοδικό. Κατά την 
εκτύπωση μιας εικόνας, δείχνουν τα όρια εκτύπωσης του εκτυπωτή

Cropping Tool Εργαλείο κοπής Εργαλείο που έχουν σχεδόν όλα τα προγράμματα για την αποκοπή 
τμημάτων φωτογραφιών

Default Προεπιλογή Οι παράμετροι μιας εντολής όπως έχουν ρυθμιστεί από τον 
κατασκευαστή του προγράμματος

Descender Κατιούσα κοντυλιά Το τμήμα του γράμματος που βρίσκεται κάτω από την γραμμή βάσης. 
π.χ. ρ ή φ.

DIN Προδιαγραφή ποιότητας σύμφωνα με το στάνταρ Deutsche Industrie 
Norm. Σε μονάδες DIN εκφράζεται η ισοδύναμη ευαισθησία του 
αισθητήρα CCD. Πρόκειται για λογαριθμική κλίμακα.

Dingbat Κουκκίδες Σύμβολα ή γραφικά που διακοσμούν κάθε γραμμή σε μια λίστα. 
Ανάλογη χρήση με των κουκκίδων.

Dmax Το σημείο μέγιστης πυκνότητας σε μια εικόνα.
Dmin Το σημείο ελάχιστης πυκνότητας σε μια εικόνα
Dot gain Άπλωμα κουκκίδας. Λόγω της απορροφητικότητας των χαρτιών εκτύπωσης οι κουκκίδες του 

μελανιού «απλώνουν» κατά την εκτύπωση. Προκειμένου να
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αντισταθμισθεί αυτό, στα προγράμματα επιτραπέζιας τυπογραφίας, 
υπάρχει η δυνατότητα να ελαττώσουμε την διάμετρο των κουκκίδων 
του ράστερ κατά το ποσοστό που έχουμε βρει από την εμπειρία, ότι 
αυξάνεται η κουκκίδα στην εκτύπωση. Το άπλωμα κουκκίδας δεν είναι 
πάντα το ίδιο. Εξαρτάται από την μέθοδο εκτύπωσης, την ποιότητα του 
χαρτιού και του μελανιού εκτύπωσης.

Dots per inch Ανάλυση Η μέτρηση της ανάλυσης σε σημεία ανά ίντσα ενός εκτυπωτή ή μιας 
οθόνης

Download Κατέβασμα Η αντιγραφή αρχείων στον υπολογιστή από το διαδίκτυο, το 
«κατέβασμα» γραμματοσειρών από τον υπολογιστή στον εκτυπωτή.

Drop Cap Κεφαλαία Χαρακτηρισμός γραφής όπου όλοι οι χαρακτήρες είναι κεφαλαίοι
Dummy «Τυφλό» κείμενο Κείμενο το οποίο χρησιμοποιείται για να γεμίζει απλώς το χώρο 

προκειμένου να ελέγχουμε οπτικά την σελίδα, πριν τοποθετηθεί το 
τελικό κείμενο.

Dye sublimation 
printer

Εκτυπωτής 
εξάχνωσης

Μέθοδος εκτύπωσης συνεχών τόνων με θερμική εξάχνωση χρωστικών 
ουσιών.

Dynamic range Δυναμική περιοχή. Το μέγιστο τονικό εύρος (από τους ανοικτούς ως τους σκούρους 
τόνους) που μία μέθοδος (ή συσκευή) σάρωσης ή εκτύπωσης μπορεί να 
αποδώσει.

Em space Τετράγωνο Μεταβλητή τυπογραφική μονάδα μέτρησης ίση με το μέγεθος του 
γράμματος που χρησιμοποιείται. Για χαρακτήρα μεγέθους 10 στιγμών 
το τετράγωνο είναι επίσης 10 στιγμές

EPS (encapsulated 
postscript)

EPS Είναι συμβατό με DTP προγράμματα που περιέχει ένα preview αρχείο 
χαμηλής ανάλυσης για εμφάνιση στην οθόνη.

Family(Type) Οικογένεια Το όνομα της οικογένειας μιας γραμματοσειράς, όπως Times New 
Roman, Tahoma

Flatbed scanner Επίπεδος Σαρωτής Σαρωτής επίπεδου τύπου όπου τα πρωτότυπα τοποθετούνται σε 
επίπεδη επιφάνεια. Η κεφαλή με τη φωτιστική πηγή και τον αισθητήρα 
CCD τοποθετούνται σε κινούμενο φορέα, όπως σε ένα φωτοτυπικό.

Fold Marks Ειδικά τυπωμένα σημεία πού δείχνουν που θα διπλωθεί ένα τυπωμένο 
φύλλο

Font Γραμματοσειρά Η γραμματοσειρά είναι το σύνολο των γραμμάτων, αριθμών και 
συμβόλων που έχουν όμοια αισθητικά χαρακτηριστικά.

Footer Υποσέλιδο Το κενό που υπάρχει στο κάτω μέρος των σελίδων, όπου γράφονται 
συνήθως οι υποσημειώσεις ή (και) η αρίθμηση σελίδων.

Forced justify Δυναμική στοίχιση Στοίχιση όμοια με την πλήρη, μόνο που τοποθετείται περισσότερο 
κενό ανάμεσα από τους χαρακτήρες, ώστε η γραμμή να τελειώνει 
οπωσδήποτε στο δεξί περιθώριο.

Format Διαμόρφωση 
εντύπου

Η συνολική εμφάνιση μιας έκδοσης, δηλαδή το μέγεθος της σελίδας, τα 
περιθώρια, περιθώρια βιβλιοδεσίας, αριθμό στηλών κλπ.

Formatting Διαμόρφωση 
κειμένου

Η εμφάνιση του κειμένου, κυρίως σε επίπεδο παραγράφου, δηλαδή οι 
αποστάσεις γραμμών και παραγράφων, μέγεθος γραμμάτων, στοίχιση κλπ.

Graphic boundary Πλαίσιο γραφικού Μη εκτυπώσιμες γραμμές που δείχνουν πόσο μακριά είναι το κείμενο 
από μια φωτογραφία ή γραφικό

Greeking ή greek 
text

«Κινέζικα» Η διαδικασία μη εμφάνισης των γραμμάτων στην οθόνη του 
υπολογιστή, μικρότερων από κάποιο μέγεθος, όταν η σελίδα 
προβάλλεται σε σμίκρυνση.

Grid Κάνναβος Οριζόντιες και κατακόρυφες γραμμές που σχηματίζουν πλαίσια και 
φέρουμε με το παράλληλο και χρησιμεύουν ως οδηγοί μόνο για την 
τοποθέτηση κειμένων και εικόνων σε μία σελίδα.

Gutter Περιθώρια ράχης Όρος που χρησιμοποιείται για να καθορίζει την απόσταση των μπλοκ 
κειμένου από το μέσα άκρο των σελίδων.

Hairline Λεπτή γραμμή 
(πάχους τρίχας)

Πάρα πολύ λεπτή γραμμή, που χρησιμοποιείται από τα προγράμματα 
γραφικών

Halftone Ημιτονική (εικόνα) Η αναπαραγωγή συνεχών τόνων φωτογραφιών με την χρήση 
κουκκίδων οι οποίες μοιάζουν με αποχρώσεις του γκρι. Η αναλογία 
μαύρων – λευκών κουκκίδων καθορίζουν τον τόνο του γκρι.

Handles Χειριστήρια Οκτώ κουκκίδες γύρω από ένα γραφικό που επιτρέπουν στον χρήστη 
τους μετασχηματισμούς του

Hanging indent Προεξοχή Στυλ παραγράφου όπου η εσοχή ή προεξοχή της πρώτης γραμμής είναι 
διαφορετική από αυτήν των επόμενων.

Hard return Τέλος παραγράφου Ένα σύμβολο που μπαίνει στο τέλος κάθε παραγράφου με το πάτημα 
του πλήκτρου Enter

highlight Ανοικτά Σημεία Φωτεινά σημεία μιας φωτογραφίας
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Image setter Εικονοθέτης Μια ειδική εκτυπωτική μηχανή (όπως η Linotronic) που χρησιμοποιείται 
στην φωτοσύνθεση για την τελική εκτύπωση σε φιλμ των δοκιμίων

Indexed color Εικόνα με περιορισμένο εύρος χρωμάτων, με ένα κανάλι 8-bit 
(256 χρώματα). Μερικά προγράμματα ρυθμίζουν την σύνθεση 
αυτής της περιορισμένης παλέτας χρωμάτων ώστε να περιλαμβάνει 
συγκεκριμένα χρώματα. Συνήθως χρησιμοποιείται για εικόνες που 
εμφανίζονται σε ιστοσελίδες.

Initial Cap Αρχίγραμμα Ένας ειδικός τύπος μεγάλου γράμματος, διαστήματος δύο ή τριών 
γραμμών που χρησιμοποιείται για να δώσει έμφαση

Insertion point Σημείο εισαγωγής Ένα ειδικό σημείο στον χώρο εργασίας που σηματοδοτεί το μέρος 
που θα εισαχθεί κείμενο ή γραφικό

Interpolation Τεχνητή αύξηση της 
ανάλυσης μιας εικόνας.

Η αύξηση του αριθμού των pixels σε μια ψηφιοποιημένη εικόνα με 
την βοήθεια των προγραμμάτων επεξεργασίας εικόνας μόνο και όχι 
με πραγματική σάρωση εξ αρχής. Η πληροφορία που προστίθεται 
δεν αντιστοιχεί σε πραγματικές λεπτομέρειες στην εικόνα αλλά είναι 
τεχνητή.

ISO ευαισθησία Ευαισθησία φιλμ Ισοδύναμη ευαισθησία του αισθητήρα CCD σύμφωνα με τα πρότυπα 
(για φιλμ] του Διεθνούς Οργανισμού Τυποποίησης (International 
Standards Organization].

Italic type Πλάγια γραφή Ένας ειδικός τύπος γραφής, όπου οι χαρακτήρες έχουν ελαφριά 
κλίση προς τα δεξιά

JPEG
Joint Photographic 
Expert Group

Μορφή συμπιεσμένου φωτογραφικού αρχείου με μεταβλητό λόγο ''απω-
λεστικής'' συμπίεσης. Χρησιμοποιείται απ’ όλα τα προγράμματα επεξερ-
γασίας εικόνας και διαθέτει συμβατότητα με πλατφόρμα Mac & PC.

kerning Απόσταση χαρακτήρων Η διαδικασία ρύθμισης των αποστάσεων μεταξύ των γραμμάτων, σε 
ειδικές εργασίες όπως επιγραφές, τίτλοι κλπ. Συνήθως αφορά ζεύγη 
γραμμάτων όπως λ, σ

Landscape Οριζόντιος Ο πλάγιος προσανατολισμός της σελίδας, με μεγαλύτερο πλάτος 
δηλαδή από το ύψος. Χρησιμοποιείται και στις φωτογραφίες.

Layers Επίπεδα ή Ριζόχαρτα «Εικονικά ριζόχαρτα» που περιέχουν διαφορετικά τμήματα εικόνας 
αλλά δίνουν την εντύπωση ότι είναι ενιαία. Χρησιμοποιούνται για να 
διευκολύνει την τμηματική επεξεργασία μιας εικόνας.

Layout Layout Η διάταξη των κειμένων και γραφικών στην σελίδα
Layout View Προεπισκόπηση Η εμφάνιση της σελίδας στην οθόνη, ακριβώς όπως θα εκτυπωθεί.
Leading διάστιχο Η απόσταση της γραμμής βάσης που γράφονται οι χαρακτήρες και 

της επομένης, μετρημένη σε στιγμές
Letter Spacing Απόσταση χαρακτήρων Η αραίωση των γραμμάτων που μετράται σε units (συνήθως 1/200 

του τετραγώνου)
Line art Γραμμική εικόνα. Αρχείο με βάθος χρώματος 2bit που έχει τη δυνατότητα να εμφανίζει 

μόνο το άσπρο και το μαύρο (όπως κάνουν τα λιθογραφικά φιλμ).
Link Δεσμός Μια ειδική λειτουργία με την οποία τα αρχεία κειμένου ή γραφικών 

που έχουν εντεθεί στο έντυπο, ενημερώνονται για τυχόν αλλαγές στα 
πρότυπα.

Logotype Λογότυπο Ένα γραφικό ή λέξη, που είναι πρωτότυπο και προσδιορίζει την 
εταιρεία που το χρησιμοποιεί.

LZW Είδος μη απωλεστικής συμπίεσης κατά Lempel - Ζiν - Welch. 
Αποτελεί μία επιλογή της μορφής αποθήκευσης TIFF.

Mask Μάσκα Μέθοδος επιλογής αντικειμένων κυρίως στα προγράμματα 
επεξεργασίας εικόνας.

Master Page Κύρια Σελίδα Η σελίδα (ες) στην οποία σχεδιάζεται το γενικότερο layout της έκδοσης.
Mini Save Γρήγορη Αποθήκευση Μια διαδικασία των περισσότερων προγραμμάτων, όπου αποθηκεύεται 

αυτόματα και σε τακτά διαστήματα η εργασία του χρήστη.
Moiré Moiré (ψάθα)      Η εμφάνιση κόκκων στην τελική εκτύπωση μετά από κακό 

συνδυασμό των ημιτονικών χρωμάτων.
Mono-spacing Ειδική γραμματοσειρά (τύπου Courier) που κάθε χαρακτήρας 

καταλαμβάνει ακριβώς τον ίδιο χώρο.
OCR Οπτική αναγνώριση 

χαρακτήρων.
Μέθοδος αναγνώρισης κειμένου με ανάλυση των επιμέρους χαρακτήρων 
ως σχημάτων που συσχετίζονται με συγκεκριμένα αλφαριθμητικά 
δεδομένα. Προηγείται η σάρωση του κειμένου σε γραμμικό αρχείο.

Optical Resolution Οπτική ανάλυση. Η πραγματική ανάλυση μετρημένη σε pixel του αισθητήρα CCD 
ενός scanner ή ψηφιακής φωτογραφικής μηχανής, χωρίς τεχνητή 
επαύξηση μέσω software.

Orphan Ορφανή γραμμή Είναι η τελευταία (ες) γραμμή μιας παραγράφου που ξεκινάει σε νέα 
σελίδα. Τα προγράμματα αποτρέπουν την εμφάνισή της κρατώντας 
την με τις προηγούμενες.242
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Outside Margin Εξωτερικό περιθώριο Το κενό ανάμεσα στο εξωτερικό άκρο της σελίδας και το τελευταίο 
γράμμα των αράδων του κειμένου.

Page Setup Διαμόρφωση σελίδας Το μέγεθος, ο προσανατολισμός, ο αριθμός σελίδων και τα περιθώρια 
μιας έκδοσης.

Page View Εμφάνιση σελίδας Η εμφάνιση στον υπολογιστή ολόκληρης της σελίδας
Pantone Colors Χρώματα Pantone Ένα πρότυπο σύστημα αναφοράς χρωμάτων τυπογραφικών μελανιών.
Perspective Προοπτική Η αναπαράσταση ενός τρισδιάστατου μοντέλου σε δύο διαστάσεις 

(οθόνη, χαρτί)
Pica Πίκα

(τετράγωνο)
Μια τυπογραφική μονάδα μέτρησης που ισοδυναμεί με 12 στιγμές. 
Είναι το 1/6 μιας ίντσας (Αγγλοσαξονικός όρος).

Pixel Εικονοστοιχείο Το μικρότερο σημείο ή κουκκίδα της οθόνης του υπολογιστή.
Η ανάλυση της οθόνης μετριέται σε pixels/ inch, όσο μεγαλύτερη
είναι τόσο πιο καθαρά τα αντικείμενα που αναπαρίστανται.

Point Στιγμή Η βάση μέτρησης της παραδοσιακής τυπογραφίας. 12 στιγμές 
αποτελούν ένα πίκα, 72 μια ίντσα.

Pointer Δείκτης Ο δείκτης του ποντικιού κινείται, όταν το κινήσουμε
Portrait Κάθετη σελίδα Ο κάθετος προσανατολισμός της σελίδας όπου το ύψος είναι 

μεγαλύτερο του πλάτους, χρησιμοποιείται και στην φωτογραφία.
Postscript Postscript Μια γλώσσα προγραμματισμού, που περιγράφει τη σελίδα στον 

εκτυπωτή. Δημιουργήθηκε από την Adobe Systems και χρησιμοποιείται 
κυρίως στις φωτοσυνθετικές μηχανές και τους εκτυπωτές laser. 
Αποτελεί παγκόσμιο standard

Process colors 
(CMYK)

Τετραχρωμία Σύστημα χρωμάτων που έχει ως βασικά χρώματα τα CMYK, ο συνδυασμός 
των οποίων δημιουργεί τα υπόλοιπα χρώματα στην εκτύπωση.

Proof Δοκίμιο Η τελική μορφή ενός έντυπου, αφού γίνουν όλες οι απαραίτητες 
διορθώσεις.

Proportional 
spacing

Αναλογικό διάστημα Η τεχνική στοιχειοθεσίας κειμένου, όπου όταν είναι αναγκαίο, 
προστίθεται επιπλέον κενό μεταξύ των λέξεων, έτσι ώστε να έχουμε 
πλήρη στοίχιση στην σελίδα.

RAM Κεντρική μνήμη Ακρωνύμιο των λέξεων Random Access Memory, είναι το μέρος όπου
ο υπολογιστής αποθηκεύει προσωρινά όλες τις πληροφορίες.

Registration 
marks

Σημεία σύμπτωσης Ειδικά σύμβολα, συνήθως ένας κύκλος με ένα σταυρόνημα, που 
εκτυπώνονται στα εξωτερικά περιθώρια των σελίδων για να ευθυγραμμίσουν 
τους χρωματικούς διαχωρισμούς των σελίδων, στην τετραχρωμία

Resampling Επαναληπτική 
δειγματοληψία.

Αύξηση ή μείωση του αριθμού των pixel μιας ψηφιοποιημένης εικόνας. 
Με τον τρόπο αυτό μπορούμε να μεγαλώσουμε ή να μικρύνουμε το 
μέγεθος μιας εικόνας. Γίνεται με ειδικούς αλγόριθμους που συγκρίνουν 
τις ομοιότητες ή διαφορές γειτονικών Pixel. Χρησιμοποιείται μόνο για 
σμίκρυνση της φωτογραφίας.

Resolution Ανάλυση. Εκφράζεται σε pixels ανά ίντσα π.χ. 150 ppi σημαίνει 150 
εικονοστοιχεία ανά ίντσα. Όσο αυξάνεται ο αριθμός, τόσο περισσότερες 
λεπτομέρειες εμφανίζονται.

(Printing) 
resolution

Ανάλυση εκτύπωσης Η ποιότητα εκτύπωσης ενός εκτυπωτή, μετρούμενη σε κουκκίδες ανά 
ίντσα, dpi (dots per inch). Σε έναν σύγχρονο εκτυπωτή ξεκινάει από 
600 και στους εικονοθέτες φθάνει τα 2540 dpi ή και περισσότερο

RGB RGB Σύστημα χρωμάτων που έχει ως βασικά χρώματα τα RGB. Ο συνδυασμός 
των οποίων δημιουργεί τα υπόλοιπα χρώματα στην οθόνη.

Ruler guide Οδηγός Μη εκτυπώσιμες γραμμές που σύρονται από τους χάρακες, για να 
βοηθήσουν την τοποθέτηση αντικειμένων στον χώρο εργασίας

Sampling Δειγματοληψία Συλλογή εικονοστοιχείων με διακριτό ή τυχαίο τρόπο βάσει 
στατιστικών διαδικασιών.

Scale Κλιμάκωση Η αλλαγή μεγέθους ενός γραφικού ή σελίδας, κατά ένα συγκεκριμένο 
ποσοστό.

Scanner (flatbed 
drum scanner)

Σαρωτής (επίπεδος ή 
τυμπάνου)

Ένα περιφερειακό του υπολογιστή, που χρησιμοποιείται για να εισάγει 
φωτογραφίες ή κείμενα σ’ αυτόν, μετατρέποντας κάθε γράμμα, σχήμα, 
φωτογραφία σε ένα σύνολο κουκκίδων.

Script Script Σύνολα εντολών προγράμματος, που κάνουν εξειδικευμένες λειτουργίες 
οδηγώντας μία άλλη εφαρμογή να εκτελέσει μία σειρά εργασιών.

Select Επιλογή Η επιλογή ενός αντικειμένου του χώρου εργασίας κάνοντας κλικ επάνω 
του.

Selection box Κουτί επιλογής Μέθοδος πολλαπλής επιλογής αντικείμενων, κατά την οποία 
σχεδιάζεται ένα νοητό παραλληλόγραμμο με το ποντίκι στο χώρο 
εργασίας και επιλέγεται ό,τι περικλείει 243
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Separation Διαχωρισμοί Μια εκτύπωση σε χαρτί ή φιλμ, η οποία περιέχει μόνο ένα από 
τα βασικά χρώματα. Στην τετραχρωμία σε κάθε έγχρωμη σελίδα 
αντιστοιχούν τέσσερις διαχωρισμοί.

Small Cap Μικρά Κεφαλαία Χαρακτήρες γραφής όπου ο χαρακτήρας έχει την μορφή κεφαλαίου 
γράμματος σε μέγεθος πεζού

Snap Έλξη Εντολή με την οποία υπάρχει έλξη ενός αντικειμένου σε κάποια 
συγκεκριμένα σημεία και όχι σε ενδιάμεσα. Συνήθως, στον κάνναβο, 
στους οδηγούς και σε άλλα σχεδιασμένα αντικείμενα

Spot Color Ατόφια χρώματα Χρώματα που δεν χρησιμοποιούν την τετραχρωμία CMYK για να 
περιγραφούν, αλλά κάποια συγκεκριμένη απόχρωση, συνήθως από 
την κλίμακα Pantone.

Spread Σαλόνι Δύο αντικριστές σελίδες μιας έκδοσης
Style Στυλ Λέξη που έχει πολλές ερμηνείες στην ηλεκτρονική επεξεργασία.

Στην σχεδίαση σημαίνει τις ιδιότητες που έχει κάποιο σχήμα όταν 
αυτές ομαδοποιηθούν. Στην τυπογραφία είναι οι ιδιότητες των 
γραμμάτων και παραγράφων. Αποδίδω στυλ σε αντικείμενο σημαίνει 
ότι κάποιο από αυτά τα αντικείμενα παίρνει τις προκαθορισμένες 
ρυθμίσεις του συγκεκριμένου στυλ.

Template Πρότυπο Ένα ηλεκτρονικό πρότυπο εγγράφου. Σε αυτό υπάρχουν συνήθως 
προκαθορισμένες ρυθμίσεις για την διαμόρφωση της σελίδας, των 
στυλ γραφής και σχεδίασης και μερικές φορές, προ-τυπωμένα 
κείμενα και σχέδια.

Text wrap Κύλιση κειμένου Τρόπος με τον οποίο το κείμενο «κυλάει» γύρω από ένα γραφικό.
Thumbnails Μικρογραφίες Πρόχειρες μικρές εικόνες χαμηλής ανάλυσης που δείχνουν την 

προεπισκόπηση ενός γραφικού ή φωτογραφίας
TIFF Tag Image File Format Το πιο δημοφιλές και διαδεδομένο φόρμα ψηφιοποίησης 

αρχείων εικόνας. Υποστηρίζεται απ' όλα σχεδόν τα προγράμματα 
επεξεργασίας εικόνας

Tiles Τρόπος εκτύπωσης μεγάλων μεγεθών εικόνων (αφίσες). Το φύλλο 
χωρίζεται σε μικρότερα τα οποία τυπώνονται, και μετά σχηματίζεται 
η τελική εικόνα με τον συνδυασμό τους

Tone curves Τονικές καμπύλες. Αναφέρονται και ως καμπύλες gamma. Ενσωματώνονται στα 
περισσότερα προγράμματα επεξεργασίας εικόνας, για την μεταβολή 
των τόνων της φωτογραφίας είτε RGB, είτε τετραχρωμίας.

Toolbox Εργαλειοθήκη Ένα μικρό παράθυρο που περιέχει πλήκτρα για όλα τα εργαλεία 
λειτουργίας του προγράμματος

Vector graphics Διανυσματικά γραφικά Σχέδια που αποτελούνται από γραμμές (όλων των ειδών), που 
περιγράφονται από μαθηματικούς τύπους.

Weight Βάρος γράμματος Το πάχος της γραμμής (κοντυλιάς) του γράμματος.
Word Spacing Απόσταση λέξεων Το ποσοστό ελεύθερου διαστήματος ανάμεσα από τις λέξεις μιας 

γραμμής. Στην στοιχειοθεσία είναι μεταβλητό και προσαρμόζεται 
ανάλογα με το μέγεθος του γράμματος και το μήκος της αράδας.

WYSIWYG WYSIWYG Ακρωνύμιο των λέξεων «What You See Is What You Get”. Αναφέρεται 
στην ποιότητα απόδοσης στην οθόνη του υπολογιστή των κειμένων ή 
των γραφικών και εννοεί ότι υπάρχει πλήρης ταύτιση με τις τελικές 
εκτυπώσεις.
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Ευρετήριο όρων

Adobe Type Manager, 190	 Ανάλυση Εικόνας, 17, 25, 89
Camera obscura, 13	 Ανάλυση εξόδου, 25
CCD, 15, 86	 Απόχρωση, 47
CMYK, 22, 33, 66	 Αρνητικό, 13
Combine, 172	 ATM, 190
Desktop Publishing, 181	 Αυτοματισμοί, 52
Document layout palette, 186	 Αυτόνομο πρόγραμμα, 51
Droplet, 51	 Βάθος χρώματος, 18
EPS, 34	 Βασική εργαλειοθήκη, Photoshop 42
feather, 46	 Βασική εργαλειοθήκη, Corel 113
font, 189	 Γέμισμα σχήματος, 133
Fountain fill, 163	 Γεμίσματα, 164
GIF, 34	 Γκρίζες κλίμακες, 62
Grayscale, 21	 Γραμματοσειρά, 189, 194
group, 140	 Γραμμές - οδηγοί, 117
image mode, 21	 Γραμμή διάστασης, 122
Indexed mode, 22	 Διαβάθμιση χρώματος, 50
Intersect, 173	 Διαβαθμισμένο γέμισμα, 163
Johannes Vermeer, 13	 Διαγραφή σελίδων, 187
JPEG, 36	 Διαμόρφωση Σελίδας, 114
Kerning, 201	 Διαστασιολόγηση, 122
Layer opacity, 74	 Διάστηλο, 205
Layer Style, 76	 Διάστημα χαρακτήρων, 200
layers, 73	 Διάστιχο, 202
LZW, 36	 Διάταξη, 171
Megapixels, 86, 26	 Διαχειριστής Αντικειμένων, 143
Mpixel, 26	 Εικονοστοιχείο, 16
Navigator palette, 45	 Εισαγωγή εικόνας, 216
Object Manager, 143	 Εισαγωγή κειμένου, 196
Options palette, 45	 Εισαγωγή νέων σελίδων, 187
Order, 171	 Εισαγωγή στηλών, 205
Page Setup, 114	 Έλξη στα αντικείμενα, 119
PDF, 34	 Έλξη στον κάνναβο, 115
PNG, 34	 Επικεφαλίδα Αρχείου, 32
Postscript, 31, 189	 Επιλογές εκτύπωσης, 210
Raster images, 98	 Επιλογή αντικειμένων, 139
RGB, 22, 65, 163	 Επίπεδα, 72, 73
Shape tool, 131	 Επίπεδα σχεδίασης, 142
TIFF, 34	 Επιτραπέζια τυπογραφία, 180
Tolerance, 46	 Εργαλεία διευθέτησης αντικειμένων, 169
Tracking, 200	 Εργαλεία επιλογής, 46
Transformations, 149	 Εργαλείο Bezier, 130
Trim, 173	 Εργαλείο ελεύθερης σχεδίασης, 129
TrueType, 189	 Εργαλείο μεγεθύνσεων, 121
Ungroup, 140	 Εργαλειοθήκες, 42, 128, 184
Uniform Fill, 162	 Εσοχές, 203
Vector graphics, 31	 Ημιτονική κουκκίδας, 25, 91, 92
Weld, 172	 Θερμοκρασία χρώματος, 58
Zoom, 121	 Θέση εικόνας, 215
Αδιαφάνεια, 49	 Ιδιότητες εργαλείων χρωματισμού, 48
Ακριβείς Μετασχηματισμοί, 149	 Καδράρισμα, 223
αλγόριθμοι συμπίεσης, 35	 Κάνναβος, 115
Άμεσης αντιστοίχησης, 25	 Κείμενο διάστασης, 122
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Κλίμακα χαρακτήρων, 201	 Τοποθέτηση, 196
κλιμάκωση, 146	 Τρόπος ανάμιξης, 49
Κλωνοποίηση, 141	 Τύποι εικόνων, 214
Κόμβοι, 129	 Υποσέλιδο, 120
Λάσο, 46	 Υφή, 165
Μάσκα, 78, 79, 80	 Φωτοκύτταρα, 14
Μάσκες, 79, 80	 Φωτοσκίαση, 59
Μέγεθος εικόνας, 89, 216	 Χρήση πρότυπου, 111
Μεγέθυνση, 192	 Χρωματικό σύστημα, 21
Μονάδες μέτρησης της τυπογραφίας, 187	 Χρωματικό τρίγωνο, 69
Μορφοποίηση κειμένου, 198	 Χρωματισμός χαρακτήρων, 199
Μορφοποίηση παραγράφων, 202	 Ψηφιακή εικόνα, 16
Μοτίβα, 164	 Ψηφιακή φωτογραφία, 16
Ντεγκραντέ, 163
Ομαδική επιλογή, 140
Ομαδοποίηση, 140
Ομοιόμορφο γέμισμα, 162
Ορατό φάσμα, 57
Ουρά, 32
Παλέτα, 32
Παλέτα διαμόρφωσης εγγράφου, 186
Παλέτα επιλογής ιδιοτήτων, 45
Παλέτα μετρήσεων, 185
Παλέτα πλοήγησης, 45
Παλέτα των καναλιών, 81
Παλέτα χρωμάτων, 113
Παλέτες, 184
Παραμόρφωση εικόνας, 217
Περιγράμματα, 158
Περιστροφή, 148
Περιστροφή εικόνας, 217
Πλαίσιο επιλογής, 139
Πλέγμα, 115
Προβολή εκτύπωσης, 121
Προβολή περιγραμμάτων, 121
Προσαρμογή των εικόνων, 216
Πυκνόμετρο, 63
Πυκνότητα, 63
Πύκνωση ζευγών χαρακτήρων, 201
Ροή κειμένου, 197
Ροή χρώματος, 50
Σαρωτής εικόνων, 88
Σελιδαρίθμηση, 187
Στρέβλωση, 148
Στυλ επιπέδου, 76
Συλλαβισμός, 204
Συνθήκες φωτισμού, 60
Σύστημα CMYK, 66
Σύστημα HSL, 65
Σύστημα L*a*b*, 67
Σύστημα RGB, 67
Σύστημα χρωμάτων, 64
Σχέση εικόνας και κειμένου, 224
Σωρός αντικειμένων, 139
Τονικές διαβαθμίσεις, 60
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Βάσει του ν. 3966/2011 τα διδακτικά βιβλία του Δημοτικού, 
του Γυμνασίου, του Λυκείου, των ΕΠΑ.Λ. και των ΕΠΑ.Σ. 
τυπώνονται από το ΙΤΥΕ - ΔΙΟΦΑΝΤΟΣ και διανέμονται 
δωρεάν στα Δημόσια Σχολεία. Τα βιβλία μπορεί να 
διατίθενται προς πώληση, όταν φέρουν στη δεξιά κάτω 
γωνία του εμπροσθόφυλλου ένδειξη «ΔIΑΤΙΘΕΤΑΙ ΜΕ 
ΤΙΜΗ ΠΩΛΗΣΗΣ». Κάθε αντίτυπο που διατίθεται προς 
πώληση και δεν φέρει την παραπάνω ένδειξη θεωρείται 
κλεψίτυπο και ο παραβάτης διώκεται σύμφωνα με τις 
διατάξεις του άρθρου 7 του νόμου 1129 της 15/21 Μαρτίου 
1946 (ΦΕΚ 1946,108, Α').
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